
Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Hướng dẫn này mô tả cấu hình và hoạt động của ILME-FR7 / ILME-FR7K Interchangeable Lens Digital Camera.

Tham khảo sách hướng dẫn này và hướng dẫn vận hành cho các thiết bị liên quan khi được yêu cầu.

Tổng quan

Ứng dụng sử dụng điển hình

Cấu hình hệ thống

Điều khiển một thiết bị đơn lẻ bằng điều khiển hồng ngoại từ xa đi kèm

Điều khiển một thiết bị đơn lẻ bằng máy tính bảng hoặc máy tính

Điều khiển một thiết bị đơn lẻ bằng bộ điều khiển từ xa bên ngoài

Điều khiển đa thiết bị bằng bảng điều khiển từ xa bên ngoài

Vị trí và chức năng của các bộ phận

Nhìn từ trước

Nhìn từ sau

Khối đầu nối

Nhìn từ mặt bên

Mặt trên

Nhìn từ dưới

Giá đỡ ống kính

Vị trí và chức năng của các bộ phận của điều khiển hồng ngoại từ xa (đi kèm)

Màn hình Ứng dụng web

Tổng quan màn hình Ứng dụng web

Cấu trúc của khu vực chung của màn hình

Cấu trúc màn hình hoạt động trực tiếp

Cấu trúc của màn hình vận hành phát lại

Cấu trúc màn hình cài đặt
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Chuẩn bị

Menu camera

Màn hình hiển thị máy quay

Gắn thiết bị

Gắn thẳng vào vị trí cố định

Gắn thẳng vào vị trí cố định trên cao

Gắn lên trần

Lắp/tháo ống kính

Thận trọng khi gắn/tháo ống kính

Kiểm tra công tắc ống kính

Biện pháp phòng ngừa khi sử dụng ống kính thu phóng

Gắn ống kính

Tháo ống kính

Cáp kết nối

Kết nối thiết bị với thiết bị mạng bằng kết nối có dây

Kết nối nguồn điện

Sử dụng nguồn AC

Sử dụng nguồn PoE++

Đặt lại chức năng xoay/nghiêng

Thiết lập cấu hình trước khi ghi hình

Khởi tạo thiết bị bằng Ứng dụng web

Truy cập Ứng dụng web từ trình duyệt web

Khởi tạo thiết bị

Cấu hình vận hành máy quay cơ bản

Chuẩn bị thẻ nhớ

Thẻ nhớ được hỗ trợ

Lắp thẻ nhớ

Tháo thẻ nhớ
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Ghi hình

Định dạng (khởi tạo) thẻ nhớ

Kiểm tra thời gian ghi còn lại

Khôi phục thẻ nhớ

Vận hành cơ bản

Bắt đầu/dừng ghi

Chuyển đổi giữa các thẻ nhớ

Kiểm tra âm thanh

Chỉ định dữ liệu thời gian

Xem lại bản ghi (Rec Review)

Điều chỉnh định khung

Màn hình điều chỉnh khung

Điều chỉnh hướng chụp

Điều chỉnh hướng chụp thủ công bằng Ứng dụng web

Cài đặt tốc độ vận hành xoay/nghiêng

Cài đặt gia tốc vận hành xoay/nghiêng

Điều chỉnh hướng chụp bằng điều khiển từ xa hồng ngoại đi kèm

Điều chỉnh thu phóng

Cài đặt loại thu phóng

Điều chỉnh thu phóng thủ công bằng Ứng dụng web

Cài đặt tốc độ vận hành thu phóng

Điều chỉnh thu phóng bằng điều khiển từ xa hồng ngoại đi kèm

Lưu/khôi phục vị trí xoay/nghiêng/thu phóng của camera (vị trí đặt trước)

Hiệu chuẩn ống kính ngàm E

Lưu/khôi phục cài đặt xoay/nghiêng, vị trí thu phóng và lấy nét bằng Ứng dụng web

Đổi tên vị trí đặt trước bằng Ứng dụng Web

Thay thế vị trí đặt trước đã lưu bằng một vị trí mới bằng Ứng dụng Web

Xóa vị trí đặt trước đã lưu bằng Ứng dụng Web

Đồng bộ vận hành xoay/nghiêng và vận hành thu phóng/lấy nét khi khôi phục vị trí đặt trước
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Thay đổi tốc độ chuyển đổi (xoay-nghiêng/thu phóng/lấy nét) khi khôi phục các vị trí đặt trước

Lưu/khôi phục cài đặt xoay/nghiên và vị trí thu phóng bằng điều khiển hồng ngoại từ xa đi kèm

Thao tác khung hình camera ghi/phát (di chuyển PTZ)

Ghi lại thao tác định khung máy quay bằng Ứng dụng Web

Phát thao tác định khung máy quay bằng Ứng dụng Web

Xóa thao tác định khung máy quay đã ghi bằng Ứng dụng Web

Ghi lại thao tác định khung máy quay bằng điều khiển từ xa hồng ngoại đi kèm

Phát thao tác định khung máy quay bằng điều khiển từ xa hồng ngoại đi kèm

Điều chỉnh lấy nét

Màn hình điều chỉnh tiêu điểm

Điều chỉnh lấy nét thủ công (Manual Focus)

Điều chỉnh thủ công bằng cách sử dụng ứng dụng web

Điều chỉnh thủ công bằng điều khiển từ xa hồng ngoại đi kèm

Lấy nét bằng cách chỉ định vị trí lấy nét (Spot Focus)

Sử dụng lấy nét tự động tạm thời (Push Auto Focus (AF))

Sử dụng tính năng lấy nét tự động trong một lần chụp (Push Auto Focus (AF-S))

Điều chỉnh lấy nét tự động (Auto Focus)

Điều chỉnh tự động bằng cách sử dụng Ứng dụng web

Điều chỉnh tự động bằng điều khiển hồng ngoại từ xa đi kèm

Cài đặt khu vực/vị trí lấy nét tự động (Focus Area)

Thay đổi nhanh khu vực lấy nét (Focus Setting)

Di chuyển khung hình khu vực lấy nét bằng thao tác cảm ứng (Touch Focus Area)

Điều chỉnh hoạt động lấy nét tự động (tốc độ chuyển đổi lấy nét tự động, độ nhạy chuyển đổi chủ thể khi lấy nét tự động)

Cài đặt mục tiêu lấy nét thủ công (AF Assist) bằng Ứng dụng web

Lấy nét thủ công trong khi lấy nét tự động bằng điều khiển hồng ngoại từ xa đi kèm

Sử dụng tạm thời tính năng lấy nét thủ công trong khi lấy nét tự động (Push Manual Focus)

Tìm kiếm bằng cách sử dụng chức năng phát hiện ra khuôn mặt và mắt (Face/Eye Detection AF)

Tìm kiếm đối tượng được chỉ định (Realtime Tracking AF)

Điều chỉnh độ sáng
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Các chức năng hữu ích

Màn hình điều chỉnh độ sáng

Đặt độ nhạy cơ bản

Đặt mức mục tiêu để điều chỉnh độ sáng tự động

Điều chỉnh cửa điều sáng

Điều chỉnh tự động cửa điều sáng

Điều chỉnh thủ công cửa điều sáng

Điều chỉnh độ lợi

Điều chỉnh tự động độ lợi

Điều chỉnh độ lợi theo cách thủ công

Điều chỉnh màn trập

Điều chỉnh tự động cho màn trập

Điều chỉnh màn trập theo cách thủ công

Điều chỉnh mức độ ánh sáng (bộ lọc ND)

Về bộ lọc ND

Điều chỉnh ở chế độ đặt trước

Điều chỉnh tự động ở chế độ biến đổi

Điều chỉnh thủ công ở chế độ biến đổi

Điều chỉnh để có màu sắc tự nhiên (cân bằng trắng)

Màn hình điều chỉnh cân bằng trắng

Điều chỉnh cân bằng trắng tự động

Điều chỉnh cân bằng trắng thủ công

Chạy cân bằng trắng tự động

Định cấu hình âm thanh ghi

Màn hình cấu hình âm thanh

Chọn thiết bị đầu vào tự động

Tự động điều chỉnh mức âm thanh ghi

Điều chỉnh mức âm thanh ghi theo cách thủ công

Thao tác menu trực tiếp
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Nút có thể gán

Chuyển động nhanh và chậm

Quay video không liên tục (Interval Rec)

Ghi ảnh vào bộ nhớ đệm (Picture Cache Rec)

Ghi đồng thời vào các thẻ nhớ A và B (2-slot Simul Rec)

Màn hình giám sát tín hiệu video

Cờ của clip

Bù góc nhìn

Ghi proxy

Tổng quan ghi proxy

Ghi proxy

Chụp với giao diện mong muốn

Tổng quan giao diện

Chọn giao diện

Nhập giao diện cơ bản mong muốn

Tùy chỉnh giao diện

Lưu giao diện

Xóa giao diện cơ bản

Chụp với điều chỉnh dáng vẻ trong hậu kỳ

Chụp với điều chỉnh dáng vẻ trong hậu kỳ

Áp dụng LUT cho đầu ra HDMI và phát trực tiếp

Thay đổi LUT

Thay đổi sự phân bố các vùng sáng và tối trong hình ảnh đã ghi

Ghi RAW

Ghi video RAW

Ghi video RAW ở chế độ Slow & Quick Motion

Điều khiển bokeh (chức năng điều khiển bokeh)

Bật/tắt chức năng điều khiển cửa điều sáng
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Chức năng mạng

Màn hình ảnh thu nhỏ

Menu camera và cài đặt chi tiết

Điều chỉnh mức độ bokeh

Lưu và tải dữ liệu cấu hình

Tổng quan lưu và tải dữ liệu cấu hình

Lưu một tệp ALL

Tải một tệp ALL

Truyền tệp

Giới thiệu về truyền tệp

Đăng ký đích truyền tệp

Chọn tệp và tải lên

Tải lên tệp proxy trên thẻ nhớ từ màn hình ảnh thu nhỏ

Tải lên tệp gốc trên thẻ nhớ từ màn hình ảnh thu nhỏ

Kiểm tra quá trình truyền tệp

Tải lên bằng FTP an toàn

Định cấu hình phát trực tiếp

Về phát trực tiếp

Thiết lập định dạng phát trực tuyến

Đặt bộ mã hóa âm thanh để phát trực tiếp

Đặt codec âm thanh để phát trực tuyến

Bắt đầu/kết thúc phát trực tiếp

Màn hình ảnh thu nhỏ

Phát clip và các vận hành clip khác

Phát clip đã ghi

Thao tác trên clip đã ghi

Cấu hình menu camera

Vận hành menu camera

Vận hành menu camera
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Nhập chuỗi ký tự

Menu User

User

Menu Edit User

Edit User

Menu Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Menu Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Menu Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Menu Pan-Tilt

P/T Acceleration

Menu TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Menu Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Menu Audio
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Audio Input

Audio Output

Menu Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Menu Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Menu Network

Wired LAN

File Transfer

Menu Maintenance

Language

Clock Set

Hours Meter

Cài đặt Menu Shooting và các giá trị mặc định

Cài đặt và giá trị mặc định ISO/Gain
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Menu trang web và cài đặt chi tiết

Cài đặt và giá trị mặc định AGC Limit

Cài đặt chất lượng hình ảnh đã lưu dành cho mỗi chế độ chụp

Cấu hình menu web

Vận hành menu web

Menu Shooting

Focus

Menu Project

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Menu Paint/Look

Base Look

Menu Pan-Tilt

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Menu Monitoring

Output Format

Output Display

Menu Audio

Audio Input
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Audio Output

Menu Technical

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Menu Network

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 thành 3

SSL

Referer Check

Brute Force Attack Protection

Menu Stream

Stream

Video Stream

Audio Stream

Menu Maintenance

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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Kết nối thiết bị bên ngoài

Phụ lục

Service

EULA

Software

Kết nối các màn hình giám sát và các thiết bị ghi bên ngoài

Kết nối một RCP/MSU (tùy chọn)

Kết nối với RCP/MSU

Kết nối một-một giữa thiết bị và RCP

Sử dụng thiết bị trong môi trường nhiều máy quay với phần mềm điều khiển từ xa MSU/máy quay

Danh sách chức năng được hỗ trợ

Vận hành sử dụng bảng điều khiển từ xa RM-IP500 (tùy chọn)

Về vận hành sử dụng bảng điều khiển từ xa RM-IP500 (tùy chọn)

Kết nối bộ điều khiển từ xa RM-IP500

Đồng bộ hóa với thiết bị bên ngoài

Đồng bộ hóa với thiết bị bên ngoài

Đồng bộ hóa pha của tính hiệu video (Genlock)

Khóa mã thời gian đối với các thiết bị khác

Kết nối micrô bên ngoài hoặc thiết bị âm thanh bên ngoài

Quản lý/chỉnh sửa các clip bằng máy tính

Xuất tín hiệu cáp quang

Kết nối tín hiệu báo hiệu

Xuất dữ liệu theo dõi (free-d)

Kết nối bộ điều khiển ống kính

Điều chỉnh thu phóng bằng bộ điều khiển ống kính

Thận trọng khi sử dụng

Định dạng đầu ra và giới hạn

Khắc phục sự cố

Thông báo lỗi/cảnh báo
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5-041-959-03(1) Copyright 2022 Sony Corporation

Danh sách mục menu

Mục đã lưu vị trí đặt trước

Sơ đồ khối

Cập nhật phần mềm ống kính ngàm E

Gắn nắp nút tháo ống kính

Giấy phép

Thông số kỹ thuật

Thương hiệu
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cấu hình hệ thống

Có thể kết hợp thiết bị này với các thiết bị ngoại vi để tạo thành các cấu hình hệ thống khác nhau.

Ống kính ngàm E1.

Bộ chuyển đổi ngàm A LA-EA3 / LA-EA42.

Điều khiển hồng ngoại từ xa (đi kèm)3.

Thẻ nhớ CFexpress Type A / Thẻ nhớ SDXC4.

Đầu đọc thẻ CFexpress Type A / Đầu đọc thẻ SD5.

Micrô ECM-680S, ECM-678*, ECM-674*6.
Yêu cầu cáp của bộ chuyển đổi 3 pin → 5 pin XLR EC-0.5X3F5M.*

Bộ chuyển đổi AC (đi kèm)7.

Màn hình giám sát video8.

Điều khiển từ xa RM-IP5009.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều khiển một thiết bị đơn lẻ bằng điều khiển hồng ngoại từ xa đi kèm

Bạn có thể điều khiển một thiết bị từ xa bằng điều khiển hồng ngoại từ xa đi kèm.

 Tín hiệu video
 Luồng tín hiệu

5-041-959-03(1) Copyright 2022 Sony Corporation

Điều khiển hồng ngoại từ xa (đi kèm)1.

Màn hình giám sát video2.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều khiển một thiết bị đơn lẻ bằng máy tính bảng hoặc máy tính

Bạn có thể kết nối máy tính bảng hoặc máy tính với thiết bị, sau đó điều khiển thiết bị bằng trình duyệt web.

 Tín hiệu video
 Tín hiệu điều khiển từ xa

  Luồng tín hiệu

5-041-959-03(1) Copyright 2022 Sony Corporation

Màn hình giám sát video1.

Máy tính bảng2.

Máy tính3.

Điểm truy cập4.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều khiển một thiết bị đơn lẻ bằng bộ điều khiển từ xa bên ngoài

Bạn có thể điều khiển một thiết bị từ xa bằng bộ điều khiển từ xa.

 Tín hiệu video
 Tín hiệu điều khiển từ xa

  Luồng tín hiệu

5-041-959-03(1) Copyright 2022 Sony Corporation

Màn hình giám sát video1.

Điều khiển từ xa RM-IP5002.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều khiển đa thiết bị bằng bảng điều khiển từ xa bên ngoài

Bạn có thể điều khiển từ xa tối đa 100 thiết bị bằng cách sử dụng chỉ duy nhất một bảng điều khiển từ xa.

 Tín hiệu video
 Tín hiệu điều khiển từ xa
 Tín hiệu báo hiệu/liên lạc

  Luồng tín hiệu

5-041-959-03(1) Copyright 2022 Sony Corporation

Màn hình giám sát video1.

Nút chuyển video2.

Cổng Ethernet hub3.

Điều khiển từ xa RM-IP5004.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nhìn từ trước

Chủ đề này mô tả vị trí và chức năng của các bộ phận ở mặt trước của thiết bị.

Gợi ý

Mô tả này đề cập đến phần minh họa của thiết bị không có ống kính đi kèm.

Đầu camera

Chú ý

Không để đầu camera bị va đập mạnh.

1.

Đèn ghi/đếm
Khi được định cấu hình làm đèn ghi, đèn sẽ sáng màu đỏ khi ghi vào thẻ nhớ. Đèn nhấp nháy khi dung lượng trống
còn lại trên phương tiện ghi gần hết hoặc khi xảy ra lỗi.

2.
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Để biết thêm thông tin chi tiết, hãy tham khảo “Thông báo lỗi/cảnh báo.”

Khi được định cấu hình làm đèn đếm, đèn sẽ sáng màu đỏ hoặc xanh theo tín hiệu đếm bên ngoài.

Để biết thêm thông tin chi tiết, hãy tham khảo “Kết nối tín hiệu báo hiệu”.
Bộ cảm biến hình ảnh

Chú ý

Không chạm trực tiếp bằng tay.

3.

Nút tháo ống kính
Nhấn để tháo ống kính.

Để biết thêm thông tin chi tiết, hãy tham khảo “Tháo ống kính”.

4.

Tiếp điểm tín hiệu ống kính

Chú ý

Không chạm trực tiếp bằng tay.

5.

Đèn POWER6.

Đèn NETWORK
Trạng thái của thiết bị được hiện thông qua kết hợp giữa màu hiển thị và trạng thái bật sáng (sáng, nhấp nháy, không
sáng) của đèn POWER và đèn NETWORK.

7.

Đèn POWER Đèn NETWORK Trạng thái của thiết bị

Màu xanh lá
cây sáng*1

Màu xanh lá cây
sáng

Bật nguồn (đã kết nối mạng)

Không sáng Bật nguồn (chưa kết nối mạng)

Nhấp nháy
màu xanh

Không sáng Đang thực hiện quá trình bật nguồn

Màu cam sáng Không sáng Trạng thái chờ nguồn điện

Nhấp nháy
màu vàng

Không sáng Đang thực hiện cập nhật phần mềm

Nhấp nháy
chậm màu
cam*2

Nhấp nháy chậm
màu xanh*2

Thiết bị không thể vận hành bình thường. Để biết thêm thông tin chi tiết, hãy
tham khảo nhật ký hệ thống. Nếu sự cố vẫn tiếp diễn ngay cả khi đặt thiết bị
ở chế độ chờ hoặc tắt nguồn rồi bật lại, hãy liên hệ với đại diện dịch vụ Sony
của bạn.

Nhấp nháy
nhanh màu
cam*3

Nhấp nháy
nhanh màu
xanh*3

Đã xảy ra sự cố trong thiết bị. Hãy liên hệ với đại diện dịch vụ Sony.

Nhấp nháy màu xanh khi nhận lệnh từ điều khiển hồng ngoại từ xa đi kèm.*1

Nhấp nháy chậm: Nhấp nháy một lần mỗi giây*2

Nhấp nháy nhanh: Nhấp nháy bốn lần mỗi giây*3

Cảm biến điều khiển hồng ngoại từ xa
Nhận tín hiệu điều khiển từ điều khiển hồng ngoại từ xa đi kèm.

8.
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Chủ đề liên quan

Thông báo lỗi/cảnh báo

Kết nối tín hiệu báo hiệu

Tháo ống kính

5-041-959-03(1) Copyright 2022 Sony Corporation

Lỗ khí vào

Chú ý

Không chặn luồng không khí. Làm như vậy có thể gây ra sự cố.

9.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nhìn từ sau

Chủ đề này mô tả vị trí và chức năng của các bộ phận ở mặt sau của thiết bị.

Chủ đề liên quan

Nhìn từ mặt bên

5-041-959-03(1) Copyright 2022 Sony Corporation

Lẫy khóa đầu camera
Khóa chuyển động về phía trước/phía sau của đầu máy quay.

Chú ý

Luôn đặt sang vị trí khóa khi không thay đổi ống kính.

Luôn tháo rời ống kính và đặt sang vị trí khóa mỗi khi di chuyển thiết bị.

Tắt nguồn của thiết bị và khóa ngang đầu camera bằng lẫy khóa xoay/nghiêng trước khi vận hành lẫy khóa để tránh bị
thương do ngón tay bị kẹp. Để biết thêm chi tiết về lẫy khóa xoay/nghiêng, hãy tham khảo “Lẫy khóa xoay/nghiêng” trong
“Nhìn từ mặt bên.”

1.

Đế trượt2.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Khối đầu nối

Chủ đề này mô tả vị trí và chức năng của các bộ phận ở khối đầu nối của thiết bị.

Đầu nối  (đất)
Kết nối với đất bằng cách kết nối với đầu nối đất của ổ điện hoặc với thanh tiếp đất.

1.

Đầu nối DC IN (giắc cắm tiêu chuẩn)
Kết nối với bộ chuyển đổi AC.

Chú ý

Không sử dụng bất kỳ bộ chuyển đổi AC nào khác với bộ chuyển đổi được cung cấp. Kết nối bộ chuyển đổi khác có thể gây
ra hỏa hoạn hoặc sự cố.

2.

Đầu nối  LAN (mạng) (RJ-45)
Kết nối cáp mạng (loại 5e trở lên) để giao tiếp mạng và cấp nguồn PoE++*.

Trạng thái hiển thị đèn LED tốc độ
Cho biết tốc độ của kết nối mạng.

3.

PoE++: Cấp nguồn qua Ethernet Plus Plus. Phù hợp với IEEE802.3bt (Loại 4 Bậc 8). Để biết chi tiết về cách kết nối, hãy tham khảo hướng
dẫn vận hành của thiết bị cung cấp điện.

*
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Trạng thái màn hình hiển thị đèn LED Link/ACT
Cho biết trạng thái của kết nối mạng.

Chú ý

Khi kết nối sản phẩm này với Internet, hãy kết nối qua hệ thống cung cấp chức năng bảo vệ, chẳng hạn như bộ định tuyến
hoặc tường lửa. Nếu được kết nối mà không có biện pháp bảo vệ như vậy, các vấn đề bảo mật có thể xảy ra.

Hiển thị  Tốc độ kết nối

Không sáng
Kết nối 10 Mbps

Kết nối 100 Mbps

Màu cam sáng Kết nối 1000 Mbps

Hiển thị  Trạng thái kết nối

 Không sáng Không có liên kết

Nhấp nháy màu xanh Liên kết được thiết lập, dữ liệu đang hoạt động

Màu xanh lá cây sáng Liên kết đang hoạt động

Đầu nối TC IN
Nhập tín hiệu mã thời gian tham chiếu bên ngoài.

Để biết thêm thông tin chi tiết, hãy tham khảo “Khóa mã thời gian đối với các thiết bị khác”.

4.

Đầu nối HDMI
Xuất video từ thiết bị dưới dạng tín hiệu HDMI.

Để biết thêm thông tin chi tiết, hãy tham khảo “Đầu nối HDMI (Đầu nối loại A)” trong “Kết nối các màn hình giám
sát và các thiết bị ghi bên ngoài.”

5.

Vít lắp tấm giữ cáp HDMI
Để ngăn cáp HDMI bị tuột ra, hãy gắn tấm giữ cáp HDMI đi kèm bằng vít lắp đi kèm (M2.6 × 6) và gắn cáp HDMI
bằng dây buộc hoặc dải cáp có bán trên thị trường.

Để biết chi tiết về cách gắn tấm giữ cáp HDMI, hãy xem “Cáp kết nối.”

6.

Đầu nối OPTION
Sử dụng để kết nối tín hiệu báo hiệu từ thiết bị bên ngoài hoặc bộ điều khiển ống kính.

Để biết thêm thông tin chi tiết, hãy tham khảo “Kết nối tín hiệu báo hiệu” và “Kết nối bộ điều khiển ống kính”.

7.

Bộ kẹp dây
Sử dụng để cố định dây bộ chuyển đổi AC.

8.

Công tắc RESET
Nhấn trong ít nhất 5 giây bằng cách sử dụng đầu bút hoặc thiết bị tương tự để đặt lại cài đặt của thiết bị về giá trị
mặc định của nhà sản xuất.
Bạn có thể chọn chỉ đặt lại cài đặt kết nối mạng hay tất cả cài đặt bằng công tắc SETUP 1.

9.

Đầu nối đầu ra OPTICAL
Xuất tín hiệu SDI được chuyển đổi sang định dạng quang học khi kết nối mô-đun SFP+ (tùy chọn).

Để biết thêm thông tin chi tiết, hãy tham khảo “Xuất tín hiệu cáp quang.”

10.
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Công tắc SETUP

Định cấu hình các thiết lập sau.
Công tắc 1: Đặt cài đặt nào sẽ được đặt lại khi nhấn công tắc RESET.

Công tắc 2: Đặt xem nguồn điện +48 V (nguồn ảo) có được bật/tắt khi thiết bị đầu vào âm thanh được kết nối hay
không. Cài đặt được áp dụng ngay lập tức.
Chức năng này được bật khi [Audio] > [Audio Input] > [AUDIO IN Select] được đặt thành [MIC] trong menu camera.

Chú ý

Cài đặt công tắc 2 sang vị trí ON và kết nối micrô không tương thích với nguồn +48V có thể làm hỏng thiết bị được kết nối.
Kiểm tra thông tin cài đặt trước khi kết nối thiết bị.

Công tắc 3: Bật/tắt giao tiếp VISCA over IP. Các cài đặt được áp dụng khi bật camera.
Đặt ở vị trí ON để sử dụng thiết bị khi được kết nối với bộ điều khiển từ xa (RM-IP500).

Chú ý

Nếu mật khẩu của quản trị viên chưa được định cấu hình, giao tiếp VISCA over IP sẽ bị tắt, bất kể cài đặt công tắc là gì. Để
biết chi tiết về cách định cấu hình mật khẩu quản trị viên, hãy xem “Khởi tạo thiết bị.”

Công tắc 4: Thay đổi tốc độ của các hoạt động xoay/nghiêng được gửi từ điều khiển hồng ngoại từ xa. Cài đặt được
áp dụng ngay lập tức.

11.

Cài đặt Mô tả

OFF (mặc
định)

Chỉ đặt lại cài đặt kết nối mạng. Cài đặt mạng, cài đặt bảo mật và thông tin người dùng (tên người
dùng và mật khẩu) của thiết bị sẽ được đặt lại.

ON Đặt lại tất cả các cài đặt về cài đặt gốc mặc định.

Cài đặt Mô tả

OFF (mặc
định)

Không cấp nguồn +48 V (nguồn điện ảo). Định cấu hình cài đặt này khi sử dụng thiết bị âm thanh
bên ngoài (chẳng hạn như bộ trộn), micrô động hoặc micrô có pin tích hợp.

ON
Cấp nguồn +48 V (nguồn điện ảo) cho micrô tương thích với nguồn ảo được kết nối với đầu nối
AUDIO IN (CH-1 hoặc CH-2).

Cài đặt Mô tả

OFF (mặc định) Sẽ không phản hồi các lệnh VISCA over IP.

ON Chấp nhận các lệnh VISCA over IP.

Cài đặt Mô tả

OFF (mặc định) Hoạt động ở tốc độ bình thường.

27



Chủ đề liên quan

Khóa mã thời gian đối với các thiết bị khác

Kết nối các màn hình giám sát và các thiết bị ghi bên ngoài

Cáp kết nối

Kết nối tín hiệu báo hiệu

Kết nối bộ điều khiển ống kính

Xuất tín hiệu cáp quang

Khởi tạo thiết bị

Đồng bộ hóa pha của tính hiệu video (Genlock)

Kết nối micrô bên ngoài hoặc thiết bị âm thanh bên ngoài

5-041-959-03(1) Copyright 2022 Sony Corporation

Cài đặt Mô tả

ON Hoạt động ở tốc độ tối đa.

Đầu nối SDI OUT
Xuất video từ thiết bị dưới dạng tín hiệu 12G/6G/3G/HD-SDI.
Cũng có thể cấu hình thiết bị cho đầu ra tín hiệu RAW.

Để biết thêm thông tin chi tiết, hãy tham khảo “Đầu nối SDI OUT (loại BNC)” trong “Kết nối các màn hình giám sát
và các thiết bị ghi bên ngoài”.

12.

 Cảm biến điều khiển hồng ngoại từ xa (mặt sau)
Cảm biến hồng ngoại cho điều khiển hồng ngoại từ xa đi kèm.

13.

Quạt/lỗ thông khí
Phát nhiệt từ bên trong thiết bị.

Chú ý

Không che lỗ thông khí. Làm như vậy có thể gây ra sự cố.

Lưu ý rằng khu vực gần cửa thoát khí có thể trở nên nóng.

14.

Đầu nối GENLOCK
Sử dụng để nhập tín hiệu đồng bộ bên ngoài.

Để biết thêm thông tin chi tiết, hãy tham khảo “Đồng bộ hóa pha của tính hiệu video (Genlock)”.

15.

Đầu nối AUDIO IN (Đầu nối XLR loại 5-chân)
Sử dụng để nhập tín hiệu từ micrô bên ngoài hoặc thiết bị âm thanh.
Nó hoạt động như một đầu nối AUDIO IN CH-1 hoặc AUDIO IN CH-2.

Để biết thêm thông tin chi tiết, hãy tham khảo “Kết nối micrô bên ngoài hoặc thiết bị âm thanh bên ngoài”.

16.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nhìn từ mặt bên

Chủ đề này mô tả vị trí và chức năng của các bộ phận ở mặt bên của thiết bị.

Gợi ý

Mô tả này đề cập đến phần minh họa của thiết bị không có ống kính đi kèm.

Lẫy khóa xoay/nghiêng
Khóa cơ chế xoay/nghiêng của thiết bị. Sử dụng trong các trường hợp sau.

Khi vận chuyển hoặc đóng gói thiết bị.
Khi gắn hoặc tháo ống kính. Để biết thêm thông tin chi tiết, hãy tham khảo “Gắn ống kính” hoặc “Tháo ống kính.”
Khi sử dụng ống kính không hỗ trợ hoạt động xoay/nghiêng (chẳng hạn như ống kính Sony SEL100400GM /
SEL200600G / SEL400F28GM / SEL600F40GM).
Luôn tháo rời ống kính và đặt sang vị trí khóa mỗi khi di chuyển thiết bị.

Gợi ý

1.
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Chủ đề liên quan
Gắn ống kính

Tháo ống kính

Lắp thẻ nhớ

Truy cập Ứng dụng web từ trình duyệt web

5-041-959-03(1) Copyright 2022 Sony Corporation

Chuyển động xoay/nghiêng có thể được cố định ở các góc sau.

Đế trượt2.

Lỗ bắt vít cho các thiết bị bên ngoài (4 vị trí)
Đối với vít M3 có chiều dài lên đến 6 mm.

Chú ý

Không sử dụng các vít có chiều dài lớn hơn 6 mm. Làm như vậy có thể gây ra sự cố.

3.

Chỉ báo truy cập A4.

Chỉ báo truy cập B
Chỉ báo sáng hoặc nhấp nháy khi phương tiện ghi được lắp vào.

Để biết thêm thông tin chi tiết, hãy tham khảo “Lắp thẻ nhớ.”

5.

Khe cắm thẻ CFexpress Type A / SD (A)6.

Khe cắm thẻ CFexpress Type A / SD (B)
Sử dụng để lắp phương tiện ghi.

Để biết thêm thông tin chi tiết, hãy tham khảo “Lắp thẻ nhớ.”

7.

Mã QR để kết nối mạng
Sử dụng khi cấu hình cài đặt ban đầu.

Để biết thêm thông tin chi tiết, hãy tham khảo “Truy cập Ứng dụng web từ trình duyệt web.”

8.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Mặt trên

Chủ đề này mô tả vị trí và chức năng của các bộ phận ở mặt trên của thiết bị.

Gợi ý

Mô tả này đề cập đến phần minh họa của thiết bị không có ống kính đi kèm.

5-041-959-03(1) Copyright 2022 Sony Corporation

Các lỗ bắt vít dành cho các thiết bị bên ngoài (2 nơi)
Phù hợp với các vít 1/4-20 UNC dành cho chân máy quay.
Chiều dài tối đa là 6 mm.

1.

ɸ (dấu bộ tạo ảnh)
Dấu bộ tạo ảnh nằm trên cùng một mặt phẳng với bộ cảm biến hình ảnh.
Để đo chính xác khoảng cách giữa thiết bị và vật thể, hãy sử dụng dấu bộ tạo ảnh này làm điểm mốc.

2.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nhìn từ dưới

Chủ đề này mô tả vị trí và chức năng của các bộ phận ở phía dưới của thiết bị.

Gợi ý

Mô tả này đề cập đến phần minh họa của thiết bị không có ống kính đi kèm.

Lỗ bắt vít giá đỡ trên trần (6 vị trí, 5,5 mm độ sâu ren hiệu dụng)
Khi lắp thiết bị lên trần hoặc giá ở vị trí cao, hãy gắn khung thân (tùy chọn) vào đế của thiết bị bằng sáu vít gắn
khung thân trong các lỗ bắt vít này.

Để biết chi tiết về cách lắp, hãy xem “Gắn thẳng vào vị trí cố định trên cao” và “Gắn lên trần.”

1.

Vít gắn chân máy (2 vị trí)
Được sử dụng khi gắn thiết bị lên chân máy quay (tùy chọn, vít 1/4-20 UNC có chiều dài lên đến 5,5 mm).

Chú ý

2.
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Chủ đề liên quan

Gắn thẳng vào vị trí cố định trên cao

Gắn lên trần

5-041-959-03(1) Copyright 2022 Sony Corporation

Không sử dụng các vít có chiều dài lớn hơn 5,5 mm. Làm như vậy có thể gây ra sự cố.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Giá đỡ ống kính

Chủ đề này mô tả vị trí và chức năng của các bộ phận giá đỡ ống kính của thiết bị.

Gợi ý

Mô tả này đề cập đến phần minh họa của thiết bị không có ống kính đi kèm.

Thanh giá đỡ ống kính (2)
Đỡ ống kính.
Cũng có thể được dùng để gắn các phụ kiện của thanh Ø15.

1.
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Thiết bị đỡ ống kính
Giá đỡ ống kính có thể trượt về phía trước/phía sau theo ống kính và sau đó được lắp chặt.

2.

Vít gắn chân giá đỡ ống kính
Gắn vào chân giá đỡ ống kính. Bạn có thể điều chỉnh vít lên/xuống sao cho phù hợp với chiều cao của chân giá đỡ
ống kính.

3.

Cần kẹp thanh giá đỡ ống kính (2 vị trí)
Cố định vị trí phía trước/phía sau của bộ phận đỡ ống kính.

4.

Cần kẹp chân giá đỡ ống kính
Giữ chặt vị trí thẳng đứng của vít gắn chân giá đỡ ống kính.

Gợi ý

Nếu cần kẹp ở vị trí khó xoay, hãy nhả cần kẹp ra và xoay theo một góc sẽ giúp thao tác dễ dàng hơn. Khi đã lắp đúng vị trí,
đóng cần kẹp.

A: Cần kẹp vít gắn chân giá đỡ ống kính
B: Cần kẹp thanh giá đỡ ống kính

Chú ý

Để ngăn bộ phận đỡ ống kính can thiệp vào hoạt động xoay/nghiêng, hãy di chuyển bộ phận đỡ ống kính lên so với đầu máy
quay khi không sử dụng bộ phận đỡ ống kính và di chuyển vít gắn chân giá đỡ ống kính đến vị trí cao nhất của nó (gần ống
kính nhất).

5.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vị trí và chức năng của các bộ phận của điều khiển hồng ngoại từ xa (đi kèm)

Chủ đề này mô tả vị trí và chức năng của các bộ phận của điều khiển hồng ngoại từ xa (đi kèm).

Nút REC● (START/STOP ghi)
Nhấn để bắt đầu hoặc dừng ghi.

1.

Nút MENU
Nhấn để hiển thị hoặc ẩn menu camera.

2.

Các nút điều khiển GUI
Nhấn để thực hiện các thao tác trong menu camera, trong hộp thoại tin nhắn bao gồm các nút và các chức năng hiển
thị màn hình khác.

3.

Nút CANC./BACK
Nhấn để hủy cài đặt hoặc để quay lại màn hình trước của menu camera của thiết bị.

4.
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Pin điều khiển hồng ngoại từ xa

Điều khiển hồng ngoại từ xa yêu cầu hai pin AA (LR6).
Lắp pin vào điều khiển hồng ngoại từ xa như trong sơ đồ sau.

Các nút điều khiển xoay và nghiêng
Nhấn các nút mũi tên để điều khiển xoay/nghiêng camera. Nhấn nút HOME để hướng camera về phía trước.

5.

Các nút điều khiển vị trí đặt trước
Nhấn và giữ nút PRESET và nhấn một trong các nút từ 1 đến 3 để lưu trạng thái điều chỉnh hướng, thu phóng và tiêu
điểm của camera trong nút số đã nhấn.
Nhấn một nút số có cài đặt đã lưu để gọi lại trạng thái đã lưu.

6.

Các nút điều khiển tiêu điểm
Sử dụng để điều chỉnh tiêu điểm.
Để điều chỉnh tiêu điểm tự động, hãy nhấn nút AF.
Để điều chỉnh tiêu điểm theo cách thủ công, hãy nhấn nút MF, sau đó nhấn nút F (Xa) để lấy nét các chủ thể ở xa
hoặc nút N (Gần) để lấy nét cho các chủ thể gần.

7.

Các nút có thể chỉ định từ 1 đến 3
Thực hiện các chức năng được chỉ định cho các nút có thể chỉ định bằng menu camera.
Nếu bạn gán chức năng [Direct Menu] cho một nút có thể gán, bạn có thể điều chỉnh độ phơi sáng, cân bằng trắng
và các cài đặt khác bằng các nút điều khiển GUI.

Để biết thông tin chi tiết về việc chỉ định bằng menu camera, hãy xem “Nút có thể gán.”

Để biết thêm thông tin chi tiết về menu trực tiếp, hãy tham khảo “Thao tác menu trực tiếp”.

8.

Nút  (nguồn)
Nhấn để bật thiết bị hoặc để chuyển nguồn điện sang trạng thái chờ.

9.

Nút THUMBNAIL
Hiển thị màn hình ảnh thu nhỏ hiển thị các clip được ghi trên thẻ nhớ của thiết bị.

Để biết thêm thông tin chi tiết về màn hình ảnh thu nhỏ, hãy tham khảo “Màn hình ảnh thu nhỏ.”

Bạn có thể chọn clip và điều khiển phát lại trên màn hình ảnh thu nhỏ bằng các nút điều khiển GUI.

Để biết thông tin chi tiết về việc chọn clip và điều khiển phát lại, hãy xem “Phát clip đã ghi” và “Thao tác trên clip
đã ghi.”

10.

Nút SLOT SEL (chọn khe cắm thẻ nhớ (A)/(B))
Khi lắp hai thẻ nhớ vào, nhấn nút để chuyển đổi giữa các thẻ nhớ để ghi.
Nhấn nút này trong khi màn hình ảnh thu nhỏ được hiển thị để chuyển đổi giữa các thẻ nhớ để xem.

11.

Nút P/T RESET (đặt lại xoay/nghiêng)
Đặt lại các chức năng xoay/nghiêng. Nhấn nút khi đèn POWER và đèn NETWORK nhấp nháy đồng thời hoặc khi
[Execute Pan-Tilt Reset] được hiển thị trong bảng điều khiển khung trên Ứng dụng web.

12.

Các nút điều khiển thu phóng
Để phóng to, hãy nhấn nút T (chụp xa).
Để thu nhỏ, hãy nhấn nút W (rộng).

13.
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Chú ý

Không sử dụng bất kỳ loại pin nào ngoài pin mangan hoặc pin kiềm vì chúng có thể bị vỡ.

Vứt bỏ pin đã qua sử dụng theo luật pháp và quy định của quốc gia hoặc khu vực.

Chủ đề liên quan

Nút có thể gán

Thao tác menu trực tiếp

Màn hình ảnh thu nhỏ

Phát clip đã ghi

Thao tác trên clip đã ghi

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tổng quan màn hình Ứng dụng web

Bằng cách kết nối với máy tính bảng hoặc máy tính, bạn có thể xoay/nghiêng, thu phóng, ghi hình, phát video đã ghi và
định cấu hình thiết bị từ một trình duyệt web (sau đây, chức năng này được gọi là “Ứng dụng web”).

Để biết thêm thông tin chi tiết về khởi chạy Ứng dụng web, hãy tham khảo “Truy cập Ứng dụng web từ trình duyệt
web.”

Chú ý

Ứng dụng web không hỗ trợ đầu ra âm thanh máy quay.

Khi khởi chạy Ứng dụng Web, màn hình vận hành trực tiếp sau đây xuất hiện.

Màn hình vận hành trực tiếp

Để biết thêm thông tin chi tiết về màn hình vận hành trực tiếp, hãy tham khảo “Cấu trúc màn hình hoạt động trực
tiếp.”
Các nút và biểu tượng chung cho màn hình vận hành trực tiếp và màn hình vận hành phát lại được hiển thị ở trên
cùng của màn hình.
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Để biết thêm thông tin chi tiết về khu vực chung của màn hình, hãy tham khảo “Cấu trúc của khu vực chung của màn
hình.”
Bạn có thể chuyển đổi giữa các màn hình bằng cách nhấn các thẻ chuyển đổi màn hình trong khu vực chung.

Màn hình vận hành phát lại

Ấn vào thẻ [Playback] để hiển thị màn hình vận hành phát lại.

Để biết thêm thông tin chi tiết về màn hình vận hành phát lại, hãy tham khảo “Cấu trúc của màn hình vận hành phát
lại.”

Màn hình cài đặt

Ấn vào thẻ [Settings] để hiển thị màn hình cài đặt (sau đây gọi là menu web).
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Chú ý

Trong menu web, cài đặt không được áp dụng cho đến khi bạn nhấn nút [OK]. Nếu bạn thay đổi cài đặt trên trang có nút [OK],
hãy nhớ nhấn nút [OK].

Để biết thêm thông tin chi tiết về màn hình cài đặt, hãy tham khảo “Cấu trúc màn hình cài đặt.”
Trong Hướng dẫn trợ giúp, màn hình cài đặt của Ứng dụng web còn được gọi là menu web.

Chủ đề liên quan
Truy cập Ứng dụng web từ trình duyệt web

Cấu trúc màn hình hoạt động trực tiếp

Cấu trúc của khu vực chung của màn hình

Cấu trúc của màn hình vận hành phát lại

Cấu trúc màn hình cài đặt

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cấu trúc của khu vực chung của màn hình

Chủ đề này mô tả cấu trúc của khu vực chung của màn hình.

Tên máy quay
Hiển thị tên của máy quay.
Bạn có thể thay đổi tên bằng cách sử dụng [Network] > [Camera Name] trong menu web.
Màu nền thay đổi theo tín hiệu đèn báo bên ngoài.

1.

Công tắc nguồn
Khi bật thiết bị, [Power ON] được hiển thị. Bạn có thể ấn công tắc và chọn [Power Standby] để đặt nguồn điện của
thiết bị vào trạng thái chờ.
Khi [Power Standby] được hiển thị, bạn có thể ấn công tắc và chọn [Power ON] để bật nguồn điện thiết bị.

2.

Thẻ chuyển đổi màn hình vận hành
Nhấn vào thẻ để hiển thị màn hình vận hành tương ứng.
Thẻ [Live]: Hiển thị màn hình vận hành trực tiếp.
Thẻ [Playback]: Hiển thị màn hình vận hành phát lại.
Thẻ [Settings]: Hiển thị màn hình cài đặt (menu web).

3.

Dấu thông báo
Khi có tin nhắn đến, chỉ báo dấu thay đổi như trình bày bên dưới.

 (Bật thông báo)
Thực hiện hành động cần thiết theo thông báo hiển thị trong bảng điều khiển hình ảnh máy quay.

Chú ý

Tin nhắn không được hiển thị khi [Monitoring] > [Output Display] > [HDMI/Stream] được đặt thành [Off] trong menu web. Đặt
thành [On] để xem nội dung tin nhắn.

4.

Nút  (Trạng thái máy quay)
Nhấn nút này để hiển thị thông tin hình ảnh đã ghi của máy quay/tín hiệu hình ảnh đầu ra, thông tin ống kính và trạng
thái bộ điều khiển ống kính (tùy chọn) trên một màn hình riêng biệt.

5.
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Khi thông báo liên quan đến bộ điều khiển ống kính (tùy chọn) xuất hiện, chỉ báo thay đổi như trình bày bên dưới.

Công tắc khóa vận hành màn hình
 (Mở khóa vận hành): Đặt công tắc sang bên trái để điều khiển các thao tác trên màn hình vận hành trực tiếp

và màn hình vận hành phát lại.
 (Khóa vận hành): Đặt công tắc sang bên phải để điều khiển các thao tác trên màn hình vận hành trực tiếp và

màn hình vận hành phát lại.

6.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cấu trúc màn hình hoạt động trực tiếp

Chủ đề này mô tả cấu trúc màn hình hoạt động trực tiếp.

Bảng điều khiển vị trí đặt trước
Hiển thị vị trí đã đăng ký của cài đặt trước bằng ảnh thu nhỏ. Nhấn đúp vào ảnh thu nhỏ để quay lại vị trí được lưu
trong cài đặt trước.

Để biết thêm thông tin chi tiết về vị trí đặt trước, hãy tham khảo “Lưu/khôi phục cài đặt xoay/nghiêng, vị trí thu
phóng và lấy nét bằng Ứng dụng web.”
Để tìm hiểu thêm thông tin về di chuyển PTZ, hãy tham khảo “Ghi lại thao tác định khung máy quay bằng Ứng
dụng Web”.

1.

Bảng điều khiển hình ảnh máy quay
Hiển thị hình ảnh camera hiện tại và trạng thái của thiết bị.
Ô này hiển thị hình ảnh giống như đầu ra HDMI.
Trạng thái sau được hiển thị phía trên hình ảnh. Khung màu đỏ hoặc khung màu xanh cũng được hiển thị xung
quanh hình ảnh theo tín hiệu đếm bên ngoài nhận được.

2.
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Nút [Display]
Nhấn nút này để hiển thị thông tin camera trên hình ảnh.
Nhấn lại trong khi thông tin camera được hiển thị để ẩn thông tin camera.

Ngoài dấu mốc, một số chỉ báo liên quan đến lấy nét tự động và các thông báo được hiển thị theo trạng thái và
không thể ẩn chúng bằng cách ấn nút [Display].

Để biết chi tiết về thông tin camera được hiển thị, hãy xem “Màn hình hiển thị máy quay.”

Nút dừng AF theo dõi thời gian thực
Nhấn nút để ngừng theo dõi đối tượng.

STT Hiển thị Mô tả

2-1 Chỉ báo chế độ lấy nét Xem “Chỉ báo chế độ lấy nét” trong “Màn hình hiển thị máy quay.”

2-2
Chế độ đang ghi, khe cắm A/B, chỉ
báo khoảng thời gian ghi Interval
Rec

Xem “Chế độ đang ghi, khe cắm A/B, chỉ báo khoảng thời gian ghi
Interval Rec” trong “Màn hình hiển thị máy quay.”

2-3
Chỉ báo trạng thái đang phát trực
tiếp

Được hiển thị trong khi phát trực tiếp (chỉ khi [Stream Setting] được
đặt thành [RTMP] hoặc [SRT-Caller]).

2-4
Chỉ báo trạng thái hoạt động đầu ra
RAW

Hiển thị trạng thái đầu ra của tín hiệu RAW. Để biết thêm thông tin
chi tiết về RAW, hãy tham khảo “Ghi video RAW”.

2-5
Chỉ báo dung lượng còn lại của
phương tiện

Xem “Chỉ báo dung lượng còn lại của phương tiện” trong “Màn hình
hiển thị máy quay.”

2-6 Chỉ báo vị trí zoom

Xem “Chỉ báo vị trí thu phóng” trong “Màn hình hiển thị máy quay.”
Khi bộ điều khiển ống kính (tùy chọn) được kết nối,  được hiển thị.
Nếu có lỗi xảy ra với bộ điều khiển ống kính (tùy chọn),  được
hiển thị.

2-7 Chỉ báo chế độ AE/mức AE
Xem “Chỉ báo chế độ AE/mức AE” trong “Màn hình hiển thị máy
quay”.
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Để biết chi tiết, hãy xem “Tìm kiếm đối tượng được chỉ định (Realtime Tracking AF)”.
Nút START/STOP ghi
Nhấn nút để bắt đầu quá trình ghi. Trong khi ghi, nút START/STOP ghi sáng lên màu đỏ.
Nhấn trong khi ghi để dừng ghi.
Bạn có thể đặt công tắc Giữ sang trạng thái Giữ để ngăn chặn thao tác sai nút START/STOP ghi.

3.

Bảng điều khiển cấu hình cơ bản của máy quay
Hiển thị cài đặt cho các chức năng cơ bản cần thiết để chụp trên các nút. Nhấn một nút để hiển thị màn hình cài đặt
tương ứng cho từng chức năng trong bảng điều chỉnh cấu hình cơ bản của camera bên dưới (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Để biết chi tiết, hãy tham khảo mô tả của từng chức năng.

4.

Chức năng Tham khảo

FPS “Chuyển động nhanh và chậm”

ISO/Gain
“Đặt độ nhạy cơ bản,” “Điều chỉnh tự động độ lợi” và “Điều chỉnh độ lợi theo cách thủ công” trong
“Điều chỉnh độ lợi”

Exposure
Index

“Đặt độ nhạy cơ bản” và “Thay đổi sự phân bố các vùng sáng và tối trong hình ảnh đã ghi”

Shutter
“Điều chỉnh tự động cho màn trập” và “Điều chỉnh màn trập theo cách thủ công” trong “Điều chỉnh
màn trập”

Iris
“Điều chỉnh tự động cửa điều sáng” và “Điều chỉnh thủ công cửa điều sáng” trong “Điều chỉnh
cửa điều sáng”

ND Filter “Về bộ lọc ND” trong “Điều chỉnh mức độ ánh sáng (bộ lọc ND)”

Scene File “Tổng quan giao diện” và các chủ đề khác trong “Chụp với giao diện mong muốn”

Base
Look/LUT

“Chụp với điều chỉnh dáng vẻ trong hậu kỳ”

White Balance “Màn hình điều chỉnh cân bằng trắng”
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Các nút có thể chỉ định/Bảng điều chỉnh cấu hình cơ bản của camera
Hiển thị các nút có thể chỉ định trong quá trình hoạt động bình thường. Ấn nút bảng điều khiển cấu hình cơ bản của
camera (mục 4) để hiển thị các mục cài đặt tương ứng. Ấn nút [X] hoặc ấn lại nút bảng điều khiển cài đặt máy quay
để quay lại màn hình nút có thể chỉ định.

Để biết thêm thông tin chi tiết về nút có thể gán, hãy tham khảo “Nút có thể gán.”
Để biết chi tiết về bảng điều chỉnh cấu hình cơ bản của camera, hãy tham khảo bản mô tả từng chức năng.

5.

Định khung bảng điều khiển / bảng điều khiển GUI
Chuyển đổi giữa bảng điều khiển khung / bảng điều khiển GUI bằng các thẻ ở trên cùng.
Bạn có thể ấn nút  (Đóng) ở trên cùng bên phải màn hình để ẩn bảng điều khiển nhằm tránh thao tác không chủ ý.
Nếu bảng điều khiển không hiển thị, ấn nút  (Mở) để nó hiển thị.
Sử dụng bảng điều khiển khung để điều chỉnh khung. Ấn vào thẻ  (Xoay/nghiêng/thu phóng) để hiển thị
bảng điều khiển khung.

Để biết thêm thông tin chi tiết về vận hành, hãy tham khảo “Điều chỉnh định khung”.

Gợi ý

Phần cần điều khiển của bảng điều khiển khung được hiển thị như hình dưới đây khi thao tác xoay/nghiêng bị tắt và khi bắt
buộc khởi tạo xoay/nghiêng.

Khi thao tác xoay/nghiêng bị khóa bằng lẫy khóa xoay/nghiêng

Khi thao tác xoay/nghiêng không được khởi tạo

6.
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Khi thao tác xoay/nghiêng cần được đặt lại

Khi thao tác xoay/nghiêng bị tắt

Khi vận hành độ xoay/nghiêng không được khởi tạo hoặc cần được đặt lại, bạn có thể nhanh chóng truy cập vào nút 
(Đặt lại xoay/nghiêng) trong bảng điều khiển máy quay bằng cách nhấn vào thông báo hiển thị bên dưới cần điều khiển.

Sử dụng bảng điều khiển GUI để vận hành menu camera, phát lại clip và các chức năng khác. Ấn vào thẻ 
(GUI Cam) để hiển thị bảng điều khiển GUI.

Để biết thêm thông tin chi tiết về vận hành, hãy tham khảo “Vận hành menu camera” và “Phát clip đã ghi.”
Bảng điều khiển máy quay
Sử dụng để cấu hình các chức năng cần thiết để vận hành camera.
Chuyển đổi giữa các màn hình để hiển thị bằng các tab ở trên cùng.
Bạn có thể ấn nút  (Đóng) ở trên cùng bên phải màn hình để ẩn bảng điều khiển nhằm tránh thao tác không chủ ý.
Nếu bảng điều khiển không hiển thị, ấn nút  (Mở) để nó hiển thị.

7.
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Để biết thêm thông tin chi tiết, hãy tham khảo mô tả của từng chức năng.

Thẻ  (Main)
Hiển thị mục cài đặt cho các chức năng thường dùng.
Có thể thay đổi chức năng thanh trượt trên cùng và dưới cùng bằng cách nhấn nút [▼] và chọn từ danh sách hiển
thị. Có thể chọn các chức năng sau.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Thẻ  (Focus)
Hiển thị các mục thiết lập liên quan đến lấy nét.

Thẻ  (Audio)

Hiển thị các mục thiết lập liên quan đến âm thanh.

Được hiển thị theo cài đặt menu.*
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Thẻ  (Stream)
Hiển thị các mục thiết lập liên quan đến phát trực tiếp.
Các mục được hiển thị sẽ khác nhau tùy thuộc vào cài đặt định dạng phát trực tiếp.
Khi được đặt thành [RTMP] hoặc [SRT-Caller], có thể bắt đầu/dừng phát trực tiếp trên màn hình này.

Để biết thêm thông tin chi tiết, hãy tham khảo “Về phát trực tiếp” và các chủ đề khác trong “Định cấu hình phát
trực tiếp.”
Thông tin lỗi được hiển thị nếu có lỗi kết nối. Để biết thêm về thông tin lỗi, hãy tham khảo “Thông báo lỗi/cảnh
báo”.

Thẻ  (Others)
Hiển thị các mục thiết lập liên quan đến các chức năng khác.
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Chủ đề liên quan

Lưu/khôi phục cài đặt xoay/nghiêng, vị trí thu phóng và lấy nét bằng Ứng dụng web

Ghi lại thao tác định khung máy quay bằng Ứng dụng Web

Màn hình hiển thị máy quay

Ghi video RAW

Tìm kiếm đối tượng được chỉ định (Realtime Tracking AF)

Chuyển động nhanh và chậm

Đặt độ nhạy cơ bản

Điều chỉnh tự động độ lợi

Điều chỉnh độ lợi theo cách thủ công

Thay đổi sự phân bố các vùng sáng và tối trong hình ảnh đã ghi

Điều chỉnh tự động cho màn trập

Điều chỉnh màn trập theo cách thủ công

Điều chỉnh tự động cửa điều sáng

Điều chỉnh thủ công cửa điều sáng

Về bộ lọc ND

Tổng quan giao diện

Chụp với điều chỉnh dáng vẻ trong hậu kỳ

Màn hình điều chỉnh cân bằng trắng

Nút có thể gán

Phát clip đã ghi

Vận hành menu camera

Về phát trực tiếp

Thông báo lỗi/cảnh báo

5-041-959-03(1) Copyright 2022 Sony Corporation

Ấn nút [Full Screen Display] sẽ mở ra thẻ mới trên trình duyệt web và hiển thị hình ảnh của bảng điều khiển hình ảnh
máy quay ở chế độ toàn màn hình.
Chỉ hiển thị hình ảnh; AF cảm ứng và các chức năng khác không khả dụng.

Chú ý

Màn hình vận hành phát trực tiếp trên thẻ ban đầu tiếp tục hoạt động. Bạn nên đóng thẻ này để giảm số lượng kết nối đồng
thời nếu không cần thực hiện thao tác nào.

Ấn nút  (Khởi tạo bộ điều khiển ống kính) để khởi tạo bộ điều khiển ống kính (tùy chọn bên thứ ba).
Nút này được bật khi [Technical] > [Lens Controller] > [Zoom] > [Setting] được đặt thành [On] trong menu web.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cấu trúc của màn hình vận hành phát lại

Chủ đề này mô tả cấu trúc của màn hình vận hành phát lại.

Bảng điều khiển hình ảnh máy quay
Hiển thị hình ảnh phát lại và thông tin liên quan. Khi dừng phát lại, màn hình hình ảnh máy quay xuất hiện.

1.
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1-1 Ngày và giờ chụp
1- 2 Chỉ báo trạng thái phát lại
1- 3 Chỉ báo định dạng phát lại (kích thước ảnh)
1- 4 Chỉ báo định dạng phát lại (codec)
1- 5 Hiển thị tên clip
1- 6 Số clip/tổng số clip
1-7 Hiển thị tên LUT
1- 8 Chỉ báo trạng thái phát trực tiếp
1- 9 Chỉ báo định dạng phát lại (tốc độ khung hình và phương thức quét)
1-10 Chỉ báo giao diện ghi

Bảng điều khiển phát lại

Hiển thị các nút điều khiển phát lại.

Nút [Display]
Ấn để chuyển giữa màn hình hiển thị trên hình ảnh.
Nút [Thumbnail]
Hiển thị các clip được ghi trên thẻ nhớ trên bảng điều khiển hình ảnh máy quay dưới dạng hình ảnh thu nhỏ.

2.

Nút Chức năng

Nút  (Phát/Tạm dừng) Phát clip. Trong khi phát lại, tạm dừng clip.

Nút  (Tua nhanh), nút  (Tua
ngược)

Phát clip ở tốc độ cao. Khi nhấn nút này, tốc độ phát lại thay đổi trong
ba bước.

Nút  (Tiếp), nút  (Trước) Chuyển đến đầu clip hoặc clip trước/sau.

Nút  (Dừng) Dừng phát lại.
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Chủ đề liên quan

Màn hình ảnh thu nhỏ

Nút có thể gán

Phát clip đã ghi

5-041-959-03(1) Copyright 2022 Sony Corporation

Ấn nút [Thumbnail] trong quá trình sử dụng màn hình hiển thị sẽ đóng màn hình ảnh thu nhỏ và trở lại hình ảnh máy
ảnh.

Để biết thêm thông tin chi tiết về màn hình ảnh thu nhỏ, hãy tham khảo “Màn hình ảnh thu nhỏ.”

Nút [Slot Select]
Chuyển đổi giữa các phương tiện phát lại mục tiêu.

Nút có thể gán
Hiển thị các nút có thể gán được gán cho các chức năng của thiết bị.

Để biết thêm thông tin chi tiết về nút có thể gán, hãy tham khảo “Nút có thể gán.”

3.

Bảng điều khiển GUI
Sử dụng bảng điều khiển GUI để vận hành menu camera, phát lại clip và các chức năng khác.

Để biết thêm thông tin chi tiết về vận hành, hãy tham khảo “Vận hành menu camera” và “Phát clip đã ghi.”

4.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cấu trúc màn hình cài đặt

Sử dụng màn hình cài đặt để cấu hình các mục thiết lập khác nhau của thiết bị, bao gồm cài đặt ban đầu, cài đặt mạng,
cài đặt ghi hình/phát lại bằng menu web.

Chú ý

Trong menu web, cài đặt không được áp dụng cho đến khi bạn nhấn nút [OK] như một quy tắc chung. Nếu bạn thay đổi cài đặt
trên trang có nút [OK], hãy nhớ nhấn nút [OK].

Để biết chi tiết về màn hình cài đặt, hãy xem “Menu trang web và cài đặt chi tiết.”

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Menu camera

Ấn nút [Menu] trong bảng điều khiển GUI của màn hình vận hành trực tiếp hoặc màn hình vận hành phát lại để hiển thị
menu camera trong bảng điều khiển hình ảnh máy quay.

Bạn có thể định cấu hình các cài đặt cần thiết để chụp và phát lại bằng menu camera.
Nhấn nút [Menu] trong khi menu camera hiển thị để ẩn menu camera.
Menu camera được vận hành bằng bảng điều khiển GUI.

Để biết chi tiết về menu camera, hãy xem “Menu camera và cài đặt chi tiết.”

Chú ý

Khi [Monitoring] > [Output Display] > [HDMI/Stream] được đặt thành Off trong menu web (tắt lớp phủ thông tin trên màn hình hiển
thị), menu camera không còn hiển thị trong bảng điều khiển hình ảnh máy quay. Tuy nhiên, hãy lưu ý rằng các vận hành menu
trong bảng điều khiển GUI vẫn đang hoạt động. Để tránh vận hành vô ý, hãy cẩn thận không thực hiện bất kỳ vận hành nào bằng
cách sử dụng bảng điều khiển GUI khi [HDMI/Stream] được đặt thành Off.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Màn hình hiển thị máy quay

Bạn có thể hiển thị trạng thái và cài đặt của thiết bị chồng lên hình ảnh đầu ra từ máy quay. Bạn có thể đặt loại đầu ra là
màn hình hiển thị bằng cách sử dụng [Monitoring] > [Output Display] trong menu web.
Bạn có thể hiển/ẩn thông tin bằng cách sử dụng nút [Display]. Ngay cả khi thông tin bị ẩn, nó vẫn sẽ xuất hiện trong khi
thực hiện các thao tác menu trực tiếp.
Bạn có thể thay hiển thị/ẩn mục bằng cách sử dụng [Monitoring] > [Display On/Off] trong menu camera.

Thông tin hiển thị trên màn hình khi chụp

Chỉ báo tải lên/chỉ báo các tệp còn lại

Để biết thêm thông tin chi tiết về truyền tệp, hãy tham khảo “Giới thiệu về truyền tệp” và các chủ đề khác trong
“Truyền tệp.”

1.

Chỉ báo khu vực lấy nét
Hiển thị khu vực lấy nét cho tính năng lấy nét tự động.

Để biết thêm thông tin chi tiết về lấy nét tự động, hãy tham khảo “Điều chỉnh tự động bằng cách sử dụng Ứng
dụng web” và các chủ đề khác trong “Điều chỉnh lấy nét tự động (Auto Focus)”.

2.

Chế độ đang ghi, khe cắm A/B, chỉ báo khoảng thời gian ghi Interval Rec

Để biết thêm thông tin chi tiết về chế độ ghi theo khoảng thời gian, hãy tham khảo “Quay video không liên tục
(Interval Rec)”.

3.

Hiển thị Ý nghĩa

●Rec Đang ghi

Stby Đang chờ ghi

Chỉ báo độ sâu trường ảnh4.
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Chỉ báo chế độ quét hình ảnh
Dấu  (không khớp) sẽ hiển thị nếu độ rộng vùng hiện ảnh của ống kính không khớp với cài đặt chế độ quét hình
có kích thước phù hợp.
Khi chế độ quét hình được đặt thành FF, dấu “C” sẽ hiển thị trong các chế độ với góc nhìn hẹp hơn (bị cắt).
Cắt hình xảy ra trong các chế độ sau.

Khi định dạng ghi là 3840×2160 và S&Q Motion tốc độ khung hình Chuyển động nhanh & chậm là 100 fps hoặc
120 fps
Khi [Codec] được đặt thành RAW hoặc RAW & XAVC-I và định dạng đầu ra RAW là 3840×2160
Để biết thêm thông tin chi tiết về chế độ quét hình, hãy tham khảo “Đặt chế độ quét hình” trong “Cấu hình vận
hành máy quay cơ bản”.

5.

Chỉ báo trạng thái hoạt động đầu ra RAW
Hiển thị trạng thái đầu ra của tín hiệu RAW.

Để biết thêm thông tin chi tiết về RAW, hãy tham khảo “Ghi video RAW”.

6.

Chỉ báo tốc độ khung hình khi ghi hình chuyển động chậm & nhanh

Để biết thêm thông tin chi tiết về Chuyển động nhanh & chậm, hãy tham khảo “Chuyển động nhanh và chậm”.

7.

Chỉ báo vị trí lấy nét

Hiển thị vị trí lấy nét.

8.

Chỉ báo chế độ lấy nét

Face/eye detection AF

Để biết thêm chi tiết về chức năng lấy nét tự động khi phát hiện khuôn mặt và mắt, hãy tham khảo “Tìm kiếm
bằng cách sử dụng chức năng phát hiện ra khuôn mặt và mắt (Face/Eye Detection AF).”

9.

Hiển thị Ý nghĩa

Focus Hold Chế độ Focus Hold

MF Chế độ lấy nét thủ công MF

AF Chế độ lấy nét tự động AF

 (Realtime tracking AF mode) Chế độ lấy nét tự động theo dõi trong thời gian thực

Hiển thị Ý nghĩa

 (Face/eye detection
AF)

Chỉ ra rằng chức năng lấy nét tự động khi phát hiện ra khuôn mặt/mắt AF đang hoạt
động

 (face/eye only AF) Chỉ ra rằng chức năng lấy nét tự động khi phát hiện ra khuôn mặt/mắt đang hoạt
động.

 (saved tracking face) Chỉ ra rằng khuôn mặt theo dõi đã được lưu

 (AF paused) Cho biết rằng chức năng AF đã tạm dừng*

Biểu tượng này hiển thị khi không có khuôn mặt theo dõi được lưu lại nào và không phát hiện ra khuôn mặt hoặc khi có khuôn mặt theo dõi
được lưu lại nhưng không phát hiện ra khuôn mặt là mục tiêu theo dõi.

*

Chỉ báo vị trí zoom10.
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Hiển thị vị trí thu phóng trong khoảng 0 (góc rộng) đến 99 (ghi hình xa) (nếu có gắn ống kính hỗ trợ hiển thị vị trí thu
phóng).
Bạn cũng có thể thay đổi chỉ báo thành màn hình thanh hoặc màn hình độ dài tiêu cự bằng cách sử dụng cài đặt
[Technical] > [Lens] > [Zoom Position Display] trong menu máy quay.
Các mục sau đây được thêm vào màn hình khi bật Thu phóng chất lượng cao.

Để biết thêm thông tin chi tiết về thu phóng, hãy tham khảo “Cài đặt loại thu phóng” và các chủ đề khác trong
“Điều chỉnh thu phóng”.

Hiển thị Ý nghĩa

 (Clear Image Zoom is enabled) Thu phóng chất lượng cao được bật

Giá trị phóng đại Khi sử dụng Thu phóng chất lượng cao

Chỉ báo chế độ ổn định hình ảnh11.

Chỉ báo trạng thái Rec Control đầu ra SDI/đầu ra HDMI
Hiển thị trạng thái đầu ra của tín hiệu điều khiển REC.

Để biết thêm thông tin chi tiết, hãy tham khảo “Kết nối các màn hình giám sát và các thiết bị ghi bên ngoài.”

12.

Chỉ báo lấy nét

Để biết thêm chi tiết, hãy tham khảo “Sử dụng tính năng lấy nét tự động trong một lần chụp (Push Auto Focus
(AF-S))” trong “Điều chỉnh lấy nét”.

13.

Chỉ báo dung lượng còn lại của phương tiện
Biểu tượng  (bảo vệ) xuất hiện nếu thẻ nhớ là loại chống ghi.

14.

Chỉ báo chế độ cân bằng trắng15.

Hiển thị Ý nghĩa

 (ATW) Chế độ tự động

 (ATW Hold) Chế độ tự động đã tạm ngưng

W:P Chế độ đặt trước

W:A Chế độ bộ nhớ A

Chỉ báo khóa ngoài mã thời gian/hiển thị dữ liệu thời gian
Hiển thị “EXT-LK” khi bị khóa với mã thời gian của thiết bị bên ngoài.

Để biết thêm thông tin chi tiết, hãy tham khảo “Chỉ định dữ liệu thời gian”.

16.

Chỉ báo lọc ND

Để biết thêm thông tin chi tiết, hãy tham khảo “Điều chỉnh mức độ ánh sáng (bộ lọc ND)”.
Để biết thêm thông tin chi tiết, hãy tham khảo “Điều khiển bokeh (chức năng điều khiển bokeh)”.

17.

Hiển thị Ý nghĩa

 (A) Chế độ tự động

 (B) Chế độ điều khiển Bokeh
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Chỉ báo tệp cảnh

Để biết thêm thông tin chi tiết về tệp cảnh, hãy tham khảo “Tổng quan giao diện” và các chủ đề khác trong “Chụp
với giao diện mong muốn”.

18.

Chỉ báo cửa điều sáng
Hiển thị vị trí cửa điều sáng (giá trị F) (nếu có gắn ống kính hỗ trợ hiển thị cài đặt cửa điều sáng).

Để biết thêm thông tin chi tiết về cửa điều sáng, hãy tham khảo “Điều chỉnh tự động cửa điều sáng” và “Điều
chỉnh thủ công cửa điều sáng”.

19.

Chỉ báo cảnh báo mức video20.

Chỉ báo độ lợi
Hiển thị giá trị EI khi ở chế độ Cine EI/Cine EI Quick.

Để biết thêm thông tin chi tiết về độ lợi, hãy tham khảo “Điều chỉnh tự động độ lợi” và “Điều chỉnh độ lợi theo
cách thủ công.”
Để biết thêm thông tin chi tiết về chế độ Cine EI/Cine EI Quick, hãy tham khảo “Đặt chế độ chụp” trong “Cấu hình
vận hành máy quay cơ bản”.

21.

Hiển thị Ý nghĩa

 (A) Chế độ tự động

L Chế độ L đặt trước

 (Temporary adjustment mode) Chế độ điều chỉnh tạm thời

 (B) Chế độ điều khiển Bokeh

Hiển thị tên clip
Hiển thị tên clip được ghi hoặc ghi tiếp theo.
Nếu đèn nhấp nháy, clip mới nhất trong phương tiện ghi không khớp với cài đặt [Camera ID] hoặc [Reel Number]. Để
biết thêm chi tiết, hãy tham khảo mô tả [Clip Name Format] > [Auto Naming].

22.

Chỉ báo màn trập

Để biết thêm thông tin chi tiết về màn trập, hãy tham khảo “Điều chỉnh tự động cho màn trập” và “Điều chỉnh màn
trập theo cách thủ công.”

23.

Chỉ báo chế độ AE/mức AE

Để biết thêm thông tin chi tiết về phơi sáng tự động (AE), hãy tham khảo “Đặt mức mục tiêu để điều chỉnh độ
sáng tự động.”

24.

Chỉ báo ống bọt nước
Hiển thị mức ngang theo ±1° gia tăng lên tới ±15°.

25.

Máy đo mức âm thanh
Hiển thị mức âm thanh của mỗi kênh.

26.

Màn hình giám sát tín hiệu video
Hiển thị dạng sóng, vectơ và biểu đồ.
Dòng màu cam cho biết các giá trị đã đặt của dấu mức độ sáng.
Trong chế độ chụp Log, loại LUT mục tiêu của màn hình theo dõi được hiển thị phía trên màn hình.

Để biết thêm thông tin chi tiết, hãy tham khảo “Màn hình giám sát tín hiệu video.”

27.
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Thông tin được hiển thị trên màn hình trong khi phát lại

Thông tin sau được chồng lên hình ảnh phát lại.

Để biết thêm thông tin chi tiết về chế độ chụp Log, hãy tham khảo “Đặt chế độ chụp” trong “Cấu hình vận hành
máy quay cơ bản”.

Chỉ báo Base Sensitivity /chỉ báo Base ISO
Trong chế độ Custom, màn hình hiển thị độ nhạy cơ bản được đặt bằng cách sử dụng nút [ISO/Gain / Exposure
Index] trong bảng cấu hình cơ bản của máy quay hoặc [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] trong menu
máy quay.
Trong chế độ chụp Log, màn hình hiển thị độ nhạy Base ISO được đặt bằng cách sử dụng nút [ISO/Gain / Exposure
Index] trong bảng cấu hình cơ bản của máy quay hoặc [Shooting] > [ISO/Gain/EI] > [Base ISO] trong menu camera.

Để biết thêm thông tin chi tiết về độ nhạy, hãy tham khảo “Chọn độ nhạy cơ bản.”
Để biết thêm thông tin chi tiết về chế độ chụp Log, hãy tham khảo “Đặt chế độ chụp” trong “Cấu hình vận hành
máy quay cơ bản”.

28.

Chỉ báo giao hiện giám sát
Trong chế độ chụp Log, màn hình hiển thị cài đặt LUT của màn hình giám sát.

Để biết thêm thông tin chi tiết về cài đặt LUT, hãy tham khảo “Chụp với điều chỉnh dáng vẻ trong hậu kỳ” và các
chủ đề liên quan.
Để biết thêm thông tin chi tiết về chế độ chụp Log, hãy tham khảo “Đặt chế độ chụp” trong “Cấu hình vận hành
máy quay cơ bản”.

29.

Giao diện cơ sở/chỉ báo giao diện ghi
Hiển thị cài đặt giao diện cơ sở.
Trong chế độ chụp Log, màn hình hiển thị tín hiệu video để ghi trên thẻ nhớ.

Để biết thêm thông tin chi tiết về giao diện cơ sở, hãy tham khảo “Tổng quan giao diện” trong “Chụp với giao diện
mong muốn.”
Để biết thêm thông tin chi tiết về chế độ chụp Log, hãy tham khảo “Đặt chế độ chụp” trong “Cấu hình vận hành
máy quay cơ bản”.

30.

Chỉ báo trạng thái proxy31.

Chỉ báo định dạng ghi (codec)
Hiển thị tên của định dạng để ghi vào thẻ nhớ.
Đặt định dạng ghi (codec) bằng cách sử dụng [Project] > [Rec Format] > [Codec] trong menu web hoặc menu
camera.

32.

Chỉ báo định dạng ghi (tốc độ khung hình và phương thức quét)33.

Chỉ báo định dạng ghi (kích thước ảnh)
Hiển thị kích thước ảnh để ghi vào thẻ nhớ.
Đặt định dạng ghi (kích thước ảnh) bằng cách sử dụng [Project] > [Rec Format] > [Codec] trong menu web hoặc
menu camera.

34.

Chỉ báo báo hiệu
Hiển thị khung màu đỏ hoặc khung màu xanh xung quanh hình ảnh theo tín hiệu báo hiệu bên ngoài nhận được.

35.
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Chủ đề liên quan

Giới thiệu về truyền tệp

Điều chỉnh tự động bằng cách sử dụng Ứng dụng web

Quay video không liên tục (Interval Rec)

Cấu hình vận hành máy quay cơ bản

Ghi video RAW

Chuyển động nhanh và chậm

Chỉ báo tải lên/chỉ báo các tệp còn lại1.

Số lượng clip2.

Chỉ báo trạng thái phát lại3.

Chỉ báo định dạng phát lại (tốc độ khung hình và phương thức quét)4.

Chỉ báo định dạng phát lại (kích thước ảnh)5.

Chỉ báo định dạng phát lại (codec)6.

Chỉ báo phương tiện
Biểu tượng  (bảo vệ) xuất hiện nếu thẻ nhớ là loại chống ghi.

7.

Hiển thị dữ liệu thời gian8.

Hiển thị tên clip9.

Chỉ báo hỗ trợ hiển thị gamma10.

Máy đo mức âm thanh
Hiển thị mức âm thanh phát lại.

11.

Giao diện cơ sở/chỉ báo giao diện ghi12.

Chỉ báo báo hiệu13.
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Tìm kiếm bằng cách sử dụng chức năng phát hiện ra khuôn mặt và mắt (Face/Eye Detection AF)

Cài đặt loại thu phóng

Kết nối các màn hình giám sát và các thiết bị ghi bên ngoài

Sử dụng tính năng lấy nét tự động trong một lần chụp (Push Auto Focus (AF-S))

Chỉ định dữ liệu thời gian

Tổng quan giao diện

Điều chỉnh tự động cửa điều sáng

Điều chỉnh thủ công cửa điều sáng

Điều chỉnh tự động độ lợi

Điều chỉnh độ lợi theo cách thủ công

Điều chỉnh tự động cho màn trập

Điều chỉnh màn trập theo cách thủ công

Đặt mức mục tiêu để điều chỉnh độ sáng tự động

Màn hình giám sát tín hiệu video

Chụp với điều chỉnh dáng vẻ trong hậu kỳ

Clip Name Format

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Gắn thẳng vào vị trí cố định

Chủ đề này mô tả cách gắn thiết bị trên bàn làm việc hoặc chân máy quay.

Lưu ý cài đặt
Để bảo vệ ống kính và khối đầu nối ống kính của thiết bị, hãy luôn gắn chặt nắp ống kính và nắp đậy của thiết bị cho
đến khi bạn gắn ống kính.
Để tránh hỏng ống kính, không giữ các bộ phận của ống kính trong khi làm việc.
Để tránh hỏng thiết bị, không giữ đầu máy quay trong khi làm việc.

Kiểm tra không gian gắn.

Khi gắn trên bàn làm việc
Gắn thiết bị này trên một bề mặt phẳng, có tính đến không gian cần thiết để xoay ống kính và hệ thống dây điện ở
phía sau thiết bị.

Chú ý

Gắn thiết bị ở một vị trí ổn định, không bị rung động. Các vị trí bị rung có thể khiến ảnh bị rung.

Nếu phải gắn thiết bị trên bề mặt nghiêng, hãy giữ thiết bị trong phạm vi ±15° so với phương ngang và thực hiện các biện
pháp để thiết bị không bị rơi.

Khi gắn vào chân máy
Gắn chân máy vào lỗ vít gắn chân máy ở phía dưới.
Sử dụng vít gắn chân máy với độ nhô ra sau đây so với bề mặt lắp và vặn chặt bằng tuốc nơ vít cầm tay.

A: Vít gắn chân máy 1/4-20 UNC, ISO 1222 (6,35 mm)
B: Độ nhô ra (4,5 mm đến 5,5 mm)

1
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Tiếp theo, gắn ống kính. Tham khảo “Gắn ống kính”, chú trọng thông tin trong “Thận trọng khi gắn/tháo ống kính”, “Kiểm
tra công tắc ống kính” và “Biện pháp phòng ngừa khi sử dụng ống kính thu phóng”.

Chủ đề liên quan

Thận trọng khi gắn/tháo ống kính

Kiểm tra công tắc ống kính

Biện pháp phòng ngừa khi sử dụng ống kính thu phóng

Gắn ống kính

5-041-959-03(1) Copyright 2022 Sony Corporation

Không dùng vít chân máy để gắn thiết bị ở địa điểm cao.

Chú ý

Chọn chân máy không bị lật ngay cả khi ống kính quay.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Gắn thẳng vào vị trí cố định trên cao

Chủ đề này mô tả quy trình gắn thiết bị vào vị trí cố định trên cao bằng giá đỡ trên trần (CIB-PCM1 (tùy chọn)).

Cần phải có nhà thầu chuyên nghiệp để gắn thiết bị vào vị trí trên cao.
Khi gắn vào vị trí trên cao, hãy đảm bảo rằng bề mặt và vật liệu gắn (không bao gồm phụ kiện) có thể chịu được 200
kg trở lên và lắp thiết bị như được mô tả trong Hướng dẫn trợ giúp này. Nếu gắn thiết bị không chắc chắn, thiết bị có
thể rơi và gây thương tích nghiêm trọng.
Gắn cáp thép chống rơi đi kèm vào Giá đỡ trên trần CIB-PCM1 (tùy chọn) để tránh thiết bị rơi từ trên trần xuống.
Khi gắn thiết bị ở vị trí cao, hãy kiểm tra mỗi năm một lần để đảm bảo lắp đặt không bị lỏng. Rút ngắn khoảng thời
gian kiểm tra tùy theo điều kiện sử dụng.

Lưu ý cài đặt
Để bảo vệ ống kính và khối đầu nối ống kính của thiết bị, không tháo nắp ống kính và nắp đậy cho đến khi ống kính
được gắn vào.
Để tránh hỏng ống kính, không giữ các bộ phận của ống kính trong khi làm việc.
Để tránh hỏng thiết bị, không giữ đầu máy quay trong khi làm việc.

Kiểm tra các phụ kiện lắp đặt ở vị trí cao và không gian lắp đặt.

Bộ giá đỡ trên trần CIB-PCM1 (tùy chọn)
Trước khi bắt đầu, hãy kiểm tra xem bạn có các bộ phận sau không.

Khung đỡ thân máy (1)
Giá đỡ trên trần (1)
Nắp nút tháo ống kính (1)
Cáp thép chống rơi (1)
+ Vít PSW M3×8 (9)
+ Vít thép không gỉ PSW M4×8 cho cáp thép chống rơi (1)

Chú ý

1

66



Cáp thép chống rơi được thiết kế để hỗ trợ thiết bị khi bị treo. Không tác dụng bất kỳ tải trọng nào lên nó ngoài tải của thiết
bị.

Không gian gắn
Tham khảo bản vẽ sau khi xác định vị trí và hướng gắn, cần tính đến không gian cần thiết để xoay ống kính và hệ
thống dây điện ở phía sau thiết bị.

A: Phạm vi di chuyển của đầu camera (ví dụ: SEL70200GM2 (với SEL20TC được gắn): Ø370)
B: Giá đỡ trên trần (lỗ trên bề mặt lắp đặt (Ø150))
C: Lỗ căn chỉnh gắn

Chú ý

Gắn thiết bị ở một vị trí ổn định, không bị rung động. Các vị trí bị rung có thể khiến ảnh bị rung.

Nếu phải gắn thiết bị trên bề mặt nghiêng, hãy giữ thiết bị trong phạm vi ±15° so với phương ngang và thực hiện các biện
pháp để thiết bị không bị rơi.

Trượt lẫy khóa xoay/nghiêng đến vị trí LOCK để khóa xoay/nghiêng đầu camera.2
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Chú ý

Nếu xoay/nghiêng đầu máy quay không khóa khi cần khóa ở vị trí LOCK, hãy di chuyển đầu máy quay theo cách thủ công
cho đến khi nó khóa vào vị trí.

Gắn khung đỡ thân máy vào đáy thiết bị bằng sáu vít đi kèm (M3×8).3
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Sử dụng các vít đi kèm. Việc sử dụng các vít khác với vít đi kèm có thể làm hỏng phần bên trong của thiết bị.

Gắn cáp thép chống rơi vào khung đỡ thân máy.4
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A: Cáp thép đi kèm　
B: Vít Phillips đi kèm (M4×8)
C: Cuộn cáp thép

Sử dụng vít đi kèm. Việc sử dụng vít khác với vít được cung cấp có thể làm giảm hiệu quả chức năng của cáp thép.

Gắn giá đỡ trên trần vào bề mặt, chẳng hạn như giá, nơi thiết bị sẽ được gắn.5
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A: Tường　
B: Dấu △ (hướng máy quay về phía trước)
C: Lỗ cho cáp kết nối
D: Giá hoặc bề mặt lắp đặt khác

Gắn cáp thép chống rơi vào điểm gần bề mặt gắn.

Sử dụng vít nắp đầu ổ cắm hình lục giác M5 (3/16 inch) (tùy chọn) và gắn nó vào một vật gần giá hoặc bề mặt mà
giá đỡ trên trần được gắn vào.

6
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A: Cáp thép　
B: Vít nắp đầu ổ cắm hình lục giác (M5, 3/16 inch)

Căn chỉnh lỗ vít 〇 ở mặt trước của giá đỡ trên trần với lỗ ◇ của giá đỡ trên trần, lắp thiết bị và tạm thời cố
định khung đỡ thân máy trong giá đỡ trên trần bằng cách xoay thiết bị theo chiều kim đồng hồ.

7
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A: Lỗ 〇
B: Lỗ ◇

Gắn khung đỡ thân máy và giá đỡ trên trần bằng ba vít khóa xoay đi kèm (M3×8).8
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Tiếp theo, gắn ống kính. Tham khảo “Gắn ống kính”, chú trọng thông tin trong “Thận trọng khi gắn/tháo ống kính”, “Kiểm
tra công tắc ống kính” và “Biện pháp phòng ngừa khi sử dụng ống kính thu phóng”.

Chú ý

Sau khi gắn ống kính, hãy kiểm tra xem ống kính đã được gắn chắc chắn chưa.
Ống kính không có bất kỳ bảo vệ chống rơi. Sony không chịu bất kỳ trách nhiệm nào đối với trường hợp ống kính rơi khỏi thiết bị.

Chủ đề liên quan

Thận trọng khi gắn/tháo ống kính

Kiểm tra công tắc ống kính

Biện pháp phòng ngừa khi sử dụng ống kính thu phóng

Gắn ống kính

Kiểm tra tình trạng gắn.

Cụ thể, hãy kiểm tra các mục sau đây. 

Vít lắp được gắn chính xác.
Cáp thép chống rơi được gắn chính xác và không bị xoắn.
Thiết bị được gắn ở cân bằng (không nghiêng hoặc lung lay).
Thiết bị không xoay tự do khi quay.

9
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Gắn lên trần

Chủ đề này mô tả quy trình gắn thiết bị lên trần bằng giá đỡ trên trần (CIB-PCM1 (tùy chọn)).

Cần phải có nhà thầu chuyên nghiệp để gắn thiết bị lên trần.
Khi gắn lên trần, hãy đảm bảo rằng bề mặt và vật liệu gắn (không bao gồm phụ kiện) có thể chịu được 200 kg trở lên
và lắp thiết bị như được mô tả trong Hướng dẫn trợ giúp này. Nếu gắn thiết bị không chắc chắn, thiết bị có thể rơi và
gây thương tích nghiêm trọng.
Gắn cáp thép chống rơi đi kèm vào Giá đỡ trên trần CIB-PCM1 (tùy chọn) để tránh thiết bị rơi từ trên trần xuống.
Khi gắn thiết bị lên trần, hãy kiểm tra mỗi năm một lần để đảm bảo thiết bị không bị lỏng lẻo. Rút ngắn khoảng thời
gian kiểm tra tùy theo điều kiện sử dụng.

Lưu ý cài đặt
Để bảo vệ ống kính và khối đầu nối ống kính của thiết bị, không tháo nắp ống kính và nắp đậy cho đến khi ống kính
được gắn vào.
Để tránh hỏng ống kính, không giữ các bộ phận của ống kính trong khi làm việc.
Để tránh hỏng thiết bị, không giữ đầu máy quay trong khi làm việc.

Kiểm tra các phụ kiện gắn trần và không gian lắp đặt.

Bộ giá đỡ trên trần CIB-PCM1 (tùy chọn)
Trước khi bắt đầu, hãy kiểm tra xem bạn có các bộ phận sau không.

Khung đỡ thân máy (1)
Giá đỡ trên trần (1)
Nắp nút tháo ống kính (1)
Cáp thép chống rơi (1)
+ Vít PSW M3×8 (9)
+ Vít thép không gỉ PSW M4×8 cho cáp thép chống rơi (1)

1
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Chú ý

Cáp thép chống rơi được thiết kế để hỗ trợ thiết bị khi bị treo. Không tác dụng bất kỳ tải trọng nào lên nó ngoài tải của thiết
bị.

Không gian gắn
Tham khảo bản vẽ sau khi xác định vị trí và hướng gắn, cần tính đến không gian cần thiết để xoay ống kính và hệ
thống dây điện ở phía sau thiết bị.

A: Phạm vi di chuyển của đầu camera (ví dụ: SEL70200GM2 (với SEL20TC được gắn): Ø370)
B: Giá đỡ trên trần (lỗ trên bề mặt trần (Ø150))
C: Lỗ căn chỉnh gắn

Chú ý

Gắn lên trần (chẳng hạn như bê tông) với độ chắc chắn vừa đủ.

Khi gắn thiết bị lên trần nhà không có đủ độ chắc chắn, hãy cung cấp đủ cốt thép.

Gắn thiết bị ở một vị trí ổn định, không bị rung động. Các vị trí bị rung có thể khiến ảnh bị rung.

Nếu phải gắn thiết bị trên bề mặt nghiêng, hãy giữ thiết bị trong phạm vi ±15° so với phương ngang và thực hiện các biện
pháp để thiết bị không bị rơi.

Phía đối diện với lỗ △ trên giá đỡ trên trần là hướng chụp (mặt trước của máy quay).

Trượt cần khóa xoay/nghiêng sang vị trí UNLOCK để mở khóa chức năng xoay/nghiêng đầu máy quay 180°
theo hướng nghiêng.

2

Trượt lẫy khóa xoay/nghiêng đến vị trí LOCK để khóa xoay/nghiêng đầu camera.3
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Đầu máy quay quay 180°

Chú ý

Nếu xoay/nghiêng đầu máy quay không khóa khi cần khóa ở vị trí LOCK, hãy di chuyển đầu máy quay theo cách thủ công
cho đến khi nó khóa vào vị trí.

Gắn khung đỡ thân máy vào đáy thiết bị bằng sáu vít đi kèm (M3×8).4
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Sử dụng các vít đi kèm. Việc sử dụng các vít khác với vít đi kèm có thể làm hỏng phần bên trong của thiết bị.

Gắn giá đỡ trên trần vào tấm gắn (tùy chọn), sau đó gắn tấm đó vào trần.5

79



A: Giá đỡ trên trần
B: Trần
C: Tấm gắn
D: Lỗ △
Gắn khung theo hướng của giá đỡ trên trần
Lưu ý rằng khi gắn lên trần, mặt trước của máy quay nằm ở bên đối diện với giá đỡ trên trần so với thẳng đứng
thông thường. Gắn chính xác bằng cách tham khảo sơ đồ chỉ dẫn hướng gắn.

A: Mặt trước khi gắn thẳng đứng (hướng lỗ △)
B: Mặt trước khi gắn trần

Chú ý

Khách hàng chịu trách nhiệm về vật liệu bề mặt gắn thiết bị.

Gắn cáp thép chống rơi lên trần.6

80



A: Giá đỡ trên trần
B: Vít nắp đầu ổ cắm hình lục giác (M5, 3/16 inch)
C: Cáp thép (đi kèm)
D: Tấm gắn
E: Trần

Kéo cáp thép qua lỗ ở giữa giá đỡ trên trần và gắn nó vào khung đỡ thân máy.

Luồn cáp thép qua vòng dây kim loại của khung đỡ thân máy và gắn chặt vào khung bằng vít thép không gỉ đi kèm
(M4×8).

A: Cáp thép đi kèm
B: Vít Phillips đi kèm (M4×8)
C: Cuộn cáp thép

7
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Sử dụng vít đi kèm. Việc sử dụng vít khác với vít được cung cấp có thể làm giảm hiệu quả chức năng của cáp thép.

Chú ý

Khuyến nghị nên có một người giữ thiết bị như trong sơ đồ sau đây trong khi một người khác gắn thiết bị.

Không giữ đầu máy quay hoặc giá đỡ ống kính trong khi gắn thiết bị. Vì có nguy cơ gây hư hại hoặc thương tích nếu thiết
bị rơi.

Cẩn thận khi đấu dây để cáp thép không tây đoản mạch cho các đầu nối và cáp điện.

Ngàm có thể đỡ khối lượng lơ lửng lên đến 8,8 kg (bao gồm cả ống kính). Để ngăn không cho thiết bị rơi, không vượt quá
khối lượng tối đa dự kiến.

Căn chỉnh lỗ vít (A) trên khung đỡ thân máy với lỗ ◇ (B) trên giá đỡ trên trần, lắp thiết bị và xoay nó
khoảng 60 độ theo chiều kim đồng hồ cho đến khi lỗ vít (A) và lỗ vít (C) thẳng hàng.

8
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A: Lỗ vít trên khung đỡ thân máy
B: Lỗ vít trên giá đỡ trên trần (lỗ ◇)
C: Lỗ vít
D: Trần
E: Tấm gắn

Gắn khung đỡ thân máy và giá đỡ trên trần bằng ba vít khóa xoay đi kèm (M3×8).9
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Tiếp theo, gắn ống kính. Tham khảo “Gắn ống kính”, chú trọng thông tin trong “Thận trọng khi gắn/tháo ống kính”, “Kiểm
tra công tắc ống kính” và “Biện pháp phòng ngừa khi sử dụng ống kính thu phóng”.

Chú ý

Để vận hành xoay/nghiêng đúng cách khi thiết bị được gắn lên trần, hãy đặt [Pan-Tilt] > [Direction] > [Ceiling] thành [On] trong
menu web.

Sau khi gắn ống kính, hãy kiểm tra xem ống kính đã được gắn chắc chắn chưa.
Ống kính không có bất kỳ bảo vệ chống rơi. Sony không chịu bất kỳ trách nhiệm nào đối với trường hợp ống kính rơi khỏi thiết bị.

Chủ đề liên quan

Thận trọng khi gắn/tháo ống kính

Kiểm tra công tắc ống kính

Kiểm tra tình trạng gắn.

Cụ thể, hãy kiểm tra các mục sau đây.

Vít lắp được gắn chính xác.
Cáp thép chống rơi được gắn chính xác và không bị xoắn.
Thiết bị được gắn ở cân bằng (không nghiêng hoặc lung lay).
Thiết bị không xoay tự do khi quay.

10
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Biện pháp phòng ngừa khi sử dụng ống kính thu phóng

Gắn ống kính

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Thận trọng khi gắn/tháo ống kính

Không để ống kính đối diện với mặt trời. Ánh nắng trực tiếp có thể xuyên qua ống kính, hội tụ vào thiết bị và có thể gây
cháy.

Chú ý

Gắn/Tháo ống kính khi thiết bị đang tắt.

Ống kính là một cấu kiện chính xác. Không đặt ống kính trên bề mặt và để ngàm ống kính úp xuống. Gắn nắp ngàm ống kính đi
kèm.

Gợi ý

Để biết thêm thông tin chi tiết về các ống kính được thiết bị hỗ trợ, hãy liên hệ với đại diện dịch vụ Sony của bạn.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kiểm tra công tắc ống kính

Những thao tác kiểm tra và cài đặt sau đây đều là bắt buộc, tùy vào từng loại ống kính.

Đối với ống kính có công tắc chế độ lấy nét

Đặt công tắc thành AF/MF hoặc AF.
Khi công tắc được đặt thành MF hoặc Full MF, chỉ có thể điều chỉnh tiêu cự bằng vòng ống kính.

Chú ý

Khi sử dụng ống kính ngàm A, điều chỉnh thủ công từ thiết bị điều khiển từ xa có thể không khả dụng.

Đối với ống kính có công tắc thu phóng

Đặt công tắc thành SERVO.
Nếu công tắc được đặt thành MANUAL, chỉ có thể điều chỉnh chức năng thu phóng bằng vòng thu phóng. Điều khiển thu
phóng từ thiết bị không có tác dụng.

Đối với ống kính có công tắc Auto Iris

Đặt công tắc thành AUTO.
Nếu công tắc được đặt thành AUTO, chỉ có thể điều chỉnh cửa điều sáng bằng vòng ống kính. Vận hành cửa điều sáng
từ thiết bị không có tác dụng.

Đối với ống kính có công tắc ổn định hình ảnh

Đặt công tắc thành OFF.
Nếu công tắc được đặt thành ON, hành vi ngoài dự kiến có thể xảy ra trong quá trình vận hành xoay/nghiêng.

SELP28135G

A: Di chuyển vòng lấy nét đến vị trí phía trước (chế độ AF/MF).
B: Đặt công tắc ZOOM sang vị trí SERVO.
C: Đặt vòng cửa điều sáng thành “A” và công tắc IRIS LOCK sang vị trí LOCK.
D: Đặt công tắc ổn định hình ảnh thành OFF.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Biện pháp phòng ngừa khi sử dụng ống kính thu phóng

Khi sử dụng ống kính thu phóng không phải là ống kính thu phóng công suất, vị trí thu phóng có thể thay đổi tùy thuộc
vào môi trường lắp đặt. Dùng băng dính cố định vòng thu phóng vào vị trí tùy theo mục đích sử dụng.

Băng phim nhựa: 471 BLA 50 hoặc tương đương

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Gắn ống kính

Chủ đề này mô tả cách gắn ống kính ngàm E hoặc ống kính ngàm A.

Chú ý

Không di chuyển thiết bị khi chưa tháo ống kính ra.

Khi sử dụng ống kính ngàm A, cửa điều sáng được đặt thủ công và lấy nét được đặt thành MF.

Trượt lẫy khóa xoay/nghiêng đến vị trí LOCK để khóa xoay/nghiêng đầu camera.

Chú ý

Nếu xoay/nghiêng đầu máy quay không khóa khi cần khóa ở vị trí LOCK, hãy di chuyển đầu máy quay theo cách thủ công
cho đến khi nó khóa vào vị trí.

1

Xoay cần kẹp của vít gắn chân giá ống kính ngược chiều kim đồng hồ để nới lỏng khóa, sau đó di chuyển
vít gắn chân giá đỡ ống kính đến vị trí không cản trở ống kính.

A: Đúng

2
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B: Sai

Xoay cần khóa đầu máy quay theo hướng mũi tên để mở khóa đầu máy quay.

Chú ý

Đầu máy quay có nguy cơ di chuyển dưới trọng lượng của chính nó cho đến khi đầu máy quay được khóa lại. Dùng tay đỡ
đầu máy quay khi thực hiện tác vụ.

3

Trượt đầu máy quay đến vị trí ngoài cùng.4

Xoay cần khóa đầu máy quay theo hướng mũi tên để khóa đầu máy quay.5
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Chú ý

Hãy đảm bảo rằng lẫy khóa đầu camera không tiếp xúc với các bộ phận khác để tránh ảnh hưởng đến thao tác nghiêng.

Tháo nắp khỏi thiết bị và ống kính.6

Căn chỉnh điểm gắn ngàm ống kính (màu trắng) với thiết bị, cẩn thận lắp ống kính vào đầu máy quay, sau
đó xoay ống kính theo chiều kim đồng hồ cho đến có tiếng tách vào vị trí được khóa.

A: Dấu ngàm (màu trắng)

Chú ý

Để sử dụng ống kính ngàm A, hãy gắn bộ nối ngàm ống kính (tùy chọn) vào thiết bị và sau đó gắn ống kính ngàm A.

7

Xoay cần khóa đầu máy quay theo hướng mũi tên để mở khóa đầu máy quay.8
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Chú ý

Đầu máy quay có nguy cơ di chuyển dưới trọng lượng của chính nó cho đến khi đầu máy quay được khóa lại. Dùng tay đỡ
đầu máy quay khi thực hiện tác vụ.

Duy trì sự cân bằng về phía trước/phía sau của đầu máy quay sao cho đế trượt nằm ngang.

Nếu bạn đang sử dụng một trong các ống kính sau, bạn có thể cân bằng một cách đại khái đơn vị và ống kính bằng
cách tham khảo tỷ lệ trên đế trượt.

9

Vị trí thang đo Tên ống kính

0,5 SEL70200GM (có gắn SEL20TC)

1,7 SEL70200GM

2,0 SEL70200GM2 (có gắn SEL20TC)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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Chú ý

Sử dụng thang đo đế trượt làm tham chiếu cho cân bằng thô.

Trong khi gắn ống kính, hãy điều chỉnh cân bằng thích hợp để thiết bị không bị nghiêng qua lại.

Điều chỉnh sự cân bằng trên bề mặt nằm ngang.

Tháo thiết bị đỡ ống kính ra khi sử dụng SELC1635G.

Vị trí thang đo Tên ống kính

5,0 trở lên SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Xoay cần khóa đầu máy quay theo hướng mũi tên để khóa đầu máy quay.

Chú ý

Hãy đảm bảo rằng lẫy khóa đầu camera không tiếp xúc với các bộ phận khác để tránh ảnh hưởng đến thao tác nghiêng.
Phương pháp xác nhận: Trượt khóa xoay/nghiêng về vị trí UNLOCK, dùng tay xoay khối camera để camera ngửa lên trên
và xác nhận bằng mắt xem liệu camera có tiếp xúc với các bộ phận khác hay không. Nếu có tiếp xúc, xoay lại lẫy khóa đầu
camera theo hướng mũi tên.

10

Xoay cần gạt của kẹp giá đỡ ống kính ngược chiều kim đồng hồ để nới lỏng thiết bị đỡ ống kính.11
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A: Cần kẹp thanh giá đỡ ống kính (2 vị trí)
B: Thiết bị đỡ ống kính

Di chuyển thiết bị đỡ ống kính sao cho chân giá đỡ ống kính thẳng hàng với vít gắn chân giá đỡ ống kính,
sau đó vặn vít theo chiều kim đồng hồ để giữ chặt chân giá đỡ ống kính.

Chú ý

Đảm bảo chân giá đỡ ống kính vuông góc với vít gắn chân giá đỡ ống kính, sau đó vặn chặt.

12

Xoay cần kẹp cho vít gắn chân giá đỡ ống kính theo chiều kim đồng hồ để khóa vít gắn chân giá đỡ ống
kính.

A: Vít gắn chân giá đỡ ống kính
B: Lỗ vít gắn
C: Cần kẹp vít gắn chân giá đỡ ống kính

Gợi ý

Nếu cần kẹp ở vị trí khó xoay, hãy nhả cần kẹp ra và xoay theo một góc sẽ giúp thao tác dễ dàng hơn. Khi đã lắp đúng vị
trí, đóng cần kẹp.

13
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Chủ đề liên quan

Hiệu chuẩn ống kính ngàm E

5-041-959-03(1) Copyright 2022 Sony Corporation

A: Cần kẹp vít gắn chân giá đỡ ống kính
B: Cần kẹp thanh giá đỡ ống kính

Xoay cần gạt của cần kẹp thanh giá đỡ ống kính theo chiều kim đồng hồ để siết chặt thiết bị đỡ ống kính.14

Kiểm tra để đảm bảo rằng cả hai cần gạt đã được siết chặt và không bị lỏng, ống kính được gắn đúng cách
và các công tắc ống kính đã được đặt chính xác.

Nếu cần kẹp bị lỏng hoặc ống kính không được gắn đúng cách, ống kính có thể bị rơi và bị hỏng.
Khi sử dụng ống kính thu phóng hiệu suất cao ngàm E, ống kính cũng phải được hiệu chuẩn riêng để khôi phục
chính xác các vị trí thu phóng được lưu trữ trong máy quay như các vị trí đặt trước. Để biết thêm thông tin chi
tiết, hãy tham khảo “Hiệu chuẩn ống kính ngàm E”.

15
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tháo ống kính

Tháo ống kính bằng quy trình ngược lại với gắn ống kính.

Chú ý

Nắm chặt ống kính trong tay để tránh ống kính rơi xuống.

Nếu không gắn ngay ống kính khác, hãy luôn gắn nắp thân máy.

Chủ đề liên quan

Gắn ống kính

5-041-959-03(1) Copyright 2022 Sony Corporation

Kiểm tra xem vị trí xoay/nghiêng đã được khóa chưa.1

Xoay cần kẹp cho vít gắn bệ đỡ ống kính ngược chiều kim đồng hồ để nới lỏng khóa.2

Tháo vít gắn bệ đỡ ống kính trên bộ phận đỡ ống kính và di chuyển nó đến vị trí không cản trở ống kính.3

Mở khóa đầu camera và trượt đầu camera đến vị trí ngoài cùng.

Để biết thêm thông tin chi tiết, hãy tham khảo các bước từ 3 đến 5 trong “Gắn ống kính.”

4

Nhấn và giữ nút tháo ống kính và xoay ống kính ngược chiều kim đồng hồ trong khi đỡ ống kính.5

Với các dấu ngàm (màu trắng) của camera và ống kính được căn chỉnh, hãy kéo ống kính ra phía trước.6
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cáp kết nối

Chủ đề này mô tả kết nối cáp.

5-041-959-03(1) Copyright 2022 Sony Corporation

Kết nối cáp cần thiết với đầu nối trên bảng điều khiển phía sau.

Để cáp HDMI không tuột, hãy tháo vít gắn vào tấm giữ cáp HDMI (M2.6×6, màu đen) khỏi cụm đầu nối và gắn tấm
giữ cáp HDMI đi kèm bằng vít gắn. Buộc chặt cáp HDMI vào tấm giữ cáp HDMI bằng dây rút nhựa hoặc đai nhựa
bán sẵn trên thị trường.

A: Vít gắn tấm giữ cáp HDMI (M2.6×6, màu đen)
B: Dây rút nhựa hoặc đai nhựa bán sẵn trên thị trường
C: Tấm giữ cáp HDMI (đi kèm)

1
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kết nối thiết bị với thiết bị mạng bằng kết nối có dây

Chủ đề này mô tả việc kết nối thiết bị với thiết bị mạng bằng kết nối có dây.

5-041-959-03(1) Copyright 2022 Sony Corporation

Kết nối thiết bị này với thiết bị mạng (chẳng hạn như điểm truy cập Wi-Fi hoặc trung tâm chuyển mạch) qua
cáp Cat 5e hoặc cáp LAN.

1
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sử dụng nguồn AC

Chủ đề này mô tả quy trình cấp nguồn cho thiết bị bằng nguồn AC.

Trượt lẫy khóa xoay/nghiêng đến vị trí LOCK để khóa xoay/nghiêng đầu camera.1

Kết nối bộ chuyển đổi AC (đi kèm) với đầu nối DC IN trên thiết bị và kết nối dây nguồn (đi kèm) với nguồn
điện AC.

A: Đầu nối DC IN
B: Dây nguồn
C: Bộ chuyển đổi AC

2

Giữ chặt dây của bộ chuyển đổi AC bằng bộ kẹp dây nếu bạn muốn dây không bị ngắt kết nối.

Mở khóa bộ kẹp dây, luồn dây qua bộ kẹp như hình dưới đây và khóa bộ kẹp.

3
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Chú ý

Không sử dụng bất kỳ bộ đổi nguồn AC hoặc dây nguồn nào, ngoài những loại được cung cấp cùng với thiết bị. Kết nối bộ
chuyển đổi hoặc dây nguồn khác có thể gây ra hỏa hoạn hoặc sự cố.

Không kết nối và sử dụng bộ chuyển đổi AC trong không gian hạn chế, chẳng hạn như giữa tường và đồ nội thất.

Không làm đoản mạch các bộ phận kim loại của phích cắm của bộ chuyển đổi AC. Làm như vậy có thể gây ra sự cố.

Kết nối bộ chuyển đổi AC với nguồn điện AC gần nhất. Nếu xảy ra sự cố trong quá trình vận hành, hãy lập tức ngắt kết nối dây
nguồn khỏi nguồn điện AC.

A: Bộ kẹp dây
B: Khóa bộ kẹp dây
C: Dây bộ chuyển đổi AC

Kiểm tra nếu đèn POWER ở mặt trước của thiết bị chuyển từ nhấp nháy xanh lục sang màu xanh lục đồng
nhất thì quá trình khởi động đã hoàn tất.

Khi thiết bị đã khởi động bình thường và được kết nối với mạng, đèn NETWORK sẽ sáng màu xanh lục.

Khi sử dụng ống kính không hỗ trợ thao tác xoay/nghiêng, hãy khóa lẫy khóa xoay/nghiêng và bỏ qua các bước
sau. Để biết thêm chi tiết về ống kính hỗ trợ xoay/nghiêng, hãy liên hệ đại lý Sony của bạn hoặc đại diện dịch
vụ Sony.

4

Trượt lẫy khóa xoay/nghiêng đến vị trí UNLOCK để mở khóa xoay/nghiêng đầu camera.5

Đặt lại độ xoay/nghiêng.

Để biết thêm thông tin chi tiết, hãy tham khảo “Đặt lại chức năng xoay/nghiêng.”

6
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Khi ngắt kết nối bộ đổi nguồn AC khỏi thiết bị, hãy nắm vào phích cắm và kéo thẳng ra. Kéo cáp có thể gây ra sự cố.

Chủ đề liên quan
Đặt lại chức năng xoay/nghiêng

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sử dụng nguồn PoE++

Khi thiết bị được kết nối với thiết bị phân phối điện tương thích PoE++, nguồn điện được cung cấp cho thiết bị qua cáp
mạng có bán trên thị trường.
Phương pháp này cho phép cung cấp điện cho thiết bị mà không cần đi dây cấp điện trong môi trường không có ổ cắm
điện gần vị trí lắp đặt.

Trượt lẫy khóa xoay/nghiêng đến vị trí LOCK để khóa xoay/nghiêng đầu camera.1

Kết nối thiết bị và thiết bị phân phối điện tương thích PoE++ bằng cáp mạng có sẵn trên thị trường.

A: Cáp mạng
B: Thiết bị phân phối điện tương thích PoE++

2

Kiểm tra nếu đèn POWER ở mặt trước của thiết bị chuyển từ nhấp nháy xanh lục sang màu xanh lục đồng
nhất thì quá trình khởi động đã hoàn tất.

Khi thiết bị đã khởi động bình thường và được kết nối với mạng, đèn NETWORK sẽ sáng màu xanh lục.

Chú ý

3
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Chú ý

Thiết bị tuân theo IEEE802.3bt Loại 4 Bậc 8. Để biết thông tin chi tiết về các thiết bị phân phối điện tương thích PoE++ đã được
xác minh, hãy liên hệ với đại lý của bạn hoặc đại diện dịch vụ của Sony.

Thiết bị tuân thủ xác thực mềm (LLDP), nhưng có thể cần phải định cấu hình các thiết bị mạng (tuân thủ IEEE802.3bt).

Không kết nối bộ chuyển đổi AC khi sử dụng phân phối điện PoE++ có bật xác thực mềm (LLDP).

Nếu bộ chuyển đổi AC và thiết bị phân phối điện PoE++ được kết nối cùng một lúc, thì nguồn điện được cung cấp từ bộ chuyển
đổi AC.

Khi cấp nguồn qua PoE++, hãy sử dụng cáp mạng Cat 5e trở lên.

Chờ khoảng 10 giây sau khi bật lại thiết bị khi được cấp nguồn qua PoE++.

Khi sử dụng phân phối điện PoE++, hãy kết nối đầu cuối nối với mặt đất.

Khi kết nối qua phân phối điện PoE++, không chạy dây ngoài trời.

Chủ đề liên quan
Đặt lại chức năng xoay/nghiêng

5-041-959-03(1) Copyright 2022 Sony Corporation

Khi điện được cung cấp bởi PoE++, xác thực ban đầu được thực hiện trong khoảng thời gian cho đến khi quá trình khởi
động kết thúc.

Khi sử dụng ống kính không hỗ trợ thao tác xoay/nghiêng, hãy khóa lẫy khóa xoay/nghiêng và bỏ qua các bước sau. Để
biết thêm chi tiết về ống kính hỗ trợ xoay/nghiêng, hãy liên hệ đại lý Sony của bạn hoặc đại diện dịch vụ Sony.

Trượt lẫy khóa xoay/nghiêng đến vị trí UNLOCK để mở khóa xoay/nghiêng đầu camera.4

Đặt lại độ xoay/nghiêng.

Để biết thêm thông tin chi tiết, hãy tham khảo “Đặt lại chức năng xoay/nghiêng.”

5
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Đặt lại chức năng xoay/nghiêng

Bạn có thể đặt lại chức năng xoay/nghiêng, ví dụ: khi bạn thay ống kính, hãy áp dụng quy trình sau đây.

5-041-959-03(1) Copyright 2022 Sony Corporation

Trượt cần khóa xoay/nghiêng sang vị trị UNLOCK và kiểm tra xem độ xoay/nghiêng của đầu máy quay đã
được mở khóa chưa.

1

Thực hiện đặt lại chức năng xoay/nghiêng.

Đặt lại chức năng xoay/nghiêng có thể được thực thi bằng điều khiển từ xa hồng ngoại, Ứng dụng web hoặc Điều
khiển từ xa RM-IP500 (tùy chọn).

Vận hành sử dụng điều khiển từ xa hồng ngoại: Nhấn nút P/T RESET.
Vận hành sử dụng Ứng dụng web: Ấn nút  (đặt lại xoay/nghiêng) trên thẻ  (Others) trong bảng điều
khiển máy quay trên màn hình vận hành trực tiếp.
Vận hành sử dụng RM-IP500: tham khảo tài liệu hướng dẫn vận hành dành cho RM-IP500.

Chú ý

Thực hiện đặt lại chức năng xoay/nghiêng khiến đầu máy quay và ống kính xoay theo. Kiểm tra để đảm bảo rằng ống kính
không bị che khuất trước khi thực hiện.

Thiết bị có chức năng giới hạn phạm vi xoay/nghiêng, nhưng chức năng này bị tắt khi bật thiết bị hoặc khi thực hiện thiết
lập lại xoay/nghiêng.

Gợi ý

Khi hoàn tất đặt lại chức năng xoay/nghiêng, thiết bị quay trở về vị trí trước khi thực hiện.

2
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Truy cập Ứng dụng web từ trình duyệt web

Bằng cách kết nối thiết bị với máy tính bảng hoặc máy tính, bạn có thể vận hành và định cấu hình thiết bị từ trình duyệt
web.

Kiểm tra xem máy tính bảng hoặc máy tính của bạn có hỗ trợ các hoạt động của Ứng dụng web hay không.

Chú ý

Nếu môi trường yêu cầu không được đáp ứng hoặc tùy thuộc vào việc sử dụng máy tính bảng/máy tính, màn hình video
trong trình duyệt web có thể bị ảnh hưởng xấu.

Ứng dụng web của thiết bị này sử dụng JavaScript. Nếu sử dụng phần mềm chống vi-rút trên máy tính bảng/máy tính của
bạn, trang web có thể không được hiển thị chính xác.

1

Mục Yêu cầu

Hiển thị
Khuyến nghị loại 1080×810 pixel trở lên
Kích thước màn hình máy tính bảng: khuyến nghị
loại 10 inch trở lên

Hỗ trợ Hệ điều hành và trình
duyệt web

Windows

Hệ điều
hành

Windows 10 trở lên

Trình duyệt
web

Google Chrome

Mac

Hệ điều
hành

macOS 10.15 trở lên

Trình duyệt
web

Google Chrome
Safari

iPad

Hệ điều
hành

iPadOS 15 trở lên

Trình duyệt
web

Google Chrome
Safari

Android

Hệ điều
hành

Android 12 trở lên

Trình duyệt
web

Google Chrome

Kiểm tra xem thiết bị, máy tính bảng hoặc máy tính và các thiết bị ngoại vi đã được bật chưa.2

Kiểm tra xem thiết bị và máy tính bảng hoặc máy tính được kết nối qua Wi-Fi hoặc kết nối cục bộ mạng
LAN có dây chưa.

3

Kết nối với thiết bị từ trình duyệt web của máy tính bảng hoặc máy tính của bạn.4
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Chú ý

Nếu số cổng HTTP được thay đổi từ giá trị 80, hãy nhập “http://địa chỉ IP của thiết bị: Số cổng” vào thanh địa chỉ.

Khi kết nối bằng mã QR hoặc bằng cách nhập URL vào thanh địa chỉ của trình duyệt web, hãy sử dụng thiết bị hỗ trợ mDNS*.

Gợi ý

Sau đó, bạn có thể truy cập thiết bị nhanh chóng bằng cách sử dụng chức năng đánh dấu của trình duyệt web.

5-041-959-03(1) Copyright 2022 Sony Corporation

Kết nối bằng mã QR
Quét mã QR in trên nắp phương tiện của thiết bị bằng cách sử dụng camera trên máy tính bảng.

Mở liên kết đã hiển thị trên máy tính bảng.
Trình duyệt web máy tính bảng khởi chạy và hiển thị màn hình Ứng dụng Web của thiết bị.

Kết nối bằng cách nhập URL vào thanh địa chỉ của trình duyệt web
Khởi chạy một trình duyệt web trên máy tính bảng hoặc máy tính, sau đó nhập URL được in trên nắp phương tiện
nằm ở mặt bên của thiết bị.
Trình duyệt web sẽ hiển thị màn hình Ứng dụng Web của thiết bị.

Kết nối bằng cách nhập địa chỉ IP của thiết bị vào thanh địa chỉ của trình duyệt web
Khởi chạy trình duyệt web trên máy tính bảng hoặc máy tính của bạn và nhập “http://địa chỉ IP của thiết bị” vào
thanh địa chỉ.
Trình duyệt web sẽ hiển thị màn hình Ứng dụng Web của thiết bị.

mDNS: Một giao thức truyền thông được sử dụng để xác định địa chỉ IP từ tên máy chủ trên mạng cục bộ.*
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Khởi tạo thiết bị

Đảm bảo định cấu hình thiết bị theo quy trình sau khi sử dụng thiết bị lần đầu tiên.

Gợi ý

Nếu pin dự phòng hết sạch, bạn sẽ cần phải định cấu hình lại thiết lập ban đầu.

Kết nối với thiết bị từ máy tính bảng hoặc máy tính và khởi chạy Ứng dụng Web.

Khi thiết bị được sử dụng lần đầu tiên, bạn sẽ được nhắc nhập tên người dùng và mật khẩu vào trình duyệt web.
Nhập các thiết lập sau.

Tên người dùng: admin
Mật khẩu: (để trống)

Làm theo hướng dẫn trên màn hình để định cấu hình thiết lập ban đầu.

1

Nhập tên người dùng và mật khẩu của quản trị viên (Administrator), sau đó nhấn nút [OK].

1: Nhập tên người dùng của quản trị viên.
2: Đặt mật khẩu của quản trị viên.
3: Nhập mật khẩu giống như vậy một lần nữa để xác nhận.

Chú ý

Có thể sử dụng các ký tự sau cho phần tên người dùng và mật khẩu. Mật khẩu phải bao gồm ít nhất một chữ cái viết hoa,
một chữ cái viết thường, một con số và có từ 8 đến 64 ký tự.

Các ký tự chữ và số

2
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Màn hình trực tiếp cho các thao tác chụp sẽ xuất hiện. Tiếp tục cấu hình hoạt động cơ bản của thiết bị theo chế độ vận
hành.

Gợi ý

Trong một số trường hợp, chẳng hạn như khi sử dụng cặp thiết bị và máy tính bảng, việc sử dụng địa chỉ IP cố định cho thiết bị
có thể dễ dàng hơn.

Ký hiệu (!$%`*+-./<=>?@[]^_{|}~)

Trình duyệt web của bạn sẽ tải lại và bạn sẽ được nhắc nhập tên người dùng và mật khẩu.

Nhập tên người dùng và mật khẩu đã được định cấu hình ở bước 2.

Màn hình thiết lập cho ngôn ngữ và đồng hồ xuất hiện.

3

Chỉ định các mục sau và nhấn nút [OK].

[Language]
Chọn ngôn ngữ sử dụng để hiển thị Ứng dụng Web và màn hình camera. Thay đổi ngôn ngữ sẽ làm thay đổi ngôn
ngữ hiển thị của Ứng dụng Web.
[Date & Time Format]
Chọn định dạng hiển thị cho ngày và thời gian từ các tùy chọn sau.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
“yyyy” biểu thị năm, “mm” biểu thị tháng, “dd” biểu thị ngày, “hh” biểu thị giờ, “mm” biểu thị phút và “s” biểu thị giây,
tương ứng.
[12 h/24 h]
Chọn [12 h] (đồng hồ theo 12 giờ) hoặc [24 h] (đồng hồ theo 24 giờ) cho hiển thị thời gian.
[Time Setting]
Chọn phương pháp cài đặt ngày/thời gian.
[Synchronize with PC]: Đồng bộ ngày/giờ của máy tính hoặc máy tính bảng.
[Manual setting]: Đặt thủ công. Khi phương pháp này được chọn, các trường nhập ngày và giờ sẽ xuất hiện.
[Time Zone]
Chọn múi giờ.

4
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Để đặt địa chỉ IP cố đinh, đầu tiên bạn hãy tắt [Network] > [Wired LAN] > [IPv4] > [DHCP] (công tắc thanh trượt trong vị trí bên
trái) trong menu web.

Các mục thiết lập liên quan đến địa chỉ IP cố định xuất hiện. Định cấu hình các mục sau đó nhấn nút [OK] trên màn hình.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cấu hình vận hành máy quay cơ bản

Chủ đề này mô tả cách cấu hình thiết bị đối với vận hành cơ bản.

Đặt chế độ chụp

Bạn có thể chọn chế độ chụp của thiết bị để phù hợp với tiến trình công việc.

Chế độ Custom: Tạo các hình ảnh một cách linh hoạt trong khi chụp.
Chế độ chụp Log: Ghi nội dụng S-Log.

Chế độ Flexible ISO: Cài đặt phơi sáng được đặt bằng cách điều chỉnh giá trị ISO phù hợp với cảnh được chụp.
Chế độ Cine EI/chế độ Cine EI Quick: Vận hành thiết bị tương tự như máy quay phim (không tạo ra đầy đủ hình
ảnh khi chụp), với cảnh quay được phát triển trong quá trình hậu kỳ.

Trong chế độ Cine EI Quick, độ nhạy cơ bản phù hợp với cài đặt chỉ số phơi sáng sẽ được chọn tự động.
Chuyển chế độ chụp bằng cách sử dụng [Project] > [Base Setting] > [Shooting Mode] trong menu web hoặc menu
camera.

Chế độ Custom
Bạn có thể chọn tiêu chuẩn video.
Chuyển bằng cách sử dụng [Project] > [Base Setting] > [Target Display] trong menu web hoặc menu camera.

[SDR(BT.709)]: Chụp theo tiêu chuẩn phát sóng HD
[HDR(HLG)]: Chụp theo tiêu chuẩn phát sóng 4K thế hệ tiếp theo

Để biết thêm thông tin chi tiết, hãy tham khảo “Tổng quan giao diện” và các chủ đề khác trong “Chụp với giao diện mong
muốn”.

Chế độ chụp Log
(chế độ Flexible ISO/chế độ Cine EI/chế độ Cine EI Quick)
Trong các chế độ chụp Log, bạn chọn gam màu cơ bản cho tín hiệu được ghi và tín hiệu đầu ra. Gam màu được chọn ở
đây là gam màu của đầu ra video khi các cài đặt [LUT On/Off] được đặt thành [MLUT Off].
Bạn có thể chuyển gam màu bằng cách sử dụng [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] trong menu camera.

[S-Gamut3.Cine/SLog3]: Dễ dàng điều chỉnh gam màu cho rạp chiếu phim kỹ thuật số (DCI-P3).
[S-Gamut3/SLog3]: Gam màu rộng của Sony bao phủ gam màu ITU-R BT.2020.

Để biết thêm thông tin chi tiết, hãy tham khảo “Chụp với điều chỉnh dáng vẻ trong hậu kỳ”.
 
Các chức năng được hỗ trợ trong mỗi chế độ chụp được trình bày trong bảng sau.
●: Được hỗ trợ, –: Không được hỗ trợ

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (được liên kết với EI)
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Gợi ý

Trong chế độ Cine EI Quick và chế độ Cine EI, quá trình chụp xảy ra ở độ nhạy ISO cơ bản mà không sử dụng độ lợi để tối đa
hóa hiệu suất của cảm biến hình ảnh. Độ sáng được điều chỉnh bằng cách sử dụng ánh sáng và bộ lọc ND để điều chỉnh lượng
ánh sáng đến cảm biến hình ảnh.

Đặt tần số của hệ thống

Chuyển bằng cách sử dụng [Project] > [Rec Format] > [Frequency] trong menu web hoặc menu camera. Thiết bị có thể
tự động khởi động lại sau khi chuyển đổi, tùy thuộc vào giá trị đã chọn.

Chú ý

Bạn không thể chuyển đổi tần số hệ thống trong khi ghi hoặc phát lại.

Đặt chế độ quét hình

Bạn có thể đặt kích thước hình ảnh và độ phân giải hiệu quả của cảm biến hình ảnh.
Chuyển bằng cách sử dụng [Project] > [Rec Format] > [Imager Scan Mode] trong menu web hoặc menu camera.
[FF]: Kích thước toàn khung.
[S35]: Kích thước Super 35mm.

Chú ý

Bạn không thể chuyển đổi chế độ quét hình trong khi ghi hoặc phát lại.

Khi được đặt thành S35, định dạng video bị giới hạn ở 1920 × 1080.

Đặt bộ mã hóa

Bạn có thể đặt bộ mã hóa để ghi.
Chuyển bằng cách sử dụng [Project] > [Rec Format] > [Codec] trong menu web hoặc menu camera.

Chú ý

Bạn không thể chuyển đổi bộ mã hóa trong khi ghi hoặc phát lại.

Đặt định dạng video

Bạn có thể đặt định dạng video để ghi và định dạng đầu ra cho đầu ra từ máy quay.

Chuyển định dạng video để ghi bằng cách sử dụng [Project] > [Rec Format] > [Video Format] trong menu web hoặc
menu camera.

Custom Flexible ISO Cine EI Cine EI Quick

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(không bao gồmBase Look)

● – – –
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Chuyển định dạng đầu ra từ các đầu nối SDI OUT và HDMI OUT bằng cách sử dụng [Monitoring] > [Output Format]
trong menu web hoặc menu camera.

Chú ý

Bạn không thể chuyển đổi định dạng video trong khi ghi hoặc phát lại.

Các hạn chế có thể áp dụng đối với tín hiệu từ đầu nối SDI OUT và HDMI OUT, tùy thuộc vào cài đặt định dạng video.

Chủ đề liên quan
Tổng quan giao diện

Chụp với điều chỉnh dáng vẻ trong hậu kỳ

5-041-959-03(1) Copyright 2022 Sony Corporation
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Thẻ nhớ được hỗ trợ

Thiết bị ghi âm thanh và video trên thẻ nhớ CFexpress Type A (bán riêng) hoặc thẻ nhớ SDXC (bán riêng) được lắp vào
các khe cắm thẻ. Thẻ nhớ cũng được sử dụng để ghi proxy.

Thẻ nhớ CFexpress Type A

Sử dụng thẻ nhớ Sony CFexpress Type A* được liệt kê trong “Phương tiện ghi được đề xuất” trong thiết bị.
Để biết chi tiết về vận hành với phương tiện của các nhà sản xuất khác, hãy tham khảo hướng dẫn vận hành đối của
phương tiện hoặc tham khảo thông tin của nhà sản xuất.

Thẻ nhớ SDXC

Sử dụng thẻ nhớ SDXC* được liệt kê trong “Phương tiện ghi được đề xuất” trong thiết bị.

Phương tiện ghi được đề xuất

Các điều kiện hoạt động được đảm bảo sẽ khác biệt tùy theo cài đặt Rec Format và Recording.

CFexpress Type A
Tuân thủ VPG400
Được hỗ trợ cho tất cả các định dạng ghi của thiết bị.

SDXC
Được hỗ trợ theo các điều kiện trong bảng sau. “●” cho biết hoạt động đã được xác minh và “–” cho biết hoạt động
không được đảm bảo.

RAW Out & XAVC-I, 4096×2160 Bậc 300, Chế độ bình thường

RAW Out & XAVC-I, 3840×2160 Bậc 300, Chế độ bình thường

Được gọi là “thẻ CFexpress” trong Hướng dẫn trợ giúp này.*

Được gọi là “thẻ SD” trong Hướng dẫn trợ giúp này.*

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●
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RAW Out & XAVC-I, 3840×2160 Bậc 300, S&Q (60 fps hoặc thấp hơn)

RAW Out & XAVC-I, 3840×2160 Bậc 300, S&Q (100 fps, 120 fps)
Phương tiện đã xác minh không có sẵn.

XAVC-I, 4096×2160 Bậc 300, Chế độ bình thường

XAVC-I, 4096×2160 Bậc 300, S&Q (60 fps hoặc thấp hơn)

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●
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XAVC-I, 3840×2160 Bậc 300, Chế độ bình thường

XAVC-I, 3840×2160 Bậc 300, S&Q (60 fps hoặc thấp hơn)

XAVC-I, 3840×2160 Bậc 300, S&Q (100 fps, 120 fps)
Phương tiện đã xác minh không có sẵn.

XAVC-I, 1920×1080 Bậc 100, Chế độ bình thường

XAVC-I, 1920×1080 Bậc 100, S&Q (60 fps hoặc thấp hơn)

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080 Bậc 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 Bậc 100, S&Q (150 fps, 180 fps)
Phương tiện đã xác minh không có sẵn.

XAVC-I, 1920×1080 Bậc 100, S&Q (200 fps, 240 fps)
Phương tiện đã xác minh không có sẵn.

XAVC-L, 3840×2160 420, Chế độ bình thường

XAVC-L, 3840×2160 420, S&Q (60 fps hoặc thấp hơn)

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, Chế độ bình thường

XAVC-L, 1920×1080 HD50, S&Q (60 fps hoặc thấp hơn)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, Chế độ bình thường

XAVC-L, 1920×1080 HD35, S&Q (60 fps hoặc thấp hơn)

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-959-03(1) Copyright 2022 Sony Corporation

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Tần số hệ thống Bậc 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lắp thẻ nhớ

Chủ đề này mô tả các biện pháp phòng ngừa khi lắp thẻ nhớ.

Mở nắp phương tiện của phần khe cắm thẻ.1

Lắp thẻ nhớ vào.

Đối với thẻ CFexpress, nhãn dán sẽ ngửa lên.

Chú ý

Trên thiết bị gắn trần, nhãn dán sẽ úp xuống.

Đối với thẻ SD, nhãn dán sẽ úp xuống.

Chú ý

Trên thiết bị gắn trần, nhãn dán sẽ ngửa lên.

Chỉ báo truy cập sáng đỏ, sau đó chuyển sang màu xanh lục nếu thẻ có thể sử dụng.

2
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Chú ý

Thẻ nhớ, khe cắm thẻ nhớ và dữ liệu hình ảnh trên thẻ nhớ có thể bị hỏng nếu thẻ bị ép vào khe cắm không đúng hướng.

Khi ghi vào phương tiện được lắp vào cả hai khe cắm thẻ CFexpress Type A / SD A và B, hãy lắp phương tiện vào cả hai khe
được khuyến nghị để hoạt động với định dạng của bản ghi.

5-041-959-03(1) Copyright 2022 Sony Corporation

Chú ý

Nếu chỉ báo truy cập nhấp nháy liên tục và không chuyển sang màu xanh lục, tạm thời tắt thiết bị và tháo thẻ nhớ ra rồi lắp
lại.

Đóng nắp phương tiện.3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tháo thẻ nhớ

Mở nắp phương tiện của phần khe cắm thẻ và ấn nhẹ thẻ nhớ vào để đẩy thẻ ra.

Chú ý

Nếu thiết bị đã bị tắt hoặc rút thẻ nhớ trong khi đang truy cập thẻ nhớ thì sẽ không bảo đảm được tính toàn vẹn của dữ liệu trên
thẻ. Tất cả dữ liệu được ghi trên thẻ có thể bị xóa bỏ. Luôn đảm bảo chỉ báo truy cập có màu xanh hoặc tắt trước khi tắt thiết bị
hoặc tháo thẻ nhớ.

Khi tháo thẻ nhớ ngay sau khi ghi xong, thẻ nhớ có thể bị nóng nhưng đây không phải là sự cố.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Định dạng (khởi tạo) thẻ nhớ

Nếu thẻ nhớ chưa được định dạng hoặc thẻ nhớ được định dạng theo một thông số kỹ thuật khác được lắp vào, thông
báo “Media Needs to be Formatted” sẽ hiển thị trong bảng điều khiển ảnh máy quay.
Định dạng thẻ bằng quy trình sau.

Chú ý

Việc định dạng thẻ nhớ sẽ xóa tất cả dữ liệu, bao gồm cả dữ liệu video đã ghi và các tệp thiết lập.

Thông báo có thể xuất hiện trong khi thực hiện tùy thuộc vào thời lượng quá trình định dạng.

Nếu định dạng không thành công
Không thể định dạng thẻ nhớ không được thiết bị hỗ trợ.
Thông báo cảnh báo sẽ hiển thị. Làm theo hướng dẫn để thay thế thẻ bằng thẻ nhớ được hỗ trợ.

Để sử dụng thẻ được định dạng trên máy quay trong khe cắm của thiết bị khác
Đầu tiên, tạo một bản sao lưu của thẻ, sau đó định dạng lại thẻ trong thiết bị sẽ sử dụng.

5-041-959-03(1) Copyright 2022 Sony Corporation

Chọn [TC/Media] > [Format Media] trong menu camera.1

Chọn Media(A) (khe A) hoặc Media(B) (khe B), sau đó chọn phương pháp định dạng (Full Format hoặc
Quick Format).

Một thông báo xác nhận xuất hiện.
[Full Format]: Khởi tạo hoàn toàn phương tiện, bao gồm vùng dữ liệu và thông tin quản lý dữ liệu.
[Quick Format]: Chỉ khởi tạo thông tin quản lý dữ liệu của phương tiện.

2

Chọn [Execute].

Một thông báo được hiển thị khi đang định dạng và chỉ báo truy cập sáng đỏ.
Khi quá trình định dạng kết thúc, một thông báo hoàn thành sẽ xuất hiện.

3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kiểm tra thời gian ghi còn lại

Khi chụp (ghi/chờ), bạn có thể theo dõi dung lượng còn lại của thẻ nhớ trong mỗi khe bằng cách sử dụng các chỉ báo
phương tiện còn lại của khe A/B trong bảng điều khiển hình ảnh máy quay.
Thời gian ghi còn lại được tính từ dung lượng còn lại của phương tiện trong mỗi khe và định dạng ghi hiện tại (tốc độ bit
ghi) và được hiển thị bằng đơn vị phút.

Thời gian thay thẻ nhớ
Khi tổng thời gian ghi còn lại trên hai thẻ nhớ dưới 5 phút, thông báo “Media Near Full” xuất hiện và đèn ghi/báo hiệu bắt
đầu nhấp nháy để cảnh báo bạn.
Thay thế bằng phương tiện có dung lượng trống.
Nếu bạn tiếp tục ghi cho đến khi tổng thời gian ghi còn lại bằng không, thông báo sẽ chuyển thành “Media Full” và quá
trình ghi sẽ dừng lại.

Chú ý

Có thể ghi lên đến khoảng 600 clip trên một thẻ.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Khôi phục thẻ nhớ

Nếu xảy ra lỗi trong thẻ nhớ vì bất cứ lý do gì, thẻ phải được khôi phục trước khi sử dụng.
Khi bạn nạp thẻ nhớ cần được khôi phục, một thông báo sẽ xuất hiện trong bảng điều khiển hình ảnh máy quay hỏi bạn
có muốn khôi phục thẻ hay không.

Để khôi phục thẻ
Chọn [Execute] bằng cách sử dụng các nút mũi tên trong khiển điều khiển GUI và nhấn nút [Set].
Một thông báo và trạng thái tiến độ (%) được hiển thị khi đang định dạng và chỉ báo truy cập sáng đỏ.
Khi quá trình khôi phục kết thúc, một thông báo hoàn thành sẽ xuất hiện.

Nếu khôi phục thất bại
Không thể khôi phục thẻ nhớ đã xảy ra lỗi bộ nhớ. Thông báo cảnh báo sẽ hiển thị. Làm theo hướng dẫn để thay thẻ
nhớ.
Thẻ nhớ đã xảy ra lỗi bộ nhớ có thể sử dụng được nếu thẻ được định dạng lại.
Trong một số trường hợp, một số clip có thể được khôi phục trong khi những clip khác không thể. Các clip đã khôi
phục có thể được phát bình thường.

Chú ý

Để khôi phục phương tiện được ghi bằng thiết bị này, hãy đảm bảo sử dụng thiết bị này.

Phương tiện được ghi bằng thiết bị không phải thiết bị này hoặc bằng thiết bị khác có phiên bản khác (thậm chí cùng kiểu máy)
có thể không khôi phục được bằng thiết bị này.

Không thể khôi phục các clip ngắn hơn 2 giây.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bắt đầu/dừng ghi

Chủ đề này mô tả cách bắt đầu/dừng ghi.

Gắn các thiết bị cần thiết, sau đó kiểm tra xem đã có nguồn điện của thiết bị và các thiết bị ngoại vi vào
chưa.

1

Lắp (̣các) thẻ nhớ vào.2

Kiểm tra trạng thái nguồn của thiết bị ở trên cùng bên trái của màn hình Ứng dụng Web.

Khi nguồn điện được bật
Khi thiết bị được bật, [Power ON] được hiển thị trên công tắc nguồn ở đầu màn hình Ứng dụng Web.

Đèn POWER sáng lên ở mặt trước của thiết bị và hình ảnh camera xuất hiện trên màn hình hoạt động trực tiếp của
Ứng dụng Web.

Chú ý

Nếu mật khẩu quản trị viên chưa được định cấu hình, màn hình nhắc bạn định cấu hình mật khẩu sẽ xuất hiện. Xem “Khởi
tạo thiết bị.”

Khi nguồn điện ở trạng thái chờ
Khi nguồn điện của thiết bị ở trạng thái chờ, [Power Standby] sẽ hiển thị trên công tắc nguồn trong Ứng dụng Web.

Ở trạng thái này, hãy ấn công tắc nguồn và chọn [Power ON]. Thiết bị bật, đèn POWER sáng lên màu xanh ở mặt
trước của thiết bị và hình ảnh camera xuất hiện trên màn hình hoạt động trực tiếp của Ứng dụng Web.

Gợi ý

Bạn cũng có thể bật thiết bị bằng nút nguồn trên điều khiển hồng ngoại từ xa đi kèm.

3
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Để chuyển nguồn điện của thiết bị sang trạng thái chờ
Ấn công tắc nguồn trong Ứng dụng web và chọn [Power Standby] để đặt nguồn điện của thiết bị ở trạng thái chờ.

Gợi ý

Bạn cũng có thể đặt nguồn điện ở trạng thái chờ bằng nút nguồn trên điều khiển hồng ngoại từ xa đi kèm.

Chủ đề liên quan

Khởi tạo thiết bị

Nhấn nút START/STOP ghi.

Quá trình ghi bắt đầu và đèn ghi/đếm (2 vị trí) của thiết bị sáng lên.
Trong khi ghi, nút START/STOP ghi sẽ sáng. Ngoài ra, biểu tượng cho phương tiện ghi mục tiêu và [●Rec] được
hiển thị.

4

Để dừng quá trình ghi, nhấn nút START/STOP ghi một lần nữa.

Quá trình ghi dừng lại và đèn ghi/đếm (2 vị trí) của thiết bị tắt.
Trong khi ghi ở trạng thái chờ, nút START/STOP ghi không sáng. Ngoài ra, biểu tượng cho phương tiện ghi mục
tiêu và [Stby] được hiển thị.

Gợi ý

Bạn cũng có thể bắt đầu/dừng ghi bằng nút START/STOP ghi trên điều khiển hồng ngoại từ xa đi kèm.

5
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Chuyển đổi giữa các thẻ nhớ

Khi cắm hai thẻ nhớ vào, bạn có thể ấn nút [Slot Select] trên bảng điều khiển phát lại của Ứng dụng web để chuyển đổi
thẻ nhớ.

Gợi ý

Bạn cũng có thể nhấn nút SLOT SEL (chọn khe cắm thẻ nhớ (A)/(B)) trên điều khiển hồng ngoại từ xa đi kèm để chuyển đổi thẻ
nhớ.

Giới thiệu về ghi chuyển tiếp

Khi ghi, thiết bị tự động chuyển sang thẻ nhớ thứ hai ngay trước khi dung lượng còn lại trên thẻ thứ nhất bị giảm về 0
(ghi chuyển tiếp). Bạn có thể tiếp tục ghi liên tục khi chuyển đổi các thẻ nhớ bằng cách thay thẻ nhớ mà đã đầy rồi bằng
một thẻ nhớ mới.

Chú ý

Bạn không thể chuyển đổi giữa các thẻ nhớ trong khi đang ở trong chế độ phát lại. Bên cạnh đó, hệ thống không hỗ trợ phát lại
liên tục một clip kéo dài trong khe cắm A và khe cắm B của phương tiện.

Giới thiệu về dữ liệu đã ghi

Khi bạn dừng ghi, video, âm thanh và dữ liệu đi kèm từ đầu đến cuối quá trình ghi được lưu lại dưới dạng “clip” đơn trên
thẻ nhớ.

Tên clip của dữ liệu đã ghi

Tên của mỗi clip do thiết bị ghi lại được tự động gán bằng cách sử dụng [TC/Media] > [Clip Name Format] trong menu
camera.

Thời lượng tối đa của clip

Lên tới 6 giờ cho mỗi clip.
Thời lượng tối đa khi ghi liên tục bằng với thời lượng tối đa của clip. Nếu thời gian ghi vượt quá thời lượng tối đa của
clip, clip mới sẽ được tạo tự động và quá trình ghi lại tiếp tục. Clip mới xuất hiện dưới dạng clip riêng biệt trên màn
thumbnail.
Nhiều clip khác nhau được ghi liên tiếp trong quá trình ghi chuyển tiếp, nhưng quá trình ghi sẽ dừng tự động sau khoảng
24 giờ.

Chú ý

Không đẩy thẻ nhớ ra khi đang thực hiện quá trình ghi. Khi ghi, chỉ thay đổi các thẻ nhớ trong khe cắm thẻ mà chỉ báo truy cập
đã tắt.

Khi dung lượng còn lại trên thẻ nhớ được ghi còn ít hơn 1 phút và thẻ nhớ ghi được đã lắp vào khe cắm thẻ khác, thông báo có
nội dung “Will Switch Slots Soon” xuất hiện. Thông báo sẽ tắt đi sau khi chuyển đổi khe cắm thẻ nhớ.

Quá trình ghi chuyển tiếp có thể không hoạt động nếu được bắt đầu khi dung lượng còn lại của thẻ nhớ là nhỏ hơn 1 phút. Để
ghi chuyển tiếp đúng cách, kiểm tra xem dung lượng còn lại của thẻ nhớ có lớn hơn 1 phút trước thời điểm bắt đầu ghi hay
không.

Không thể phát lại liền mạch trên thiết bị video được tạo bằng chức năng ghi chuyển tiếp của thiết bị.
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Nhằm gộp video được tạo sử dụng chức năng ghi chuyển tiếp của thiết bị, hãy sử dụng phần mềm “Catalyst Browse”.
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Kiểm tra âm thanh

Âm thanh được xuất ra từ các đầu nối SDI và HDMI của thiết bị. Chọn kết hợp các kênh âm thanh được xuất ra từ đầu
nối HDMI bằng cách sử dụng [Audio] > [Audio Output] > [HDMI/Stream Output CH] trong menu camera.
CH1/CH2: kết hợp CH1 và CH2
CH3/CH4: kết hợp CH3 và CH4
Khi giám sát âm thanh trên Ứng dụng web, hãy sử dụng máy đo mức âm thanh ở phía dưới bên phải của hình ảnh máy
quay.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Chỉ định dữ liệu thời gian

Chủ đề này mô tả cách đặt dữ liệu thời gian.

Cài đặt mã thời gian

Đặt mã thời gian để ghi bằng cách sử dụng [TC/Media] > [Timecode] trong menu camera.

Cài đặt bit người dùng

Bạn có thể thêm số thuộc hệ thập lục phân 8 con số vào hình ảnh đã ghi dưới dạng bit người dùng. Bạn cũng có thể đặt
bit người dùng thành thời gian hiện tại. Đặt chế độ bằng cách sử dụng [TC/Media] > [Users Bit] trong menu camera.

Hiển thị dữ liệu thời gian

Đặt mã thời gian để hiển thị bằng cách sử dụng [TC/Media] > [TC Display] > [Display Select] trong menu camera.
Nhấn nút có thể gán mà đã được gán là [DURATION/TC/U-BIT] thì sẽ chuyển đổi được hiển thị giữa mã thời gian, bit
người dùng và thời lượng theo trình tự.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Xem lại bản ghi (Rec Review)

Bạn có thể xem lại clip được ghi cuối cùng trên màn hình (xem lại bản ghi).

Chú ý

Không hỗ trợ tính năng Rec Review nếu thay đổi định dạng video sau khi ghi một clip.

Cài đặt vị trí bắt đầu Rec Review

Bạn có thể cài đặt các vị trí bắt đầu phát lại thành một trong số các lựa chọn sau bằng cách sử dụng cài đặt [Technical] >
[Rec Review] trong menu camera.

3 giây cuối của clip
10 giây cuối của clip
Thời điểm bắt đầu của clip

Gợi ý

Nếu muốn xem lại một clip cụ thể nào đó sau khi ghi nhiều clip khác nhau, hãy ấn nút [Thumbnail] để hiển thị màn hình ảnh thu
nhỏ và chọn clip để bắt đầu phát lại.

Bạn cũng có thể ấn nút THUMBNAIL của điều khiển từ xa hồng ngoại đi kèm để hiển thị màn hình ảnh thu nhỏ.

Phương thức Rec Review

Gán trước chức năng Rec Review cho một trong các nút có thể gán trên bảng điều chỉnh cấu hình cơ bản.

Để biết thêm thông tin chi tiết về lệnh gán, hãy tham khảo “Nút có thể gán” trong “Các chức năng hữu ích”

Dừng ghi và sau đó ấn một nút có thể gán đã gán chức năng Rec Review để bắt đầu phát lại clip đã ghi trước đó.
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Clip được phát cho đến hết, Rec Review kết thúc và thiết bị quay trở về chế độ Stby (chờ).

Cách dừng Rec Review
Ấn nút có thể gán đã gán chức năng Rec Review hoặc ấn nút [Cancel/Back].
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Gợi ý

Bạn cũng có thể ấn nút [Cancel/Back] của điều khiển từ xa hồng ngoại đi kèm để dừng chức năng Rec Review.

Chủ đề liên quan

Nút có thể gán

5-041-959-03(1) Copyright 2022 Sony Corporation
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Màn hình điều chỉnh khung

Định khung được điều chỉnh bằng cách sử dụng các phần sau của màn hình vận hành trực tiếp.

Chú ý

Tùy thuộc vào hướng của camera, có thể nhìn thấy độ dài tiêu cự của ống kính và vị trí thu phóng, một phần của thiết bị hoặc
dây cáp kết nối với khối đầu nối. Trước khi quay, hãy kiểm tra trường nhìn của ống kính và độ dài tiêu cự bạn đang sử dụng. Bạn
cũng có thể kiểm soát phạm vi xoay/nghiêng bằng cách sử dụng [Pan-Tilt] > [P/T Range Limit] trong menu web. Khi bật thiết bị
hoặc thực hiện đặt lại chức năng xoay/nghiêng, cài đặt giới hạn phạm vi này bị bỏ qua. Để biết thêm thông tin chi tiết, hãy tham
khảo [Pan-Tilt] > [P/T Range Limit] trong menu web.

Gợi ý

Bạn cũng có thể điều khiển khung bằng điều khiển hồng ngoại từ xa đi kèm.

5-041-959-03(1) Copyright 2022 Sony Corporation

Bảng điều khiển vị trí đặt trước1.

Thẻ  (Main) /thẻ  (Others)2.

Bảng điều khiển khung3.
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Điều chỉnh hướng chụp thủ công bằng Ứng dụng web

Di chuyển máy quay theo chiều ngang được gọi là xoay và di chuyển máy quay theo chiều dọc được gọi là nghiêng.
Bạn có thể điều chỉnh hướng chụp bằng các thao tác xoay/nghiêng.

Gợi ý

Nếu [Execute Pan-Tilt Reset] được hiển thị bên dưới cần điều khiển, thì thông tin gốc điều khiển xoay/nghiêng của thiết bị đã xảy
ra mâu thuẫn. Thực hiện chức năng đặt lại xoay/nghiêng để cập nhật thông tin gốc. Để biết thêm thông tin chi tiết, hãy tham khảo
“Đặt lại chức năng xoay/nghiêng.”

Hướng camera trở lại mặt trước
Ấn nút  (Trang chủ xoay/nghiêng) trên thẻ  (Others) trong bảng điều khiển máy quay.

Chú ý

Tùy thuộc vào hướng của camera, có thể nhìn thấy độ dài tiêu cự của ống kính và vị trí thu phóng, một phần của thiết bị hoặc
dây cáp kết nối với khối đầu nối. Trước khi quay, hãy kiểm tra trường nhìn của ống kính và độ dài tiêu cự bạn đang sử dụng. Bạn
cũng có thể kiểm soát phạm vi xoay/nghiêng bằng cách sử dụng [Pan-Tilt] > [P/T Range Limit] trong menu web. Khi bật thiết bị
hoặc thực hiện đặt lại chức năng xoay/nghiêng, cài đặt giới hạn phạm vi này bị bỏ qua. Để biết thêm thông tin chi tiết, hãy tham
khảo [Pan-Tilt] > [P/T Range Limit] trong menu web.

Chủ đề liên quan

Đặt lại chức năng xoay/nghiêng

Nhấn thẻ  (Xoay/nghiêng/thu phóng) trong bảng điều khiển khung để hiển thị cần điều khiển.1

Kéo trung tâm của cần điều khiển theo hướng bạn muốn xem trong khi theo dõi bảng điều khiển hình ảnh
máy quay.

Hướng và tốc độ của máy quay thay đổi theo hướng và mức kéo.
Bạn có thể điều chỉnh xoay/nghiêng chính xác hơn bằng cách nhấn vào các vùng ngoại vi của cần điều khiển.

2
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Cài đặt tốc độ vận hành xoay/nghiêng

Bạn có thể thay đổi tốc độ vận hành xoay/nghiêng bằng thanh trượt [Pan-Tilt Speed] trong bảng điều khiển máy quay
bằng cách vận hành cần điều khiển trên bảng điều khiển khung.

Chú ý

Nếu có bức tường hoặc vật cản nào khác trong phạm vi di chuyển của máy quay, hãy cẩn thận để tránh va chạm với máy quay
hoặc ống kính trong quá trình vận hành xoay/nghiêng.

Sự tăng tốc xoay/nghiêng tùy thuộc vào các đặc điểm vật lý, chẳng hạn như cân bằng trọng lượng của ống kính. Bạn có thể thay
đổi cài đặt gia tốc bằng cách sử dụng [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] trong menu web hoặc menu camera.
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Ấn vào thẻ  (Main) trong bảng điều khiển máy quay.1

Chọn thanh trượt [Pan-Tilt Speed] từ danh sách.

Nếu thanh trượt [Pan-Tilt Speed] không được hiển thị, chọn một trong số hai nút chọn chức năng thanh trượt để
hiển thị thanh trượt.

2

Chỉnh núm thanh trượt sang trái hoặc phải.

Di chuyển núm sang trái để giảm tốc độ vận hành, di chuyển núm sang phải để tăng tốc độ vận hành.

3

140



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cài đặt gia tốc vận hành xoay/nghiêng

Bạn có thể đặt vận hành tăng tốc trong phạm vi chín cấp độ bằng cách sử dụng [Pan-Tilt] > [P/T Acceleration] > [Ramp
Curve] trong menu web hoặc menu camera. Tăng giá trị cho các thay đổi nhanh hơn về tốc độ hoặc giảm giá trị cho các
thay đổi dần dần về tốc độ.
Để có khả năng phản hồi tốt hơn khi vận hành xoay/nghiêng, hãy chọn một giá trị trong phạm vi từ 7 đến 9.
Để có độ chính xác vị trí cao hơn khi bắt đầu/kết thúc chuyển động đến vị trí thiết lập sẵn, bạn nên sử dụng một giá trị
trong phạm vi từ 1 đến 6.

Để biết thêm thông tin chi tiết về vị trí thiết lập sẵn, hãy tham khảo “Lưu/Khôi phục xoay/nghiêng và vị trí thu phóng.”

Chú ý

Khi giá trị được đặt cao, chức năng này có thể không hoạt động bình thường nếu gắn một ống kính nặng. Kiểm tra hoạt động
trước khi sử dụng thực tế.

Mối quan hệ giữa cài đặt [Ramp Curve] và vận hành xoay/nghiêng

Khi tính năng xoay/nghiêng được vận hành

Khi vị trí thiết lập sẵn được thu hồi

141



5-041-959-03(1) Copyright 2022 Sony Corporation

142



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh hướng chụp bằng điều khiển từ xa hồng ngoại đi kèm

Bạn có thể điều chỉnh hướng chụp bằng các nút thao tác xoay/nghiêng của điều khiển hồng ngoại từ xa đi kèm.

Hướng camera trở lại mặt trước
Nhấn nút HOME.

Chú ý

Tùy thuộc vào hướng của camera, có thể nhìn thấy độ dài tiêu cự của ống kính và vị trí thu phóng, một phần của thiết bị hoặc
dây cáp kết nối với khối đầu nối. Trước khi quay, hãy kiểm tra trường nhìn của ống kính và độ dài tiêu cự bạn đang sử dụng. Bạn
cũng có thể kiểm soát phạm vi xoay/nghiêng bằng cách sử dụng [Pan-Tilt] > [P/T Range Limit] trong menu web. Khi bật thiết bị
hoặc thực hiện đặt lại chức năng xoay/nghiêng, cài đặt giới hạn phạm vi này bị bỏ qua. Để biết thêm thông tin chi tiết, hãy tham
khảo [Pan-Tilt] > [P/T Range Limit] trong menu web.
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Nhấn các nút mũi tên để điều khiển xoay/nghiêng.

Nhấn nút mũi tên của hướng bạn muốn xem trong khi theo dõi hình ảnh camera.
Để di chuyển một khoảng cách ngắn, hãy nhấn nhanh nút mũi tên.
Để di chuyển một khoảng cách dài, hãy nhấn và giữ nút mũi tên.
Để di chuyển theo đường chéo, hãy nhấn và giữ nút  (mũi tên lên) hoặc  (mũi tên xuống) và nhấn nút 
(mũi tên trái) hoặc  (mũi tên phải).

1
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Cài đặt loại thu phóng

Đặt loại thu phóng bằng cách sử dụng [Technical] > [Zoom] > [Zoom Type] trong menu camera.
Loại thu phóng sẽ khác nhau tùy vào loại ống kính đi kèm.

Chú ý

Không có Thu phóng chất lượng cao trong các trường hợp sau.

Khi [Shooting] > [S&Q Motion] > [Setting] được đặt thành On và cài đặt [Frame Rate] trong menu camera cao hơn 60 fps
Khi [Project] > [Rec Format] > [Codec] trong menu camera được đặt thành [RAW] hoặc một tùy chọn có bao gồm RAW

Việc vận hành công tắc chọn SERVO/MANUAL trên ống kính sẽ đặt lại độ phóng đại của Thu phóng chất lượng cao thành 1×.

AF-S không được hỗ trợ trong quá trình Thu phóng chất lượng cao.

Thu phóng chất lượng cao

Thiết bị này được trang bị chức năng thu phóng sử dụng bộ xử lý tín hiệu hình ảnh có tên là Clear Image Zoom (Thu
phóng chất lượng cao). Khi bật Thu phóng chất lượng cao, chức năng thu phóng được hỗ trợ ngay cả đối với các ống
kính một tiêu cự. Nó cũng có thể được sử dụng để mở rộng phạm vi ngoài phạm vi quang học trên ống kính thu phóng
hiệu suất cao.
Tỷ lệ thu phóng tối đa sử dụng thu phóng chất lượng cao thay đổi tùy thuộc vào độ phân giải ghi.

Đối với độ phân giải ghi QFHD/4K: 1,5×
Đối với độ phân giải ghi HD: 2×
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Loại ống kính đi kèm
Cài đặt [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Ống kính một tiêu cự/ống kính thu
phóng thủ công

Không hỗ trợ thao tác thu
phóng.

Hỗ trợ Thu phóng chất lượng cao.

Ống kính thu phóng hiệu suất cao
Chỉ hỗ trợ thu phóng
quang học.

Hỗ trợ thu phóng quang học và thu phóng
chất lượng cao.
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Điều chỉnh thu phóng thủ công bằng Ứng dụng web

Bạn có thể điều chỉnh thu phóng của thiết bị bằng cách sử dụng thu phóng tùy chọn hoặc Clear Image Zoom. Chủ đề
này mô tả cách điều chỉnh bằng Ứng dụng web. Để biết thêm thông tin chi tiết, hãy tham khảo “Cài đặt loại thu phóng.”

Chú ý

Tùy thuộc vào hướng của camera, có thể nhìn thấy độ dài tiêu cự của ống kính và vị trí thu phóng, một phần của thiết bị hoặc
dây cáp kết nối với khối đầu nối. Trước khi quay, hãy kiểm tra trường nhìn của ống kính và độ dài tiêu cự bạn đang sử dụng. Bạn
cũng có thể kiểm soát phạm vi xoay/nghiêng bằng cách sử dụng [Pan-Tilt] > [P/T Range Limit] trong menu web. Khi bật thiết bị
hoặc thực hiện đặt lại chức năng xoay/nghiêng, cài đặt giới hạn phạm vi này bị bỏ qua. Để biết thêm thông tin chi tiết, hãy tham
khảo [Pan-Tilt] > [P/T Range Limit] trong menu web.

Tốc độ và độ chính xác thu phóng thực tế sẽ khác nhau tùy vào ống kính. Kiểm tra hoạt động trước khi sử dụng.

Gợi ý

Bạn có thể điều khiển độ thu phóng của ống kính thu phóng thủ công bằng cách sử dụng bộ điều khiển ống kính (tùy chọn)
tương thích với thiết bị này. Để biết chi tiết, hãy xem “Kết nối bộ điều khiển ống kính” và “Điều chỉnh thu phóng bằng bộ điều
khiển ống kính”.

Chủ đề liên quan
Cài đặt loại thu phóng

Kết nối bộ điều khiển ống kính

Điều chỉnh thu phóng bằng bộ điều khiển ống kính

Ấn vào thẻ  (Xoay/nghiêng/thu phóng) trong bảng điều khiển khung để hiển thị bảng điều khiển
xoay/nghiêng.

1

Trượt núm thanh trượt [Zoom] theo hướng chữ [T] (Chụp xa) hoặc theo hướng chữ [W] (Rộng) để điều
chỉnh thu phóng.

Tốc độ thu phóng khác nhau tùy vào chuyển động của thanh trượt.

2
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cài đặt tốc độ vận hành thu phóng

Bạn có thể thay đổi tốc độ vận hành thu phóng bằng thanh trượt [Zoom] trong bảng điều khiển khung bằng cách sử dụng
thanh trượt [Zoom Speed] trên bảng điều khiển máy quay.

Chú ý

Tốc độ và độ chính xác thu phóng thực tế sẽ khác nhau tùy vào ống kính. Kiểm tra hoạt động trước khi sử dụng.

5-041-959-03(1) Copyright 2022 Sony Corporation

Ấn vào thẻ  (Main) trong bảng điều khiển máy quay.1

Chọn thanh trượt [Zoom Speed] từ danh sách.

Nếu thanh trượt [Zoom Speed] không được hiển thị, chọn một trong số hai nút chọn chức năng thanh trượt để hiển
thị thanh trượt.

 

2

Chỉnh núm thanh [Zoom Speed] trượt sang trái hoặc phải.

Di chuyển núm sang trái để giảm tốc độ vận hành, di chuyển núm sang phải để tăng tốc độ vận hành.

3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh thu phóng bằng điều khiển từ xa hồng ngoại đi kèm

Bạn có thể điều chỉnh thu phóng của thiết bị bằng cách sử dụng thu phóng tùy chọn hoặc Clear Image Zoom. Chủ đề
này mô tả cách thực hiện các điều chỉnh bằng điều khiển từ xa hồng ngoại đi kèm. Để biết thêm thông tin chi tiết về Thu
phóng chất lượng cao, hãy tham khảo “Cài đặt loại thu phóng.”

Chú ý

Tùy thuộc vào hướng của camera, có thể nhìn thấy độ dài tiêu cự của ống kính và vị trí thu phóng, một phần của thiết bị hoặc
dây cáp kết nối với khối đầu nối. Trước khi quay, hãy kiểm tra trường nhìn của ống kính và độ dài tiêu cự bạn đang sử dụng. Bạn
cũng có thể kiểm soát phạm vi xoay/nghiêng bằng cách sử dụng [Pan-Tilt] > [P/T Range Limit] trong menu web. Khi bật thiết bị
hoặc thực hiện đặt lại chức năng xoay/nghiêng, cài đặt giới hạn phạm vi này bị bỏ qua. Để biết thêm thông tin chi tiết, hãy tham
khảo [Pan-Tilt] > [P/T Range Limit] trong menu web.

Gợi ý

Bạn có thể điều khiển độ thu phóng của ống kính thu phóng thủ công bằng cách sử dụng bộ điều khiển ống kính (tùy chọn)
tương thích với thiết bị này. Để biết chi tiết, hãy xem “Kết nối bộ điều khiển ống kính” và “Điều chỉnh thu phóng bằng bộ điều
khiển ống kính”.

Chủ đề liên quan

Cài đặt loại thu phóng

Kết nối bộ điều khiển ống kính

Điều chỉnh thu phóng bằng bộ điều khiển ống kính

5-041-959-03(1) Copyright 2022 Sony Corporation

Nhấn nút thu phóng để điều chỉnh thu phóng.

Nhấn nút T (Chụp xa) hoặc W (Rộng) trong khi theo dõi màn hình để điều chỉnh thu phóng.
Để phóng to, nhấn nút T.
Để thu vào, nhấn nút W.

1
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Hiệu chuẩn ống kính ngàm E

Chức năng chỉnh sửa các chênh lệch về vị trí thu phóng do sự khác biệt trong các ống kính riêng lẻ khi sử dụng ống kính
thu phóng công suất lớn ngàm E.
Để tính toán chính xác vị trí thu phóng, hiệu chuẩn ống kính của bạn để sửa các chênh lệch riêng lẻ trên ống kính bằng
cách áp dụng quy trình sau đây.

Dữ liệu hiệu chuẩn
Dữ liệu hiệu chuẩn cho tối đa năm ống kính có thể được lưu trong thiết bị. Dữ liệu cũ nhất sẽ bị ghi đè khi hiệu chỉnh
đến ống kính thứ 6 hoặc tiếp theo đó.
Bạn có thể kiểm tra xem dữ liệu hiệu chuẩn có khả dụng đối với ống kính đi kèm hay không bằng cách nhấn nút 
(Trạng thái máy quay) trong khu vực chung của màn hình Ứng dụng web rồi chọn [Lens] > [Calibration Data].

5-041-959-03(1) Copyright 2022 Sony Corporation

Nếu ống kính có nút chuyển SERVO/MANUAL, hãy chuyển sang vị trí SERVO.

Chú ý

Ống kính sẽ không thể nhận các hướng dẫn thu phóng từ thiết bị nếu nút chuyển được đặt thành MANUAL.

1

Chạy hiệu chuẩn bằng cách sử dụng [Technical] > [Lens] > [Lens Calibration] trong menu camera.

Trong quá trình hiệu chuẩn, ống kính thu phóng di chuyển tự động và được đo.

2
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lưu/khôi phục cài đặt xoay/nghiêng, vị trí thu phóng và lấy nét bằng Ứng dụng web

Bạn có thể lưu cài đặt xoay/nghiêng, vị trí thu phóng và lấy nét rồi sau đó gọi lại chúng khi cần thiết bằng Ứng dụng web
(chức năng vị trí đặt trước).

Để biết thêm thông tin chi tiết về các mục có thể được lưu/khôi phục, hãy tham khảo “Mục đã lưu vị trí đặt trước.”

Chú ý

Không thể lưu vị trí đặt trước nếu tỷ lệ Thu phóng chất lượng cao đang quá 1×.

Nếu cài đặt [Pan-Tilt] > [P/T Direction] > [Ceiling] trong menu web thay đổi, tất cả các vị trí đặt trước đã lưu đều bị xóa.

Đặt chế độ hỗ trợ PTZ thành [Pos.] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

1

Xác định vị trí mà bạn muốn lưu bằng cách sử dụng các thao tác xoay/nghiêng và thu phóng.2

Ấn nút [+] trong bảng điều khiển vị trí đặt trước.

Hình ảnh có vị trí đã lưu được hiển thị trong bảng điều khiển vị trí đặt trước.

Gợi ý

Nếu bảng điều khiển vị trí đặt trước không hiển thị, ấn nút  (Mở) để nó hiển thị.

Các vị trí được lưu theo thứ tự từ [Preset1].

Nếu trong một chuỗi các giá trị đặt trước có các giá trị đặt trước chưa sử dụng, các vị trí sẽ được lưu trong các giá trị đặt
trước bắt đầu từ các giá trị đặt trước chưa sử dụng. Ví dụ: nếu các vị trí đặt trước được lưu trong [Preset1] và [Preset3]
nhưng không được lưu trong [Preset2], các vị trí đặt trước tiếp theo sẽ được lưu trong [Preset2] và sau đó là trong
[Preset4].

3
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Hủy thao tác khôi phục vị trí đặt trước
Nhấn nút  (Hủy khôi phục) hiển thị trên bảng điều khiển vị trí đặt trước trong quá trình khôi phục vị trí đặt trước để hủy
thao tác khôi phục. Sử dụng cần điều khiển và thanh trượt [Zoom] để điều chỉnh khung.

Có thể lưu đến 100 vị trí đặt trước.

Bạn có thể đổi tên mỗi vị trí đặt trước. Để biết thêm thông tin chi tiết, hãy tham khảo “Đổi tên vị trí đặt trước bằng Ứng dụng
web”.

Khôi phục vị trí đã lưu.

Ấn hai lần vào hình ảnh thu nhỏ vị trí mà bạn muốn khôi phục trong bảng điều khiển vị trí đặt trước để khôi phục vị
trí tương ứng.

Gợi ý

Bạn cũng có thể khôi phục vị trí bằng cách ấn vào hình ảnh, ấn vào nút  (Menu vị trí đặt trước) xuất hiện và chọn
[Recall].

Tốc độ chuyển đổi sang vị trí đã lưu được xác định bằng cài đặt [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt Speed for
Common] trong menu web khi vị trí được lưu. Bạn cũng có thể thay đổi tốc độ chuyển đổi sau khi lưu. Để biết thêm chi tiết,
hãy tham khảo “Thay đổi tốc độ chuyển đổi (xoay-nghiêng/thu phóng/lấy nét) khi khôi phục các vị trí đặt trước”.

Có thể điều chỉnh mức độ thay đổi trong vị trí xoay/nghiêng khi di chuyển đến vị trí đặt trước bằng cách sử dụng cài đặt tốc
độ chuyển tiếp và [Ramp Curve]. Để biết thêm chi tiết, hãy tham khảo “Thay đổi tốc độ chuyển đổi (xoay-nghiêng/thu
phóng/lấy nét) khi khôi phục các vị trí đặt trước” và “Cài đặt gia tốc vận hành xoay/nghiêng”.

Nếu gọi lại cài đặt trước khác trong khi đang phát lại cài đặt trước, hoạt động của cài đặt trước được gọi lại đầu tiên sẽ
dừng và hoạt động của cài đặt trước được gọi lại sau đó sẽ bắt đầu.

Chú ý

Nếu nhiệt độ của môi trường thay đổi đáng kể giữa thời điểm lưu vị trí đặt trước và thời điểm vị trí đó được phát lại thì có
thể xảy ra sai lệch trong khung hình.

Khi vị trí đặt trước đang được khôi phục, bạn không thể thực hiện bất kỳ thao tác nào khác ngoài việc khôi phục hoặc hủy
vị trí đặt trước.

4
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Chủ đề liên quan
Mục đã lưu vị trí đặt trước

Đổi tên vị trí đặt trước bằng Ứng dụng Web

Thay đổi tốc độ chuyển đổi (xoay-nghiêng/thu phóng/lấy nét) khi khôi phục các vị trí đặt trước

Cài đặt gia tốc vận hành xoay/nghiêng

5-041-959-03(1) Copyright 2022 Sony Corporation
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Đổi tên vị trí đặt trước bằng Ứng dụng Web

Bạn có thể đổi tên các vị trí đặt trước đã lưu.

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt chế độ hỗ trợ PTZ thành [Pos.] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

1

Ấn vào vị trí đặt trước mà bạn muốn đổi tên.

Nút  (Menu vị trí đặt trước) xuất hiện ở góc trên bên phải của hình ảnh.

2

Ấn vào nút  (Menu vị trí đặt trước) và chọn [Rename] từ menu hiển thị.3

Nhập tên đặt trước mới.4
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Thay thế vị trí đặt trước đã lưu bằng một vị trí mới bằng Ứng dụng Web

Bạn có thể thay thế vị trí đặt trước đã lưu bằng một vị trí mới.

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt chế độ hỗ trợ PTZ thành [Pos.] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

1

Xác định vị trí mà bạn muốn lưu bằng cách sử dụng các thao tác xoay/nghiêng và thu phóng.2

Ấn vào hình ảnh vị trí mà bạn muốn thay thế trong bảng điều khiển vị trí đặt trước.

Nút  (Menu vị trí đặt trước) xuất hiện ở góc trên bên phải của hình ảnh.

3

Ấn vào nút  (Menu vị trí đặt trước) và chọn [Replace] từ menu hiển thị.

Vị trí mới thay thế cài đặt hiện tại.

4
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Xóa vị trí đặt trước đã lưu bằng Ứng dụng Web

Bạn có thể xóa các vị trí đặt trước đã lưu.

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt chế độ hỗ trợ PTZ thành [Pos.] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

1

Ấn vào hình ảnh vị trí mà bạn muốn xóa trong bảng điều khiển vị trí đặt trước.

Nút  (Menu vị trí đặt trước) xuất hiện ở góc trên bên phải của hình ảnh.

2

Ấn vào nút  (Menu vị trí đặt trước) và chọn [Delete] từ menu hiển thị.

Vị trí đã lưu đã bị xóa.

3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Đồng bộ vận hành xoay/nghiêng và vận hành thu phóng/lấy nét khi khôi phục vị trí
đặt trước

Bạn có thể đồng bộ vận hành xoay/nghiêng và vận hành thu phóng/lấy nét khi khôi phục vị trí đặt trước để khung mượt
mà hơn.

Gợi ý

Bạn có thể chỉ định trước các cài đặt được sử dụng để đăng ký vị trí đặt trước. Đặt [Pan-Tilt] > [P/T Preset] > [Default] > [Zoom
Sync] thành [On] trong menu web.

Khi [Pan-Tilt] > [P/T Preset] > [Speed Select] được đặt thành [Common], tất cả vị trí đặt trước sẽ được khôi phục với tốc độ được
đặt bằng cách sử dụng [Pan-Tilt] > [P/T Preset] > [Common Speed].

Sau khi hoàn tất chuyển động thu phóng, máy quay sẽ di chuyển đến vị trí lấy nét đã lưu.

Sau khi hoàn tất chuyển động, [AF Transition Speed] trở lại cài đặt ban đầu.

Đặt chế độ hỗ trợ PTZ thành [Pos.] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

1

Ấn vào hình ảnh cho vị trí đặt trước mà bạn muốn thay đổi tốc độ chuyển đổi.

Nút  (Menu vị trí đặt trước) xuất hiện ở góc trên bên phải của hình ảnh.

2

Ấn vào nút  (Menu vị trí đặt trước) và chọn [Edit…] từ menu hiển thị.

Màn hình thiết lập cho vị trí đặt trước đã chọn xuất hiện.

3

Trượt công tắc [Zoom Sync] sang bên phải để bật chức năng này và ấn nút [OK].

Lần tiếp theo khi vị trí đã lưu được khôi phục, máy quay sẽ không di chuyển với tốc độ đã cấu hình.

4
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Thay đổi tốc độ chuyển đổi (xoay-nghiêng/thu phóng/lấy nét) khi khôi phục các vị trí
đặt trước

Bạn có thể thay đổi tốc độ chuyển đổi (vận hành xoay/nghiêng và vận hành thu phóng, lấy nét) khi khôi phục vị trí đặt
trước đã lưu.

Gợi ý

Khi [Pan-Tilt] > [P/T Preset] > [Speed Select] được đặt thành [Common], tất cả vị trí sẽ được khôi phục với tốc độ đã đặt bằng
cách sử dụng [Pan-Tilt] > [P/T Preset] > [Common Speed].

Sau khi hoàn tất chuyển động thu phóng, máy quay sẽ di chuyển đến vị trí lấy nét đã lưu.

Sau khi hoàn tất chuyển động, [AF Transition Speed] trở lại cài đặt ban đầu.

Đặt [Pan-Tilt] > [P/T Preset] > [Speed Select] thành [Separate] trong menu web.1

Đặt chế độ hỗ trợ PTZ thành [Pos.] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

2

Ấn vào hình ảnh cho vị trí đặt trước mà bạn muốn thay đổi tốc độ chuyển đổi.

Nút  (Menu vị trí đặt trước) xuất hiện ở góc trên bên phải của hình ảnh.

3

Ấn vào nút  (Menu vị trí đặt trước) và chọn [Edit…] từ menu hiển thị.

Màn hình thiết lập cho vị trí đặt trước đã chọn xuất hiện.

4

Đặt tốc độ chuyển đổi (xoay-nghiêng/thu phóng/lấy nét) mà bạn muốn thay đổi bằng cách sử dụng thanh
trượt hoặc nhập trực tiếp các giá trị và nhấn nút [OK].

Lần tiếp theo khi vị trí đã lưu được khôi phục, máy quay sẽ không di chuyển với tốc độ đã cấu hình.

5
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lưu/khôi phục cài đặt xoay/nghiên và vị trí thu phóng bằng điều khiển hồng ngoại từ
xa đi kèm

Bạn có thể lưu cài đặt xoay/nghiêng và vị trí thu phóng và gọi lại chúng khi được yêu cầu bằng điều khiển hồng ngoại từ
xa đi kèm.

Chủ đề liên quan

Thay đổi tốc độ chuyển đổi (xoay-nghiêng/thu phóng/lấy nét) khi khôi phục các vị trí đặt trước

Điều chỉnh xoay/nghiêng và thu phóng của máy quay.1

Đặt chế độ hỗ trợ PTZ thành [Pos.] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước trong Ứng dụng Web.

2

Nhấn và giữ nút PRESET và nhấn một trong các nút từ 1 đến 3.

Vị trí đã được lưu.

3

Khôi phục vị trí đã lưu.

Nhấn một trong các nút từ 1 đến 3 để khôi phục vị trí đã đặt trước đó.

Gợi ý

Tốc độ chuyển đổi khi khôi phục vị trí đặt trước được xác định bởi giá trị [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed] đã lưu
trong menu web. Bạn có thể thay đổi tốc độ chuyển đổi sau khi lưu giá trị. Để biết thêm chi tiết, hãy tham khảo “Thay đổi
tốc độ chuyển đổi (xoay-nghiêng/thu phóng/lấy nét) khi khôi phục các vị trí đặt trước”.

4
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Ghi lại thao tác định khung máy quay bằng Ứng dụng Web

Bạn có thể ghi lại thao tác định khung máy quay bằng Ứng dụng Web.

Điều chỉnh vị trí bắt đầu vận hành của máy quay.1

Đặt chế độ hỗ trợ PTZ thành [Trace] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

2

Ấn nút [+] trong bảng điều khiển vị trí đặt trước.

Hình ảnh thu nhỏ được thêm vào và máy quay chuyển sang trạng thái chờ ghi.

Gợi ý

Bạn có thể ấn nút  (Đóng) trên hình ảnh thu nhỏ để thoát trạng thái chờ ghi và trở về vận hành bình thường.

3
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Gợi ý

Thời gian ghi còn lại được hiển thị ở đầu bảng điều khiển hình ảnh của máy quay trong khi ghi.

Chú ý

Thao tác định khung đã ghi sẽ bị xóa nếu bạn chuyển sang giá treo trên trần

Việc chuyển đổi tần số hệ thống có thể xóa thao tác định khung đã ghi.

Thao tác thu phóng không được ghi lại khi bộ điều khiển ống kính được kết nối.

Thời lượng tối đa để ghi lại một thao tác định khung là 3 phút. Quá trình ghi sẽ tự động dừng khi thời lượng ghi đạt 3 phút.

Không thể bắt đầu ghi thao tác định khung nếu tỷ lệ Thu phóng chất lượng cao lớn hơn 1×.

Nếu máy quay được vận hành từ một thiết bị khác trong khi đang ghi lại thao tác định khung thì các thao tác từ thiết bị kia cũng
sẽ được ghi lại. Để biết thêm chi tiết về thao tác ghi bằng bộ điều khiển từ xa của bên thứ ba, hãy liên hệ với nhà sản xuất tương
ứng.

Chức năng này không ghi lại các cài đặt về lấy nét và chất lượng hình ảnh.

Không thể tái tạo chính xác các thao tác xoay/nghiêng/thu phóng được ghi khi ghi lại thao tác định khung trong khi phát lại định
khung.

Nếu sau khi ghi lại thao tác định khung, bạn đặt giới hạn phạm vi xoay/nghiêng bằng cách sử dụng [Pan-Tilt] > [P/T Range Limit]
trong menu web, giới hạn xoay/nghiêng sẽ không thể được áp dụng trong quá trình phát lại định khung. Nếu bạn muốn sử dụng
thao tác định khung và chức năng giới hạn xoay/nghiêng cùng nhau, hãy đặt giới hạn phạm vi xoay/nghiêng trước khi ghi lại thao
tác định khung.

Khởi động thao tác định khung bằng cần điều khiển và thanh trượt [Zoom].

Hoạt động ghi bắt đầu ngay khi thao tác định khung chạy.

4

Nhấn nút  (Dừng ghi) trên màn hình thu nhỏ để kết thúc.5
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Không thể phát lại các thao tác tạo định khung đã ghi khi chọn đầu ra video RAW.

Không thể phát lại các thao tác định khung đã ghi khi tín hiệu video không được xuất ra từ đầu nối đầu ra SDI.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Phát thao tác định khung máy quay bằng Ứng dụng Web

Bạn có thể phát thao tác định khung máy quay bằng Ứng dụng Web.

Đặt chế độ hỗ trợ PTZ thành [Trace] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

1

Chọn hình ảnh thu nhỏ có thao tác định khung mà bạn muốn phát.

Nút  (Chuẩn bị) xuất hiện trên màn hình thu nhỏ.

2

Ấn nút  (Chuẩn bị).

Máy quay di chuyển đến vị trí bắt đầu thao tác định khung và chuyển sang trạng thái chờ phát lại.

3

Ấn nút  (Phát) trên màn hình thu nhỏ.4
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Gợi ý

Ở trạng thái chờ phát lại và trong khi phát lại, bạn có thể hủy phát lại và trở lại vận hành bình thường bằng cách thực hiện bất kỳ
thao tác nào sau đây.

Ấn nút  (Dừng) trên màn hình thu nhỏ hoặc trong bảng điều khiển vị trí đặt trước.
Vận hành cần điều khiển.
Vận hành thanh trượt [Zoom].

Thời gian phát lại đã trôi qua được hiển thị ở đầu bảng điều khiển hình ảnh của máy quay trong quá trình phát lại.

Chú ý

Hành vi không mong muốn có thể xảy ra nếu cài đặt Thu phóng chất lượng cao khác nhau giữa hoạt động ghi và phát lại các
thao tác định khung.

Không hỗ trợ việc phát lại thao tác thu phóng khi kết nối bộ điều khiển ống kính. Thao tác thu phóng sẽ ngừng phát lại các thao
tác định khung.

Trong khi phát lại thao tác định khung, việc thay đổi giới hạn phạm vi xoay/nghiêng bằng cách sử dụng [Pan-Tilt] > [P/T Range
Limit] trong menu web không có hiệu lực. Đặt giới hạn phạm vi xoay/nghiêng trước khi ghi lại thao tác định khung.

5-041-959-03(1) Copyright 2022 Sony Corporation

Phát lại định khung bắt đầu chạy.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Xóa thao tác định khung máy quay đã ghi bằng Ứng dụng Web

Bạn có thể xóa thao tác định khung máy quay đã ghi bằng Ứng dụng Web.

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt chế độ hỗ trợ PTZ thành [Trace] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

1

Chọn hình ảnh thu nhỏ có thao tác định khung mà bạn muốn xóa.

Nút  (Menu kéo) xuất hiện trên màn hình thu nhỏ.

2

Ấn nút  (Menu kéo).

Menu xuất hiện.

3

Chọn [Delete] từ menu hiển thị.

Thao tác định khung đã chọn bị xóa.

4
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ghi lại thao tác định khung máy quay bằng điều khiển từ xa hồng ngoại đi kèm

Bạn có thể ghi lại thao tác định khung máy quay bằng điều khiển hồng ngoại từ xa đi kèm.

Để biết thêm chi tiết về phát thao tác định khung đã ghi, hãy tham khảo “Phát thao tác định khung máy quay bằng điều
khiển từ xa hồng ngoại đi kèm”.

Chú ý

Thời lượng tối đa để ghi lại một thao tác định khung là 3 phút. Quá trình ghi sẽ tự động dừng khi thời lượng ghi đạt 3 phút.

Nếu máy quay được vận hành từ một thiết bị khác trong khi đang ghi lại thao tác định khung thì các thao tác từ thiết bị kia cũng
sẽ được ghi lại như một phần của thao tác định khung.

Nếu chất lượng hình ảnh được điều chỉnh trong khi ghi lại thao tác định khung, thay đổi đó sẽ không được ghi lại.

Chủ đề liên quan

Phát thao tác định khung máy quay bằng điều khiển từ xa hồng ngoại đi kèm

5-041-959-03(1) Copyright 2022 Sony Corporation

Truy cập màn hình vận hành trực tiếp của Ứng dụng Web.1

Đặt chế độ hỗ trợ PTZ thành [Trace] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

2

Điều chỉnh vị trí bắt đầu vận hành của máy quay bằng điều khiển hồng ngoại từ xa.3

Nhấn và giữ nút PRESET và nhấn một trong các nút POSITION từ 1 đến 3.

Máy quay chuyển sang trạng thái chờ ghi.

4

Thực hiện thao tác định khung mà bạn muốn ghi.5

Để dừng ghi, ấn và giữ nút PRESET và ấn nút POSITION đã chọn ở bước 4.6
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Phát thao tác định khung máy quay bằng điều khiển từ xa hồng ngoại đi kèm

Bạn có thể phát thao tác định khung máy quay bằng điều khiển hồng ngoại từ xa đi kèm.

Chú ý

Vận hành xoay/nghiêng/thu phóng của máy quay sẽ dừng phát lại.

Chủ đề liên quan

Ghi lại thao tác định khung máy quay bằng điều khiển từ xa hồng ngoại đi kèm
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Truy cập màn hình vận hành trực tiếp của Ứng dụng Web.1

Đặt chế độ hỗ trợ PTZ thành [Trace] trong danh sách thả xuống ở hàng trên của bảng điều khiển vị trí đặt
trước.

2

Chọn và ấn một trong các nút POSITION từ 1 đến 3 để chọn thao tác định khung đã ghi.

Chức năng xoay/nghiêng/thu phóng của máy quay chuyển sang vị trí bắt đầu phát lại.

3

Sau khi máy quay di chuyển đến vị trí bắt đầu phát lại, ấn nút POSITION đã chọn lần nữa.

Bắt đầu phát lại.

4
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Interchangeable Lens Digital Camera
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Màn hình điều chỉnh tiêu điểm

Tiêu điểm được điều chỉnh bằng cách sử dụng các phần sau của màn hình hoạt động trực tiếp.
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Bảng điều khiển hình ảnh máy quay
Bạn có thể điều chỉnh tiêu điểm bằng cách chạm vào hình ảnh camera. Bạn có thể tắt vận hành cảm ứng trong Ứng
dụng Web bằng cách tắt công tắc [Touch Focus] trên thẻ  (Focus) trong bảng điều khiển camera.

1.

Bảng điều khiển máy quay – thẻ  (Focus)2.

Bảng điều khiển GUI3.
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Interchangeable Lens Digital Camera
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Điều chỉnh thủ công bằng cách sử dụng ứng dụng web

Bạn có thể điều chỉnh lấy nét thủ công, chẳng hạn như trong các trường hợp dưới đây.

Đối tượng bị che khuất một phần bởi các giọt nước
Đối tượng có độ tương phản thấp đối với nền phía sau
Đối tượng ở xa hơn đối tượng ở gần

Chú ý

Không thể điều khiển lấy nét thủ công từ Ứng dụng web trong khi đang thực hiện thao tác thu phóng.

Gợi ý

Bạn cũng có thể sử dụng lấy nét tự động khi điều chỉnh thủ công là phương pháp vận hành chính. Để biết thêm thông tin chi tiết,
hãy tham khảo “Cài đặt mục tiêu lấy nét thủ công (AF Assist) bằng Ứng dụng web.”

Chủ đề liên quan

Kiểm tra công tắc ống kính

Cài đặt mục tiêu lấy nét thủ công (AF Assist) bằng Ứng dụng web
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Nếu ống kính phù hợp với công tắc bộ chọn tiêu điểm, đưa công tắc này về vị trí “AF/MF” hoặc “AF”.

Chú ý

Nếu đưa nút chuyển về vị trí “Full MF” hoặc “MF” thì không thể thực hiện lấy nét ống kính trên thiết bị. Tham khảo “Đối với
ống kính có công tắc chế độ lấy nét” trong “Kiểm tra công tắc ống kính.”

1

Trượt nút chuyển [Auto Focus] sang trái trên bảng điều khiển máy quay để tắt lấy nét tự động.

Chế độ lấy nét thủ công được kích hoạt.

 (MF)

2

Điều chỉnh bằng cách dùng thanh trượt ở phía dưới của thẻ  (Focus).3
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Interchangeable Lens Digital Camera
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Điều chỉnh thủ công bằng điều khiển từ xa hồng ngoại đi kèm

Bạn có thể điều chỉnh lấy nét thủ công bằng điều khiển từ xa hồng ngoại đi kèm.

Gợi ý

Bạn cũng có thể sử dụng lấy nét tự động khi điều chỉnh thủ công là phương pháp vận hành chính. Để biết thêm thông tin chi tiết,
hãy tham khảo “Lấy nét thủ công trong khi lấy nét tự động bằng điều khiển hồng ngoại từ xa đi kèm.”

Chủ đề liên quan

Lấy nét thủ công trong khi lấy nét tự động bằng điều khiển hồng ngoại từ xa đi kèm
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Nhấn nút MF trên điều khiển từ xa hồng ngoại.1

Điều chỉnh lấy nét thủ công bằng nút F (Xa) và nút N (Gần).

Để lấy nét cho vật thể ở xa, nhấn nút F.
Để lấy nét cho vật thể ở gần, nhấn nút N.

2
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Lấy nét bằng cách chỉ định vị trí lấy nét (Spot Focus)

Ở chế độ lấy nét thủ công, bạn có thể chỉ định vị trí mà mình muốn điều chỉnh lấy nét bằng bảng điều khiển hình ảnh
máy quay.

Chú ý

Chức năng lấy nét điểm sẽ không hoạt động nếu ống kính được cài đặt lấy nét thủ công.

Gợi ý

Ở chế độ lấy nét điểm, bạn có thể nhấn nút có thể gán đã được gán với tính năng [Push AF/MF] để tạm thời dừng hoạt động lấy
nét điểm và bật lấy nét tự động trong khi nhấn nút này. Tính năng lấy nét quay trở về chế độ lấy nét thủ công khi bạn thả nút này
ra.

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt [Shooting] > [Focus] > [Touch Function in MF] thành [Spot Focus] trong menu web hoặc menu camera.1

Trượt nút chuyển [Touch Focus] trên thẻ  (Focus) sang bên phải để bật.2

Trượt nút chuyển [Auto Focus] trên thẻ  (Focus) sang bên trái để tắt.3

Chỉ định vị trí lấy nét.

Điểm đánh dấu tiêu điểm xuất hiện và hình ảnh được điều chỉnh để lấy nét tại vị trí đó.

Ví dụ về việc chỉ định vị trí bằng vận hành cảm ứng

4
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Sử dụng lấy nét tự động tạm thời (Push Auto Focus (AF))

Khi ở trong chế độ lấy nét thủ công, bạn có thể điều chỉnh lấy nét tạm thời bằng lấy nét tự động bằng cách ấn và giữ
[Push AF/MF] để lấy nét tạm thời.
Cài đặt như thế này rất hữu dụng khi bạn muốn di chuyển từ từ tiêu điểm từ đối tượng này sang một đối tượng khác
trong khi lấy nét thủ công.

Chú ý

Chức năng lấy nét tự động đẩy không hoạt động nếu ống kính được cài đặt để lấy nét thủ công.

Gợi ý

Hoạt động tương tự được hỗ trợ bằng cách sử dụng nút có thể gán đã được gán với tính năng [Push AF/MF].

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt [Shooting] > [Focus] > [Push AF Mode] thành [AF] trong menu camera.1

Trượt nút chuyển [Auto Focus] trên thẻ  (Focus) sang bên trái để tắt.2

Ấn nút [Push AF/MF].

Chế độ lấy nét tự động sẽ hoạt động khi nhấn nút này.

Tính năng lấy nét đẩy được thả và quay trở về chế độ lấy nét thủ công khi bạn thả nút này ra.

3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sử dụng tính năng lấy nét tự động trong một lần chụp (Push Auto Focus (AF-S))

Bạn có thể ấn nút [Push AF/MF] khi ở chế độ lấy nét thủ công để lấy nét tự động ở tốc độ cao.
Chức năng này rất tiện lợi khi bạn lấy nét vào một đối tượng trước khi chụp.

Chú ý

Chức năng lấy nét tự động đẩy không hoạt động nếu ống kính được cài đặt để lấy nét thủ công.

Phạm vi của khu vực lấy nét không bị ẩn khi sử dụng nút [Display].

Đặt [Shooting] > [Focus] > [Push AF Mode] thành [Single-shot AF(AF-S)] trong menu web hoặc menu
camera.

1

Chỉ định vị trí bạn muốn điều chỉnh tiêu điểm bằng cách sử dụng [Shooting] > [Focus] > [Focus Area (AF-
S)] trong menu camera.

Gợi ý

Bạn có thể thay đổi vị trí bằng cách nhấn một nút có thể gán được gán với [Focus Setting] để hiển thị khung màu cam xung
quanh vùng lấy nét và chọn vị trí bằng vận hành cảm ứng.

2

Trượt nút chuyển [Auto Focus] trên thẻ  (Focus) sang bên trái để tắt.3

Ấn nút [Push AF/MF].

Nếu bạn nhả nút trước khi quá trình lấy nét kết thúc, quá trình lấy nét tự động đẩy sẽ dừng lại.

Trong khi lấy nét tự động đẩy, trạng thái lấy nét được hiển thị bằng chỉ báo lấy nét.
Bật: Tiêu điểm được cố định tại vị trí lấy nét.
Nhấp nháy: bị mờ nét. Vì quá trình lấy nét không phải là lấy nét tự động, hãy thay đổi cài đặt bố cục và tiêu điểm
để lấy nét.
Tính năng lấy nét quay trở về chế độ lấy nét thủ công khi bạn thả nút này ra.

4
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Trong khi vận hành Clear Image Zoom, không thể đặt vị trí khung hình [Focus Area (AF-S)]. Trong khi vận hành lấy nét tự động
đẩy, vận hành AF cũng ưu tiên cho phần trung tâm.

Gợi ý

Hoạt động tương tự được hỗ trợ bằng cách sử dụng nút có thể gán đã được gán với tính năng [Push AF/MF].

Bạn cũng có thể gán chức năng [Push AF Mode] cho nút có thể gán.

Bạn cũng có thể gán chức năng [Focus Area (AF-S)] cho nút có thể gán.

Bạn có thể hiển thị/ẩn phạm vi của khu vực lấy nét bằng cách sử dụng [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)]
trong menu camera.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh tự động bằng cách sử dụng Ứng dụng web

Thiết bị sử dụng tính năng lấy nét tự động phát hiện pha để lấy nét tốc độ cao và lấy nét tự động tương phản để lấy nét
độ chính xác cao.
Kết hợp hai phương thức lấy nét tự động này cho phép lấy nét tự động theo cả 2 cách là tốc độ cao và độ chính xác
cao.

Chú ý

Bắt buộc phải có ống kính có hỗ trợ tính năng lấy nét tự động.

Tùy theo điều kiện ghi hình mà có thể không đạt được sự chính xác.

Trên ống kính ngàm A, có thể không điều chỉnh được lấy nét tự động.

Gợi ý

Trong chế độ lấy nét tự động, bạn có thể điều chỉnh lấy nét bằng cách sử dụng thanh trượt Focus trong bảng điều khiển máy
quay. Để biết thêm thông tin chi tiết, hãy tham khảo “Cài đặt mục tiêu lấy nét thủ công (AF Assist) bằng Ứng dụng web.”

Chủ đề liên quan
Kiểm tra công tắc ống kính

Cài đặt mục tiêu lấy nét thủ công (AF Assist) bằng Ứng dụng web

5-041-959-03(1) Copyright 2022 Sony Corporation

Nếu ống kính phù hợp với công tắc bộ chọn tiêu điểm, đưa công tắc này về vị trí “AF/MF” hoặc “AF”.

Chú ý

Nếu đưa nút chuyển về vị trí “Full MF” hoặc “MF” thì không thể thực hiện lấy nét ống kính trên thiết bị. Tham khảo “Đối với
ống kính có công tắc chế độ lấy nét” trong “Kiểm tra công tắc ống kính.”

1

Trượt nút chuyển [Auto Focus] sang phải trong bảng điều khiển máy quay để bật lấy nét tự động.

Chế độ lấy nét tự động được kích hoạt.

 (AF)

2
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh tự động bằng điều khiển hồng ngoại từ xa đi kèm

Bạn có thể điều chỉnh tiêu điểm tự động bằng điều khiển hồng ngoại từ xa đi kèm.

Chú ý

Bạn cũng có thể sử dụng lấy nét tự động khi điều chỉnh thủ công là phương pháp vận hành chính. Để biết thêm thông tin chi tiết,
hãy tham khảo “Lấy nét thủ công trong khi lấy nét tự động bằng điều khiển hồng ngoại từ xa đi kèm.”

Chủ đề liên quan
Lấy nét thủ công trong khi lấy nét tự động bằng điều khiển hồng ngoại từ xa đi kèm

5-041-959-03(1) Copyright 2022 Sony Corporation

Nhấn nút AF trên điều khiển hồng ngoại từ xa.

Tiêu điểm trên một đối tượng được điều chỉnh tự động.

1
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cài đặt khu vực/vị trí lấy nét tự động (Focus Area)

Bạn có thể đặt khu vực mục tiêu để lấy nét tự động và điều chỉnh tiêu điểm cho khu vực đó.

Ấn nút [Menu] trong bảng điều khiển GUI để mở menu camera.1

Đặt khu vực mục tiêu để lấy nét tự động bằng cách sử dụng [Shooting] > [Focus] > [Focus Area] trong
menu camera.

[Wide]:
Tìm kiếm đối tượng theo một góc rộng nào đó của hình ảnh khi lấy nét. Không hiển thị khung hình.

[Zone]:
Tìm kiếm tự động vị trí lấy nét trong phạm vi vùng vụ thể nào đó.
Sau khi chọn, hãy chỉ rõ vị trí này bằng cách sử dụng các nút mũi tên trong bảng điều khiển GUI.

Bạn có thể quay trở về vị trí trung tâm bằng cách ấn và giữ nút [Set].
[Flexible Spot]:
Tập trung vào một vị trí cụ thể nào đó của hình ảnh.

2
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Chú ý

Phạm vi của khu vực lấy nét không bị ẩn khi sử dụng nút [Display] trong bảng điều khiển hình ảnh máy quay.

Trong khi vận hành Thu phóng chất lượng cao, khu vực lấy nét được đặt thành [Wide] (cố định).

Gợi ý

Bạn có thể hiển thị/ẩn phạm vi của khu vực lấy nét bằng cách sử dụng [Monitoring] > [Display On/Off] > [Focus Area Indicator]
trong menu camera.

5-041-959-03(1) Copyright 2022 Sony Corporation

Sau khi chọn, hãy chỉ rõ vị trí này bằng cách sử dụng các nút mũi tên trong bảng điều khiển GUI.

Bạn có thể quay trở về vị trí trung tâm bằng cách ấn và giữ nút [Set].
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Thay đổi nhanh khu vực lấy nét (Focus Setting)

Bạn có thể thay đổi nhanh vị trí và kích thước của khu vực lấy nét tự động trong khi ghi hình bằng cách gán chức năng
[Focus Setting] cho nút có thể gán.

Để biết thêm thông tin chi tiết về nút có thể gán, hãy tham khảo “Nút có thể gán.”

Hoạt động này thay đổi tùy thuộc vào cài đặt khu vực lấy nét.

Khi [Shooting] > [Focus] > [Focus Area] được đặt thành [Flexible Spot] hoặc [Zone] trong
menu camera

Bạn có thể thay đổi vị trí của khu vực lấy nét bằng cách ấn nút có thể gán đã được gán với tính năng [Focus Setting]
và điều chỉnh bằng cách sử dụng các nút mũi tên trong bảng điều khiển GUI. Bạn có thể làm cho vị trí của khu vực
lấy nét quay trở lại trung tâm trong khi điều chỉnh vị trí bằng cách ấn nút [Set].
Bạn có thể thay đổi kích thước của khu vực lấy nét bằng cách ấn và giữ nút có thể gán đã được gán với tính năng
[Focus Setting]. Sau khi thay đổi kích thước, bạn có thể thay đổi vị trí của khu vực lấy nét bằng cách ấn nút [Set]. Khi
hoàn thành, ấn nút có thể gán đã được gán với tính năng [Focus Setting] để quay trở về màn hình ban đầu.

Khi [Shooting] > [Focus] > [Focus Area] được đặt thành [Wide] trong menu camera

Bạn chỉ có thể thay đổi kích thước của khu vực lấy nét bằng cách ấn và giữ nút có thể gán đã được gán với tính năng
[Focus Setting]. Có thể thay đổi vị trí bằng cách thay đổi loại thành [Flexible Spot] hoặc [Zone] trước tiên.

Gợi ý

Khi cả hai tính năng [Shooting] > [Focus] > [Push AF Mode] được đặt thành [Single-shot AF(AF-S)] trong menu camera và nút
chuyển [Auto Focus] được gạt sang vị trí tắt (chế độ lấy nét thủ công), bạn có thể thay đổi vị trí khu vực lấy nét [Focus Area (AF-
S)].

Phạm vi của khu vực lấy nét được hiển thị là màu cam khi vị trí của khu vực lấy nét có thể thay đổi được.

Chủ đề liên quan

Nút có thể gán

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Di chuyển khung hình khu vực lấy nét bằng thao tác cảm ứng (Touch Focus Area)

Bạn có thể thay đổi vị trí của khu vực lấy nét bằng cách ấn nút có thể gán được gán với [Focus Setting] để thay đổi hiển
thị khu vực lấy nét thành màu cam, sau đó di chuyển khung hình khu vực lấy nét bằng vận hành cảm ứng trong bảng
điều khiển GUI.
Nhấn vào màn hình để di chuyển khu vực lấy nét, sau đó khu vực lấy nét sẽ có trung tâm là vị trí đã nhấn vào. Kéo trên
màn hình để di chuyển khu vực lấy nét đến vị trí mà ngón tay người dùng kéo đến.

Gợi ý

Bạn có thể bật/tắt khu vực lấy nét cảm ứng trên màn hình chụp bằng một nút có thể gán được gán với [Focus Setting].

Nhấn vào vị trí bất kỳ.

Vị trí được nhấn sẽ trở thành trung tâm của khu vực lấy nét.

1

Kéo để di chuyển khu vực lấy nét, lần theo vị trí ngón tay của bạn.2
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Chú ý

Nếu bạn nhấn vào vị trí hoặc kéo khu vực lấy nét đến vị trí vượt quá phạm vi cài đặt, khu vực lấy nét được đặt đến mép trên
cùng/dưới cùng/bên phải của phạm vi cài đặt.

Chức năng này chưa sử dụng được trong những hoàn cảnh sau.

Khi nút chuyển [Touch Focus] được tắt trong bảng điều khiển máy quay
Khi khung hình khu vực lấy nét được hiển thị là màu xám hoặc không hề hiển thị

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh hoạt động lấy nét tự động (tốc độ chuyển đổi lấy nét tự động, độ nhạy
chuyển đổi chủ thể khi lấy nét tự động)

Bạn có thể điều chỉnh hoạt động lấy nét tự động bằng cách thay đổi tốc độ chuyển đổi và độ nhạy chuyển đổi đối tượng.

Đặt tốc độ chuyển đổi AF

Bạn có thể cài đặt tốc độ của truyền động lấy nét cho thời điểm đối tượng thay đổi bằng cách sử dụng nút [AF Transition
Speed] trong bảng điều khiển máy quay.

Chọn tốc độ từ phạm vi [Speed 1] (Chậm) đến [Speed 7] (Nhanh) với gia số là 1. Nhấn nút < để giảm giá trị (chậm hơn)
hoặc nút > để tăng giá trị (nhanh hơn).
Khi đặt thành tốc độ thấp, tiêu điểm di chuyển chậm khi đối tượng cần được lấy nét thay đổi. Nhờ đó mà ghi được biểu
cảm hình ảnh ấn tượng.
Khi đặt thành tốc độ cao, tiêu điểm sẽ chuyển nhanh giữa các đối tượng. Trong ví dụ dưới đây, tiêu điểm thay đổi nhanh
chóng từ tòa nhà ở hậu cảnh sang người đang đi ở tiền cảnh. Đối tượng xuất hiện trong khung hình ngay lập tức được
lấy nét, vì vậy mà cài đặt như vậy khá lý tưởng đối với ghi hình phim tư liệu mà cần phải lấy nét nhanh.

Độ nhạy chuyển đổi đối tượng khi lấy nét tự động

Bạn có thể đặt độ nhạy để thay đổi giữa các chủ thể bằng [AF Subj. Shift Sens.] trong bảng điều khiển máy quay.
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Chọn độ nhạy từ phạm vi [Sens 1] (Đã khóa Bật) đến [Sens 5] (Phản ứng) với gia số là 1. Nhấn nút < để giảm giá trị
(thay đổi chậm) hoặc nút > để tăng giá trị (thay đổi nhanh).
Khi đặt thành độ nhạy thấp, tiêu điểm sẽ không dễ dàng thay đổi ngay cả khi đối tượng khác di chuyển trước đối tượng
được lấy nét.

Khi đặt thành độ nhạy cao, tiêu điểm sẽ chuyển đổi để ưu tiên cho đối tượng di chuyển phía trước.

Gợi ý

Nếu tính năng [AF Speed/Sens.] được gán cho một nút có thể gán nào đó, thì mỗi lần người sử dụng máy quay ấn nút đó, các
thanh mức độ để điều chỉnh các giá trị sẽ hiển thị trong bảng điều khiển hình ảnh máy quay theo thứ tự. Nhờ đó, người sử dụng
có thể thay đổi tốc độ chuyển đổi lấy nét tự động và cài đặt độ nhạy chuyển đổi đối tượng khi lấy nét tự động.
Tốc độ chuyển đổi khi lấy nét tự động → Độ nhạy chuyển đổi đối tượng khi lấy nét tự động → Không hiển thị …
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cài đặt mục tiêu lấy nét thủ công (AF Assist) bằng Ứng dụng web

Sau khi chuyển và điều chỉnh lấy nét thủ công, bạn có thể chuyển điều khiển lấy nét thành lấy nét tự động để điều chỉnh
lấy nét chính xác.

Chú ý

Trong trạng thái hỗ trợ lấy nét tự động, việc chuyển đổi lấy nét trở nên khó khăn bất kể cài đặt [Shooting] > [Focus] > [AF Subj.
Shift Sens.] trong menu camera.

Trạng thái hỗ trợ lấy nét tự động bị hủy trong các trường hợp sau.

Khi chủ thể được lấy nét bằng thanh trượt [Focus] không còn hiển thị nữa
Khi chuyển sang lấy nét thủ công
Khi lấy nét tự động theo dõi thời gian thực được khởi động

Gợi ý

Trạng thái hỗ trợ lấy nét tự động có thể được hủy nhanh chóng bằng cách sử dụng nút có thể gán đã được gán với tính năng
[Push AF/MF].

Lấy nét tự động theo dõi thời gian thực dừng khi vận hành thanh trượt [Focus].

Đặt [Shooting] > [Focus] > [AF Assist] thành [On] trong menu camera.1

Đặt [Shooting] > [Focus] > [AF Assist Control] thành [On] trong menu web.2

Trượt nút chuyển [Auto Focus] sang phải trong bảng điều khiển máy quay để bật lấy nét tự động.

Chế độ lấy nét tự động được kích hoạt.

3

Đặt lấy mục tiêu lấy nét tiêu bằng cách sử dụng thanh trượt [Focus] trong bảng điều khiển máy quay.

[Near]: Lấy nét chủ thể ở gần.
[Far]: Lấy nét chủ thể ở xa.

Trong trạng thái hỗ trợ lấy nét tự động, một vật thể ở xa được đặt với thanh trượt [Focus] sẽ được lấy nét tự động.

4
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Trong chế độ Face/Eye Only AF, lấy nét tự động tập trung vào khuôn mặt gần vị trí lấy nét nhất của thanh trượt [Focus].

5-041-959-03(1) Copyright 2022 Sony Corporation

187



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lấy nét thủ công trong khi lấy nét tự động bằng điều khiển hồng ngoại từ xa đi kèm

Khi [Shooting] > [Focus] > [AF Assist] được đặt thành [On] trong menu camera, bạn có thể sử dụng nút F (Xa) và N
(Gần) trên điều khiển hồng ngoại từ xa đi kèm ngay cả trong khi lấy nét tự động để điều chỉnh lấy nét vào một đối tượng.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sử dụng tạm thời tính năng lấy nét thủ công trong khi lấy nét tự động (Push Manual
Focus)

Ấn nút [Push AF/MF] khi ở chế độ lấy nét tự động để lấy nét thủ công trong khi đang ấn nút này. Tiêu điểm sẽ quay trở
về chế độ lấy nét tự động khi bạn thả nút này ra.
Nhờ đó, bạn có thể tạm thời dừng hoạt động lấy nét tự động và thực hiện lấy nét thủ công khi có gì đó không phải đối
tượng đang ghi hình đi ngang qua trước đối tượng đó.

Gợi ý

Hoạt động tương tự được hỗ trợ bằng cách sử dụng nút có thể gán đã được gán với tính năng [Push AF/MF].
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tìm kiếm bằng cách sử dụng chức năng phát hiện ra khuôn mặt và mắt (Face/Eye
Detection AF)

Thiết bị có thể phát hiện ra khuôn mặt và mắt người để lấy làm mục tiêu tìm kiếm và sau đó điều chỉnh tiêu điểm tụ vào
khuôn mặt và mắt trong phạm vi khu vực lấy nét.
Khi phát hiện ra khuôn mặt nào đó, khung nhận diện khuôn mặt/mắt màu xám sẽ hiển thị. Khi có thể lấy nét tự động,
khung hình sẽ thay đổi thành màu trắng và quá trình tìm kiếm bắt đầu. Khi phát hiện ra mắt nào đó và điều chỉnh lại tiêu
điểm, khung nhận diện khuôn mặt/mắt sẽ hiển thị trên mắt được phát hiện ra. Khi phát hiện ra nhiều đối tượng, thì đối
tượng chính sẽ tự động được xác định.
Chức năng này chỉ sử dụng được khi chế độ lấy nét đang ở chế độ lấy nét tự động hoặc trong khi đang ở chế độ lấy nét
tự động khi đẩy nút.

Gợi ý

Khi khu vực lấy nét được cài đặt thành [Zone] hoặc [Flexible Spot] và các khuôn mặt hoặc mắt chồng lên nhau trong phạm vi khu
vực lấy nét được chỉ định, các khung nhận diện khuôn mặt/mắt thay đổi thành màu trắng và thiết bị sẽ tập trung vào các khuôn
mặt/mắt đó.

Khi sử dụng tính năng lấy nét tự động khi đẩy nút một lần (AF-S), các khung nhận diện khuôn mặt/mắt đối với các khuôn mặt/mắt
đang được lấy nét sẽ thay đổi thành màu xanh.

Cài đặt bằng cách sử dụng nút [Face/Eye Detection AF] trong bảng điều khiển máy quay

Ấn nút [Face/Eye Detection AF] và đặt vận hành Lấy nét tự động khi phát hiện ra khuôn mặt/mắt.

[Face/Eye Only AF]: Máy quay phát hiện ra các khuôn mặt/mắt của đối tượng (người), sau đó lấy nét và chỉ tìm kiếm
trên các khuôn mặt/mắt đó. Trong khi không phát hiện ra một khuôn mặt hoặc mắt nào đó, chức năng lấy nét tự động sẽ
tạm thời dừng lại và  biểu tượng (Chế độ chỉ lấy nét tự động đối với khuôn mặt/mắt tạm dừng) sẽ hiển thị. Chế độ này
rất hữu dụng khi bạn muốn lấy nét tự động và chỉ tìm kiếm các khuôn mặt/mắt.
[Face/Eye Priority AF]: Máy quay phát hiện ra các khuôn mặt/mắt của đối tượng (người) và ưu tiên lấy nét/tìm kiếm các
khuôn mặt/mắt đó. Khi không phát hiện ra một khuôn mặt hoặc mắt nào đó, tính năng lấy nét sẽ ở chế độ lấy nét tự
động (cài đặt mặc định).
[AF]: Chức năng lấy nét tự động khi phát hiện ra khuôn mặt/mắt được tắt đi.

Chú ý

Trong quá trình vận hành lấy nét tự động khi đẩy nút diễn ra, chức năng [Face/Eye Priority AF] được kích hoạt ngay cả khi lúc đó
đã chọn chức năng [Face/Eye Only AF].
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Khi nút chuyển [Auto Focus] được tắt đi, tính năng Lấy nét tự động khi phát hiện ra khuôn mặt/mắt được tắt đi (ngoại trừ trong
khi thực hiện vận hành lấy nét tự động khi đẩy nút).

Nếu bạn tắt máy quay video đi trong khi đã chọn tính năng [Face/Eye Only AF], chế độ của máy sẽ tự động chuyển sang
[Face/Eye Priority AF] khi máy được bật lên sau đó.

Gợi ý

Bạn có thể cài đặt vận hành Lấy nét tự động khi phát hiện ra khuôn mặt/mắt bằng cách sử dụng [Shooting] > [Focus] > [Face/Eye
Detection AF] trong menu camera.

Ẩn các khung nhận diện khuôn mặt/mắt
Bạn có thể hiển thị/ẩn phạm vi của khung nhận diện khuôn mặt/mắt bằng cách sử dụng [Monitoring] > [Display On/Off] >
[Face/Eye Detection Frame] trong menu camera.

Chú ý

Các khung nhận diện khuôn mặt/mắt màu xanh sẽ hiển thị đối với các khuôn mặt và mắt đang được lấy nét bằng cách sử dụng
chức năng lấy nét tự động khi đẩy nút (AF-S) và không bị ẩn bằng cách sử dụng nút [Display] hoặc khi [Face/Eye Detection
Frame] được đặt thành [Off].

Chuyển đổi vận hành lấy nét tự động khi phát hiện ra khuôn mặt/mắt bằng cách sử dụng nút có thể
gán
Gán [Face/Eye Detection AF] cho một nút có thể gán. Sau đó, bạn có thể chuyển đổi vận hành lấy nét tự động khi phát
hiện ra khuôn mặt/mắt theo thứ tự [Face/Eye Priority AF], [Face/Eye Only AF] và [AF] mỗi lần ấn nút đó.

Cài đặt bằng cách sử dụng menu trực tiếp

Bạn cũng có thể cài đặt vận hành Lấy nét tự động khi phát hiện ra khuôn mặt/mắt bằng cách sử dụng menu trực tiếp.

Để biết thêm thông tin chi tiết về menu trực tiếp, hãy tham khảo “Thao tác menu trực tiếp”.

Chủ đề liên quan
Thao tác menu trực tiếp

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tìm kiếm đối tượng được chỉ định (Realtime Tracking AF)

Bạn có thể duy trì tiêu điểm trên một đối tượng nào đó bằng cách chỉ định đối tượng đó nhờ vận hành cảm ứng hoặc
bằng cách chọn một khung nhận diện khuôn mặt nào đó trong bảng điều khiển máy quay.
Khi đã chọn đối tượng rồi thì khung tìm kiếm màu trắng sẽ hiển thị và quá trình tìm kiếm bắt đầu.

Gợi ý

Hệ thống sẽ tìm kiếm trên toàn bộ khu vực hình ảnh, bất kể cài đặt khu vực lấy nét là gì.

Khi [Shooting] > [Focus] > [Touch Function in MF] được đặt thành [Tracking AF] trong menu web hoặc menu camera, AF theo dõi
thời gian thực được hỗ trợ ngay cả khi chế độ lấy nét là chế độ MF.

Các hoạt động sau sẽ xảy ra đối với mục tiêu tìm kiếm, tùy theo cài đặt chế độ của hoạt động lấy nét tự động khi phát
hiện ra khuôn mặt/mắt.

[Face/Eye Only AF] hoặc [Face/Eye Priority AF]: Lấy nét và tìm kiếm đối tượng được chỉ định.
Nếu mục tiêu tìm kiếm là một người nào đó và máy phát hiện ra một khuôn mặt/mắt, camera sẽ lấy nét nào khuôn
mặt/mắt đó.
Khi phát hiện ra một khuôn mặt/mắt là mục tiêu tìm kiếm nào đó, khuôn mặt là mục tiêu tìm kiếm sẽ được lưu lại. Khi đã
lưu rồi, một  (biểu tượng khuôn mặt tìm kiếm được lưu lại) sẽ hiển thị.

Chú ý

Nếu bắt đầu hoạt động lấy nét tự động khi tìm kiếm trong khi đang ở chế độ lấy nét thủ công, thì khuôn mặt mục tiêu tìm kiếm sẽ
không được lưu lại.

[AF]: Sử dụng để lấy nét và theo dõi một đối tượng cụ thể. Không diễn ra hoạt động phát hiện khuôn mặt/mắt, ngay cả
khi mục tiêu tìm kiếm là một người nào đó.

Chú ý

Chức năng lấy nét tự động theo dõi thời gian thực sẽ không hoạt động nếu cài đặt lấy nét thủ công cho ống kính.

Khởi động chế độ lấy nét tự động khi tìm kiếm trong thời gian thực

Khi một đối tượng cụ thể được chỉ định làm mục tiêu theo dõi, việc theo dõi mục tiêu đó sẽ bắt đầu.
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Để chỉ định thông qua thao tác cảm ứng
Trượt công tắc [Touch Focus] trên thẻ  (Focus) trong bảng điều khiển máy quay đến vị trí phù hợp để bật, sau đó
chạm vào đối tượng mục tiêu để tìm kiếm ở bất kỳ trạng thái nào sau đây.

Trong quá trình sử dụng lấy nét thủ công hoặc trong khi lấy nét thủ công khi đẩy nút và khi [Shooting] > [Focus] >
[Touch Function in MF] được đặt thành [Tracking AF] trong menu web hoặc menu camera
Trong quá trình sử dụng lấy nét tự động hoặc lấy nét tự động khi đẩy nút (AF)

Để chỉ định thông qua lực chọn khung nhận diện khuôn mặt
Di chuyển con trỏ lựa chọn khuôn mặt (gạch chân màu cam) đến đối tượng mục tiêu để tìm kiếm bằng cách sử dụng các
nút mũi tên trong bảng điều khiển GUI và ấn nút [Set].

A: Các khung phát hiện khuôn mặt khác (màu xám)
B: Khung tìm kiếm
C: Con trỏ chọn khuôn mặt (màu cam)

Chú ý

Trong quá trình lấy nét thủ công, không thể khởi động hoạt động tìm kiếm thông qua lựa chọn khung nhận diện khuôn mặt.

Gợi ý

Bạn cũng có thể thay đổi mục tiêu tìm kiếm trong quá trình lấy nét tự động khi tìm kiếm trong thời gian thực.

Dừng quá trình lấy nét tự động khi tìm kiếm trong thời gian thực

Nhấn nút  (dừng AF theo dõi thời gian thực).

Gợi ý

Quá trình lấy nét tự động khi tìm kiếm trong thời gian thực sẽ dừng trong các trường hợp sau:

Khi chuyển đổi [Auto Focus] hoặc điều khiển AUTO/MANUAL trên ống kính
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Khi thay đổi chế độ lấy nét
Khi hỗ trợ lấy nét tự động được thực hiện
Khi thay đổi cài đặt khu vực lấy nét hoặc hoạt động Lấy nét tự động khi phát hiện ra khuôn mặt/mắt
Khi ấn nút có thể gán được gán với tính năng [Push AF/MF]
Khi mục tiêu tìm kiếm không ở trong phạm vi màn hình quay chụp hoặc khi đối tượng đang bị mờ nét trong vài giây

Khi lưu một khuôn mặt tìm kiếm (Khi  (biểu tượng khuôn mặt tìm kiếm đã lưu) hiển thị), quá trình Lấy nét tự động khi tìm kiếm
trong thời gian thực sẽ tiếp tục thực hiện khi khuôn mặt tìm kiếm đã lưu đi vào khu vực hình ảnh. Để xóa khuôn mặt tìm kiếm đó,
hãy dừng quá trình Lấy nét tự động khi tìm kiếm trong thời gian thực theo mô tả ở trên.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Màn hình điều chỉnh độ sáng

Bạn có thể điều chỉnh độ sáng bằng cách điều chỉnh cửa điều sáng, độ lợi, tốc độ màn trập và bằng cách điều chỉnh
mức độ ánh sáng bằng cách sử dụng các bộ lọc ND trong các bảng điều khiển sau của màn hình hoạt động trực tiếp
của Ứng dụng Web. Bạn cũng có thể điều chỉnh độ sáng tự động.

Chú ý

Không thể điều chỉnh được độ lợi khi [Shooting Mode] được đặt thành [Cine EI Quick] hoặc [Cine EI]. Bên cạnh đó, không thể
điều chỉnh độ sáng tự động bằng cách sử dụng tốc độ màn khi được đặt thành [Cine EI Quick] hoặc [Cine EI]. Có hỗ trợ tính
năng điều chỉnh độ sáng tự động bằng cách sử dụng cửa điều sáng và bộ lọc ND.

Gợi ý

Chế độ Cine EI là một chế độ để chụp ở độ nhạy cơ bản mà không sử dụng độ lợi để tối đa hóa hiệu suất của cảm biến hình
ảnh. Độ sáng được điều chỉnh bằng cách sử dụng ánh sáng và bộ lọc ND để điều chỉnh lượng ánh sáng đến cảm biến hình ảnh.

Bảng điều khiển máy quay – thẻ  (Main)1.

Bảng điều khiển cấu hình cơ bản của máy quay
Hiển thị trạng thái cài đặt của các chức năng cơ bản cần thiết để chụp trên các nút. Nhấn một nút để hiển thị màn
hình cài đặt tương ứng cho từng chức năng trong bảng điều chỉnh cấu hình cơ bản của camera bên dưới.

2.

Bảng điều chỉnh cấu hình cơ bản của camera
Hiển thị bảng điều chỉnh cho mục thiết lập đã chọn trên bảng cấu hình cơ bản của máy quay.

3.
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Để biết thêm thông tin chi tiết về Exposure Index (EI), hãy tham khảo “Thay đổi sự phân bố các vùng sáng và tối trong hình ảnh
đã ghi”.

Chủ đề liên quan

Thay đổi sự phân bố các vùng sáng và tối trong hình ảnh đã ghi

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Đặt độ nhạy cơ bản

Bạn có thể đặt độ nhạy cơ bản trước khi bắt đầu điều chỉnh độ sáng.

Khi [Shooting Mode] được đặt thành [Custom]

Nhấn nút [ISO/Gain] trong khiển cấu hình cơ bản của máy quay và đặt [Base Sensitivity] trên bảng điều khiển điều chỉnh
ISO/Gain thành [High] hoặc [Low].
Chọn [Low] trong các điều kiện ánh sáng bình thường và chọn [High] trong các điều kiện ánh sáng thấp.
Được hiển thị khi [AGC] bị tắt

Được hiển thị khi [AGC] được bật

Khi [Shooting Mode] được đặt thành [Flexible ISO] hoặc [Cine EI]

Nhấn nút [Base ISO/Exposure Index] trong bảng điều khiển cấu hình cơ bản của máy quay và đặt [Base ISO] trên bảng
điều chỉnh Base ISO/Exposure Index thành [ISO 12800] hoặc [ISO 800].
Chọn [ISO 800] trong các điều kiện ánh sáng bình thường và chọn [ISO 12800] trong các điều kiện ánh sáng thấp.

Gợi ý
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Bạn cũng có thể đặt chức năng này trên thẻ  (Main) trong bảng điều khiển của máy quay.

Bạn cũng có thể đặt điều này bằng cách sử dụng [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] hoặc [Base ISO] trong menu
camera.

Bạn cũng có thể gán chức năng [Base ISO/Sensitivity] cho nút có thể gán.

Trong chế độ chụp [Cine EI Quick] độ nhạy cơ bản sẽ tự động được đặt theo cài đặt chỉ số phơi sáng.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Đặt mức mục tiêu để điều chỉnh độ sáng tự động

Cài đặt mức độ mục tiêu để điều chỉnh độ sáng tự động bằng cách sử dụng thanh trượt [AE Level] trong bảng điều khiển
máy quay.

5-041-959-03(1) Copyright 2022 Sony Corporation

Ấn vào thẻ  (Main) trong bảng điều khiển máy quay.

Nếu thanh trượt [AE Level] không được hiển thị, hãy chọn một trong hai nút chọn chức năng của thanh trượt và
chọn thanh trượt [AE Level] từ danh sách.

Thanh trượt [AE Level] xuất hiện.

1

Đặt mức mục tiêu bằng thanh trượt.

Chỉnh núm thanh trượt sang trái để làm cho hình ảnh tối hơn. Chỉnh núm thanh trượt sang phải để làm cho hình
ảnh sáng hơn.

Gợi ý

Bạn cũng có thể đặt bằng cách sử dụng [Shooting] > [Auto Exposure] > [Level] trong menu camera.

2
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh tự động cửa điều sáng

Bạn có thể điều chỉnh độ sáng tự động theo đối tượng. Yêu cầu ống kính tương thích.

Chú ý

Không thể điều chỉnh tự động cửa điều sáng trên ống kính ngàm A.

Gợi ý

Bạn cũng có thể gán chức năng [Auto Iris] cho nút có thể gán.

5-041-959-03(1) Copyright 2022 Sony Corporation

Nếu ống kính có bố trí công tắc Auto Iris, hãy đưa công tắc về vị trí AUTO.1

Ấn nút [Iris] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [Iris] chuyển thành màu cam.

Bảng điều chỉnh Iris xuất hiện.

2

Trượt công tắc [Auto] sang vị trí bên phải để bật.

Cửa điều sáng chuyển sang chế độ tự động điều chỉnh. Giá trị cửa điều sáng được điều chỉnh tự động được hiển
thị ở phía bên phải của công tắc.

3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh thủ công cửa điều sáng

Bạn có thể điều chỉnh độ sáng theo cách thủ công.

Để tạm thời điều chỉnh tự động cửa điều sáng
Bạn cũng có thể ấn và giữ nút [Push Auto] trên bảng chỉnh Iris để điều chỉnh cửa điều sáng tự động.

Nếu ống kính có bố trí công tắc Auto Iris, hãy đưa công tắc về vị trí AUTO.

Chú ý

Khi công tắc Auto Iris của ống kính được cài đặt thành MANUAL, các chức năng [Auto Iris] và [Push Auto Iris] trên thiết bị
sẽ không có tác dụng. Chức năng điều chỉnh cửa điều sáng thủ công trên thiết bị cũng không có tác dụng.

1

Ấn nút [Iris] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [Iris] chuyển thành màu cam.

Bảng điều chỉnh Iris xuất hiện.

2

Trượt công tắc [Auto] sang vị trí bên trái để tắt.

Cửa điều sáng chuyển sang chế độ điều chỉnh thủ công.

3

Điều chỉnh cửa điều sáng bằng cách sử dụng thanh trượt [Iris] hoặc các nút điều chỉnh [Iris].

Gợi ý

Thanh trượt và cài đặt nút điều chỉnh được liên kết với nhau.

Bạn cũng có thể chỉ định cửa điều sáng cho thanh trượt trên thẻ  (Main) trong bảng điều khiển máy quay.

4
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Gợi ý

Ấn và giữ nút có thể gán được gán với chức năng [Push Auto Iris] để tự động điều chỉnh độ cửa điều sáng.
Cửa điều sáng quay trở về chế độ thủ công khi bạn thả nút này ra.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh tự động độ lợi

Bạn có thể tự động điều chỉnh độ sáng bằng cách sử dụng cài đặt độ lợi khi [Shooting Mode] được đặt thành [Custom]
hoặc [Flexible ISO].
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Đặt [Project] > [Shooting Mode] thành [Custom] trong menu web hoặc menu camera.1

Ấn nút [ISO/Gain] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [ISO/Gain] chuyển thành màu cam.

Bảng điều chỉnh ISO/Gain xuất hiện.

2

Trượt công tắc [AGC] sang vị trí bên phải để bật.

Độ lợi chuyển sang chế độ tự động điều chỉnh. Giá trị độ lợi được điều chỉnh tự động được hiển thị ở phía bên phải
của công tắc.

Gợi ý

Bạn cũng có thể thực hiện hành động tương tự bằng cách đặt [Shooting] > [Auto Exposure] > [AGC] thành [On] trong menu
camera.

Bạn cũng có thể gán chức năng [AGC] cho nút có thể gán.

3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Điều chỉnh độ lợi theo cách thủ công

Bạn có thể điều chỉnh độ sáng bằng cách sử dụng cài đặt độ lợi khi [Shooting Mode] được đặt thành [Custom] hoặc
[Flexible ISO].
Bạn có thể điều khiển độ lợi khi muốn điều chỉnh độ phơi sáng trong khi sử dụng cài đặt cửa điều sáng cố định hoặc khi
muốn ngăn độ lợi tăng lên do AGC.

Để tạm thời điều chỉnh độ lợi theo cách thủ công
Bạn cũng có thể điều chỉnh độ lợi tạm thời bằng cách chỉ định [ISO/Gain] cho nút chọn chức năng thanh trượt trên thẻ

 (Main) trong bảng điều khiển máy quay và sử dụng thanh trượt.
Cài đặt như vậy là rất hữu dụng khi bạn muốn điều chỉnh độ phơi sáng theo từng bước mà không làm thay đổi độ sâu
trường ảnh.
Kết quả điều chỉnh quay về giá trị đặt trước đã cấu hình bằng cách sử dụng [ISO/Gain<L>] sau khi thực hiện bất kỳ thao
tác nào sau đây.

Đặt [Project] > [Shooting Mode] thành [Custom] trong menu web hoặc menu camera.1

Ấn nút [ISO/Gain] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [ISO/Gain] chuyển thành màu cam.

Bảng điều chỉnh ISO/Gain xuất hiện.

2

Trượt công tắc [AGC] sang vị trí bên trái để tắt.

Độ lợi chuyển sang chế độ điều chỉnh theo cách thủ công.

3

Điều chỉnh độ lợi đại bằng cách sử dụng thanh trượt [ISO/Gain] hoặc các nút điều chỉnh [ISO/Gain].

Gợi ý

Thanh trượt và cài đặt nút điều chỉnh được liên kết với nhau.

4

204



Thay đổi các mục điều chỉnh ISO/Gain
Chuyển đổi độ nhạy cơ bản
Đưa công tắc AGC sang vị trí on
Chuyển nguồn điện của thiết bị sang trạng thái chờ

Để tạm thời điều chỉnh độ lợi tự động bằng cách sử dụng một nút có thể chỉ định
Ấn và giữ nút có thể gán được gán với chức năng [Push AGC] để tự động điều chỉnh độ cửa điều độ lợi.
Độ lợi quay trở về chế độ thủ công khi bạn thả nút này ra.
Kết quả điều chỉnh quay về giá trị đặt trước đã cấu hình bằng cách sử dụng [ISO/Gain<L>] sau khi thực hiện bất kỳ thao
tác nào sau đây.

Thay đổi các mục điều chỉnh ISO/Gain
Chuyển đổi độ nhạy cơ bản
Đưa công tắc AGC sang vị trí on
Chuyển nguồn điện của thiết bị sang trạng thái chờ

Chú ý

Không thể thực hiện chức năng này khi [Shooting] > [Iris] > [Bokeh Control] được đặt thành [On] trong menu camera.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Điều chỉnh tự động cho màn trập

Bạn có thể điều chỉnh tự động cho màn trập theo độ sáng của hình ảnh.

5-041-959-03(1) Copyright 2022 Sony Corporation

Ấn nút [Shutter] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [Shutter] chuyển thành màu cam.

Bảng điều chỉnh Shutter xuất hiện.

1

Ấn nút [Shutter Type] và chọn [Auto] từ danh sách.

Gợi ý

Bạn cũng có thể thực hiện hành động tương tự bằng cách đặt [Shooting] > [Auto Exposure] > [Auto Shutter] thành [On]
trong menu camera.

Bạn cũng có thể gán chức năng [Auto Shutter] cho nút có thể gán.

2
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Điều chỉnh màn trập theo cách thủ công

Bạn có thể điều chỉnh màn trập theo cách thủ công.

Ấn nút [Shutter] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [Shutter] chuyển thành màu cam.

Bảng điều chỉnh Shutter xuất hiện.

1

Ấn nút [Shutter Type] và chọn [Speed] từ danh sách.2

Điều chỉnh màn trập đại bằng cách sử dụng thanh trượt [Speed] hoặc các nút điều chỉnh [Speed].

Để điều chỉnh thời gian phơi sáng cho khớp với khoảng thời gian giữa các khung hình, hãy chọn [Off] ở bước 2.
Bạn cũng có thể đặt giá trị cố định bằng [ECS] (tần số) hoặc tự động điều chỉnh bằng cách sử dụng [Auto].
Ví dụ: Đặt bằng [ECS] (tần số)

Gợi ý

Thanh trượt và cài đặt nút điều chỉnh được liên kết với nhau.

Để sử dụng [Angle] thay vì [Speed] hoặc [Off], đặt [Shooting] > [Shutter] > [Mode] thành [Angle] trong menu camera.

3
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Về bộ lọc ND

Trong điều kiện môi trường có ánh sáng quá rực rỡ, bạn có thể cài đặt độ sáng phù hợp bằng cách thay đổi bộ lọc ND.
Khi ghi hình một đối tượng nào đó phát sáng rực rỡ, việc đóng cửa điều sáng quá nhiều lần có thể gây ra nhòe do nhiễu
xạ, khiến hình ảnh bắt đầu trở nên mờ nét (hiện tượng thường gặp ở các máy quay). Bạn có thể loại bỏ hiệu ứng này để
có các kết quả ghi hình chất lượng hơn bằng cách sử dụng bộ lọc ND.
Thiết bị nổi bật với hai chế độ bộ lọc ND.
Chế độ đặt trước

Tham khảo “Điều chỉnh ở chế độ đặt trước.”

Chế độ biến đổi (điều chỉnh tự động)

Tham khảo “Điều chỉnh tự động ở chế độ biến đổi.”

Chế độ biến đổi (điều chỉnh thủ công)

Tham khảo “Điều chỉnh thủ công ở chế độ biến đổi”.

Chủ đề liên quan

Điều chỉnh ở chế độ đặt trước

Điều chỉnh tự động ở chế độ biến đổi

Điều chỉnh thủ công ở chế độ biến đổi

5-041-959-03(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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Điều chỉnh ở chế độ đặt trước

Bạn có thể chọn trước ba giá trị truyền qua bộ lọc ND và nhanh chóng chuyển đổi giữa chúng khi quay.

Gợi ý

Khi ấn nút có thể gán được gán với [ND Filter Position], bộ lọc ND thay đổi theo trình tự [Clear] → [Preset1] → [Preset2] →
[Preset3] → [Clear].

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt [Shooting] > [ND Filter] > [Mode] thành [Preset] trong menu camera.1

Ấn nút [ND Filter] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [ND Filter] chuyển thành màu cam.

Bảng điều chỉnh ND Filter xuất hiện.

2

Ấn nút [ND Filter] và chọn một trong những tùy chọn sau đây từ danh sách.

[Clear]: Không có bộ lọc ND.
[Preset1]: Hệ số truyền được đặt bởi [Shooting] > [ND Filter] > [Preset1] trong menu camera.
[Preset2]: Hệ số truyền được đặt bởi [Shooting] > [ND Filter] > [Preset2] trong menu camera.
[Preset3]: Hệ số truyền được đặt bởi [Shooting] > [ND Filter] > [Preset3] trong menu camera.

Khi một trong các [Preset1] thành [Preset3] được chọn cho bộ lọc ND, giá trị hệ số truyền được hiển thị bên cạnh
tên của bộ lọc ND.

3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Điều chỉnh tự động ở chế độ biến đổi

Bạn có thể cho phép điều chỉnh phơi sáng tự động bằng cách sử dụng bộ lọc ND.

Chú ý

Khi bộ lọc ND được chuyển đổi thành hoặc từ chế độ [Clear] trong quá trình chụp, khung bộ lọc ND sẽ được hiển thị trên hình
ảnh và phát ra âm thanh vận hành.

Gợi ý

Bạn cũng có thể gán chức năng [Auto ND Filter] cho nút có thể gán và nhấn nút để chuyển đổi giữa bộ lọc [Auto] và [Manual].
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Đặt [Shooting] > [ND Filter] > [Mode] thành [Variable] trong menu camera.1

Ấn nút [ND Filter] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [ND Filter] chuyển thành màu cam.

Bảng điều chỉnh ND Filter xuất hiện.

2

Ấn nút [ND Filter] và chọn [Auto] từ danh sách.

Giá trị truyền qua bộ lọc ND được điều chỉnh tự động hiển thị bên cạnh nút [ND Filter].

3
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Điều chỉnh thủ công ở chế độ biến đổi

Bạn có thể tiến hành điều chỉnh thủ công độ phơi sáng bằng bộ lọc ND.

Điều chỉnh tự động tạm thời
Bạn có thể gán chức năng [Push Auto ND] cho nút có thể gán và tạm thời bật bộ lọc ND tự động bằng cách ấn và giữ
nút này. Thả nút này ra và tắt bộ lọc ND tự động.
Đặt bộ lọc ND thành [Manual].

Chú ý

Khi bộ lọc ND được chuyển đổi thành hoặc từ chế độ [Clear] trong quá trình chụp, khung bộ lọc ND sẽ được hiển thị trên hình
ảnh và phát ra âm thanh vận hành.

Đặt [Shooting] > [ND Filter] > [Mode] thành [Variable] trong menu camera.1

Ấn nút [ND Filter] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [ND Filter] chuyển thành màu cam.

Bảng điều chỉnh ND Filter xuất hiện.

2

Ấn nút [ND Filter] và chọn [Manual] từ danh sách.3

Điều chỉnh độ truyền của bộ lọc ND bằng thanh trượt [ND Filter] hoặc các nút điều chỉnh [ND Filter].

Gợi ý

Thanh trượt và cài đặt nút điều chỉnh được liên kết với nhau.

Bạn cũng có thể điều chỉnh bộ lọc ND trên thẻ  (Main) trong bảng điều khiển của máy quay.

4
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Gợi ý

Bạn cũng có thể gán chức năng [ND Filter Position] cho nút có thể gán và nhấn nút để chuyển đổi giữa bộ lọc [Manual] và
[Clear].

Bạn cũng có thể ấn và giữ nút [Push Auto] trên bảng điều chỉnh ND Filter để điều chỉnh bộ lọc ND tự động.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Màn hình điều chỉnh cân bằng trắng

Bạn có thể điều chỉnh cân bằng trắng bằng cách sử dụng màn hình hoạt động trực tiếp của Ứng dụng Web để có được
cân bằng trắng giúp hình ảnh trông tự nhiên hơn.

5-041-959-03(1) Copyright 2022 Sony Corporation

Bảng điều khiển cấu hình cơ bản của máy quay1.

Bảng điều chỉnh cấu hình cơ bản của camera
Hiển thị bảng điều chỉnh cho mục thiết lập đã chọn trên bảng cấu hình cơ bản của máy quay.

2.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh cân bằng trắng tự động

Bạn có thể đạt được độ cân bằng trắng điều chỉnh phù hợp tại mọi thời điểm bằng ATW (Cân bằng trắng theo dấu tự
động).
Khi bật ATW, cân bằng trắng sẽ được điều chỉnh tự động khi nhiệt độ màu của nguồn ánh sáng thay đổi.

Chú ý

Không thể sử dụng ATW khi [Shooting Mode] được đặt thành [Cine EI] hoặc [Cine EI Quick].

Có thể không điều chỉnh được tới màu thích hợp bằng cách sử dụng ATW, tùy theo điều kiện ánh sáng và đối tượng.
Các ví dụ:

Khi đối tượng có chủ yếu là màu đơn sắc, chẳng hạn như bầu trời, biển, đất hoặc hoa.
Khi nhiệt độ màu là cực kỳ cao hoặc cực kỳ thấp.

Nếu tốc độ tìm kiếm cân bằng trắng tự động chậm hoặc không thể thu được hiệu ứng phù hợp, nhấn nút [WB SET] để chạy cân
bằng trắng tự động.

Gợi ý

Bạn có thể chọn tốc độ phản hồi trong chế độ ATW qua năm bước (1, 2, 3, 4, 5) bằng cách sử dụng [Shooting] > [White Setting]
> [ATW Speed] trong menu camera. Số càng thấp, tốc độ phản hồi càng nhanh.

Bạn có thể đóng băng cài đặt cân bằng trắng hiện tại bằng cách gán chức năng [ATW Hold] cho nút có thể gán và nhấn nút có
thể gán để tạm dừng ATW trong chế độ ATW.

5-041-959-03(1) Copyright 2022 Sony Corporation

Ấn nút [White Balance] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [White Balance] chuyển thành màu cam.

Bảng điều chỉnh White Balance xuất hiện.

1

Ấn nút [White Mode] và chọn [ATW] từ danh sách.2

215



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh cân bằng trắng thủ công

Bạn có thể điều chỉnh cân bằng trắng thủ công.

Ấn nút [White Balance] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [White Balance] chuyển thành màu cam.

Bảng điều chỉnh White Balance xuất hiện.

1

Ấn nút [White Mode] và chọn một trong những tùy chọn sau đây từ danh sách.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Điều chỉnh cân bằng trắng bằng cách sử dụng thanh trượt hoặc nút điều chỉnh.

Gợi ý

Thanh trượt và cài đặt nút điều chỉnh được liên kết với nhau.

Sự khác nhau giữa [Memory A(T/T)] và [Memory A(R/B)] là trục điều chỉnh khác nhau, nhưng các kết quả điều chỉnh được
liên kết với nhau.

Đối với [Memory A(T/T)]
Chế độ này điều chỉnh cân bằng trắng được lưu trong bộ nhớ A bằng cách điều chỉnh nhiệt độ màu (Temp) và Tint.
Bạn có thể đặt nhiệt độ màu theo mức tăng 20 K trong phạm vi 2000 K đến 5600 K. Các giá trị trên 5600 K có thể
được đặt trong khoảng thời gian bằng với lượng thay đổi màu (mired) từ 5580 K đến 5600 K.

3
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Ấn nút [Reset] ở bên phải [Temp] hoặc [Tint] khôi phục cài đặt tương ứng về giá trị mặc định.
Đối với [Memory A(R/B)]
Chế độ này điều chỉnh cân bằng trắng được lưu trong bộ nhớ A bằng cách điều chỉnh R Gain và B Gain.
Ấn nút [Reset] khôi phục cài đặt độ lợi tương ứng về giá trị mặc định.
Đối với [Preset]
Chế độ này điều chỉnh nhiệt độ màu thành giá trị đặt trước.
Bạn có thể đặt giá trị trong số gia 100 K.
Ở chế độ đặt trước, bạn cũng có thể gán chức năng [Preset White Select] cho nút có thể gán và ấn nút này để thay
đổi giá trị đặt trước cấu hình sẵn.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Chạy cân bằng trắng tự động

Trong chế độ bộ nhớ A, cân bằng trắng cần lưu được điều chỉnh tự động.

Ấn nút [White Balance] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [White Balance] chuyển thành màu cam.

Bảng điều chỉnh White Balance xuất hiện.

1

Ấn nút [White Mode] và chọn [Memory A(T/T)] hoặc [Memory A(R/B)] từ danh sách.

[Memory A(T/T)]

[Memory A(R/B)]

2

Đặt tờ giấy trắng (hoặc vật thể khác) ở nơi có nguồn sáng và điều kiện ánh sáng tương tự như đối tượng,
sau đó zoom vào tờ giấy đó để cho màu trắng hiển thị trên màn hình.

3

Điều chỉnh độ sáng.

Điều chỉnh cửa điều sáng theo quy trình trong “Điều chỉnh thủ công cửa điều sáng.”

4

Ấn nút [WB SET] trên bảng điều khiển điều chỉnh cân bằng trắng.

[Memory A(T/T)]

[Memory A(R/B)]

5
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Chú ý

Nếu không điều chỉnh được, một thông báo có lỗi sẽ hiển thị trên màn hình trong khoảng 3 giây. Nếu thông có báo lỗi vẫn còn
sau nhiều lần cố gắng cài đặt cân bằng trắng, hãy liên hệ với đại diện dịch vụ Sony của bạn.

Gợi ý

Bạn cũng có thể chạy nó ở chế độ ATW. Bạn có thể sử dụng thao tác này nếu bạn muốn điều chỉnh nhanh cân bằng trắng trong
quá trình vận hành ATW. Sau khi điều chỉnh, chế độ trở về vận hành ATW thông thường.

Chủ đề liên quan

Điều chỉnh thủ công cửa điều sáng

5-041-959-03(1) Copyright 2022 Sony Corporation

Nếu chạy cân bằng trắng ở chế độ thẻ nhớ, kết quả điều chỉnh tự động được lưu trong thẻ nhớ A.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Màn hình cấu hình âm thanh

Bạn có thể điều chỉnh mức độ âm thanh để ghi bằng thiết bị trên màn hình vận hành trực tiếp của Ứng dụng web. Định
cấu hình các công tắc trên khối đầu nối của thiết bị và định cấu hình âm thanh bằng menu camera hoặc menu web.

5-041-959-03(1) Copyright 2022 Sony Corporation

Bảng điều khiển máy quay – thẻ  (Audio)1.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Chọn thiết bị đầu vào tự động

Đặt các nút chuyển sau đây theo thiết bị được kết nối với đầu nối AUDIO IN.

Chú ý

Âm thanh không được ghi ở chế độ Interval Rec hoặc Slow & Quick Motion.

5-041-959-03(1) Copyright 2022 Sony Corporation

Khi micrô được kết nối, đặt nút chuyển SETUP 2 ở khối đầu nối phía sau của thiết bị.

CH-1 và CH-2 có các cài đặt chung.

1

Cài đặt Mô tả

OFF (mặc
định)

Chọn khi sử dụng micrô động hoặc micrô chạy bằng pin. Thao tác này tắt nguồn điện ảo +48 V và
đặt LINE hoặc đầu vào MIC thành nguồn âm thanh CH-1 và CH-2.

ON
Chọn khi sử dụng micrô tương thích nguồn điện ảo +48 V. Thao tác này tắt nguồn điện ảo +48V và
micrô tương thích nguồn điện ảo thành nguồn âm thanh CH-1 và CH-2.

Đặt loại thiết bị được kết nối bằng cách sử dụng [Audio] > [Audio Input] > [AUDIO IN Select] trong menu
camera.

2

Chọn đầu vào âm thanh bằng cách sử dụng [Audio] > [Audio Input] > [CH1 Input Select] thành [CH4 Input
Select] trong menu web hoặc menu camera.

3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tự động điều chỉnh mức âm thanh ghi

Đặt kênh mà bạn muốn tự động điều chỉnh mức âm thanh ghi thành [Auto] trên trang [Audio] của menu web hoặc sử
dụng [Audio] > [Audio Input] > [CH1 Level Control] thành [CH4 Level Control] trong menu camera.
Các kênh được chỉ định cho điều chỉnh tự động được biểu thị bằng biểu tượng  (Auto) bên cạnh kênh tương ứng trên
thẻ  (Audio) của màn hình vận hành trực tiếp.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh mức âm thanh ghi theo cách thủ công

Bạn có thể điều chỉnh mức âm thanh ghi theo cách thủ công.

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt kênh mà bạn muốn điều chỉnh thủ công mức âm thanh ghi thành [Manual] trên trang [Audio] của menu
web hoặc sử dụng [Audio] > [Audio Input] > [CH1 Level Control] thành [CH4 Level Control] trong menu
camera.

1

Nhấn vào thẻ  (Audio) trong bảng điều khiển máy quay.2

Trên màn hình [Audio] trong bảng điều khiển máy quay, hãy đặt mức âm thanh ghi bằng cách sử dụng
thanh trượt hoặc các nút điều chỉnh cho kênh có mức âm thanh ghi bạn muốn đặt theo cách thủ công.

Chú ý

Các kênh có biểu tượng  (Auto) hiển thị đều được điều chỉnh một cách tự động. Những thay đổi đối với các giá trị sử
dụng thanh trượt hoặc nút đều được áp dụng cho âm thanh ghi.

Gợi ý

Thanh trượt và cài đặt nút điều chỉnh trong mỗi hàng được liên kết với nhau.

Bạn có thể kiểm tra mức đầu vào âm thanh trong thời gian thực bằng cách sử dụng màn hình đồng hồ đo mức âm thanh
trên màn hình chụp.

3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Thao tác menu trực tiếp

Bạn có thể kiểm tra trạng thái và cài đặt của thiết bị được hiển thị phủ trên hình ảnh camera, đồng thời chọn và thay đổi
cài đặt bằng các nút điều khiển GUI trên điều khiển từ xa hồng ngoại.
Có thể thiết lập cấu hình cho các mục sau.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
Giá trị [ND Filter]
[Auto Iris]
Giá trị [Iris]
[AGC]
Giá trị [Gain]
Giá trị [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
Giá trị [Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] và [Frame Rate]

Gợi ý

Bạn cũng có thể thực hiện chức năng tương tự bằng cách sử dụng một nút có thể gán và bảng điều khiển GUI của Ứng dụng
web.

Nhấn nút có thể gán đã được gán với [Direct Menu] trên điều khiển từ xa hồng ngoại.

Nút [Direct Menu] được gán cho một nút có thể gán 1 bởi mặc định của nhà sản xuất.
Chỉ thiết lập cấu hình cho những mục trên màn hình bằng cách sử dụng menu trực tiếp. Đây là loại menu cho phép
chọn bằng cách sử dụng con trỏ màu cam.

1

Di chuyển con trỏ đến mục bạn muốn đặt bằng cách sử dụng nút mũi tên trong bảng điều khiển GUI và ấn
nút [Set].

Một menu hoặc mục để chọn sẽ được hiển thị trên nền trắng phía sau.

2

Chọn cài đặt bằng cách sử dụng nút mũi tên và nhấn nút [Set].

Menu hoặc nền trắng phía sau sẽ biến mất và chế độ cài đặt mới được hiển thị cùng với con trỏ màu cam.
Nhấn nút có thể gán đã được gán với tính năng [Direct Menu] một lần nữa hoặc chờ 3 giây mà không thực hiện bất
kỳ thao tác nào để thoát khỏi menu trực tiếp.

3
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nút có thể gán

Có mười nút có thể gán trên Ứng dụng web của thiết bị mà bạn có thể gán các chức năng cho chúng.
Các nút có thể gán được hiển thị trên màn hình vận hành phát trực tiếp và màn hình vận hành phát lại.

Chú ý

Danh sách các nút có thể gán không được hiển thị khi đặt cấu hình các cài đặt trong bảng vận hành cơ bản của máy quay của
màn hình vận hành phát trực tiếp. Để kết thúc vận hành, nhấn nút [X] trên góc phải bảng điều khiển điều chỉnh.

Các chức năng sau đây được gán cho các nút theo mặc định của nhà sản xuất.
Nút 1: [Direct Menu]
Nút 2: [Focus Setting]
Nút 3: [Rec Review]

Các nút từ 1 đến 3 tương đương với các nút số tương tự trên điều khiển từ xa hồng ngoại đi kèm.

Nút 4: [Push Auto ND]
Nút 5: [Crop Select]
Nút 6: [Marker]
Nút 7: [Video Signal Monitor]
Nút 8: [Clip Flag OK]
Nút 9: [Color Bars]
Nút Focus Hold: [Focus Hold]

Nút Focus Hold tương đương với nút Focus Hold trên ống kính ngàm E.

Thay đổi chức năng của nút
Sử dụng [Project] > [Assignable Button] trong menu camera.
Khi thay đổi một lệnh gán, hiển thị của danh sách nút có thể gán cũng thay đổi.
Để biết thêm thông tin chi tiết về các chức năng có thể gán, hãy tham khảo “Assignable Button” trong “Menu camera và
cài đặt chi tiết”.

Chủ đề liên quan

Assignable Button

5-041-959-03(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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Chuyển động nhanh và chậm

Khi định dạng ghi được cài đặt thành các giá trị sau, bạn có thể chỉ định các giá trị khác nhau cho tốc độ khung ghi hình
và tốc độ khung phát lại.
Bảng sau đây trình bày tốc độ khung hình.

Tần số hệ thống: 59.94/50/29.97/25/23.98, Chế độ quét hình: FF

Tần số hệ thống: 59.94/50/29.97/25/23.98, Chế độ quét hình: S35

Tần số hệ thống: 24, Chế độ quét hình: FF

Chú ý

Không thể cài đặt chức năng Slow & Quick Motion khi đang trong quá trình ghi, phát lại hoặc trong khi màn thumbnail đang hiển
thị.

Không hỗ trợ ghi âm ở chế độ Slow & Quick Motion.

Chức năng cửa điều sáng tự động và màn trập tự động được tắt ở chế độ Slow & Quick Motion.

Tự động lấy nét ở chế độ Slow & Quick Motion có những hạn chế sau.

Những hạn chế do mẫu ống kính, tần số hệ thống và tốc độ khung hình chụp

Codec Định dạng video Tốc độ khung hình có thể cấu hình

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Codec Định dạng video Tốc độ khung hình có thể cấu hình

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Codec Định dạng video Tốc độ khung hình có thể cấu hình

XAVC-I 4096×2160P 1–60
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Chức năng lấy nét tự động tạm thời bị tắt nếu cửa điều sáng được đặt ở mức F18 trở lên.

Để biết thêm thông tin chi tiết về bằng cách sử dụng đầu ra RAW, hãy tham khảo “Ghi video RAW.”

Chủ đề liên quan

Ghi video RAW

5-041-959-03(1) Copyright 2022 Sony Corporation

Ống kính Sony Tần số hệ thống Tính khả dụng của chức năng lấy nét tự động

Ngoài SEL16F28 – Hỗ trợ 7 fps trở lên

SEL16F28

59.94/29.97/23.98 Hỗ trợ 30, 60, 120, 240 fps

50,00/25,00 Hỗ trợ 25, 50, 100, 200 fps

24,00 Không hỗ trợ
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Quay video không liên tục (Interval Rec)

Chức năng Interval Rec cho phép bạn quay video không liên tục vào bộ nhớ trong của thiết bị. Chức năng này rất hữu
dụng khi ghi hình đối tượng có chuyển động chậm.
Khi bắt đầu ghi hình, thiết bị sẽ tự động ghi một số lượng khung hình (Number of Frames) trong một khoảng thời gian
đều được chỉ định đước (Interval Time).

A: Khoảng thời gian chụp (Interval Time)
B: Số lượng khung hình trong một lần quay, chụp (Number of Frames)

Chú ý

Trong một thời điểm, chỉ sử dụng được duy nhất một chức năng ghi đặc biệt, chẳng hạn như chức năng Interval Rec.

Nếu bật chức năng ghi đặc biệt khác trong khi đang sử dụng chức năng Interval Rec, thì Interval Rec sẽ tự động thoát.

Chế độ Interval Rec sẽ tự động thoát sau khi thay đổi cài đặt hệ thống, chẳng hạn như thay đổi định dạng video.

Không thể thay đổi thông tin cài đặt Interval Rec trong quá trình ghi hoặc phát lại hoặc khi màn thumbnail đang hiển thị.

Những hạn chế trong quá trình ghi
Không ghi được âm thanh.
Không xem lại được bản ghi (chức năng Rec Review không hoạt động được).

Nếu thiết bị bị tắt trong quá trình ghi
Khi nguồn cấp điện cho thiết bị được đặt ở trạng thái chờ, hệ thống sẽ truy cập phương tiện đó trong vài giây để ghi
lại những hình ảnh đã lưu trữ trong bộ nhớ cho đến thời điểm đó và sau đó thiết bị sẽ tự động chuyển sang trạng thái
chờ.
Nếu dây nguồn DC bị ngắt kết nối, nguồn bị tắt khỏi bộ chuyển đổi AC hoặc ngắt kết nối nguồn PoE++, thì dữ liệu
được quay đến thời điểm đó có thể bị mất (tối đa 10 giây). Cần thận trọng.

Đặt số lượng khung hình và khoảng thời gian giữa các lần chụp

Đặt [Project] > [Interval Rec] > [Setting] thành [On] trong menu web và đặt [Number of Frames] và [Interval Time].
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Thiết bị sẽ thoát chế độ Interval Rec khi tắt nguồn máy, nhưng các cài đặt [Number of Frames] và [Interval Time] vẫn
được giữ nguyên. Bạn không cần phải cài đặt lại các thông tin này vào lần ghi hình tiếp theo ở chế độ Interval Rec.

Gợi ý

Bạn cũng có thể đặt bằng cách sử dụng [Project] > [Interval Rec] trong menu camera.

Bắt đầu chụp

Nhấn nút START/STOP ghi để bắt đầu quá trình ghi. sẽ xuất hiện luân phiên “Int●Rec” và “Int●Stby” sẽ xuất hiện luân
phiên.

Cách dừng chụp

Dừng quá trình ghi hình.
Khi quá trình ghi hình kết thúc, dữ liệu video sẽ được lưu trữ trong bộ nhớ đến thời điểm được ghi vào phương tiện.
Để thoát khỏi chế độ Interval Rec, hãy thực hiện một trong các thao tác sau.

Chuyển nguồn điện của thiết bị sang trạng thái chờ.
Trong chế độ đang chờ ghi, đặt [Project] > [Interval Rec] > [Setting] thành [Off].

Bên cạnh đó, chế độ Interval Rec sẽ tự động thoát khi khởi động lại thiết bị.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Ghi ảnh vào bộ nhớ đệm (Picture Cache Rec)

Khi bắt đầu quá trình ghi, nhờ chức năng ghi ảnh vào bộ nhớ đệm Picture Cache Rec mà bạn có thể giữ lại video từ
trước đó bằng cách luôn dành một bộ nhớ đệm nội bộ cho một khoảng thời lượng xác định trước khi đang ghi hình.

Cài đặt kích thước bộ nhớ đệm

Đặt [Project] > [Picture Cache Rec] > [Setting] thành [On] trong menu web và đặt kích thước bộ nhớ đệm bằng cách sử
dụng [Cache Size].

Chú ý

Không thể sử dụng Picture Cache Rec kết hợp với Interval Rec, ghi đồng thời 2 khe hoặc ghi proxy. Khi cài đặt chế độ Picture
Cache Rec thành On, các chế độ ghi đặc biệt khác buộc phải chuyển thành Off.

Không thể chọn chế độ ghi ảnh vào bộ nhớ Picture Cache Rec trong khi đang trong quá trình ghi hoặc quá trình xem lại bản ghi
Rec Review.

Khi cài đặt chế độ Picture Cache Rec thành On, mã thời gian sẽ được ghi ở chế độ [Free Run] nếu được đặt thành [Regen] hoặc
[Rec Run].

Có thể không cấu hình được cài đặt [Output Format] ở chế độ Picture Cache Rec. Nếu xảy ra việc này, tạm thời cài đặt Picture
Cache Rec thành Off, sau đó hãy thay đổi thông tin cài đặt.

Gợi ý

Thời gian lưu bộ nhớ đệm có thể ngắn hơn, tùy thuộc vào định dạng ghi. Kiểm tra thời gian hiển thị trong [Project] > [Picture
Cache Rec] > [Cache Rec Time] trong menu web.

Bạn cũng có thể đặt bằng cách sử dụng [Project] > [Picture Cache Rec] trong menu camera.

Bạn cũng có thể chuyển đổi [Picture Cache Rec] giữa On và Off bằng nút có thể gán.

Bắt đầu Picture Cache Rec

Khi [Picture Cache Rec] được đặt thành On, “●Cache” (● màu xanh) sẽ xuất hiện.
Khi nhấn nút START/STOP ghi, quá trình ghi bắt đầu và video được ghi vào thẻ nhớ bắt đầu từ video được lưu trong bộ
nhớ đệm.

Chú ý

Thao tác thay đổi định dạng ghi hoặc giao diện cơ bản sẽ xóa sạch video trong bộ nhớ đệm đã được lưu trữ cho đến thời điểm
đó và bắt đầu lưu video mới vào bộ nhớ đệm. Kết quả là, không thể thực hiện ghi ảnh vào bộ nhớ đệm trước khi thay đổi định
dạng, ngay cả khi bạn bắt đầu ghi ngay sau khi thay đổi định dạng.

Cài đặt [Cache Size] Thời gian lưu bộ nhớ đệm (gần đúng)

[Short] 5 giây

[Medium] 10 giây

[Long] 20 giây

[Max] Giá trị tối đa cho mỗi định dạng ghi
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Nếu chế độ Picture Cache Rec được cài đặt thành On hoặc Off ngay sau khi lắp thẻ nhớ, có thể sẽ không ghi được dữ liệu bộ
nhớ đệm vào thẻ.

Video được lưu trữ trong bộ nhớ đệm khi chức năng Picture Cache Rec được đặt thành On. Video trước khi chức năng này
được cài đặt thành On sẽ không được lưu vào bộ nhớ đệm.

Video sẽ không được lưu trữ vào bộ nhớ đệm trong khi đang truy cập thẻ nhớ, chẳng hạn như trong quá trình phát lại, xem lại
bản ghi Rec Review, hoặc hiển thị màn thumbnail. Không thể thực hiện chức năng ghi ảnh vào bộ nhớ đệm Picture cache
recording cho video trong khoảng thời gian đó.

Hủy chế độ Picture Cache Rec

Đặt [Project] > [Picture Cache Rec] > [Setting] thành [Off] trong menu web hoặc ấn vào nút có thể gán đã được gán với
chức năng [Picture Cache Rec].

5-041-959-03(1) Copyright 2022 Sony Corporation
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Ghi đồng thời vào các thẻ nhớ A và B (2-slot Simul Rec)

Bạn có thể ghi đồng thời vào cả hai thẻ nhớ A và thẻ nhớ B bằng cách cài đặt [Project] > [Simul Rec] > [Setting] thành
[On] menu web hoặc menu camera.

Ghi riêng vào thẻ nhớ A và thẻ nhớ B

Bạn có thể bắt đầu/dừng ghi vào mỗi thẻ nhớ một cách độc lập bằng cách sử dụng nút START/STOP ghi hoặc nút [2nd
Rec START/STOP] trên thẻ  (Others).
Theo chế độ mặc định của nhà sản xuất, cả hai nút được cài đặt thành bắt đầu/dừng ghi đồng thời vào cả hai thẻ nhớ A
và B.
Khi các nút này được cài đặt để điều khiển quá trình ghi cho các thẻ nhớ khác nhau, chức năng điều khiển bắt đầu/dừng
ghi [SDI/HDMI Rec Control] sẽ tuân theo trạng thái ghi của khe cắm A.

Thay đổi thông tin cài đặt

Đặt các chức năng sau bằng cách sử dụng [Project] > [Simul Rec] > [Rec Button Set] trong menu camera.

5-041-959-03(1) Copyright 2022 Sony Corporation

Cài đặt [Rec Button
Set] Các nút và thẻ nhớ

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:<Slot
A> <Slot B>

Bắt đầu/dừng ghi đồng thời vào các thẻ nhớ A và B bằng cách sử dụng một trong hai nút.

Rec Button:<Slot A>
2nd Rec Button:<Slot
B>

Nút START/STOP ghi sẽ bắt đầu/dừng quá trình ghi vào thẻ nhớ A và nút [2nd Rec
START/STOP] trên thẻ  (Others) sẽ bắt đầu/dừng quá trình ghi vào thẻ nhớ B.

Rec Button:<Slot B>
2nd Rec Button:<Slot
A>

Nút START/STOP ghi sẽ bắt đầu/dừng quá trình ghi vào thẻ nhớ B và nút [2nd Rec
START/STOP] trên thẻ  (Others) sẽ bắt đầu/dừng quá trình ghi vào thẻ nhớ A.
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Màn hình giám sát tín hiệu video

Bạn có thể cài đặt loại tín hiệu video sẽ hiển thị trên bảng điều khiển hình ảnh máy quay thành dạng sóng, vectơ hoặc
biểu đồ bằng cách sử dụng [Monitoring] > [Video Signal Monitor] > [Setting] trong menu camera.
Dòng màu cam cho biết các giá trị đã đặt của [Level Marker 1] và [Level Marker 2].
Bạn cũng có thể gán chức năng [Video Signal Monitor] cho nút thể gán.

Giám sát hiển thị mục tiêu
Ở các hế độ chụp Log, thông tin cài đặt gam màu hoặc cài đặt LUT của màn hình giám sát được hiển thị ở trên cùng
bên phải của màn hình giám sát tín hiệu video để chỉ báo mục tiêu giám sát.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Cờ của clip

Bạn có thể thêm cờ của clip [OK] cho một clip bằng cách nhấn nút có thể chỉ định được chỉ định với chức năng [Clip Flag
OK] và chọn [Add OK].
Bạn có thể xóa cờ của clip [OK] bằng cách nhấn nút này hai lần rồi chọn [Delete Clip Flag].

Gợi ý

Bạn cũng có thể thêm cờ của clip bằng cách sử dụng [Thumbnail] > [Set Clip Flag] trong menu camera.

Màn hình ảnh thu nhỏ có thể được hiển thị và sắp xếp theo loại cờ của clip (màn hình ảnh thu nhỏ clip đã lọc). Để biết thêm
thông tin chi tiết, hãy tham khảo “Thao tác trên clip đã ghi” trong “Màn hình ảnh thu nhỏ.”

Chủ đề liên quan

Thao tác trên clip đã ghi

5-041-959-03(1) Copyright 2022 Sony Corporation
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Bù góc nhìn

Bạn có thể thực hiện bù góc nhìn cho ống kính bằng cách sử dụng [Technical] > [Lens] > [Breathing Compensation]
trong menu camera.
Chức năng này khắc phục hiện tượng thay đổi góc nhìn khi vị trí lấy nét thay đổi.
Khi thực hiện chức năng bù góc nhìn, một phần hình ảnh sẽ được cắt bằng điện tử để duy trì góc nhìn không đổi nên
hiện tượng nhòe không xuất hiện.

Chú ý

Khi bật tính năng bù góc nhìn, góc nhìn và chất lượng hình ảnh có thể thay đổi một chút.

Tùy thuộc vào ống kính, có thể không điều chỉnh được sự thay đổi trong góc nhìn khi bật chế độ bù góc nhìn.

Không thể bù khi gắn ống kính không hỗ trợ bù góc nhìn.

Chức năng này được đặt thành Off (cố định) trong các trường hợp sau.

Khi [Technical] > [Lens] > [Distortion Comp.] được đặt thành [Off] trong menu camera
Khi [Shooting] > [S&Q Motion] > [Setting] được đặt thành [On] trong menu web hoặc menu camera
Khi [Project] > [Rec Format] > [Codec] được đặt thành [RAW] hoặc [RAW & XAVC-I] trong menu web hoặc menu camera

5-041-959-03(1) Copyright 2022 Sony Corporation
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Tổng quan ghi proxy

Chức năng này cho phép bạn ghi đồng thời dữ liệu proxy có độ phân giải thấp cùng lúc với việc ghi video dữ liệu gốc có
độ phân giải cao.

Để biết thêm thông tin chi tiết về các thẻ nhớ được hỗ trợ, định dạng các thẻ nhớ và kiểm tra dung lượng còn lại, hãy
tham khảo “Thẻ nhớ được hỗ trợ” trong “Chuẩn bị thẻ nhớ.”

Giới thiệu về tệp đã ghi
Có phần mở rộng của tên tệp là “.mp4”.
Timecode cũng được ghi đồng thời.

Đích lưu trữ của tệp đã ghi
Tệp đã ghi được lưu trữ trong thư mục sau.

Giới thiệu về tên tệp
Tên tệp gồm có tên clip đã ghi trên thẻ nhớ và hậu tố “S03”.
Để biết thêm thông tin chi tiết về tên clip, hãy tham khảo [TC/Media] > [Clip Name Format] trong menu máy quay.

Chủ đề liên quan

Thẻ nhớ được hỗ trợ

5-041-959-03(1) Copyright 2022 Sony Corporation

Phương tiện ghi Đường dẫn thư mục

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Ghi proxy

Bạn có thể bắt đầu ghi khi bật tính năng ghi proxy.

Cách dừng ghi hình
Dừng quá trình ghi hình.

Cách đặt kênh âm thanh để ghi proxy
Đặt kênh âm thanh để ghi dữ liệu proxy bằng cách sử dụng [Project] > [Proxy Rec] > [Audio Channel] trong menu
camera.

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt [Project] > [Proxy Rec] > [Setting] thành [On] trong menu web hoặc menu camera.1

Cắm thẻ nhớ vào khe cắm thẻ CFexpress Type A / SD.

Đối với thẻ CFexpress, hãy cắm với nhãn hướng lên trên.
Đối với thẻ SD, hãy cắm với nhãn hướng xuống dưới.

Chú ý

Không thể cài đặt Proxy Rec thành On cùng lúc với chế độ S&Q Motion hoặc Interval Rec. Khi Proxy Rec được đặt thành
On, các chế độ ghi khác này bắt buộc phải được đặt thành Off.

2

Nhấn nút START/STOP ghi.

Bắt đầu ghi proxy.

Chú ý

Nếu thiết bị đã bị tắt hoặc rút thẻ nhớ trong khi đang truy cập thẻ nhớ thì sẽ không bảo đảm được tính toàn vẹn của dữ liệu
trên thẻ.
Tất cả dữ liệu được ghi trên thẻ nhớ có thể bị xóa bỏ. Luôn phải bảo đảm chỉ báo truy cập thẻ nhớ là tắt trước khi tắt thiết
bị hoặc tháo thẻ nhớ.

Đảm bảo rằng thẻ nhớ không bị bung ra khi cắm hoặc tháo.

3
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Tổng quan giao diện

Khi thiết bị ở chế độ Custom, bạn có thể thêm các tùy chỉnh cho màu đen, ma trận và các tham số khác để tạo “giao
diện” dựa trên giao diện cơ sở.

Bạn cũng có thể nhanh chóng chọn một giao diện khác bằng cách lưu các tổ hợp cài đặt khác nhau trong các tệp cảnh
quay.
Thiết bị được cung cấp với tổng cộng bảy giao diện thiết lập sẵn.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Chọn giao diện

Chủ đề này mô tả cách chọn một giao diện.

Kiểm tra liệu [Project] > [Base Setting] > [Shooting Mode] đã được đặt thành [Custom] trong menu web
hoặc menu camera.

Gợi ý

Trong chế độ [Custom], nút [ISO/Gain] và nút [Scene File] được hiển thị trong bảng cấu hình cơ bản của máy quay.

1

Ấn nút [Scene File] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [Scene File] chuyển thành màu cam.

Bảng điều chỉnh Scene File xuất hiện.

2

Ấn nút [Scene File] trên bảng điều chỉnh và chọn tệp cảnh quay với giao diện mong muốn từ danh sách.

Các thiết lập sẵn sau đây được cấu hình theo mặc định của nhà sản xuất.

Gợi ý

Bạn cũng có thể chọn giao diện bằng cách sử dụng [Paint/Look] > [Scene File] > [Recall] trong menu camera. Bạn cũng có
thể gọi lại một giao diện đặt trước bằng cách sử dụng [Scene File] > [Preset Recall].

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Tệp cảnh quay 1 [S-Cinetone] [HLG Live]

Tệp cảnh quay 2 [Standard] [HLG Natural]

Tệp cảnh quay 3 [Still] (Chưa đăng ký)

Tệp cảnh quay 4 [ITU709] (Chưa đăng ký)

Tệp cảnh quay 5 [709tone] (Chưa đăng ký)

Tệp cảnh quay 6 đến 16 (Chưa đăng ký) (Chưa đăng ký)
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Chú ý

Đặt trước tệp cảnh 5 được đặt thành [709tone] với phiên bản phần mềm 2.0 trở lên. Cài đặt trước được hiển thị khi
[Maintenance]> [Reset] > [Factory Default] trong menu web được thực thi.
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Nhập giao diện cơ bản mong muốn

Bạn có thể nhập tệp 3D LUT, được tạo trên máy tính hoặc thiết bị khác, làm giao diện cơ bản. Có thể nhập tối đa 16 tệp.
Định dạng tệp: Tệp CUBE (*.cube) cho 3D LUT 17 ô hoặc 33 ô được tạo ra bằng cách sử dụng Catalyst Browse, RAW
Viewer hoặc DaVinci Resolve* (bởi Blackmagic Design Pty. Ltd.).

Gam màu đầu vào/Gamma: [S-Gamut3.Cine/S-Log3] hoặc [S-Gamut3/S-Log3]

Để điều chỉnh thiếu sáng

Đã được xác minh với Resolve V9.0, V10.0 và V11.0.*

Lưu tệp 3D LUT trên thiết bị chạy Ứng dụng Web.1

Đặt [Paint/Look] > [Base Look] trong menu web.

Một danh sách các giao diện cơ bản đã đăng ký xuất hiện.

2

Ấn nút [Import] trong hàng mà bạn muốn nhập tệp.

Hộp thoại chọn tệp xuất hiện.

3

Chọn tệp 3D LUT đã chuẩn bị.

Tệp 3D LUT được nhập sẽ trở thành giao diện cơ bản của thiết bị.

4

Chọn tệp LUT 3D đã nhập bằng cách sử dụng [Paint/Look] > [Base Look] > [Select] trong menu camera.5

Cấu hình [Paint/Look] > [Base Look] > [Input] và [Output] trong menu camera để khớp với các thuộc tính
của tệp LUT 3D đã nhập.

6
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Nếu có xu hướng thiếu sáng khi chọn phơi sáng tự động khi sử dụng giao diện cơ bản đã nhập, hãy điều chỉnh giao diện
bằng cách sử dụng [Paint/Look] > [Base Look] > [AE Level Offset] trong menu web.

Chú ý

Chỉ nhập tệp 3D LUT không ảnh hưởng đến hình ảnh. Tải tệp LUT 3D đã nhập bằng cách sử dụng [Paint/Look] > [Base Look] >
[Select] trong menu camera.

Nếu [Input] không được đặt chính xác, sẽ không có được giao diện phù hợp.

Cài đặt mục menu [Input], [Output] và [AE Level Offset] được áp dụng cho giao diện cơ sở đã chọn bằng cách sử dụng [Select].
Nếu nhập nhiều tệp 3D LUT, hãy chọn từng tệp 3D LUT bằng cách sử dụng [Select] và cấu hình [Input], [Output] và [AE Level
Offset] cho từng tệp.

Các cài đặt [Input], [Output] và [AE Level Offset] đã được định cấu hình được lưu cho mỗi tệp LUT 3D.

Các tùy chọn lựa chọn giao diện cơ bản/LUT cho các tệp 3D LUT được nhập phổ biến đối với các chế độ [SDR(BT.709)],
[HDR(HLG)] và chụp Log, nhưng chuyển đổi gam màu và gamma không được thực hiện theo các chế độ này.

Không xóa được các tệp 3D LUT khi [Maintenance] > [Reset] > [All Reset (except for Network Settings)] được thực hiện trên
menu web.

 (Lỗi đính kèm tệp 3D LUT) được hiển thị trước màn hình [Base Look Name] cho biết rằng không thể đính kèm các tệp 3D LUT
vào clip đã được ghi bằng các chế độ chụp Log. Nhập lại tệp 3D LUT.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Tùy chỉnh giao diện

Bạn có thể tùy chỉnh giao diện dựa trên giao diện cơ sở bằng cách sử dụng thanh trượt [Master Black], [R Black] và [B
Black] trong bảng điều chỉnh Scene File trong khiển cấu hình cơ bản của máy quay và [Paint/Look] > [Matrix] và các mục
thiết lập khác trong menu camera.
Kết nối thiết bị với TV hoặc màn hình giám sát, sau đó điều chỉnh chất lượng hình ảnh trong khi quan sát hình ảnh trên
màn hình TV hoặc màn hình giám sát.

1: thanh trượt/nút điều chỉnh [R Black]
2: thanh trượt/nút điều chỉnh [B Black]
3: thanh trượt/nút điều chỉnh [Master Black]

Chú ý

Khi bạn nhập một tệp LUT 3D và áp dụng nó cho hình ảnh, bạn không thể thu được giao diện mong muốn được xác định trong
tệp LUT 3D nếu [Paint/Look] > [Matrix] và các cài đặt ngoài cài đặt giao diện cơ sở trong menu camera đã thay đổi.

Bạn cũng có thể đặt lại tất cả cài đặt tùy chỉnh bằng cách sử dụng [Paint/Look] > [Reset Paint Settings] > [Reset without Base
Look] trong menu camera.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Lưu giao diện

Bạn có thể lưu giao diện hiện tại dưới dạng tệp cảnh quay trong bộ nhớ trong bằng cách sử dụng [Paint/Look] > [Scene
File] > [Store] trong menu camera.
Bạn có thể nhanh chóng nhớ lại giao diện hiện lưu bằng cách sử dụng bảng điều chỉnh Scene File hoặc sử dụng các
thao tác menu trực tiếp.

Chú ý

Nếu bạn chọn một giao diện khác mà không lưu giao diện hiện tại, giao diện hiện tại sẽ bị loại bỏ.

Gợi ý

Bạn có thể ghi đè lên các tệp cảnh quay được đặt trước. Để khôi phục tệp cảnh quay được đặt trước, hãy tải giao diện cần khôi
phục bằng cách sử dụng [Paint/Look] > [Scene File] > [Preset Recall] trong menu camera, sau đó lưu tệp cảnh quay bằng [Scene
File] > [Store].

Để xóa giao diện đã lưu
Bạn có thể xóa tệp cảnh quay được lưu trong bộ nhớ trong bằng cách sử dụng [Paint/Look] > [Scene File] > [Delete]
trong menu camera.

Gợi ý

Khi đã xóa, tệp không còn hiển thị trong bảng điều chỉnh Scene File hoặc menu trực tiếp.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Xóa giao diện cơ bản

Bạn có thể xóa từng tệp LUT 3D đã nhập bằng cách sử dụng [Paint/Look] > [Base Look] > [Delete] trong menu camera.
Bạn có thể xóa các tệp LUT 3D đã nhập bằng cách sử dụng [Paint/Look] > [Base Look] > [Delete All] trong menu
camera.

Chú ý

Trước khi xóa, hãy kiểm tra xem giao diện cơ bản không được sử dụng trong bất kỳ tệp cảnh quay nào. Nếu một giao diện cơ
bản đang được sử dụng bị xóa, giao diện của các tệp cảnh quay tương ứng sẽ không chính xác.

Không xóa được các tệp LUT 3D đã nhập khi [Maintenance] > [Reset] > [All Reset (except for Network Settings)] được thực hiện
trên menu web.

Giao diện cơ bản đã xóa không còn có thể được sử dụng làm LUT ở chế độ chụp Log.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Chụp với điều chỉnh dáng vẻ trong hậu kỳ

Bằng cách sử dụng thiết bị ở chế độ chụp Log*1 và ghi lại sự chuyển màu đồng đều từ vùng tối đến vùng sáng, bạn có
thể thực hiện tinh chỉnh, chẳng hạn như khôi phục cục bộ chuyển màu của vùng tối và vùng sáng trong hậu kỳ.
Tuy nhiên, khi xem các hình ảnh đã ghi trên một màn hình thông thường, độ tương phản tổng thể sẽ có vẻ thấp, gây khó
khăn cho việc điều chỉnh lấy nét và phơi sáng.
Bạn có thể áp dụng LUT cho mục tiêu màn hình trên thiết bị để hỗ trợ các điều chỉnh khác nhau trong khi chụp. Bạn
cũng có thể áp dụng LUT đã sử dụng khi chụp tự động sau khi phát lại để kiểm tra nhanh kết quả hoàn thiện.
LUT được áp dụng bởi các hệ thống sau. Tuy nhiên, chỉ có thể áp dụng một LUT.

Đầu ra SDI
Đầu ra HDMI và phát trực tiếp
Đoạn proxy được ghi trên phương tiện ghi
Clip độ phân giải cao (chính) được ghi trên phương tiện ghi

5-041-959-03(1) Copyright 2022 Sony Corporation

Thuật ngữ chung cho chế độ Flexible ISO/chế độ Cine EI/chế độ Cine EI Quick*1
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Áp dụng LUT cho đầu ra HDMI và phát trực tiếp

Bạn có thể áp dụng LUT cho đầu ra HDMI và phát trực tiếp.

Chú ý

Hình ảnh phát trực tiếp cũng chứa hình ảnh trong bảng điều khiển hình ảnh máy quay của Ứng dụng web.

Gợi ý

Bạn cũng có thể đặt bằng cách sử dụng [Shooting] > [LUT On/Off] > [HDMI/Stream] trong menu camera.

Đầu ra SDI có thể được đặt theo cách tương tự.

Đối với video trên phương tiện ghi, bạn có thể đặt tính năng này bằng cách sử dụng [Shooting] > [LUT On/Off] > [Internal Rec] và
[Proxy] trong menu camera.

 (Lỗi đính kèm tệp 3D LUT) được hiển thị trước màn hình [Base Look/LUT] cho biết rằng không thể đính kèm các tệp 3D LUT
vào clip đã được ghi bằng các chế độ chụp Log. Nhập lại tệp 3D LUT.
Biểu tượng này cũng được hiển thị khi tệp đính kèm không thành công do tắc nghẽn xử lý tạm thời.

Kiểm tra liệu [Project] > [Base Setting] > [Shooting Mode] đã được đặt thành [Flexible ISO], [Cine EI] hoặc
[Cine EI Quick] trong menu web hoặc menu camera chưa.

Gợi ý

Trong các chế độ chụp Log, nút [Base ISO/Exposure Index] và nút [Base Look/LUT] được hiển thị trong bảng cấu hình cơ
bản của máy quay.

1

Ấn nút [Base Look/LUT] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [Base Look/LUT] chuyển thành màu cam.

Bảng điều chỉnh Base Look/LUT xuất hiện.

2

Chọn [HDMI/Stream] > [MLUT].3
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Thay đổi LUT

Bạn có thể thay đổi LUT để áp dụng.

Gợi ý

Thiết bị cung cấp [s709], [709(800%)] và [S-Log3] dưới dạng các LUT đặt trước.

Bạn cũng có thể nhập và áp dụng một tệp LUT 3D. Để biết thêm thông tin chi tiết, hãy tham khảo “Nhập giao diện cơ bản mong
muốn” và “Xóa giao diện cơ bản.”

Bạn cũng có thể đặt bằng cách sử dụng [Paint/Look] > [Base Look] > [Select] trong menu camera.

Chủ đề liên quan
Nhập giao diện cơ bản mong muốn

Xóa giao diện cơ bản

5-041-959-03(1) Copyright 2022 Sony Corporation

Ấn nút [Base Look/LUT] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [Base Look/LUT] chuyển thành màu cam.

Bảng điều chỉnh Base Look/LUT xuất hiện.

1

Ấn nút [Base Look/LUT] và chọn giao diện cơ sở để áp dụng.2
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Thay đổi sự phân bố các vùng sáng và tối trong hình ảnh đã ghi

Trong chế độ chụp Cine EI và Cine EI Quick bạn có thể thay đổi sự phân bố của vùng tối và vùng sáng, chẳng hạn, nếu
bạn muốn ưu tiên tông màu của vùng tối hơn vùng sáng, bằng cách thay đổi Exposure Index từ độ nhạy cơ sở.

Ấn nút [Base Look/LUT] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [Base Look/LUT] chuyển thành màu cam.

Bảng điều chỉnh Base Look/LUT xuất hiện.

1

Chọn [HDMI/Stream] > [MLUT].

Một LUT được áp dụng cho đầu ra HDMI và phát trực tiếp.

2

Ấn nút [Base ISO/Exposure Index] trong bảng cấu hình cơ bản của máy quay.

Khung của nút [Base ISO/Exposure Index] chuyển thành màu cam.

Bảng điều chỉnh Base ISO/Exposure Index xuất hiện.

3

Điều chỉnh chỉ số phơi sáng theo sự phân bố mong muốn của vùng tối và vùng sáng bằng cách sử dụng
thanh trượt [Exposure Index] hoặc các nút điều chỉnh [Exposure Index].

Đối với [Cine EI]

Đối với [Cine EI Quick]
Độ nhạy cơ bản được đặt tự động theo chỉ số phơi sáng được chỉ định.

4
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Gợi ý

Bạn cũng có thể đặt bằng cách sử dụng [Shooting] > [ISO/Gain/EI] > [Exposure Index] trong menu camera.

Có thể sử dụng đầu ra SDI có theo cách tương tự.

Giá trị số thứ hai của cài đặt cho biết có bao nhiêu bước thông tin độ sáng được chỉ định cho các vùng sáng (độ sáng cao hơn
18% màu xám). Những vùng sáng hơn những vùng này bị phơi sáng quá mức.
Ví dụ: Trong “400EI/5.0E”, các bước 5.0 được chỉ định ở phía sáng.

Bạn cũng có thể sử dụng điều này làm hướng dẫn để kiểm tra tông màu của vùng tối và vùng sáng trong khi chụp. Đừng quên
quay lại giá trị EI ban đầu sau khi kiểm tra độ phơi sáng. Ngoài ra, trong chế độ Cine EI Quick này, hãy cẩn thận để không ảnh
hưởng xấu đến độ nhạy cơ sở.

5-041-959-03(1) Copyright 2022 Sony Corporation

Điều chỉnh ánh sáng và/hoặc bộ lọc ND để hình ảnh máy quay xuất ra từ [HDMI/Stream] có độ phơi sáng
thích hợp.

5
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Ghi video RAW

Bạn có thể ghi đầu ra tín hiệu video RAW từ đầu nối SDI OUT của thiết bị vào đầu ghi bên ngoài được hỗ trợ.
Các định dạng đầu ra RAW được hỗ trợ được liệt kê dưới đây.

Tần số hệ thống [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Kết nối thiết bị ghi RAW bên ngoài với đầu nối SDI OUT của thiết bị.1

Đặt [Project] > [Base Setting] > [Shooting Mode] thành [Cine EI], [Cine EI Quick] hoặc [Flexible ISO] trong
menu web hoặc menu camera.

2

Đặt định góc xem của (FF chỉ) bằng cách sử dụng [Project] > [Rec Format] > [Imager Scan Mode] trong
menu web hoặc menu camera.

3

Đặt [Project] > [Rec Format] > [Codec] thành [RAW] trong menu web hoặc menu camera.

Chọn [RAW & XAVC-I] sẽ đồng thời ghi video vào thiết bị ghi RAW bên ngoài và video vào thẻ nhớ trong thiết bị.

4

Đặt độ phân giải bằng cách sử dụng [Project] > [Rec Format] > [RAW Output Format] trong menu web hoặc
menu camera.

5

Kiểm tra xem đã bật thiết bị ghi bên ngoài chưa, sau đó nhấn nút START/STOP ghi trên màn hình hoạt động
trực tiếp.

Trạng thái quay video RAW được biểu thị bằng một biểu tượng trong bảng điều khiển hình ảnh máy quay.

6
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Chú ý

Khi bắt đầu quá trình ghi trên thiết bị ghi bên ngoài mà không sử dụng nút START/STOP trên màn hình hoạt động trực tiếp thì
các clip có thể không được ghi đúng cách.

5-041-959-03(1) Copyright 2022 Sony Corporation

Chú ý

Tín hiệu kiểm soát ghi phát ra từ đầu nối SDI OUT của thiết bị, nhưng không thể biết được tình trạng của thiết bị ghi bên
ngoài. Theo đó, thiết bị có thể chỉ báo đang trong quá trình ghi video RAW khi thiết bị ghi bên ngoài đang không thực sự
ghi. Kiểm tra chỉ báo trên thiết bị ghi bên ngoài để biết được tình trạng hoạt động chính xác.
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Ghi video RAW ở chế độ Slow & Quick Motion

Bạn có thể ghi video RAW ở chế độ Slow & Quick Motion.

Để biết thêm thông tin chi tiết về tốc độ khung hình được hỗ trợ ghi, hãy tham khảo “Chuyển động nhanh và chậm.”

Chủ đề liên quan

Chuyển động nhanh và chậm

5-041-959-03(1) Copyright 2022 Sony Corporation
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Bật/tắt chức năng điều khiển cửa điều sáng

Bạn có thể dễ dàng điều chỉnh mức độ bokeh bằng cách liên kết bộ lọc ND và độ lợi với hoạt động của cửa điều sáng.

Bật/tắt chức năng điều khiển cửa điều sáng

Chỉ có thể bật chức năng này khi điều chỉnh phơi sáng theo cách thủ công. Đặt bộ lọc ND thành chế độ biến đổi, sau đó
đặt cửa điều sáng, độ lợi, màn trập và bộ lọc ND thành điều chỉnh thủ công.
Bạn có thể bật/tắt chức năng điều khiển bokeh bằng cách sử dụng [Shooting] > [Iris] > [Bokeh Control] trong menu
camera.
Khi chức năng điều khiển hiệu ứng bokeh được đặt thành On, biểu tượng  (B) sẽ hiển thị trên bộ lọc ND và các chỉ
báo thu được.

Chú ý

Chức năng này chỉ được bật trên các ống kính ngàm E có thể giao tiếp với thiết bị.

Hiệu quả tối đa của chức năng này có thể đạt được khi sử dụng ống kính ngàm E của Sony.

Chức năng điều khiển bokeh được đặt thành Off khi thực hiện bất kỳ vận hành nào sau đây.

Khi thiết bị được tắt
Khi bất kỳ cửa điều sáng, độ lợi, màn trập hoặc bộ lọc ND nào được đặt thành Auto
Khi chế độ chụp được chuyển
Khi bộ lọc ND được đặt ở chế độ xóa hoặc đặt trước
Khi ống kính được tháo ra
Ví dụ: khi thiết bị khởi động lại sau khi chuyển đổi tần số

Gợi ý

Bạn cũng có thể gán chức năng [Bokeh Control] cho một nút có thể gán và chuyển chức năng điều khiển bokeh giữa On và Off
bằng nút này.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Điều chỉnh mức độ bokeh

Điều chỉnh cài đặt trong các bước từ 2 đến 4 như được yêu cầu.

Chú ý

Hình thức có thể khác nhau tùy thuộc vào tốc độ hoạt động, ống kính, cài đặt chụp và đối tượng, đồng thời độ sáng cũng có thể
thay đổi. Nên kiểm tra camera trước khi chụp.

Độ sáng có thể thay đổi khi hướng hoạt động của cửa điều sáng thay đổi, chẳng hạn như khi mở cửa điều sáng sau khi đóng
hoặc khi đóng cửa điều sáng sau khi mở. Trong trường hợp này, hãy điều chỉnh nhiều hơn một chút so với yêu cầu trước đó, sau
đó sao lưu một chút, kiểm tra độ sáng rồi bắt đầu chụp. Ví dụ: nếu bạn muốn mở cửa điều sáng đến khẩu độ F8 và làm mờ hậu
cảnh, trước tiên hãy đóng khẩu độ qua F8 rồi quay lại F8, kiểm tra độ sáng và bắt đầu chụp.

Thực hiện các thao tác điều khiển bokeh một cách chậm rãi. Nếu bạn cần tăng tốc hoạt động, hãy thử điều chỉnh dần dần trong
khi kiểm tra các thay đổi đối với hình ảnh.

Gợi ý

Khi chức năng điều khiển bokeh được đặt thành On, bộ lọc ND và độ lợi hoạt động cùng nhau để bù đắp những thay đổi về độ
phơi sáng do điều chỉnh cửa điều sáng, cho phép bạn thay đổi mức độ bokeh.

Điều khiển bokeh trước tiên được liên kết với bộ lọc ND để phản ứng với hoạt động của cửa điều sáng. Khi bộ lọc ND không thể
thay đổi được nữa, độ lợi được liên kết.

Ở chế độ MF, trước tiên bạn nên mở cửa điều sáng và sau đó điều chỉnh tiêu điểm.

Nếu bạn sử dụng bộ lọc ND tự động thay vì chức năng điều khiển bokeh, bộ lọc ND sẽ tuân theo sự thay đổi độ sáng của đối
tượng.

Màn hình hiển thị trong quá trình hoạt động liên kết độ lợi
Khi chức năng điều khiển bokeh được đặt thành On, độ lợi có thể thay đổi khi cửa điều sáng được điều chỉnh.
Khi liên kết độ lợi đang hoạt động và độ lợi thay đổi, một thông báo sẽ xuất hiện ở đầu màn hình và biểu tượng  (B)
trên chỉ báo độ lợi sẽ nhấp nháy.

Đặt chức năng điều khiển bokeh thành On.1

Mở hoàn toàn cửa điều sáng.2

Đặt bộ lọc ND thành 1/128.3

Đặt độ lợi thành 0 dB và sử dụng ánh sáng để có độ phơi sáng chính xác.4

Điều chỉnh lấy nét.5

Điều chỉnh cửa điều sáng.

Mức độ bokeh thay đổi.

6
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Tổng quan lưu và tải dữ liệu cấu hình

Bạn có thể lưu cài đặt của thiết bị này dưới dạng dữ liệu cấu hình bằng ứng dụng web. Điều này cho phép bạn nhanh
chóng gọi lại một bộ cài đặt menu phù hợp cho tình huống hiện tại.
Với thiết bị này, bạn có thể lưu gần như toàn bộ các cài đặt liên quan đến các chức năng của máy quay, ngoài ghi chú
sau, dưới dạng tệp ALL (tệp chứa tất cả cài đặt).

Chú ý

Cài đặt chức năng mạng và thông tin xác thực không được lưu. Để biết thêm thông tin chi tiết về các mục đã lưu, hãy tham khảo
“Danh sách mục menu.”

Chủ đề liên quan

Danh sách mục menu

5-041-959-03(1) Copyright 2022 Sony Corporation
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Lưu một tệp ALL

Chủ đề này mô tả cách lưu một tệp ALL.
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Đặt [Project] > [All File] trong menu web.1

Ấn nút [Save All File] > [Save].

Trình duyệt web sẽ tải xuống một tệp có tên all-file.ALL trong giây lát.

2

Chỉ định vị trí và tên tệp cho tệp all-file.ALL đã tải xuống và lưu tệp.

Để biết chi tiết về hoạt động vận hành tệp, hãy tham khảo hướng dẫn vận hành của thiết bị.

3
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Tải một tệp ALL

Chủ đề này mô tả cách tải một tệp ALL.

Chú ý

Thiết bị sẽ tự khởi động sau khi tải dữ liệu cấu hình. Sau khi khởi động lại, hãy tải lại trang trên trình duyệt web.
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Đặt [Project] > [All File] trong menu web.1

Ấn nút [Load All File] > [Load].

Hộp thoại mở tệp xuất hiện trên thiết bị chạy Ứng dụng Web.

2

Mở tệp bạn muốn tải.

Để biết chi tiết về hoạt động vận hành tệp, hãy tham khảo hướng dẫn vận hành của thiết bị.

3

Khi màn hình xác nhận tên tệp tải xuất hiện, nhấn nút [OK].4

Khi màn hình kết quả thực hiện xuất hiện, nhấn nút [OK].5

Chờ thiết bị khởi động lại, sau đó kết nối lại Ứng dụng Web.6
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Giới thiệu về truyền tệp

Bạn có thể tải tệp proxy hoặc tệp gốc được ghi trên thiết bị lên máy chủ trên Internet hoặc máy chủ trên mạng cục bộ.

Chú ý

Khi nguồn điện được đặt sang trạng thái chờ, quá trình truyền tệp sẽ tạm dừng dù thiết bị vẫn được cấp điện.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Đăng ký đích truyền tệp

Bạn có thể đăng ký một máy chủ đích truyền trước khi bắt đầu truyền tệp.

Đặt [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (hoặc [Server Settings2],
[Server Settings3]) trong menu web.

Gợi ý

Tên của tùy chọn lựa chọn sẽ thay đổi theo [Display Name] được định cấu hình trong bước tiếp theo.

1

Định cấu hình các mục sau để [Network] > [FTP Server 1] thành [FTP Server 3] trong menu web.

[Display Name]
Nhập tên của máy chủ để hiển thị trong danh sách công việc truyền khi chọn một máy chủ đích truyền.
[Service]
Hiển thị loại máy chủ.
[FTP]: Máy chủ FTP
[Host Name]
Nhập địa chỉ hoặc tên máy chủ lưu trữ của máy chủ.
[Port]
Nhập số cổng của máy chủ để kết nối.
[User Name]
Nhập tên người dùng.
[Password]
Nhập mật khẩu.
[Passive Mode]
Bật/Tắt chế độ thụ động.
[Destination Directory]
Nhập tên của thư mục trên máy chủ đích.

Chú ý

Nếu các ký tự không hợp lệ trên máy chủ đích được nhập vào [Destination Directory], các tệp sẽ được truyền vào thư mục
chính của người dùng. Các ký tự không hợp lệ sẽ khác biệt tùy thuộc vào máy chủ.

[Using Secure Protocol]
Đặt có thực hiện truyền FTP an toàn hay không.
[Root Certificate]
Tải/Xóa chứng chỉ.
[Load]: Tải chứng chỉ CA. Tải chứng chỉ định dạng PEM.
[Clear]: Xóa chứng chỉ CA.
[None]: Không tải hay xóa chứng chỉ.

Chú ý

Đặt đồng hồ của thiết bị về thời gian chính xác trước khi tải chứng chỉ CA.

Không thể chọn [Load] khi ghi ở XAVC-I 4096×2160P/3840×2160P 59.94/50P.

[Root Certificate Status]: Hiển thị trạng thái tải của chứng chỉ.

2
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[Reset]: Đặt lại cài đặt Server Settings về mặc định.
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Tải lên tệp proxy trên thẻ nhớ từ màn hình ảnh thu nhỏ

Bạn có thể tải lên tệp proxy trên thẻ nhớ một cách riêng lẻ từ màn hình ảnh thu nhỏ.

Chú ý

Có thể đăng ký tối đa 200 lệnh truyền.
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Ấn nút [Thumbnail] trên màn hình vận hành trực tiếp của Ứng dụng web.

Màn hình thay đổi từ hình ảnh máy quay sang màn hình ảnh thu nhỏ.

1

Chọn [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] trong menu camera.

Để truyền đồng thời tất cả tệp proxy, chọn [Transfer Clip (Proxy)] > [All Clips].
Clip có thể được truyền từ màn thumbnail hoặc màn thumbnail clip đã lọc.

2

Chọn clip bạn muốn chuyển bằng cách sử dụng nút [Set], sau đó nhấn nút [Menu].

Màn hình xác nhận truyền sẽ xuất hiện.

3

Chọn [Execute].

Tệp proxy tương ứng với clip đã chọn được đăng ký dưới dạng lệnh truyền và bắt đầu tải lên.
Khi đăng ký thành công lệnh truyền, màn hình kết quả truyền sẽ xuất hiện.

4

Ấn nút [OK].5
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Tải lên tệp gốc trên thẻ nhớ từ màn hình ảnh thu nhỏ

Bạn có thể tải lên tệp gốc trên thẻ nhớ từ màn hình ảnh thu nhỏ.

Chú ý

Có thể đăng ký tối đa 200 lệnh truyền.
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Ấn nút [Thumbnail] trên màn hình vận hành trực tiếp của Ứng dụng web.

Màn hình thay đổi từ hình ảnh máy quay sang màn hình ảnh thu nhỏ.

1

Chọn [Thumbnail] > [Transfer Clip] > [Select Clip] trong menu camera.

Để truyền đồng thời tất cả tệp gốc, chọn [Transfer Clip] > [All Clips].
Clip có thể được truyền từ màn thumbnail hoặc màn thumbnail clip đã lọc.

2

Chọn clip bạn muốn chuyển bằng cách sử dụng nút [Set], sau đó nhấn nút [Menu].

Màn hình xác nhận truyền sẽ xuất hiện.

3

Chọn [Execute].

Tệp gốc của clip đã chọn được đăng ký dưới dạng lệnh truyền và bắt đầu tải lên.
Khi đăng ký thành công lệnh truyền, màn hình kết quả truyền sẽ xuất hiện.

4

Ấn nút [OK].5

266



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kiểm tra quá trình truyền tệp

Bạn có thể kiểm tra trạng thái truyền tệp bằng cách chọn [Network] > [File Transfer] > [View Job List] trong menu
camera.

Chú ý

Có thể đăng ký tối đa 200 lệnh truyền.

Công việc truyền vẫn duy trì khi thiết bị được chuyển sang trạng thái chờ, nhưng trong tối đa 10 phút của quá trình đó thì thông
tin có thể bị mất nếu nguồn điện bị ngắt bởi bất kỳ phương tiện nào.

Nếu có lỗi xảy ra trong quá trình truyền tệp, quá trình truyền clip có cùng tên với clip đã truyền có thể không tiếp tục được tùy
thuộc vào thiết lập và trạng thái máy chủ đích. Trong trường hợp này, hãy kiểm tra thiết lập và trạng thái của máy chủ đích.

Gợi ý

Nếu [Network] > [File Transfer] > [Auto Upload (Proxy)] được đặt thành [On] trong menu camera và có kết nối mạng, các tệp
proxy sẽ tự động được tải lên máy chủ được chỉ định bằng [Default Upload Server] khi quá trình ghi kết thúc.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Tải lên bằng FTP an toàn

Bạn có thể tải lên tệp có mã hóa bằng FTPS ở chế độ Explicit (FTPES) để kết nối với máy chủ tệp đích.
Để truyền FTP an toàn, đặt [Using Secure Protocol] thành [On] trong cài đặt máy chủ tệp đích và tải chứng chỉ.

Để biết chi tiết về cấu hình, hãy xem “Đăng ký đích truyền tệp.”

Chủ đề liên quan
Đăng ký đích truyền tệp

5-041-959-03(1) Copyright 2022 Sony Corporation
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Về phát trực tiếp

Thiết bị có thể phát trực tiếp đồng thời video và âm thanh phát ra từ đầu nối HDMI.

Chú ý

Để sử dụng phát trực tiếp như một video chính, hãy đặt [Monitoring] > [Output Display] > [SDI] thành [On] và [HDMI/Stream]
thành [Off] trong menu web và theo dõi trạng thái máy quay trên màn hình giám sát SDI.

Nếu màn hình HDMI được kết nối không hỗ trợ định dạng đầu ra HDMI được định cấu hình bằng menu [Monitoring] trong menu
web hoặc menu camera, hình ảnh máy quay sẽ không được xuất sang Ứng dụng web. Video phát trực tiếp cũng không thể xuất
ra.

Không thể đặt độ phân giải phát trực tiếp cao hơn độ phân giải tín hiệu đầu ra HDMI.

Khi nhiều người dùng cùng xem, hình ảnh có thể bị biến dạng tùy thuộc vào cài đặt codec.

Thiết bị hỗ trợ các phương pháp phát trực tiếp sau đây. Các bộ giải mã video có thể chọn lựa được nêu trong ngoặc
đơn.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Định cấu hình cài đặt định dạng phát trực tiếp, cài đặt bộ giải mã video và cài đặt bộ giải mã âm thanh theo thứ tự đó.

●: Đã bật, –: Đã tắt

Gợi ý

Hình ảnh trong bảng điều khiển hình ảnh máy quay của Ứng dụng web cũng là hệ thống phát trực tiếp.

Định dạng phát trực tiếp
Cài đặt bộ giải mã

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Ứng dụng web – – ● –

RTMP có thể được chọn khi [Stream] > [Audio Stream] được đặt thành [On] trong menu web.*1

Khi tần số hệ thống là 59.94 hoặc 50 và định dạng đầu ra HDMI là 3840×2160 trở lên, đầu ra video 2 không khả dụng.*2
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Thiết lập định dạng phát trực tuyến

Đặt các chức năng sau bằng cách sử dụng [Stream] > [Stream] > [Stream Setting] > [Setting] trong menu web.

Khi [Setting] được đặt thành [RTSP]

Trong phát trực tuyến RTSP, hình ảnh từ một camera có thể được xem đồng thời bởi tối đa năm người dùng.
Bạn có thể thiết lập hai chế độ codec video.
[Port Number]
Đặt số cổng để sử dụng cho phát trực tuyến RTSP. Giá trị mặc định là 554.
Thay đổi cài đặt sẽ khởi động lại máy chủ RTSP.
[Time Out]
Chỉ định thời gian chờ của lệnh Keep-Alive để phát trực tuyến RTSP. Có thể đặt thời gian chờ trong khoảng 0 giây đến
600 giây. Giá trị mặc định là 60 giây.
Khi được đặt thành 0 giây, thời gian chờ do lệnh Keep-Alive không xảy ra.
[Authentication]
Đặt xem có cần xác thực hay không.
[Video Port Number 1], [Video Port Number 2]
Chỉ định số cổng giao tiếp dữ liệu hình ảnh để sử dụng cho phát trực tuyến unicast RTSP. Giá trị mặc định lý thuyết cho
Video Port Number 1 là 51000. Giá trị mặc định lý thuyết cho Video Port Number 2 là 53000. Chỉ định một số chẵn trong
phạm vi từ 1024 đến 65534. Số được đặt ở đây và số lẻ tiếp theo, thu được bằng cách thêm 1, trở thành hai số cổng
được sử dụng để điều khiển và truyền dữ liệu hình ảnh.
[Video Port Number 1] và [Video Port Number 2] tương ứng với [Stream] > [Video Stream] > [Video Stream 1] và [Video
Stream 2].
[Audio Port Number]
Chỉ định số cổng giao tiếp dữ liệu âm thanh được sử dụng cho phát trực tuyến unicast RTSP. Giá trị mặc định là 57000.
Chỉ định một số chẵn trong phạm vi từ 1024 đến 65534. Số được đặt ở đây và số lẻ tiếp theo, thu được bằng cách thêm
1, trở thành hai số cổng được sử dụng để điều khiển và truyền dữ liệu âm thanh.

Khi [Setting] được đặt thành [RTMP]

Chế độ giải mã video mà có thể chỉ được sử dụng cho RTMP là H.264. Để sử dụng RTMP, [Stream] > [Audio Stream]
phải được đặt thành [On] trong menu web.
[Server URL]
Đặt URL đích tải lên. Chỉ định chuỗi ký tự bắt đầu bằng “rtmp://” hoặc “rtmps://”.
[Stream Key]
Nhập khóa luồng thu được từ trang web bạn đang sử dụng. Ấn nút [Clear] sẽ xóa nội dung đầu vào.

Chú ý

Hãy thận trọng khi xử lý khóa luồng. Nếu bên thứ ba biết khóa luồng, sẽ có nguy cơ giả mạo luồng.

[Root Certificate]
Nhập chứng chỉ gốc cần thiết để phát trực tuyến bằng giao thức RTMPS. Để nhập chứng chỉ gốc, nhấn nút [Load] và
chọn chứng chỉ gốc. Nhấn nút [OK] trong hộp thoại chọn tệp để nhập tệp đã chọn vào thiết bị. Nếu có chứng chỉ gốc
được nhập vào thiết bị, chứng chỉ gốc sẽ được cập nhật. Để xóa chứng chỉ gốc đã nhập, nhấn nút [Delete] trên màn
hình thiết lập. Trạng thái chứng chỉ được hiển thị trong [Root Certificate Status].

Chú ý

Nhập chứng chỉ gốc theo yêu cầu của dịch vụ phát trực tuyến.
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Khi [Setting] được đặt thành [SRT-Caller] hoặc [SRT-Listener]

Chế độ codec video chỉ là H.264.
[Destination]
Được hiển thị khi chế độ phát trực tuyến được đặt thành [SRT-Caller]. Đặt URL đích của kết nối.
[Port Number]
Được hiển thị khi chế độ phát trực tuyến được đặt thành [SRT-Listener]. Đặt số cổng để nghe. Giá trị mặc định là 4201.
[Latency]
Đặt độ trễ trong phạm vi từ 20 ms đến 8000 ms. Giá trị mặc định là 120.
[TTL]
Đặt giá trị TTL trong phạm vi từ 1 đến 255. Giá trị mặc định là 64.
[Encryption]
Chọn phương pháp mã hóa. Chọn Off, AES128, hoặc AES256. Giá trị mặc định là Off.
[Passphrase]
Đặt cụm mật khẩu được sử dụng để mã hóa. Ấn nút [Clear] sẽ đặt lại cụm mật khẩu đã định cấu hình.
[ARC]
Để bật chức năng Adaptive Rate Control, hãy đặt thành On.
Khi bật chức năng Adaptive Rate Control, có thể giảm bớt gián đoạn hình ảnh do tắc nghẽn đường truyền.

Khi [Setting] được đặt thành [NDI|HX]

Thiết bị tuân thủ NDI|HX phiên bản 2 của NewTek.
Để sử dụng NDI|HX, bạn phải mua khóa cấp phép.
Mua khóa cấp phép
Mua hàng tại URL của NewTek sau đây.
https://www.newtek.com/ndihx/products/upgrade/

Chú ý

Tải xuống trình điều khiển NDI|HX mới nhất và cài đặt trong sản phẩm của NewTek.

Để biết chi tiết về đăng ký và vận hành NDI|HX, hãy tham khảo hướng dẫn vận hành dành cho sản phẩm của NewTek.

[License]
Hiển thị thông tin cấp phép cho một giấy phép được kích hoạt.
[Source Name]
Hiển thị tên nguồn.
[Group]
Để bật chức năng nhóm NDI, hãy đặt thành On.
[Group Name]: Đặt tên nhóm NDI. Có thể định cấu hình nhiều cài đặt phân tách bằng dấu phẩy.
[Discovery Server 1], [Discovery Server 2]
Đặt máy chủ khám phá NDI 1 và máy chủ khám phá NDI 2.
[Reliable UDP Mode]
Để bật chế độ Reliable UDP, hãy đặt thành On.
[Multicast Mode]
Để bật tính năng phát trực tiếp đa điểm, hãy đặt thành On.
[Multicast Prefix]: Đặt tiền tố để sử dụng cho phát trực tiếp đa điểm.
[Multicast Netmask]: Đặt mặt nạ mạng xác định phạm vi địa chỉ đa điểm.
[Multicast TTL]: Đặt giá trị TTL cho phát trực tiếp đa điểm trong phạm vi từ 1 đến 256. Giá trị mặc định là 3.
[Multi-TCP Mode]
Để bật chế độ Multi-TCP, hãy đặt thành On.
[Unicast UDP Mode]
Để bật chế độ Unicast UDP, hãy đặt thành On.

Giới thiệu về dịch vụ và phần mềm của bên thứ 3
Các điều khoản sử dụng khác nhau có thể được áp dụng.

Việc cung cấp dịch vụ và cập nhật phần mềm có thể bị gián đoạn hoặc chấm dứt mà không cần thông báo.
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Mô tả các dịch vụ và phần mềm có thể thay đổi mà không cần thông báo trước.
Có thể cần đăng ký và đặt mua riêng.

Sony sẽ không chịu trách nhiệm đối với bất kỳ khiếu nại nào của người dùng hoặc bên thứ ba do sử dụng các dịch vụ và
phần mềm của các công ty khác.
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Hướng dẫn trợ giúp
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Đặt bộ mã hóa âm thanh để phát trực tiếp

Đặt bộ mã hóa video bằng cách sử dụng [Stream] > [Video Stream] trong menu web.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Bạn có thể thiết lập ba chế độ bộ mã hóa hình ảnh. Định cấu hình các cài đặt sau đây một cách riêng lẻ cho từng chế độ
hình ảnh.
[Video Stream 3] được sử dụng cho màn hình bảng điều khiển hình ảnh máy quay.

Chú ý

Khi [Stream] > [Stream Setting] > [Setting] được đặt thành [RTMP], [SRT-Caller] hoặc [SRT-Listener], một số cài đặt [Video
Stream 1], [Video Stream 2] và [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode]) có giá trị mặc
định.

[Codec 1], [Codec 2], [Codec 3]
Chọn [H.264], [H.265] hoặc [Off]. Hãy lưu ý rằng không thể đặt [Codec 1] thành [Off]. Ngoài ra, [Codec 3] được đặt thành
[JPEG] (cố định).

Chú ý

Các hiện tượng sau có thể xảy ra tùy thuộc vào sự kết hợp của nhiều cài đặt khác nhau, chẳng hạn như kích thước ảnh, tốc độ
khung hình và tốc độ bit của [Codec 1], [Codec 2] và [Codec 3].

Tăng độ trễ của video.
Bỏ qua khung hình trong khi phát lại video.
Âm thanh ngắt quãng.
Máy quay phản hồi chậm với các lệnh khác nhau.
Máy quay phản hồi chậm với các hoạt động từ bảng điều khiển từ xa.
Màn hình điều khiển chậm hiển thị và các thao tác cấu hình.

Nếu bạn gặp phải các hiện tượng này, hãy giảm giá trị của các thông số kích thước hình ảnh, tốc độ khung hình và tốc độ bit
hoặc thay đổi giá trị của các thông số thiết lập khác để giải quyết vấn đề.

Khi [Stream] > [Stream Setting] > [Setting] được đặt thành [RTMP], [SRT-Caller] hoặc [SRT-Listener], [Codec 1] được đặt thành
[H.264] (cố định). [Codec 2] được đặt thành [Off] (cố định).

Khi kích thước hình ảnh hoặc tần số hệ thống của đầu ra HDMI thay đổi, [Codec 2] được đặt thành [Off].

[Size 1], [Size 2], [Size 3]
Chọn kích thước hình ảnh để phát trực tiếp từ máy quay.
Các tùy chọn kích thước hình ảnh có sẵn sẽ khác nhau tùy thuộc vào kích thước hình ảnh của đầu ra HDMI.

Chú ý

Khi kích thước hình ảnh hoặc tần số hệ thống của đầu ra HDMI thay đổi, kích thước hình ảnh tối đa sẽ được chọn.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Đặt tốc độ khung hình của hình ảnh.
Đơn vị “fps” cho biết số khung hình được phát trực tiếp mỗi giây.
Các tùy chọn tốc độ khung hình khả dụng sẽ khác nhau tùy thuộc vào kích thước hình ảnh của đầu ra HDMI.

Chú ý
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Khi kích thước hình ảnh hoặc tần số hệ thống của đầu ra HDMI thay đổi, tốc độ khung hình tối đa sẽ được chọn.

[I-Picture Mode 1], [I-Picture Mode 2]
Đặt phương pháp chỉ định khoảng chèn hình ảnh I cho H.264 và H.265 thành [Time] hoặc [Frame].
Không thể được đặt cho [Codec 3].
[Time]: Đặt khoảng thời gian chèn hình ảnh I làm thời gian.
[Frame]: Đặt khoảng thời gian chèn hình ảnh I làm số khung hình.
[I-Picture Interval 1], [I-Picture Interval 2]
Đặt khoảng thời gian chèn hình ảnh I theo đơn vị giây. Đặt giá trị trong phạm vi từ 1 giây đến 5 giây. Giá trị mặc định là 1
giây.
Không thể được đặt cho [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Đặt khoảng thời gian chèn hình ảnh I cho H.264 và H.265 dưới dạng số khung hình trong phạm vi từ 15 đến 300. Giá trị
mặc định là 300 khung hình.
Không thể được đặt cho [Codec 3].
[Profile 1], [Profile 2]
Đặt hồ sơ bộ mã hóa hình ảnh H.264 hoặc H.265.
[H.264]: Chọn hồ sơ [high], [main] hoặc [baseline].
[H.265]: Chọn hồ sơ [main] hoặc [main10]. Khi hai bộ mã hóa video được bật, chỉ có tùy chọn lựa chọn hồ sơ [main] là
khả dụng.
Hiệu quả nén hình ảnh tăng theo thứ tự [high], [main] và [baseline]. Chọn hồ sơ được hệ thống của bạn hỗ trợ.
Khi [H.265] được đặt thành [main10], vận hành nằm trong [main10] khi đầu ra HDMI là YCrCb hoặc trong [main] khi đầu
ra HDMI là RGB.
Không thể được đặt cho [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Chọn [CBR] hoặc [VBR].
Để duy trì tốc độ bit không đổi, chọn [CBR]. Để duy trì chất lượng hình ảnh, chọn [VBR].
Không thể được đặt cho [Codec 3].

Chú ý

Tốc độ khung hình và tốc độ bit thực sự được phát trực tiếp có thể khác với các giá trị đã đặt, tùy thuộc vào kích thước ảnh, cảnh
chụp, môi trường mạng và các yếu tố khác.

Khi [Stream] > [Stream Setting] > [Setting] được đặt thành [RTMP], [SRT-Caller] hoặc [SRT-Listener], [Bit Rate Compression
Mode 1] được đặt thành [CBR] (cố định).

[Bit Rate 1], [Bit Rate 2]
Bạn có thể đặt tốc độ bit trên mỗi lần phát trực tiếp video khi [Bit Rate Compression Mode] được đặt thành [CBR]. Đặt
tốc độ bit cao sẽ cho phép bạn phát trực tiếp video có chất lượng hình ảnh cao.
Không thể được đặt cho [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Đặt chất lượng hình ảnh trong phạm vi từ 1 đến 10. Giá trị 10 đặt chất lượng hình ảnh cao nhất. Giá trị mặc định là 6.
Đối với [Quality 1] và [Quality 2], bạn có thể đặt chất lượng hình ảnh H.264 bằng cách đặt [Bit Rate Compression Mode]
thành [VBR] và [Codec] thành [H.264]. Bạn có thể đặt chất lượng H.265 bằng cách đặt [Bit Rate Compression Mode]
thành [VBR] và [Codec] thành [H.265].

5-041-959-03(1) Copyright 2022 Sony Corporation
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Đặt codec âm thanh để phát trực tuyến

Đặt bộ mã hóa âm thanh bằng cách sử dụng [Stream] > [Audio Stream] trong menu web.
[Setting]
Để bật tính năng phát trực tiếp âm thanh, hãy đặt thành On.

Chú ý

Để chọn RTMP, luôn đặt trước thành On.

[Codec]
Chọn loại codec để sử dụng cho âm thanh phát trực tuyến.
[AAC (256kbps)]: Chọn để ưu tiên chất lượng âm thanh.
[AAC (128kbps)]: Chọn để ưu tiên dung lượng dữ liệu.
Cài đặt này không ảnh hưởng đến clip do thiết bị ghi hoặc tín hiệu âm thanh được nhúng vào tín hiệu HDMI/SDI.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bắt đầu/kết thúc phát trực tiếp

Đối với [RTSP], [SRT-Listener] và [NDI|HX]

Thiết bị chờ yêu cầu phân phối trực tuyến.
Khởi chạy ứng dụng khách để xem phát trực tiếp và truy cập URL hiển thị trong bảng sau đây.
Nhập giá trị dành cho tên người dùng và mật khẩu được cấu hình trong thiết bị.

<camera_address>: Địa chỉ IP của thiết bị
<Port>: Cổng nghe được cấu hình bằng cách sử dụng [Port Number]

Chú ý

Không đảm bảo phát lại trong tất cả các ứng dụng hoặc thiết bị.

Đối với [RTMP] và [SRT-Caller]

Nhấn nút [Stream now] trên thẻ  (Phát trực tuyến) của màn hình vận hành trực tuyến để bắt đầu phát trực truyến. Nút
đổi thành [Stop stream] và biểu tượng [Stream] xuất hiện ở hàng đầu của bảng điều khiển hình ảnh máy quay.
Nhấn nút [Stop stream] trong quá trình phát trực tuyến để kết thúc. Nút đổi lại thành [Stream now] và biểu tượng
[Stream] biến mất khỏi hàng đầu của bảng điều khiển hình ảnh máy quay.

Chú ý

Không đảm bảo phát lại trong tất cả các ứng dụng hoặc thiết bị.

5-041-959-03(1) Copyright 2022 Sony Corporation

Định dạng phát trực tiếp URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX Tham khảo hướng dẫn vận hành dành cho thiết bị khách tương thích NDI|HX.
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Màn hình ảnh thu nhỏ

Khi bạn ấn nút [Thumbnail] trên màn hình vận hành phát lại hoặc nút THUMBNAIL trên điều khiển từ xa hồng ngoại, các
clip đã ghi trên thẻ nhớ được hiển thị trên bảng điều khiển hình ảnh máy quay. Màn hình này trên bảng điều khiển hình
ảnh máy quay được gọi là màn hình ảnh thu nhỏ.
Bạn có thể chọn một clip trên màn hình ảnh thu nhỏ và bắt đầu phát lại clip đó.
Ấn nút [Thumbnail] trong quá trình sử dụng màn hình ảnh thu nhỏ sẽ đóng màn hình ảnh thu nhỏ và trở lại màn hình ảnh
chụp.

Chú ý

Chỉ có các clip ghi ở định dạng ghi đang chọn mới hiển thị trên màn hình ảnh thu nhỏ. Nếu clip đã ghi dự kiến không hiển thị, hãy
kiểm tra định dạng ghi. Đặt biệt lưu ý đến yếu tố này trước khi định dạng (khởi chạy) phương tiện.

Bố cục màn hình

Hình thu nhỏ của clip đã chọn được hiển thị với nền màu cam.
Thông tin về clip đã chọn sẽ hiển thị ở cuối màn hình.
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Chọn thẻ nhớ
Biểu tượng khóa xuất hiện nếu thẻ nhớ là loại chống ghi.

1.

Số clip/tổng số clip2.

Hình thu nhỏ (ảnh chỉ mục)
Hiển thị ảnh chỉ mục của một clip. Khi ghi clip, khung hình đầu tiên sẽ tự động được đặt làm ảnh chỉ mục.
Thông tin clip/khung hình sẽ hiển thị bên dưới thumbnail. Bạn có thể thay đổi tên bằng cách sử dụng [Thumbnail] >
[Customize View] > [Thumbnail Caption] trong menu camera.

3.

Tên clip
Hiển thị tên của clip đã chọn.

4.

Định dạng ghi
Hiển thị định dạng tệp của clip đã chọn.

5.

Thông tin ghi đặc biệt
Chỉ hiển thị chế độ ghi nếu clip đã được ghi bằng chế độ ghi đặc biệt.
Đối với các clip Chuyển động Chậm & Nhanh, tốc độ khung hình hiển thị ở bên phải.

6.

Thời lượng clip7.

Ngày tạo8.
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Phát clip đã ghi

Bạn có thể phát các clip đã ghi khi thiết bị ở chế độ chờ ghi (Stby).
Chủ đề này mô tả cách phát clip đã ghi bằng bảng điều khiển GUI.

Cắm thẻ nhớ vào để phát.1

Ấn nút [Thumbnail].

Ảnh thu nhỏ của clip xuất hiện.

2

Sử dụng các nút mũi tên trong bảng điều khiển GUI để di chuyển con trỏ đến ảnh thu nhỏ của clip mà bạn
muốn phát.

3
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Chú ý

Có thể có hiện tượng vỡ hình hoặc hiển thị hình tĩnh tạm thời ở ranh giới giữa các clip. Trong lúc này thì bạn không thể vận hành
thiết bị.

Khi bạn chọn một clip trong màn hình ảnh thu nhỏ và bắt đầu phát lại, có thể có hiện tượng biến dạng hình ảnh tạm thời ở đầu
clip. Để xem phần bắt đầu của clip mà không bị biến dạng, tạm dừng phát lại rồi nhấn nút  (Trước) để quay lại phần bắt đầu
của clip và bắt đầu phát lại.

Chú ý

Không thể chọn clip bằng thao tác chạm.

Ấn nút [Set] trong bảng điều khiển GUI.

Phát lại sẽ bắt đầu từ đầu của clip đã chọn.

4

Yêu cầu vận hành bảng điều khiển phát lại.

Gợi ý

Bạn cũng có thể điều khiển hoạt động bằng cách sử dụng bảng điều khiển GUI.

Phát: Nhấn nút [Set].
Tạm dừng phát lại: Nhấn nút [Set] trong khi phát lại. Nhấn một lần nữa để tiếp tục phát lại.
Chuyển đến đầu clip/bắt đầu clip tiếp theo: Nhấn nút trái/nút phải.
Tiến/lùi nhanh: Nhấn và giữ nút trái/nút phải. Quá trình phát lại quay lại tốc độ bình thường khi bạn nhả nút.
Dừng phát lại: Nhấn nút [Cancel/Back].

5

Nút Chức năng

Nút  (Phát/Tạm dừng) Phát clip. Trong khi phát lại, tạm dừng clip.

Nút  (Tua nhanh), nút  (Tua
ngược)

Phát clip ở tốc độ cao. Khi nhấn nút này, tốc độ phát lại thay đổi trong
ba bước.

Nút  (Trước), nút  (Tiếp) Chuyển đến đầu clip hoặc clip trước/sau.

Nút  (Dừng) Dừng phát lại và chuyển về màn hình chụp.
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Thao tác trên clip đã ghi

Trên màn hình ảnh thu nhỏ, bạn có thể vận hành clip hoặc kiểm tra các thuộc tính của clip bằng cách sử dụng menu
[Thumbnail] trong menu camera.
Ấn nút [Menu] trên màn hình vận hành phát lại để hiển thị menu camera trong bảng điều khiển hình ảnh máy quay.
Bạn có thể thực hiện các thao tác sau đây bằng cách sử dụng menu [Thumbnail] trong menu camera.
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Gợi ý

Bạn cũng có thể nhấn nút [Menu] trên màn hình vận hành trực tiếp để hiển thị menu camera.

Các thao tác sử dụng menu [Thumbnail] trên menu camera
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Chọn một chức năng để vận hành bằng các nút mũi tên trong bảng điều khiển GUI và ấn nút [Set].
Ấn nút [Cancel/Back] để trở lại màn hình trước đó.

Chú ý

Tùy thuộc vào trạng thái khi menu hiển thị, có thể sẽ không chọn được một số mục.

Mục menu để vận hành clip

Menu [Thumbnail] trong menu camera có các mục menu sau đây liên quan đến vận hành clip.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Để biết thông tin chi tiết về mục menu, hãy tham khảo menu “[Thumbnail]”.

Hiển thị màn hình thuộc tính clip
Chọn [Thumbnail] > [Display Clip Properties] trong menu máy quay để hiển thị màn hình thuộc tính clip.
Nhấn nút  (Trước) hoặc nút  (Tiếp) để đến clip trước đó/tiếp theo.

Thêm cờ cho clip
Bạn có thể thêm cờ cho clip (các dấu OK, NG hoặc KP) cho clip để lọc hiển thị clip dựa trên cờ.
Chọn hình ảnh thu nhỏ cho clip mà bạn muốn thêm cờ, sau đó chọn cờ cho clip bằng cách sử dụng [Thumbnail] > [Set
Clip Flag] trong menu camera.

Gợi ý

Bạn cũng có thể sử dụng nút có thể gán đã được gán với chức năng cờ của clip để thêm cờ.

Hiển thị màn hình ảnh thu nhỏ của clip đã lọc
Chọn [Thumbnail] > [Filter Clips] trong menu camera và chọn một loại cờ để hiển thị chỉ những clip có cờ được chỉ định.
Để hiển thị tất cả các clip, hãy chọn [All].
Bạn cũng có thể nhấn nút [Display] để sắp xếp hiển thị hình thu nhỏ theo cờ.

Xóa clip
Bạn có thể xóa clip từ thẻ nhớ.
Chọn [Thumbnail] > [Delete Clip] > [Select Clip] hoặc [All Clips] trong menu camera.
[Select Clip]: Xóa clip đã chọn. Chức năng hỗ trợ chọn nhiều clip.
[All Clips]: Xóa tất cả clip hiển thị.

Thay đổi thông tin hiển thị trên màn hình ảnh thu nhỏ
Bạn có thể thay đổi thông tin clip/khung hình hiển thị bên dưới ảnh thu nhỏ.
Chọn [Thumbnail] > [Customize View] > [Thumbnail Caption] trong menu camera và chọn thông tin để hiển thị.

Cài đặt Đã thêm cờ cho clip

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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[Date Time]: Hiển thị ngày và giờ tạo và sửa đổi clip gần nhất.
[Time Code]: Hiển thị mã thời gian.
[Duration]: Hiển thị thời lượng của clip.
[Sequential Number]: Hiển thị số thứ tự trên mỗi ảnh thu nhỏ.
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Cấu hình menu camera

Khi ấn nút [Menu] trong bảng điều khiển GUI hoặc nút MENU trên điều khiển từ xa hồng ngoại, menu camera để định
cấu hình các cài đặt cần thiết khác nhau để chụp và xem lại sẽ hiển thị trong bảng điều khiển hình ảnh máy quay.

Menu gồm các menu sau.

Cấu hình menu

Menu [User]
Chứa các mục menu do người dùng định cấu hình.
Có thể chỉnh sửa bằng cách sử dụng [Edit User Menu].
Menu [Edit User]
Chức các mục menu để chỉnh sửa menu [User].
Menu [Shooting]
Chứa các cài đặt liên quan đến chụp.
Menu [Project]
Chứa các cài đặt cơ bản cho dự án.
Menu [Paint/Look]
Chứa các cài đặt liên quan đến chất lượng hình ảnh.
Menu [Pan-Tilt]
Chứa các cài đặt liên quan đến xoay/nghiêng.
Menu [TC/Media]
Chứa các cài đặt liên quan đến mã thời gian và thiết bị quay.
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Menu [Monitoring]
Chứa các cài đặt liên quan đến đầu ra video và hiển thị màn hình.
Menu [Audio]
Chứa các cài đặt liên quan đến âm thanh.
Menu [Thumbnail]
Chứa các cài đặt liên quan đến hiển thị thumbnail.
Menu [Technical]
Chứa các cài đặt về mục kỹ thuật.
Menu [Network]
Chứa các cài đặt liên quan đến mạng.
Menu [Maintenance]
Chứa các cài đặt thiết bị, như đồng hồ và ngôn ngữ.

Cấu hình và phân cấp menu camera

Cấp 1 Cấp 2

User
(Cài đặt gốc)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Cấp 1 Cấp 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Cấp 1 Cấp 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Cấp 1 Cấp 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Vận hành menu camera

Khi ấn nút [Menu] trong bảng điều khiển GUI hoặc nút MENU trên điều khiển từ xa hồng ngoại, menu camera để định
cấu hình các cài đặt cần thiết khác nhau để chụp và xem lại sẽ hiển thị trong bảng điều khiển hình ảnh máy quay.
Vận hành menu bằng các nút trong bảng điều khiển GUI.

Nút [Menu]: Ấn để hiển thị menu camera. Ấn lại trong khi menu camera hiển thị để ấn menu.
Arrow buttons: Nhấn nút mũi tên để di chuyển con trỏ lên/xuống/sang trái/sang phải trên menu camera để chọn mục
menu hoặc cài đặt menu.
Nút [Set]: Ấn để áp dụng mục đã chọn.
Nút [Cancel/Back] button: Ấn để trở lại menu trước đó. Thay đổi chưa hoàn tất sẽ bị hủy.

Chú ý

Tùy thuộc vào trạng thái khi menu hiển thị, có thể sẽ không chọn được một số mục.

Mục menu thiết lập

Di chuyển con trỏ đến mục bạn muốn đặt bằng cách sử dụng nút mũi tên trong bảng điều khiển GUI và ấn nút [Set] để
áp dụng cài đặt.

Vùng chọn mục menu sẽ hiển thị tối đa tám dòng. Nếu các tùy chọn có sẵn dành cho một mục không hiển thị cùng
lúc, hãy cuộn màn hình hiển thị bằng cách di chuyển con trỏ lên/xuống.
Với các tiểu mục có phạm vi cài đặt rộng (ví dụ: −99 đến +99), vùng cài đặt sẽ không hiển thị. Cài đặt hiện tại được
tô sáng để cho biết có thể thay đổi giá trị.
Chọn [Execute] cho một chức năng sẽ thực hiện chức năng tương ứng.
Chọn mục cần xác nhận trước khi thao tác thực hiện ẩn tạm thời menu và hiển thị thông báo xác nhận. Kiểm tra
thông báo, sau đó chọn xem thực hiện hay hủy chức năng.
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Nhập chuỗi ký tự

Khi bạn chọn một mục, như là tên tệp, cần nhập ký tự, thì màn hình nhập ký tự sẽ xuất hiện.
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Ấn các nút mũi tên trong bảng điều khiển GUI để chọn loại ký tự và áp dụng cài đặt.

[ABC]: Ký tự chữ cái viết hoa
[abc]: Ký tự chữ cái viết thường
[123]: Ký tự số
[!#$]: Ký tự đặc biệt

1

Chọn một ký tự và ấn nút [Set] để áp dụng cài đặt.

Con trỏ di chuyển sang trường tiếp theo.
[Space]: Nhập một ký tự khoảng trống vào vị trí con trỏ.
[←] [→]: Di chuyển vị trí con trỏ.
[BS]: Xóa ký tự ở bên trái của con trỏ (xóa lùi).

2

Khi hoàn tất, nhấn nút [Done] và áp dụng cài đặt.

Chuỗi ký tự được xác nhận và màn hình nhập ký tự sẽ biến mất.

3
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User

Chủ đề này mô tả chức năng và các cài đặt của mỗi mục menu.

Chú ý

Bạn có thể thêm và xóa các mục menu trong menu [User] bằng cách sử dụng menu [Edit User]. Có thể cấu hình tối đa 20 mục.
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Mục Mô tả

Base Setting Mục Project > Base Setting

Focus Mục Shooting > Focus

S&Q Motion Mục Shooting > S&Q Motion

LUT On/Off Mục Shooting > LUT On/Off

Simul Rec Mục Project > Simul Rec

Proxy Rec Mục Project > Proxy Rec

Interval Rec Mục Project > Interval Rec

Picture Cache Rec Mục Project > Picture Cache Rec

Assignable Button Mục Project > Assignable Button

Scene File Mục Project > Scene File

Base Look Mục Paint/Look > Base Look

P/T Acceleration Mục Pan-Tilt > P/T Acceleration

Clip Name Format Mục TC/Media > Clip Name Format

Format Media Mục TC/Media > Format Media

Video Signal Monitor Mục Monitoring > Video Signal Monitor

Marker Mục Monitoring > Marker

Zoom Mục Technical > Zoom

Lens Mục Technical > Lens

Edit User Menu Hiển thị menu Edit User.
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Edit User

Menu [Edit User] hiển thị ở cấp trên cùng khi chọn [Edit User Menu] trong menu [User].
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Mục Cài đặt tiểu
mục

Mặc định của
nhà sản xuất Mô tả

Add Item
Thêm một mục vào menu
[User]

– – Thêm một mục menu cấp 2 vào menu [User].

Customize Reset
Cài đặt lại mục trong menu
[User]

– –
Khôi phục mục menu đã đăng ký trên menu
[User] về cài đặt gốc mặc định.

Mục menu cấp 2 đã chọn
trong khi chỉnh sửa

Delete –
Xóa mục menu cấp 2 đã đăng ký từ menu
[User].

Move –
Sắp xếp lại các mục menu đã đăng ký trong
menu [User].

Edit Sub
Item

–
Chỉnh sửa (đăng ký/xóa) tiểu mục menu cấp 3
đã đăng ký trong menu [User].
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Interchangeable Lens Digital Camera
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ISO/Gain/EI

Đặt cài đặt độ khuếch đại.

Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Mode ISO/dB dB
Chọn chế độ cài đặt độ
khuếch đại.

ISO/Gain<L>

Để biết thêm thông tin chi tiết về cài
đặt, hãy tham khảo “Cài đặt và giá trị
mặc định ISO/Gain”.

–
Đặt giá trị độ khuếch đại
cài đặt sẵn <L>.

Exposure
Index<L>

Khi Base ISO được đặt thành ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Khi Base ISO được đặt thành ISO
12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Khi Base ISO được đặt
thành ISO 800: 800EI /
6.0E
When Base ISO được
đặt thành ISO 12800:
12800EI / 6.0E

Đặt giá trị Exposure
Index<L>.

Shockless
Gain

On / Off Off
Bật/tắt chức năng độ
khuếch đại không va đập.

Base
Sensitivity

High / Low Low
Đặt độ nhạy cơ sở cho chế
độ Custom.
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Chủ đề liên quan

Cài đặt và giá trị mặc định ISO/Gain

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Base ISO ISO 12800 / ISO 800 ISO 800
Đặt độ nhạy ISO cơ sở cho
chế độ Cine EI/chế độ
Flexible ISO.
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Interchangeable Lens Digital Camera
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ND Filter

Đặt giá trị thiết lập sẵn cho kính lọc cường độ trung tính (ND).

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Mode Preset / Variable Variable Chọn chế độ kính lọc ND.

Preset1
1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/4
Đặt giá trị thiết lập sẵn 1 cho kính lọc
ND.

Preset2
1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/16
Đặt giá trị thiết lập sẵn 2 cho kính lọc
ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/64 Đặt giá trị thiết lập sẵn 3 cho kính lọc
ND.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Shutter

Đặt hoạt động màn trập điện tử.
Được dùng để chụp rõ các đối tượng chuyển động nhanh.

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Mode Speed / Angle Speed

Chọn chế độ để cài đặt tốc độ
màn trập theo giây (Speed)
hoặc dưới dạng góc màn trập
(Angle).

Shutter
Speed
On/Off

On / Off Off

Đặt thời gian phơi sáng khi
chọn chế độ Speed tuân theo
giá trị [Shutter Speed] hay
được đặt để phơi sáng hoàn
toàn.

Shutter
Speed

64F đến 1/8000
Cài đặt có sẵn khác nhau tùy thuộc vào tần số
khung hình của định dạng video đã chọn.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250
/ 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 / 1/120 / 1/125
/ 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 / 1/96
/ 1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Đặt tốc độ màn trập khi chọn
chế độ Speed.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F /
360.0° / 300.0° / 270.0° / 240.0° / 216.0° / 210.0° /
180.0° / 172.8° / 150.0° / 144.0° / 120.0° / 90.0° /
86.4° / 72.0° / 45.0° / 30.0° / 22.5° / 11.25° / 5.6°

180.0°
Đặt góc màn trập khi chọn chế
độ Angle.

ECS On/Off On / Off Off
Bật/tắt chức năng Extended
Clear Scan.
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Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

ECS
Frequency

23.99 đến 8000
Cài đặt có sẵn khác nhau tùy thuộc vào tần số
khung hình của định dạng ghi đã chọn.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Đặt tần số ECS khi Mode được
đặt về ECS.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Iris

Đặt các cài đặt cửa điều sáng.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Bokeh Control On / Off Off Bật/tắt chức năng điều khiển cửa điều sáng.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Auto Exposure

Đặt cài đặt điều chỉnh độ phơi sáng tự động.

Mục Cài đặt tiểu mục
Mặc định

của nhà sản
xuất

Mô tả

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 /
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / ±0
/ −0.25 / −0.5 / −0.75 / −1.0 / −1.25 / −1.5 /
−1.75 / −2.0 / −2.25 / −2.5 / −2.75 / −3.0

±0
Đặt mức độ sáng cho độ phơi sáng
được phát hiện tự động.

Mode Backlight / Standard / Spotlight Standard

Đặt chế độ vận hành khi điều chỉnh độ
phơi sáng tự động.
Backlight: Chế độ ngược sáng (chế
độ dùng để giảm độ tối của đối tượng
khi đối tượng bị ngược sáng)
Standard: Chế độ tiêu chuẩn
Spotlight: Chế độ đèn chiếu (chế độ
dùng để giảm độ trắng bị cắt khi đối
tượng được chiếu sáng bởi đèn chiếu)

Speed −99 đến +99 ±0
Chọn tốc độ điều chỉnh khi điều chỉnh
độ phơi sáng tự động.

AGC On / Off Off
Bật/tắt chức năng AGC (kiểm soát độ
khuếch đại tự động).

AGC Limit

Để biết thêm thông tin chi tiết về cài đặt,
hãy tham khảo “Cài đặt và giá trị mặc
định AGC Limit”.

–
Đặt độ khuếch đại tối đa của chức
năng AGC.

AGC Point F2.8 / F4 / F5.6 F2.8
Đặt giá trị F-stop của cửa điều sáng khi
bắt đầu vận hành AGC trong khi chức
năng AGC đặt ở On.

Auto Shutter On / Off Off
Bật/tắt chức năng kiểm soát màn trập
tự động.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Đặt tốc độ màn trập nhanh nhất cho
chức năng màn trập tự động.

A.SHT Point F5.6 / F8 / F11 / F16 F11
Đặt giá trị F-stop của cửa điều sáng khi
bắt đầu vận hành màn trập tự động.

Clip High
light

On / Off Off
Tắt chức năng bỏ qua các vùng sáng
nhất để phản hồi phẳng hơn khi bật/tắt
chức năng độ chói cao.
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Chủ đề liên quan

Cài đặt và giá trị mặc định AGC Limit

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục
Mặc định

của nhà sản
xuất

Mô tả

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Đặt phạm vi đo sáng để tự động điều
chỉnh độ phơi sáng theo độ sáng của
đối tượng. (Không áp dụng khi điều
chỉnh độ phơi sáng thủ công)

Detect
Window
Indication

On / Off Off Bật/tắt chỉ báo phạm vi đo sáng.

Custom
Width

40 đến 999 500 Đặt chiều rộng của phạm vi đo sáng.

Custom
Height

70 đến 999 500 Đặt chiều cao của phạm vi đo sáng.

Custom H
Position

−479 đến +479 ±0
Đặt vị trí nằm ngang của phạm vi đo
sáng.

Custom V
Position

−464 đến +464 ±0 Đặt vị trí nằm dọc của phạm vi đo
sáng.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

White

Đặt các cài đặt cân bằng trắng.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu
mục

Mặc định của
nhà sản xuất Mô tả

Preset
White

2000K đến
15000K

3200K Đặt giá trị cài đặt sẵn của độ cân bằng trắng.

Color
Temp <A>

2000K đến
15000K

3200K

Đặt nhiệt độ màu cân bằng trắng đã lưu trong bộ nhớ A.

Chú ý

Vì Color Temp được cắt ở mức 2000K và 15000K trong khi vận hành R
Gain/B Gain nên không thể hiển thị chính xác giá trị dành cho giá trị Color
Temp đối với giá trị R Gain/B Gain.

Tint<A> −99 đến
+99

±0

Đặt giá trị sắc thái cân bằng trắng đã lưu trong bộ nhớ A.

Chú ý

Vì Tint được cắt ở mức ±99 trong khi vận hành R Gain/B Gain, nên không
thể hiển thị chính xác giá trị sắc độ dành cho giá trị R Gain/B Gain.

R Gain
<A>

−99.0 đến
+99.0

±0.0 Đặt giá trị độ khuếch đại R cân bằng trắng đã lưu trong bộ nhớ A.

B Gain
<A>

−99.0 đến
+99.0

±0.0 Đặt giá trị độ khuếch đại B cân bằng trắng đã lưu trong bộ nhớ A.
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Hướng dẫn trợ giúp
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White Setting

Điều chỉnh các cài đặt cân bằng trắng.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu
mục

Mặc định của nhà
sản xuất Mô tả

Shockless
White

Off / 1 / 2 / 3 2

Đặt tốc độ phản hồi cân bằng trắng khi chuyển đổi chế độ
cân bằng trắng.
Off: Chuyển đổi ngay lập tức.
1 đến 3: Chuyển đổi càng chậm thì số càng cao.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Đặt tốc độ phản hồi trong chế độ ATW.
Tốc độ phản hồi nhanh nhất là 1 và tốc độ phản hồi chậm
nhất là 5.
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Offset White

Đặt cài đặt độ bù cân bằng trắng.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt
tiểu mục

Mặc định của
nhà sản xuất Mô tả

Offset White <A> On / Off Off
Chọn thêm (On) hay không thêm giá trị bù (Off) cho cân bằng
trắng trong bộ nhớ A.

Offset Color
Temp<A>

−99 đến
+99

±0
Đặt độ bù nhiệt độ màu cần thêm vào cân bằng trắng trong bộ
nhớ A khi [Offset White <A>] được đặt thành On.

Offset Tint<A>
−99 đến
+99

±0
Đặt độ bù giá trị Tint cần thêm vào cân bằng trắng trong bộ
nhớ A khi [Offset White <A>] được đặt thành On.

Offset
White<ATW>

On / Off On
Chọn thêm (On) hay không thêm giá trị bù (Off) cho cân bằng
trắng ATW.

Offset Color
Temp<ATW>

−99 đến
+99

±0
Đặt độ bù nhiệt độ màu cần thêm vào cân bằng trắng ATW khi
[Offset White<ATW>] được đặt thành On.

Offset Tint<ATW>
−99 đến
+99

±0
Đặt độ bù giá trị sắc độ cần thêm vào cân bằng trắng ATW khi
[Offset White<ATW>] được đặt thành On.
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Interchangeable Lens Digital Camera
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Focus

Đặt các cài đặt lấy nét.

Chủ đề liên quan

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

AF Transition
Speed

1(Slow) / 2 / 3 / 4 / 5 /
6 / 7(Fast)

5
Đặt tốc độ bộ truyền động lấy nét khi đối tượng thay đổi
trong khi lấy nét tự động.

AF Subj.
Shift Sens.

1(Locked On) / 2 / 3 /
4 / 5(Responsive)

5(Responsive)
Đặt độ nhạy để thay đổi điểm lấy nét đối tượng trong khi
lấy nét tự động.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Đặt vùng mục tiêu khi lấy nét tự động và lấy nét tự động
đẩy (AF).

Tham khảo “Điều chỉnh lấy nét tự động (Auto Focus)”
và “Cài đặt khu vực/vị trí lấy nét tự động (Focus
Area).”

Wide: Tìm kiếm đối tượng theo một góc rộng nào đó của
hình ảnh khi lấy nét.
Zone: Tự động tìm kiếm điểm lấy nét trong vùng chỉ định.
Flexible Spot: Tập trung vào một vị trí cụ thể nào đó của
hình ảnh.

Focus Area
(AF-S)

Flexible Spot Flexible Spot Đặt vùng mục tiêu để lấy nét tự động đẩy (AF-S).

Face/Eye
Detection AF

Face/Eye Only AF /
Face/Eye Priority AF
/ Off

Face/Eye Priority
AF

Bật/tắt chế độ AF phát hiện khuôn mặt.

Tham khảo “Tìm kiếm bằng cách sử dụng chức năng
phát hiện ra khuôn mặt và mắt (Face/Eye Detection
AF).”

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Đặt chế độ lấy nét tự động đẩy.

Touch
Function in
MF

Tracking AF / Spot
Focus Tracking AF

Đặt thao tác khi chạm vào hình ảnh máy quay trên màn
hình thao tác trực tiếp của Ứng dụng Web ở chế độ MF.

AF Assist On / Off On

Khi đặt thành On, chế độ sẽ cho phép bạn tạm thời ghi
đè lên lấy nét tự động và đặt chế độ lấy nét thủ công.

Tham khảo “Cài đặt mục tiêu lấy nét thủ công (AF
Assist) bằng Ứng dụng web” và “Lấy nét thủ công
trong khi lấy nét tự động bằng điều khiển hồng ngoại
từ xa đi kèm.”
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Cài đặt khu vực/vị trí lấy nét tự động (Focus Area)

Tìm kiếm bằng cách sử dụng chức năng phát hiện ra khuôn mặt và mắt (Face/Eye Detection AF)

Cài đặt mục tiêu lấy nét thủ công (AF Assist) bằng Ứng dụng web

Lấy nét thủ công trong khi lấy nét tự động bằng điều khiển hồng ngoại từ xa đi kèm
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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S&Q Motion

Đặt cài đặt chế độ Chuyển động nhanh và chậm (xem “Chuyển động nhanh và chậm”).

Chủ đề liên quan
Chuyển động nhanh và chậm

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Setting On / Off Off Bật/tắt chế độ Chuyển động Chậm & Nhanh.

Frame
Rate

1fps đến 60fps / 100fps / 120fps /
150fps / 180fps / 200fps / 240fps

–

Đặt tốc độ khung hình khi chụp ở chế độ Chuyển
động Chậm & Nhanh.

Chú ý

Các cài đặt có sẵn khác nhau tùy theo tần số,
codec và định dạng video của hệ thống đã
chọn.
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LUT On/Off

Đặt các cài đặt LUT.
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Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

SDI MLUT On / MLUT Off MLUT Off
Chọn có áp dụng Monitor LUT cho video đầu
ra SDI hay không.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Chọn có áp dụng Monitor LUT cho video đầu
ra HDMI và phát trực tiếp hay không.

Proxy MLUT On / MLUT Off MLUT Off
Chọn có áp dụng Monitor LUT cho video ghi
proxy hay không.

Internal Rec MLUT On / MLUT Off MLUT Off
Chọn có áp dụng Monitor LUT cho video ghi
chính hay không.

LUT On/Off Button
Target

SDI / HDMI/Stream / SDI
& HDMI/Stream

HDMI/Stream
Đặt đầu ra mục tiêu được điều khiển bởi một
nút có thể gán đã được gán với LUT On/Off.
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Noise Suppression

Đặt các cài đặt triệt nhiễu.

Gợi ý

Các cài đặt [Setting(Custom)] và [Level(Custom)] đều được phản ánh trong cài đặt [Target Display].

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

Setting(Custom) On / Off On
Bật/tắt chức năng triệt nhiễu trong chế độ
Custom.

Level(Custom)
Low / Mid /
High

Mid Đặt mức triệt nhiễu trong chế độ Custom.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Bật/tắt chức năng triệt nhiễu trong chế độ
chụp Log.

Level (Cine EI/Flex. ISO)
Low / Mid /
High

Mid Đặt mức triệt nhiễu trong chế độ chụp Log.
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Flicker Reduce

Đặc các cài đặt hiệu chỉnh lỗi nháy.
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Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

Mode Auto / On / Off Off Đặt chế độ hiệu chỉnh lỗi nháy.

Frequency 50Hz / 60Hz 60Hz
Đặt tần số nguồn điện cung cấp ánh sáng gây ra lỗi
nháy.
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Hướng dẫn trợ giúp
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SteadyShot

Đặt các cài đặt chống rung hình ảnh.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu
mục

Mặc định của
nhà sản xuất Mô tả

Setting
Active /
Standard / Off

Off

Đặt chức năng ổn định hình ảnh.

Chú ý

Đã bật khi có gắn ống kính tương thích.

Nếu công tắc được đặt thành Active hoặc Standard, hành vi ngoài dự
kiến có thể xảy ra trong quá trình vận hành xoay/nghiêng.
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Base Setting

Đặt các cài đặt cơ sở.

Chủ đề liên quan

Cấu hình vận hành máy quay cơ bản

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI

Custom

Đặt chế độ ghi hình.

Hãy tham khảo “Đặt chế độ chụp” trong
“Cấu hình vận hành máy quay cơ bản.”

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Đặt gam màu của ghi hình/đầu ra trong chế độ
Custom.
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Rec Format

Đặt các cài đặt định dạng quay.

Cài đặt [RAW Output Format]

Các giá trị mặc định được bôi đậm.
Đã bỏ qua các điều kiện không thể đặt [RAW Output Format].

Cài đặt [Video Format]

Mục Cài đặt tiểu mục
Mặc định

của nhà sản
xuất

Mô tả

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Chọn tần số của hệ thống.

Imager Scan
Mode

FF / S35 FF Chọn kích thước hình ảnh.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Đặt codec ghi/phát lại clip.

Chú ý

Khi [Imager Scan Mode] được đặt thành
[S35], không thể chọn [RAW] và [RAW &
XAVC-I].

RAW Output
Format

Các cài đặt có sẵn khác nhau tùy
thuộc vào cài đặt [Frequency].

Tham khảo “Cài đặt [RAW Output
Format]” bên dưới.

–

Đặt kích thước hình ảnh RAW để xuất bản
ghi RAW bên ngoài.

Chú ý

Khi [Codec] được đặt thành [RAW &
XAVC-I], cài đặt [Video Format] chuyển
sang liên kết với cài đặt [RAW Output
Format].

Video Format

Các cài đặt có sẵn khác nhau tùy
thuộc vào cài đặt [Frequency],
[Imager Scan Mode] và [Codec].

Tham khảo “Cài đặt [Video
Format]” bên dưới.

– Đặt kích thước hình ảnh và tốc độ bit.

Frequency Imager Scan Mode Codec Cài đặt

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Các giá trị mặc định được bôi đậm.

5-041-959-03(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Cài đặt

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Đặt cài đặt chế độ chụp Log (tham khảo “Đặt chế độ chụp” trong “Cấu hình vận hành máy quay cơ bản”).

Chủ đề liên quan

Cấu hình vận hành máy quay cơ bản
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Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Đặt gam màu cho các chế độ chụp Log
([Flexible ISO], [Cine EI Quick], [Cine EI]).

Embed
LUT File

On / Off On
Bật/tắt ghi siêu dữ liệu tệp 3D LUT (tệp
CUBE).
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Simul Rec

Đặt cài đặt chế độ ghi đồng thời 2 khe (tham khảo “Ghi đồng thời vào các thẻ nhớ A và B (2-slot Simul Rec)”).

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Setting On / Off Off
Bật/tắt chế độ ghi
đồng thời 2 khe.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec Button:<Slot
A> <Slot B> / Rec Button:<Slot A> 2nd Rec Button:
<Slot B> / Rec Button:<Slot B> 2nd Rec Button:<Slot
A>

Rec Button:<Slot A>
<Slot B> 2nd Rec
Button:<Slot A> <Slot
B>

Gán các nút ghi được
sử dụng để kiểm soát
từng thiết bị ghi.
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Proxy Rec

Đặt cài đặt chế độ ghi proxy (xem “Ghi proxy”).
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Setting On / Off Off Bật/tắt chế độ ghi proxy.

Audio Channel CH1/CH2 / CH3/CH4 CH1/CH2 Chọn kênh âm thanh để ghi về dữ liệu proxy.
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Interval Rec

Đặt cài đặt chế độ ghi theo khoảng thời gian (tham khảo “Quay video không liên tục (Interval Rec)”).
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Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Setting On / Off Off

Bật/tắt chế độ ghi theo khoảng
thời gian. (Cài đặt chế độ này
thành On sẽ đặt tất cả các chế
độ đặc biệt khác về Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20
/ 30 / 40 / 50 (giây)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20
/ 30 / 40 / 50 (phút)
1 / 2 / 3 / 4 / 6 / 12 / 24 (giờ)

1

Đặt khoảng thời gian giữa các
lần ghi trong chế độ ghi Interval
Rec (khi Interval Rec được đặt
thành On).

Number of
Frames

1frame / 2frames / 3frames / 6frames /
9frames / 12frames
Cài đặt có sẵn khác nhau tùy thuộc vào
tần số khung hình của định dạng video
đã chọn.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Đặt số khung hình để ghi mỗi
cảnh trong chế độ ghi Interval
Rec (khi Interval Rec được đặt
thành On).
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Picture Cache Rec

Đặt cài đặt chế độ ghi bộ nhớ đệm hình ảnh (xem “Ghi ảnh vào bộ nhớ đệm (Picture Cache Rec)”).

Chủ đề liên quan

Ghi ảnh vào bộ nhớ đệm (Picture Cache Rec)
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Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Setting On / Off Off Bật/tắt chức năng ghi ảnh vào bộ nhớ đệm.

Cache Size
Short / Medium /
Long / Max

Max
Đặt thời gian để dồn hình ảnh trong bộ nhớ đệm hình ảnh
(thời gian ghi đệm hình ảnh).

Cache Rec
Time

– –
Hiển thị thời gian để dồn hình ảnh trong bộ nhớ đệm hình
ảnh (thời gian ghi đệm hình ảnh).
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SDI/HDMI Rec Control

Đặt các cài đặt điều khiển ghi SDI/HDMI.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục
Mặc định
của nhà
sản xuất

Mô tả

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Đặt chức năng điều khiển bắt đầu/dừng ghi của một thiết bị kết nối bên
ngoài thông qua tín hiệu đầu ra SDI/HDMI.
Off: Không sử dụng điều khiển từ xa.
SDI/HDMI Remote I/F: Chức năng điều khiển bắt đầu/dừng ghi của một
thiết bị kết nối bên ngoài khi không gắn phương tiện nào vào thiết bị.
Không được đồng bộ hóa với độ chính xác của khung hình tới phương
tiện trong thiết bị.
Parallel Rec: Chức năng điều khiển bắt đầu/dừng ghi của một thiết bị kết
nối bên ngoài khi có gắn một phương tiện vào thiết bị. Đồng bộ với độ
chính xác khung hình tới phương tiện trong thiết bị.

Chú ý

Để điều khiển bằng tín hiệu đầu ra HDMI, hãy đặt [TC/Media] > [HDMI TC
Out] > [Setting] thành [On] trong menu camera.
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Assignable Button

Đặt các chỉ định chức năng cho các nút có thể gán (từ <1> đến <9>) và [Focus Hold Button].
Có thể chỉ định các chức năng sau.
[Off]: Không chỉ định chức năng.
[Base ISO/Sensitivity]: Chuyển đổi độ nhạy cơ sở của cảm biến hình ảnh.
[AGC]: Bật/tắt chức năng AGC.
[Push AGC]: Bật chức năng AGC khi ấn nút.
[ND Filter]

Ở chế độ biến đổi: Điều chỉnh truyền qua bộ lọc ND. Ấn và giữ để chuyển giữa Clear/Manual/Auto.
Ở chế độ đặt trước: Nhấn và giữ để chuyển các cài đặt trước.

[ND Filter Position]: Chuyển các bộ lọc ND.
[Auto ND Filter]: Bật/tắt chức năng bộ lọc ND tự động.
[Push Auto ND]: Bật chức năng bộ lọc ND tự động trong khi ấn nút.
[Auto Iris]: Bật/tắt chức năng cửa điều sáng tự động trong khi ấn nút.
[Push Auto Iris]: Bật chức năng cửa điều sáng tự động khi ấn nút.
[Bokeh Control]: Bật/tắt chế độ điều khiển bokeh.
[Auto Shutter]: Bật/tắt chức năng màn trập tự động.
[AE Level/Mode]: Điều chỉnh mức AE. Nhấn và giữ để chuyển chế độ AE.
[Backlight]: Chuyển đổi giữa Backlight và Standard.
[Spotlight]: Chuyển đổi giữa Spotlight và Standard.
[Preset White Select]: Chuyển đổi giá trị trong chế độ cài đặt sẵn về cân bằng trắng.
[ATW]: Bật/tắt chức năng ATW.
[ATW Hold]: Tạm dừng vận hành chức năng ATW.
[AF Speed/Sens.]: Chuyển đổi cài đặt tốc độ chuyển tiếp AF và cài đặt độ nhạy bắt nét chủ thể AF.
[Focus Setting]: Đặt vùng lấy nét.
[Face/Eye Detection AF]: Chuyển đổi các cài đặt lấy nét tự động phát hiện khuôn mặt.
[Push AF Mode]: Chuyển đổi cài đặt chế độ Push AF.
[Push AF/MF]: Trong chế độ lấy nét AF, ấn nút này sẽ kích hoạt MF. Trong chế độ lấy nét AF, nhấn nút này sẽ kích hoạt
MF.
[Focus Hold]: Trong chế độ lấy nét AF, ấn nút này sẽ cố định chức năng lấy nét.
[S&Q Motion]: Bật/tắt chức năng Chuyển động Nhanh và chậm. Nếu nhấn và giữ nút này sẽ đặt tốc độ khung hình
chụp.
[LUT On/Off]: Bật/tắt chức năng LUT. Đặt mục tiêu chuyển đổi bằng cách sử dụng [Shooting] > [LUT On/Off] > [LUT
On/Off Button Target].
[SteadyShot]: Chuyển đổi giữa Active, Standard và Off.
[Crop Select]: Chuyển đổi Imager Scan Mode. Đã bật tính năng chuyển đổi trong phạm vi mà không cần thay đổi định
dạng ghi.
[Rec]: Bắt đầu/dừng ghi.
[Picture Cache Rec]: Bật/tắt chế độ ghi đệm hình ảnh.
[Rec Review]: Bật/tắt chức năng xem lại bản ghi động.
[Clip Flag OK]: Thực hiện Add OK. Ấn hai lần để thực hiện Delete Clip Flag.
[Clip Flag NG]: Thực hiện Add NG. Ấn hai lần để thực hiện Delete Clip Flag.
[Clip Flag Keep]: Thực hiện Add KEEP. Ấn hai lần để thực hiện Delete Clip Flag.
[Slot Select]: Chuyển đổi khe cắm bộ nhớ (A) và (B).
[Color Bars]: Bật/tắt thanh màu.
[DURATION/TC/U-BIT]: Chuyển đổi giữa Time Code, Users Bit và Duration.
[Display]: Bật/: tắt các chỉ báo trên màn hình.
[Lens Info]: Chuyển đổi chỉ báo độ sâu trường ảnh.
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[Video Signal Monitor]: Chuyển đổi màn hình tín hiệu video (như màn hình dạng sóng).
[Marker]: Bật/tắt chức năng dấu mốc.
[Thumbnail]: Hiển thị/thoát màn hình ảnh thu nhỏ.
[Auto Upload (Proxy)]: Bật/tắt tính năng tự động tải lên tệp proxy.
[Direct Menu]: Hiển thị/thoát menu trực tiếp.
[User Menu]: Hiển thị/thoát menu User.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Scene File

Đặt các cài đặt liên quan đến các tệp cảnh quay (xem “Chụp với giao diện mong muốn”).
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Mục Cài đặt tiểu mục
Mặc định
của nhà
sản xuất

Mô tả

Recall – –

Tải tệp cảnh quay được lưu trữ trong
bộ nhớ trong và áp dụng các cài đặt
làm cài đặt chất lượng hình ảnh hiện
tại.

Store – –
Lưu trạng thái chất lượng hình ảnh
hiện tại dưới dạng tệp cảnh quay
trong bộ nhớ trong.

Delete – –
Xóa tệp cảnh quay được lưu vào bộ
nhớ trong.

Preset
Recall

Khi Shooting Mode được đặt thành Custom và
Target Display được đặt thành SDR(BT.709): S-
Cinetone / Standard / Still / ITU709/ 709tone
/ Khi Shooting Mode được đặt thành Custom và
Target Display được đặt thành HDR(HLG): HLG
Live / HLG Natural

–
Áp dụng cài đặt chất lượng hình ảnh
đặt trước (không thể ghi lại) làm cài
đặt chất lượng hình ảnh hiện tại.
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Base Look

Đặt cài đặt liên quan đến giao diện cơ sở.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Select

Khi Shooting Mode được đặt thành
Custom và Target Display được đặt thành
SDR(BT.709): S-Cinetone / Standard / Still /
ITU709 / 709tone / User1 thành User16
Khi Shooting Mode được đặt thành
Custom và Target Display được đặt thành
HDR(HLG): HLG Live / HLG Natural / User1
thành User16
Khi Shooting Mode được đặt thành chế
độ chụp Log: s709 / 709(800) / S-Log3 /
User1 thành User16

Khi Shooting Mode được đặt
thành Custom và Target Display
được đặt thành SDR(BT.709): S-
Cinetone
Khi Shooting Mode được đặt
thành Custom và Target Display
được đặt thành HDR(HLG): HLG
Live
Khi Shooting Mode được đặt
thành chế độ chụp Log: s709

Chọn giao diện cơ
sở.

Delete – –
Xóa giao diện cơ sở
đã chọn.

Delete
All

– –
Xóa tất cả giao diện
cơ sở.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 S-Gamut3.Cine/SLog3

Đặt gam màu đầu
vào cho giao diện cơ
sở đã chọn bằng
cách sử dụng
[Select].

Output BT.709 / HLG BT.709

Đặt gam màu đầu ra
cho giao diện cơ sở
đã chọn bằng cách
sử dụng [Select].

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 5/3EV /
2EV

0EV

Đặt giá trị tham chiếu
phơi sáng cho giao
diện cơ sở đã chọn
bằng cách sử dụng
[Select].
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Reset Paint Settings

Đặt lại các cài đặt của menu [Paint/Look] ngoại trừ giao diện cơ bản.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu
mục

Mặc định của nhà
sản xuất Mô tả

Reset without Base
Look

Execute /
Cancel

–
Đặt lại các cài đặt của menu [Paint/Look] ngoại trừ
giao diện cơ bản.
Execute: Thực hiện chức năng.
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Black

Đặt các cài đặt màu đen.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Master Black −99.0 đến +99.0 ±0.0 Đặt mức màu đen chính.

R Black −99.0 đến +99.0 ±0.0 Đặt mức màu đen R.

B Black −99.0 đến +99.0 ±0.0 Đặt mức màu đen B.
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Knee

Đặc các cài đặt hiệu chỉnh knee.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Setting

Khi Target Display được
đặt thành SDR(BT.709): On
/ Off / ---
Khi Target Display được
đặt thành HDR(HLG): On /
Off / ---

Khi Target Display được
đặt thành SDR(BT.709): Off
Khi Target Display được
đặt thành HDR(HLG): Off

Bật/tắt chức năng hiệu chỉnh knee.

Chú ý

Chỉ được bật khi [Base Look] > [Select]
được đặt thành [Standard], [ITU709],
[709tone], [HLG Live], hoặc [HLG Natural].

Auto
Knee

Khi Target Display được
đặt thành SDR(BT.709): On
/ Off / ---
Khi Target Display được
đặt thành HDR(HLG): On /
Off / ---

Khi Target Display được
đặt thành SDR(BT.709): On
Khi Target Display được
đặt thành HDR(HLG): Off

Bật/tắt chức năng knee tự động.

Chú ý

Chỉ được bật khi [Base Look] > [Select]
được đặt thành [Standard], [ITU709] hoặc
[709tone].

Point 75% - 109% 90% Đặt điểm knee.

Slope −99 đến +99 ±0 Đặt độ dốc knee.
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Detail

Đặt các cài đặt điều chỉnh chi tiết.
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Mục Cài đặt tiểu
mục

Mặc định
của nhà sản

xuất
Mô tả

Setting On / Off On Bật/tắt chức năng chi tiết.

Level −7 đến +7 ±0 Đặt mức chi tiết.

Manual
Setting

On / Off / --- Off Bật/tắt chức năng điều chỉnh chi tiết theo cách thủ công.

H/V Ratio −2 đến +2 ±0

Đặt độ cân bằng giữa chi tiết ngang (H) và chi tiết dọc (V) để điều
chỉnh chi tiết theo cách thủ công.

Chú ý

Mục này sẽ khác nhau tùy thuộc vào phiên bản phần mềm.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Đặt độ cân bằng giữa chi tiết màu đen (B) cho các vùng có độ
sáng thấp và chi tiết màu trắng (W) cho các vùng có độ sáng cao
để điều chỉnh chi tiết theo cách thủ công.

Limit 0 đến 7 7
Đặt mức giới hạn của chi tiết để điều chỉnh chi tiết theo cách thủ
công.

Crispening 0 đến 7 0 Đặt mức sắc nét của chi tiết để điều chỉnh chi tiết cách thủ công.

High Light
Detail

0 đến 4 0
Đặt mức chi tiết của các vùng có độ sáng cao để điều chỉnh chi tiết
theo cách thủ công.

Trong phiên bản phần mềm 1.00, mục menu là [V/H Balance]. Từ phiên bản phần mềm 1.10 trở lên, mục menu là [H/V Ratio]. Phạm vi cài đặt
không thay đổi từ −2 đến 0 đến +2, tuy nhiên hiệu ứng trong chất lượng hình ảnh khác nhau.
Phiên bản phần mềm 1.00: Giá trị đặt sẵn càng cao, chi tiết ngang (H) càng cao.
Phiên bản phần mềm 1.10 trở lên: Giá trị đặt sẵn càng cao, chi tiết dọc (V) càng cao.
Sau khi cập nhật phiên bản phần mềm từ 1.00 lên 1.10 trở lên, cài đặt [All File], [Scene File] và các cài đặt khác được kế thừa nhưng với phân
cực ngược (chất lượng hình ảnh được duy trì).
Nếu bạn đã đăng ký mục menu [V/H Balance] trong menu [User], nó sẽ được tự động thay thế bằng mục menu [H/V Ratio] trong menu [User]
sau khi cập nhật phần mềm.

*1
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Matrix

Đặc các cài đặt hiệu chỉnh ma trận.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

User Matrix On / Off Off
Bật/tắt chức năng hiệu chỉnh ma trận của người
dùng.

User Matrix Level −99 đến +99 ±0 Điều chỉnh độ bão hòa màu của toàn bộ hình ảnh.

User Matrix
Phase

−99 đến +99 ±0 Điều chỉnh tông màu (pha) của toàn bộ hình ảnh.

User Matrix R-G −99 đến +99 ±0 Đặt ma trận người dùng R-G do người dùng xác
định.

User Matrix R-B −99 đến +99 ±0
Đặt ma trận người dùng R-B do người dùng xác
định.

User Matrix G-R −99 đến +99 ±0
Đặt ma trận người dùng G-R do người dùng xác
định.

User Matrix G-B −99 đến +99 ±0
Đặt ma trận người dùng G-B do người dùng xác
định.

User Matrix B-R −99 đến +99 ±0 Đặt ma trận người dùng B-R do người dùng xác
định.

User Matrix B-G −99 đến +99 ±0
Đặt ma trận người dùng B-G do người dùng xác
định.
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Multi Matrix

Đặc cài đặt đa hiệu chỉnh ma trận.
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Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Setting On / Off Off
Bật/tắt chức năng đa hiệu chỉnh ma
trận.

Reset Execute / Cancel –
Đặt lại màu sắc và độ bão hòa của
mỗi màu trục về giá trị mặc định.

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL− / YL
/ YL+ / G− / G / G+ / CY / CY+ / B−

B Chọn trục.

Hue −99 đến +99 ±0
Đặt sắc độ màu sử dụng để đa hiệu
chỉnh ma trận.

Saturation −99 đến +99 ±0
Đặt độ bão hòa màu sử dụng để đa
hiệu chỉnh ma trận.
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P/T Acceleration

Đặt các cài đặt liên quan đến gia tốc cho các hoạt động xoay/nghiêng.
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Mục Cài đặt tiểu
mục

Mặc định của nhà
sản xuất Mô tả

Ramp
Curve

1 đến 9 8
Chọn gia tốc/giảm tốc cho các hoạt động xoay/nghiêng. Số càng
lớn thì gia tốc càng cao.
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Timecode

Đặt các cài đặt mã thời gian.
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Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Mode
Preset / Regen /
Clock

Preset

Đặt chế độ chạy mã thời gian.
Preset: Bắt đầu chạy từ giá trị cài đặt sẵn.
Regen: Bắt đầu chạy từ mã thời gian đó đến hết clip
trước.
Clock: Sử dụng đồng hồ bên trong làm mã thời gian.

Run Rec Run / Free Run Rec Run Rec Run: Chỉ chạy khi đang ghi.
Free Run: Luôn chạy bất kể hoạt động ghi.

Setting – –
Đặt mã thời gian thành giá trị tùy ý.
Set: Đặt giá trị.

Reset Execute / Cancel –
Đặt lại mã thời gian về 00:00:00:00.
Execute: Thực hiện chức năng.

TC
Format

DF / NDF DF
Đặt định dạng mã thời gian.
DF: Drop Frame
NDF: Non-Drop Frame
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TC Display

Đặt các cài đặt hiển thị dữ liệu thời gian.
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Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Display
Select

Timecode / Users Bit /
Duration

Timecode
Chuyển đổi hiển thị dữ liệu thời
gian.
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Users Bit

Đặt các cài đặt liên quan đến bit của người dùng.
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Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

Mode Fix / Time Fix

Đặt chế độ bit của người dùng.
Fix: Sử dụng giá trị cố định tùy ý bằng bit của người dùng.
Time: Sử dụng giờ, phút và giây hiện tại theo bit của người
dùng.

Setting – – Đặt bit của người dùng thành giá trị tùy ý.
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HDMI TC Out

Đặt cài đặt liên quan đến đầu ra mã thời gian khi sử dụng HDMI.
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Mục Cài đặt tiểu
mục

Mặc định của nhà
sản xuất Mô tả

Setting On / Off Off
Đặt xem có xuất mã thời gian ra thiết bị vì các mục đích khác bằng
cách sử dụng HDMI không.
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Clip Name Format

Đặt các cài đặt liên quan đến đặt tên và xóa clip.
Khi [Auto Naming] được đặt thành [Cam ID + Reel#], bốn ký tự đầu tiên của tên clip được xác định cho từng phương
tiện ghi. Khi phương tiện ghi mới được lắp vào hoặc khi clip cuối cùng trên phương tiện ghi không khớp với cài đặt
[Camera ID] hoặc [Reel Number], tên clip nhấp nháy để thông báo cho bạn.
Khi [Auto Naming] được đặt thành [Title], bạn có thể sử dụng chuỗi ký tự tùy ý làm phần đầu tiên của tên clip.

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Auto
Naming

Cam ID + Reel# / Title

Chọn định dạng đặt tên clip.
Cam ID + Reel#: ID Máy quay + Số cuộn + Số lần chụp +
ngày + chuỗi ngẫu nhiên
Title: Chuỗi bất kỳ được chỉ định bởi [Title Prefix] + số
lượng clip

Camera ID A đến Z A

Đặt ID Máy quay đã dùng khi tạo tên clip.

Chú ý

Chỉ có thể cấu hình khi [Auto Naming] được đặt thành
[Cam ID + Reel#].

Reel
Number

001 đến 999 001

Đặt phần số cuộn được sử dụng khi tạo tên clip.

Chú ý

Chỉ có thể cấu hình khi [Auto Naming] được đặt thành
[Cam ID + Reel#].

Camera
Position

C / L / R C

Đặt phần ký tự đầu tiên của Số lần chụp được sử dụng khi
tạo tên clip.

Chú ý

Chỉ có thể cấu hình khi [Auto Naming] được đặt thành
[Cam ID + Reel#].

Title Prefix

nnn_(nnn là 3 chữ số
cuối cùng của số sê-ri)
(Hiển thị tối đa 7 chữ
số)

nnn

Đặt phần tiêu đề (4 đến 46 ký tự) của tên clip.
Mở màn hình nhập chuỗi ký tự.

Để biết chi tiết về cách đặt tiêu đề và màn hình nhập ký
tự, hãy xem “Để đặt tiêu đề” bên dưới và “Nhập chuỗi
ký tự”.

Chú ý

Chỉ có thể cấu hình khi [Auto Naming] được đặt thành
[Title].
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Đặt [Title Prefix]

Chủ đề liên quan

Nhập chuỗi ký tự
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Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Number
Set

0001 đến 9999 0001

Đặt hậu tố tên clip là số gồm 4 chữ số.

Chú ý

Chỉ có thể cấu hình khi [Auto Naming] được đặt thành
[Title].

Chọn ký tự để chèn tại vị trí con trỏ trong vùng [Title Prefix] từ vùng chọn ký tự bằng cách sử dụng các nút
mũi tên và ấn nút trong bảng điều khiển (ký tự được tô sáng) và ấn nút [Set] trong bảng điều khiển GUI.

Ký tự đã chọn được chèn, và con trỏ di chuyển sang bên phải.

1

Lặp lại bước 1 để đặt tiêu đề.

Sử dụng [BS] theo yêu cầu.

2

Sau khi đặt tiêu đề, nhấn nút [Done] để đóng màn hình nhập ký tự.

Để biết chi tiết về thao tác trên màn hình nhập ký tự, hãy xem “Nhập chuỗi ký tự.”

Có thể chọn các ký tự sau.
!#$%()+,-.;=@[ ]^_~ khoảng trắng
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3

339



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Update Media

Cập nhật tệp quản lý trên thẻ nhớ (xem “Khôi phục thẻ nhớ”).

Chủ đề liên quan

Khôi phục thẻ nhớ
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Media(A) Execute / Cancel –
Cập nhật tệp quản lý trên thẻ nhớ trong khe A.
Execute: Thực hiện chức năng.

Media(B) Execute / Cancel –
Cập nhật tệp quản lý trên thẻ nhớ trong khe B.
Execute: Thực hiện chức năng.
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Format Media

Định dạng (khởi tạo) thẻ nhớ (hãy tham khảo “Định dạng (khởi tạo) thẻ nhớ”).

Chủ đề liên quan
Định dạng (khởi tạo) thẻ nhớ
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Media(A) Full Format / Quick Format / Cancel – Định dạng thẻ nhớ trong khe A.

Media(B) Full Format / Quick Format / Cancel – Định dạng thẻ nhớ trong khe B.
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Media Life

Hiển thị thời gian sử dụng còn lại của thẻ nhớ.

Chú ý

Yêu cầu thẻ nhớ hỗ trợ hiển thị thời gian sử dụng còn lại của phương tiện.
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Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

Media(A) – –
Hiển thị thời gian sử dụng còn lại của thẻ nhớ trong khe
A.

Media(B) – –
Hiển thị thời gian sử dụng còn lại của thẻ nhớ trong khe
B.
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Output Format

Đặt các cài đặt định dạng đầu ra.

Chủ đề liên quan

Định dạng đầu ra và giới hạn
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Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

SDI Để biết thêm thông tin chi tiết về cài đặt, hãy tham khảo
“Định dạng đầu ra và giới hạn.”

– Đặt độ phân giải đầu ra
SDI và HDMI.HDMI –
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Display On/Off

Đặt các cài đặt mục hiển thị.
Để hiển thị mục hiển thị, chọn On. Để ẩn mục hiển thị, chọn Off.

Mục Cài đặt tiểu mục Mặc định của nhà sản xuất

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Đặt các cài đặt màn hình tín hiệu video.
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Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Setting
Off / Waveform / Vector /
Histogram

Off Đặt loại màn hình tín hiệu video.

Level Marker
1

0% - 109% 70%
Đặt mức của dấu mốc mức độ sáng
1.

Level Marker
2

0% - 109% 100%
Đặt mức của dấu mốc mức độ sáng
2.

346
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Marker

Đặt các cài đặt hiển thị dấu mốc.

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Setting On / Off On Bật/tắt màn hình hiển thị tất cả các dấu mốc.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Chọn màu tín hiệu dấu mốc.

Center
Marker

1 / 2 / 3 / 4 / Off Off Chọn dấu mốc trung tâm.

Safety Zone On / Off Off Bật/tắt dấu mốc vùng an toàn.

Safety Area 80% / 90% / 92.5% / 95% 90%
Chọn kích thước của dấu mốc vùng an toàn
(dưới dạng phần trăm của tổng kích thước màn
hình).

Aspect
Marker

Line / Mask / Off Off Chọn loại dấu mốc khung hình.

Aspect
Mask

0 đến 15 12 Chọn mức tín hiệu video ngoài dấu mốc.

Aspect
Safety Zone

On / Off Off Bật/tắt dấu mốc vùng an toàn của khung hình.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Chọn kích thước của dấu mốc vùng an toàn của
khung hình (dưới dạng phần trăm của tổng kích
thước màn hình).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 /
16:9 / 17:9 / 1.66:1 / 1.85:1 /
2.35:1 / 2.39:1 / Custom

2.39:1 Đặt chế độ khi hiển thị dấu mốc của khung hình.

Custom
Aspect
Ratio

Nhập một giá trị tùy ý. 01.00:01.00

Đặt tỷ lệ màn ảnh thành giá trị tùy ý.

Chú ý

Được bật khi [Aspect Select] được đặt thành
[Custom].

Guide
Frame

On / Off Off
Bật/tắt màn hình hiển thị khung hình dẫn
hướng.

100%
Marker

On / Off Off Bật/tắt 100% dấu mốc.

User Box On / Off Off
Bật/tắt màn hình hiển thị dấu mốc hộp người
dùng.
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Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

User Box
Width

3 đến 479 240
Cài đặt chiều rộng của dấu mốc hộp người dùng
(khoảng cách từ trung tâm đến cạnh bên trái và
bên phải).

User Box
Height

3 đến 269 135
Cài đặt chiều cao của dấu mốc hộp người dùng
(khoảng cách từ trung tâm đến cạnh trên và
cạnh dưới).

User Box H
Position

−476 đến +476 0 Đặt vị trí ngang của trung tâm dấu mốc hộp
người dùng.

User Box V
Position

−266 đến +266 0
Đặt vị trí dọc của trung tâm dấu mốc hộp người
dùng.
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Interchangeable Lens Digital Camera
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Audio Input

Đặt các cài đặt đầu vào âm thanh.

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

AUDIO IN
Select

MIC / LINE MIC Chọn loại thiết bị được kết nối với đầu nối AUDIO IN.

Phantom
Power +48V

On / Off Off Hiển thị trạng thái của cấp nguồn ảo +48 V.

CH1 Input
Select

AUDIO IN CH1
AUDIO IN
CH1

Hiển thị nguồn đầu vào để ghi trên kênh 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

Chuyển đổi nguồn đầu vào để ghi trên kênh 2.

CH3 Input
Select

Off / AUDIO IN CH1
AUDIO IN
CH1

Chuyển đổi nguồn đầu vào để ghi trên kênh 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

Chuyển đổi nguồn đầu vào để ghi trên kênh 4.

AUDIO IN CH1
MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Đặt mức ghi tham chiếu cho đầu vào micrô XLR từ AUDIO
IN CH1.

AUDIO IN CH2
MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Đặt mức ghi tham chiếu cho đầu vào micrô XLR từ AUDIO
IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Chọn mức đầu vào tham chiếu khi [AUDIO IN Select] được
đặt thành LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB Chọn mức ghi của tín hiệu tông tham chiếu 1 kHz.

CH1 Wind
Filter

On / Off Off Bật/tắt bộ lọc giảm gió để ghi kênh 1.

CH2 Wind
Filter

On / Off Off Bật/tắt bộ lọc giảm gió để ghi kênh 2.

CH3 Wind
Filter

On / Off Off Bật/tắt bộ lọc giảm gió để ghi kênh 3.

CH4 Wind
Filter

On / Off Off Bật/tắt bộ lọc giảm gió để ghi kênh 4.

CH1 Level
Control

Auto / Manual Auto
Chọn điều chỉnh tự động mức âm thanh đầu vào hoặc điều
chỉnh thủ công để ghi kênh 1.
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Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

CH2 Level
Control

Auto / Manual Auto
Chọn điều chỉnh tự động mức âm thanh đầu vào hoặc điều
chỉnh thủ công để ghi kênh 2.

CH3 Level
Control

Auto / Manual Auto
Chọn điều chỉnh tự động mức âm thanh đầu vào hoặc điều
chỉnh thủ công để ghi kênh 3.

CH4 Level
Control

Auto / Manual Auto
Chọn điều chỉnh tự động mức âm thanh đầu vào hoặc điều
chỉnh thủ công để ghi kênh 4.

CH1 Input
Level

0 đến 99 49 Đặt mức nguồn đầu vào để ghi kênh 1.

CH2 Input
Level

0 đến 99 49 Đặt mức nguồn đầu vào để ghi kênh 2.

CH3 Input
Level

0 đến 99 49 Đặt mức nguồn đầu vào để ghi trên kênh 3.

CH4 Input
Level

0 đến 99 49 Đặt mức nguồn đầu vào để ghi kênh 4.

Master Input
Level

0 đến 99 99 Đặt mức đầu vào âm thanh chính.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Chọn đặc điểm của bộ giới hạn đối với các tín hiệu đầu vào
lớn khi điều chỉnh thủ công mức đầu vào âm thanh.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Đặt chế độ điều chỉnh mức âm thanh để ghi kênh 1 và kênh
2. Khi đặt thành Stereo, AGC được liên kết giữa các kênh.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Đặt chế độ điều chỉnh mức âm thanh để ghi kênh 3 và kênh
4. Khi đặt thành Stereo, AGC được liên kết giữa các kênh.

AGC Spec
−6dB / −9dB / −12dB
/ −15dB / −17dB

−6dB Chọn đặc điểm AGC.

1kHz Tone on
Color Bars

On / Off Off

Bật/tắt tín hiệu tông tham chiếu 1 kHz khi hiển thị các thanh
màu.

Chú ý

Khi đặt thành [On], tín hiệu tông tham chiếu 1 kHz được đặt
để ghi trên kênh 3 và kênh 4, ngay cả khi [CH3 Input
Select] và [CH4 Input Select] được đặt thành [Off].
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Audio Output

Đặt các cài đặt đầu ra âm thanh.
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Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

HDMI/Stream Output
CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Đặt kết hợp các kênh âm thanh trên đầu ra
HDMI/phát trực tiếp.

351



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display Clip Properties

Hiển thị màn hình thuộc tính clip.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Display Clip Properties – – Hiển thị màn hình thuộc tính clip.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Set Clip Flag

Đặt các cài đặt cờ clip.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Add OK – – Thêm cờ OK.

Add NG – – Thêm cờ NG.

Add KEEP – – Thêm cờ KEEP.

Delete Clip Flag – – Xóa tất cả các cờ.
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Interchangeable Lens Digital Camera
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Lock/Unlock Clip

Đặt các cài đặt bảo vệ clip.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Select Clip – – Chọn và khóa/mở khóa clip.

Lock All Clips – – Khóa tất cả clip.

Unlock All Clips – – Mở khóa tất cả clip.
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Interchangeable Lens Digital Camera
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Delete Clip

Xóa các clip.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Select Clip – – Xóa clip đã chọn.

All Clips – – Xóa tất cả các clip.
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Interchangeable Lens Digital Camera
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Transfer Clip

Chuyển clip.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Select Clip – – Chuyển các clip đã chọn.

All Clips – –

Chuyển tất cả các clip.

Chú ý

Có thể đăng ký tối đa 200 lệnh truyền.
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Interchangeable Lens Digital Camera
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Transfer Clip (Proxy)

Chuyển các clip proxy.
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Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

Select
Clip

– – Chuyển các clip proxy tương ứng với các clip đã chọn.

All Clips – –

Chuyển các clip proxy tương ứng với tất cả các clip đã
chọn.

Chú ý

Có thể đăng ký tối đa 200 lệnh truyền.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Filter Clips

Đặt các cài đặt của clip để hiển thị.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

OK – – Chỉ hiển thị các clip có cờ OK.

NG – – Chỉ hiển thị các clip có cờ NG.

KEEP – – Chỉ hiển thị các clip có cờ KEEP.

None – – Chỉ hiển thị clip không có cờ.

All – – Hiển thị tất cả các clip, bất kể chúng có cờ hay không.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Customize View

Chuyển đổi dạng xem màn hình ảnh thu nhỏ.
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Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Chuyển đổi thông tin hiển thị
dưới thumbnail.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Color Bars

Đặt các cài đặt thanh màu.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Setting On / Off Off Bật/tắt thanh màu.

Type ARIB / 100% / 75% / SMPTE ARIB Chọn loại thanh màu.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Genlock

Định cấu hình hiển thị trạng thái genlock (hãy tham khảo “Đồng bộ hóa pha của tính hiệu video (Genlock)”).

Chủ đề liên quan

Đồng bộ hóa pha của tính hiệu video (Genlock)
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Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Reference
Internal / External(HD) /
External(SD)

–
Hiển thị loại tín hiệu tham chiếu
genlock.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

Đặt các cài đặt đèn ghi/đếm (xem “Kết nối tín hiệu báo hiệu”).

Chủ đề liên quan
Kết nối tín hiệu báo hiệu
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Mục Cài đặt tiểu
mục

Mặc định của nhà
sản xuất Mô tả

Tally Lamp
Brightness

High / Low /
Off

High Đặt độ sáng của đèn ghi/đếm.

G Tally Lamp
Enable /
Disable

Enable Bật/tắt đèn đếm G.

Tally Control
External /
Internal

Internal

Chọn mục tiêu để chấp nhận thông tin điều khiển đèn
ghi/đếm của thiết bị.
External: Điều khiển đếm từ bên ngoài máy quay.
Internal: Điều khiển thông qua vận hành ghi hình của
máy quay.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Review

Đặt cài đặt xem lại bản ghi (hãy tham khảo “Xem lại bản ghi (Rec Review)”).

Chủ đề liên quan
Xem lại bản ghi (Rec Review)
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Setting 3s / 10s / Clip 3s Đặt thời gian phát lại clip vừa ghi để xem lại bản ghi.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zoom

Đặt cài đặt zoom (“Điều chỉnh thu phóng”).
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Đặt loại zoom.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lens

Đặt các cài đặt liên quan đến ống kính.

Chủ đề liên quan
Bù góc nhìn
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Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Lens Calibration Execute / Cancel –
Thực thi chức năng sửa các chênh lệch về vị trí thu
phóng do sự khác biệt trong các ống kính riêng lẻ
khi sử dụng ống kính thu phóng công suất.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Đặt hướng vận hành vòng thu phóng.

Chú ý

Chỉ được bật khi sử dụng ống kính ngàm E hỗ trợ
chuyển đổi hướng vòng thu phóng.

Shading
Compensation

Auto / Off Auto Đặt chức năng bù đổ bóng tự động.

Chroma
Aberration Comp.

Auto / Off Auto Đặt chức năng bù quang sai màu tự động.

Distortion Comp. Auto / Off Auto Đặt chức năng bù méo tự động.

Breathing
Compensation

Auto / Off Off
Đặt chức năng bù góc nhìn ống kính.

Xem “Bù góc nhìn.”

Distance Display Meter / Feet Meter
Đặt đơn vị hiển thị cho thông tin ống kính và vị trí
lấy nét.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length Đặt định dạng hiển thị cho vị trí thu phóng.
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Interchangeable Lens Digital Camera
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APR

Thực hiện APR.
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Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

APR
Execute /
Cancel –

Chạy APR (Khôi phục pixel tự động) để điều chỉnh tự động cảm
biến hình ảnh.
Execute: Thực hiện chức năng.

Chú ý

Luôn gắn nắp ống kính trước khi chạy APR.
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Interchangeable Lens Digital Camera
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Wired LAN

Đặt các cài đặt liên quan đến kết nối mạng LAN có dây.
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Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

HTTP Port – 80 Hiển thị cổng truy cập HTTP.

Detail
Settings

– – Hiển thị các thuộc tính của kết nối mạng LAN có dây.

DHCP
On / Off

On Hiển thị xem DHCP được bật (On) hay tắt (Off).

IP Address –
Hiển thị địa chỉ IP của thiết bị khi đặt [DHCP] thành
[Off].

Subnet Mask –
Hiển thị mặt nạ mạng con của thiết bị khi đặt [DHCP]
thành [Off].

Gateway –
Hiển thị cổng mặc định của thiết bị khi đặt [DHCP]
thành [Off].

DNS Auto
On / Off

On Hiển thị cài đặt chuyển đổi DNS auto.
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File Transfer

Đặt cài đặt liên quan đến truyền tệp (xem “Giới thiệu về truyền tệp”).

Chủ đề liên quan

Giới thiệu về truyền tệp
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Mục Cài đặt tiểu mục
Mặc định

của nhà sản
xuất

Mô tả

Auto Upload
(Proxy)

On / Off Off Bật/tắt tính năng tự động tải lên tệp proxy.

Default
Upload Server

Server Settings1
thành 3 > Display
Name

–

Chọn máy chủ tải lên cho tệp. Máy chủ được chọn ở đây sẽ
trở thành đích tải lên tự động cho các tệp proxy và đích tải lên
cho các tệp từ màn hình ảnh thu nhỏ.
Hiển thị các cài đặt [Display Name] được cấu hình trong
[Server Settings1 đến 3].

Clear
Completed
Jobs

Execute / Cancel –
Xóa tất cả các tác vụ truyền đã hoàn tất khỏi danh sách.
Execute: Thực hiện chức năng.

Clear All Jobs Execute / Cancel –
Xóa tất cả các tác vụ truyền khỏi danh sách.
Execute: Thực hiện chức năng.

View Job List – – Hiển thị danh sách tác vụ truyền.
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Language

Đặt ngôn ngữ hiển thị.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Select – –
Đặt ngôn ngữ hiển thị.
Set: Đặt giá trị.
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Clock Set

Đặt các cài đặt đồng hồ bên trong.

Chú ý

Khi cài đặt này được thay đổi từ menu camera, hãy tắt nguồn thiết bị và khởi động lại thiết bị. Hành vi không mong muốn có thể
xảy ra nếu chế độ chờ nguồn được bắt đầu bằng điều khiển hồng ngoại từ xa hoặc Ứng dụng web.
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Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Time
Zone

UTC − 12:00 đến UTC +
14:00

–
Đặt độ chênh thời gian so với UTC theo đơn
vị 30 phút.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Chọn định dạng hiển thị ngày.
YYMMDD: Năm, tháng, ngày
MMDDYY: Tháng, ngày, năm
DDMMYY: Ngày, tháng, năm

12H/24H 12H / 24H 24H
Chọn định dạng hiển thị đồng hồ.
12H: chế độ 12 giờ
24H: chế độ 24 giờ

Date – –
Đặt ngày hiện tại.
Set: Đặt giá trị.

Time – –
Đặt giờ hiện tại.
Set: Đặt giá trị.
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Hours Meter

Hiển thị thời gian chạy cộng dồn.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Hours(System) – – Hiển thị giờ sử dụng cộng dồn (không thể đặt lại).

Hours(Reset) – – Hiển thị giờ sử dụng cộng dồn (có thể đặt lại).

Reset Execute / Cancel –
Đặt lại thời gian chạy cộng dồn thành 0.
Execute: Thực hiện chức năng.
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Cài đặt và giá trị mặc định ISO/Gain

Phạm vi của các cài đặt và giá trị mặc định của [ISO/Gain<L>] khác nhau tùy vào các cài đặt [Mode], [Base Look] >
[Select] và [Base Sensitivity].
Giá trị mặc định trong bảng được in đậm.

Khi [Mode] được đặt thành [ISO]

Khi [Base Look] > [Select] được đặt thành [S-Cinetone], [Standard], [ITU709], [709tone] hoặc [Still]

Khi [Base Look] > [Select] được đặt thành [HLG Live] hoặc [HLG Natural]

Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[Low]

Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Khi [Base Look] > [Select] được đặt thành [User1] thành [User16]

Khi [Mode] được đặt thành [dB]

Có thể định cấu hình giá trị trong phạm vi từ −3dB đến +30dB với gia số 1dB.
Giá trị mặc định là 0dB.
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Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[Low]

Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[Low]

Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Cài đặt và giá trị mặc định AGC Limit

Phạm vi của các cài đặt menu và giá trị mặc định của [AGC Limit] khác nhau tùy vào các cài đặt [Mode], [Base Look] >
[Select] và [Base Sensitivity].
Giá trị mặc định trong bảng được in đậm.

Khi [Mode] được đặt thành [ISO]

Khi [Base Look] > [Select] được đặt thành [S-Cinetone], [Standard], [ITU709], [709tone] hoặc [Still]

Khi [Base Look] > [Select] được đặt thành [HLG Live] hoặc [HLG Natural]

Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[Low]

Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Khi [Base Look] > [Select] được đặt thành [User1] thành [User16]

Khi [Mode] được đặt thành [dB]

Chọn từ 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Giá trị mặc định là 15dB.
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Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[Low]

Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[Low]

Khi [ISO/Gain/EI] > [Base Sensitivity] được đặt thành
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Cài đặt chất lượng hình ảnh đã lưu dành cho mỗi chế độ chụp

Trạng thái hiện tại của các mục cấu hình liên quan đến chất lượng hình ảnh được lưu cho mỗi chế độ chụp sau đây. Khi
bạn thay đổi chế độ chụp, cài đặt tương ứng đã lưu cho chế độ chụp mục tiêu được áp dụng.

Hiển thị mục tiêu trong chế độ Custom SDR(BT.709)
Hiển thị mục tiêu trong chế độ Custom HDR(HLG)
Chụp Log (Cine EI, Cine EI Quick, Flexible ISO)

Các mục cấu hình liên quan đến chất lượng hình ảnh mà được lưu cho từng chế độ chụp được trình bày trong các bảng
sau.
“Có” cho biết một cài đặt đã được lưu và “Không” cho biết một cài đặt chưa được lưu. “Có” bao trùm nhiều cột biểu thị
các cài đặt phổ biến.

Mục

Chế độ chụp

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Shooting

ISO/Gain/EI

ISO/Gain Có1) Có Không

Exposure Index Không Không Có Có

Base Sensitivity Có Không

Base ISO Không Có4) Không3) Có4)

White
Preset White Có Có

Khác Có

White Setting Có

Offset White Có Không

LUT On/Off Không Có

Noise
Suppression

Setting(Custom) Có Có Không

Level(Custom) Có Có Không

Setting (Cine
EI/Flex. ISO) Không Có

Level (Cine EI/Flex.
ISO)

Không Có
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Mục

Chế độ chụp

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Paint/Look

Base Look

Select Có Có Có

Input2) Có

Output2) Có

Bù mức AE 2) Có

Black Có Có Không

Knee
Auto Knee Có Không Không

Khác Có Có Không

Detail Có Có Không

Matrix Có Có Không

Multi Matrix Có Có Không

Các cài đặt độ nhạy ISO riêng biệt được lưu cho cả chế độ Custom SDR(BT.709) và HDR(HLG).1)

Cài đặt được lưu cho mỗi Giao diện cơ sở và không phụ thuộc vào chế độ chụp.2)

Độ nhạy ISO cơ bản thay đổi cùng với chỉ số phơi sáng.3)

Giá trị cài đặt chung trong các chế độ chụp Flexible ISO và Cine EI.4)
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Cấu hình menu web

Nhấn vào thẻ chuyển màn hình vận hành [Settings] để hiển thị màn hình cài đặt.
Sử dụng màn hình cài đặt để cấu hình các mục thiết lập khác nhau của thiết bị, bao gồm cài đặt ban đầu, cài đặt mạng,
cài đặt ghi hình/phát lại bằng menu web.

Menu gồm các menu sau.

Hệ thống phân cấp và cấu hình menu

Cấp 1 Mô tả cấp 1 Cấp 2

Shooting Chứa các cài đặt liên quan đến chụp. Focus
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Cấp 1 Mô tả cấp 1 Cấp 2

Project Chứa các cài đặt cơ bản cho dự án.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Chứa các cài đặt liên quan đến chất lượng hình ảnh. Base Look

Pan-Tilt Chứa các cài đặt liên quan đến xoay/nghiêng.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring Chứa các cài đặt liên quan đến đầu ra video và hiển thị màn hình.
Output Format

Output Display

Audio Chứa các cài đặt liên quan đến âm thanh. Audio

Technical Chứa các cài đặt về mục kỹ thuật.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Chứa các cài đặt liên quan đến mạng.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack Protection

379



Chú ý

[Accessibility] chỉ có trên các kiểu máy ở thị trường Bắc Mỹ.
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Cấp 1 Mô tả cấp 1 Cấp 2

Stream Chứa các cài đặt liên quan đến phát trực tiếp.

Stream

Video Stream

Audio Stream

Maintenance Chứa các cài đặt thiết bị, như đồng hồ và ngôn ngữ.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software

380



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vận hành menu web

Ấn vào thẻ chuyển đổi màn hình vận hành [Settings] để hiển thị màn hình cài đặt để định cấu hình các mục cài đặt khác
nhau của thiết bị, bao gồm cài đặt ban đầu, cài đặt mạng, cài đặt chụp/phát lại bằng menu web.
Định cấu hình cài đặt trong menu web trên máy tính bảng bằng thao tác chạm hoặc trên máy tính bằng thao tác chuột.
Nhấn vào menu cho các mục bạn muốn định cấu hình để hiển thị các mục thiết lập và cài đặt của chúng trong menu đó.

Phương pháp cấu hình

Lựa chọn giá trị

Nhấn nút radio cho một mục. Nút radio cho một mục đã chọn được hiển thị bằng màu cam.

Menu (mức 1)1.

Menu (mức 2)2.

Cài đặt3.
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Bật/tắt mục

Nhấn công tắc để bật/tắt mục. Công tắc có màu cam khi mục được bật và có màu trắng khi mục được tắt.

Lựa chọn giá trị từ danh sách

Nhấn nút thả xuống và chọn một mục từ danh sách được hiển thị.

Lựa chọn giá trị số

Nhấn < hoặc > để thay đổi giá trị số. Nếu giá trị số được gạch dưới, bạn cũng có thể nhập trực tiếp giá trị số.

Nhập ký tự/số

Cấu hình trên màn hình riêng biệt
Nhấn nút để thực hiện các thao tác thiết lập trên một màn hình riêng biệt.

Thông báo hướng dẫn

Thông tin giúp bạn định cấu hình một số cài đặt và thông báo kêu gọi sự chú ý đến người dùng được hiển thị.

Lưu cài đặt

Khi hoàn tất cấu hình một cài đặt, nhấn nút [OK] để lưu cài đặt.
Nhấn nút [Cancel] để hủy các thay đổi đối với một cài đặt và hoàn nguyên về cài đặt trước đó.
Nhấn nút [Reload] để cập nhật hiển thị màn hình.

Chú ý

Nếu bạn nhấn nút [Reload] trước khi lưu cài đặt, các thay đổi đối với cài đặt sẽ bị hủy.

Nếu bạn chuyển sang một trang khác trước khi lưu cài đặt, các thay đổi đối với cài đặt sẽ bị hủy.
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Focus

Đặt các cài đặt lấy nét.

Chủ đề liên quan

Cài đặt mục tiêu lấy nét thủ công (AF Assist) bằng Ứng dụng web
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Mục Cài đặt tiểu
mục

Mặc định của
nhà sản xuất Mô tả

Push AF
Mode

AF / Single-
shot AF(AF-S)

AF Đặt chế độ lấy nét tự động đẩy.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Đặt vận hành này khi chạm vào màn hình hình ảnh máy quay
trong chế độ MF.

AF Assist
Control

On / Off On

Khi đặt thành [On], bạn có thể sử dụng thanh trượt lấy nét trong
Ứng dụng web trong quá trình lấy nét tự động để điều chỉnh vị
trí lấy nét.

Để biết thêm thông tin chi tiết, hãy tham khảo “Cài đặt mục
tiêu lấy nét thủ công (AF Assist) bằng Ứng dụng web.”

Chú ý

Mục này chỉ được bật khi [AF Assist] được đặt thành [On] trong
menu camera.
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Base Setting

Đặt các cài đặt cơ sở.

Chủ đề liên quan

Cấu hình vận hành máy quay cơ bản
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Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI

Custom

Đặt chế độ ghi hình.

Hãy tham khảo “Chế độ chụp” trong “Cấu
hình vận hành máy quay cơ bản.”

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Đặt gam màu của ghi hình/đầu ra trong chế
độ Custom.
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Rec Format

Đặt các cài đặt định dạng quay.

Cài đặt [RAW Output Format]

Mục Cài đặt tiểu mục
Mặc định

của nhà sản
xuất

Mô tả

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Chọn tần số của hệ thống.

Chú ý

Nếu thay đổi tần số, camera sẽ khởi động
lại. Sau khi khởi động lại, hãy tải lại trang
trên trình duyệt web.

Imager Scan
Mode

FF / S35 FF Chọn kích thước hình ảnh.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Đặt codec ghi/phát lại clip.

Chú ý

Khi [Imager Scan Mode] được đặt thành
[S35], không thể chọn [RAW] và [RAW &
XAVC-I].

RAW Output
Format

Các cài đặt có sẵn khác nhau tùy
thuộc vào cài đặt [Frequency].

Tham khảo “Cài đặt [RAW Output
Format]” bên dưới.

–

Đặt kích thước hình ảnh RAW để xuất bản
ghi RAW bên ngoài.

Chú ý

Khi [Codec] được đặt thành [RAW &
XAVC-I], cài đặt [Video Format] chuyển
sang liên kết với cài đặt [RAW Output
Format].

Video Format

Các cài đặt có sẵn khác nhau tùy
thuộc vào cài đặt [Frequency],
[Imager Scan Mode] và [Codec].

Tham khảo “Cài đặt [Video
Format]” bên dưới.

– Đặt kích thước hình ảnh.

Frequency Imager Scan Mode Codec Cài đặt

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160
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Các giá trị mặc định được bôi đậm.
Đã bỏ qua các điều kiện không thể đặt [RAW Output Format].

Cài đặt [Video Format]

Các giá trị mặc định được bôi đậm.

5-041-959-03(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Cài đặt

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan Mode Codec Cài đặt

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Đặt cài đặt chế độ ghi đồng thời 2 khe (tham khảo “Ghi đồng thời vào các thẻ nhớ A và B (2-slot Simul Rec)”).

Chủ đề liên quan

Ghi đồng thời vào các thẻ nhớ A và B (2-slot Simul Rec)

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Setting On / Off Off
Bật/tắt chức năng ghi đồng thời và đặt phương tiện
đích đến cho đoạn quay.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Hiển thị chỉ định nút ghi cho mỗi phương tiện ghi.
Đặt [Project] > [Simul Rec] > [Rec Button Set] trong
menu camera.2nd Rec

Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B

387



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Proxy Rec

Đặt cài đặt chế độ ghi proxy (xem “Ghi proxy”).

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Setting On / Off Off Bật/tắt chế độ ghi proxy.
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Interval Rec

Đặt cài đặt chế độ ghi theo khoảng thời gian (tham khảo “Quay video không liên tục (Interval Rec)”).

Chủ đề liên quan

Quay video không liên tục (Interval Rec)

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Setting On / Off Off

Bật/tắt chế độ ghi theo khoảng
thời gian. (Cài đặt chế độ này
thành On sẽ đặt tất cả các chế
độ đặc biệt khác về Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20
/ 30 / 40 / 50 (giây)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20
/ 30 / 40 / 50 (phút)
1 / 2 / 3 / 4 / 6 / 12 / 24 (giờ)

1

Đặt khoảng thời gian giữa các
lần ghi trong chế độ ghi Interval
Rec (khi Interval Rec được đặt
thành On).

Number of
Frames

1frame / 2frames / 3frames / 6frames /
9frames / 12frames
Cài đặt có sẵn khác nhau tùy thuộc vào
tần số khung hình của định dạng video
đã chọn.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Đặt số khung hình để ghi mỗi
cảnh trong chế độ ghi Interval
Rec (khi Interval Rec được đặt
thành On).
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Picture Cache Rec

Đặt cài đặt chế độ ghi bộ nhớ đệm hình ảnh (xem “Ghi ảnh vào bộ nhớ đệm (Picture Cache Rec)”).

Chủ đề liên quan

Ghi ảnh vào bộ nhớ đệm (Picture Cache Rec)

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Setting On / Off Off Bật/tắt chức năng ghi ảnh vào bộ nhớ đệm.

Cache Size
Short / Medium /
Long / Max

Max
Đặt thời gian để dồn hình ảnh trong bộ nhớ đệm hình ảnh
(thời gian ghi đệm hình ảnh).

Cache Rec
Time

– –
Hiển thị thời gian để dồn hình ảnh trong bộ nhớ đệm hình
ảnh (thời gian ghi đệm hình ảnh).
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All File

Thực hiện vận hành tệp ALL (tham khảo “Lưu và tải dữ liệu cấu hình”).
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Mục Cài đặt tiểu
mục

Mặc định của nhà
sản xuất Mô tả

Load All
File

– –

Tải một tệp ALL vào thiết bị này từ thiết bị chạy ứng dụng web.

Chú ý

Khi tải xong một tệp ALL vào thiết bị, nó sẽ khởi động lại. Sau khi khởi
động lại, hãy tải lại trang trên trình duyệt web.

Save All
File

– –
Lưu cài đặt của thiết bị này vào thiết bị chạy ứng dụng web dưới dạng
một tệp ALL.

391



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Base Look

Bạn có thể tải giao diện cơ sở vào thiết bị.
Danh sách các giao diện cơ sở khả dụng được hiển thị trên màn hình. Giao diện cơ sở đang được áp dụng sẽ được chỉ
báo bằng dấu ● ở bên trái của số giao diện cơ sở.

[No.]: Số giao diện cơ sở
[Base Look Name]: Tên giao diện cơ sở
[Input]: Tín hiệu đầu vào của giao diện cơ sở
[Output]: Tín hiệu đầu ra của giao diện cơ sở
[AE Level Offset]: Giá trị bù tham chiếu độ phơi sáng của giao diện cơ sở

Cách thêm giao diện cơ sở
Ấn nút [Import] để nhập một giao diện cơ sở mới. Làm theo hướng dẫn trên màn hình.
Sau khi nhập, đặt các giá trị phù hợp cho [Input], [Output] và [AE Level Offset]. Để biết thêm thông tin chi tiết, hãy tham
khảo “Nhập giao diện cơ bản mong muốn.”

Chủ đề liên quan
Nhập giao diện cơ bản mong muốn

5-041-959-03(1) Copyright 2022 Sony Corporation
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P/T Speed

Đặt các cài đặt liên quan đến tốc độ xoay/nghiêng.
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Mục Cài đặt tiểu
mục

Mặc định của
nhà sản xuất Mô tả

Speed
Step

Normal /
Extended

Extended

Đặt số bước tốc độ của phần điều khiển xoay/nghiêng.
Normal: Có thể chỉ định tốc độ bằng phạm vi 24 bước. Sử dụng cài
đặt này để tương thích với các máy quay điều khiển từ xa hiện có của
Sony.
Extended: Có thể chỉ định tốc độ bằng phạm vi 50 bước.

Speed
Mode

Normal /
Slow

Normal

Đặt chế độ tốc độ của phần điều khiển xoay/nghiêng.
Chỉ được bật khi [Speed Step] được đặt thành [Normal].
Normal: Vận hành ở phạm vi tốc độ bình thường (tối thiểu đến tối đa
(60 độ/giây)).
Slow: Vận hành ở phạm vi tốc độ thấp (tối thiểu đến tối đa (40
độ/giây)).
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P/T Acceleration

Đặt các cài đặt liên quan đến tốc độ xoay/nghiêng.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu
mục

Mặc định của nhà
sản xuất Mô tả

Acceleration 1 đến 9 8
Chọn gia tốc/giảm tốc cho các hoạt động xoay/nghiêng. Số càng
lớn thì gia tốc càng cao.
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P/T Range Limit

Đặt cài đặt liên quan đến giới hạn phạm vi vận hành xoay/nghiêng.
Đặt các giới hạn phạm vi vận hành xoay/nghiêng bằng màn hình sau.

Chú ý

Khi bật thiết bị hoặc thực hiện đặt lại chức năng xoay/nghiêng, cài đặt giới hạn phạm vi này bị bỏ qua. Không thể sử dụng chức
năng này để tránh các chướng ngại vật gần thiết bị.

Đặt công tắc [Setting]sang vị trí on.

Chức năng giới hạn phạm vi vận hành xoay/nghiêng bị tắt.

1

Kiểm tra hình ảnh bằng điều khiển xoay/nghiêng của máy quay.2

Để đặt vị trí tại nơi giới hạn vận hành, nhấn nút [Left], [Right], [Up], [Down] > [Set Current Value] tại các vị
trí đó.

[Left]: Bên trái máy quay
[Right]: Bên phải máy quay
[Up]: Mặt trên máy quay

3
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Chú ý

Không thể lưu các vị trí máy quay nằm ngoài các vị trí giới hạn dưới dạng đặt trước.

Nếu thay đổi cài đặt [Pan-Tilt] > [P/T Direction] > [Ceiling], các cài đặt vị trí giới hạn đã cấu hình sẽ trở về mặc định của nhà sản
xuất.

Không thể thay đổi cài đặt này trong quá trình phát lại, trong khi hiển thị hình thu nhỏ, khi xảy ra lỗi xoay/nghiêng, khi không bắt
đầu xoay/nghiêng và khi khóa xoay/nghiêng.

5-041-959-03(1) Copyright 2022 Sony Corporation

[Down]: Mặt dưới máy quay

Các vị trí giới hạn được đặt và hiển thị dưới dạng giá trị số (góc).
Để hủy giới hạn, nhấn nút [Reset] cho từng vị trí riêng lẻ.

Ấn nút [OK].

Vận hành xoay/nghiêng bị hạn chế trong các vị trí giới hạn đã cấu hình.

4
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P/T Direction

Đặt các cài đặt liên quan đến hướng xoay/nghiêng.

Chú ý

Khi áp dụng cài đặt được thay đổi [Ceiling], toàn bộ vị trí đặt trước bị xóa vì tọa độ xoay/nghiêng bị đảo ngược.

Các thay đổi phạm vi xoay/nghiêng được trình bày trong lược đồ sau đây phụ thuộc vào cài đặt [Ceiling].

A: Khi [Ceiling] được đặt thành [Off]
B: Khi [Ceiling] được đặt thành [On]
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Mục Cài đặt tiểu
mục

Mặc định của
nhà sản xuất Mô tả

Ceiling On / Off Off
Khi gắn thiết bị lên mặt bàn, hãy đặt thành [Off]. Khi gắn thiết bị lên trần,
hãy đặt thành [On]. Khi [Ceiling] được đặt thành [On], [Pan Direction] sẽ
tự động được đặt thành [Opposite].

Pan
Direction

Normal /
Opposite

Normal Đặt hướng đĩa xoay. Khi cài đặt này thay đổi, hướng đĩa đảo ngược.

Tilt
Direction

Normal /
Opposite

Normal Đặt hướng đĩa nghiêng. Khi cài đặt này thay đổi, hướng đĩa đảo ngược.
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P/T Preset

Đặt các cài đặt liên quan đến đặt trước camera.

Pan-Tilt
Đặt tốc độ cho các giá trị đặt trước.

Default
Đặt các giá trị mặc định sẽ được cấu hình khi vị trí đặt trước được lưu.
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Mục Cài đặt tiểu
mục

Mặc định của
nhà sản xuất Mô tả

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Đặt tốc độ đặt trước được định cấu hình riêng hay sử dụng
cài đặt chung.

Pan-Tilt Speed
for Common

1 đến 50 50

Đặt tốc độ chung cho các giá trị đặt trước.

Chú ý

Tốc độ tối đa 24 được sử dụng nếu đặt giá trị từ 25 trở lên
khi [Pan-Tilt] > [P/T Speed] > [Speed Step] được đặt thành
[Normal].

Mục Cài đặt
tiểu mục

Mặc định của
nhà sản xuất Mô tả

Pan-Tilt Speed for
Separate

1 đến 50 50
Đặt tốc độ cho các giá trị đặt trước khi phương pháp chọn tốc
độ đặt trước được đặt thành [Separate].

Zoom Sync On / Off On
Đặt xem liệu thao tác xoay/nghiêng và thao tác thu phóng có
được đồng bộ khi khôi phục vị trí đặt trước không.

Zoom Speed
0 đến
32767 32767 Đặt tốc độ thu phóng.

Focus Recall On / Off On Đặt xem liệu cài đặt lấy nét có được khôi phục không.

MF Speed
0 đến
32767

32767 Đặt tốc độ lấy nét cho lấy nét thủ công.
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Output Format

Đặt các cài đặt định dạng đầu ra.

Chủ đề liên quan

Định dạng đầu ra và giới hạn
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Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

SDI Để biết thêm thông tin chi tiết về cài đặt, hãy tham khảo
“Định dạng đầu ra và giới hạn.”

– Đặt độ phân giải đầu ra
SDI và HDMI.HDMI –
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Output Display

Đặt các cài đặt liên quan đến tín hiệu đầu ra.
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Mục Cài đặt
tiểu mục

Mặc định của
nhà sản xuất Mô tả

SDI On / Off Off
Đặt xem menu và trạng thái có được nhúng vào tín hiệu đầu ra SDI hay
không.

HDMI/Stream On / Off On

Đặt xem menu và trạng thái có được nhúng vào tín hiệu đầu ra HDMI
hay không.

Chú ý

Cài đặt này cũng được áp dụng cho hình ảnh tín hiệu đầu ra HDMI, hình
ảnh đầu ra phát trực tiếp và hình ảnh trong bảng điều khiển hình ảnh máy
quay của Ứng dụng web.
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Audio Input

Đặt các cài đặt liên quan đến đầu vào âm thanh từ CH1 đến CH4.

Đặt mức đầu vào âm thanh chính. Mức đầu vào âm thanh chính được sử dụng cho tất cả các kênh từ 1 đến 4.
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Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Level
Control

Auto / Manual Auto
Chọn mức đầu vào âm thanh điều chỉnh tự động
hoặc điều chỉnh thủ công.

Level 0 đến 99 49 Đặt mức đầu vào.

Input
Select

AUDIO IN CH1 / AUDIO
IN CH2 / Off

CH1 và CH3:
AUDIO IN CH1
CH2 và CH4:
AUDIO IN CH2

Đặt nguồn đầu vào âm thanh.

Chú ý

CH1 được đặt thành [AUDIO IN CH1] (cố định).

Wind Filter On / Off Off Bật/tắt bộ lọc giảm tiếng ồn của gió.

Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Master 0 đến 99 99 Đặt mức đầu vào chính.

401



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Output

Đặt các cài đặt liên quan đầu ra âm thanh.

Chú ý

Cài đặt này cũng được áp dụng cho âm thanh đầu ra phát trực tuyến.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

HDMI/Stream Output
CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Đặt kết hợp các kênh âm thanh trên đầu ra
HDMI/phát trực tiếp.
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Tracking Data Output

Đặt cài đặt liên quan đến xuất thông tin theo dõi (tuân thủ giao thức fee-d).
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Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Transfer Mode
Off / Always / On
Demand

Off Chọn phương thức xuất thông tin theo dõi.

Camera ID 0 đến 255 255 Đặt ID của thiết bị.

Destination
Address

Địa chỉ IPv4 –
Khi [Transfer Mode] được đặt thành [Always], đặt địa chỉ IP
đích của thông tin theo dõi.

Destination
Port

1024 đến 65534 40000 Khi [Transfer Mode] được đặt thành [Always], đặt số cổng
đích của thông tin theo dõi.

Listen Port 1024 đến 65534 40000
Khi [Transfer Mode] được đặt thành [On Demand], đặt số
cổng trên thiết bị nhận yêu cầu từ khách hàng.
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Tally

Đặt các cài đặt đèn ghi/đếm (xem “Kết nối tín hiệu báo hiệu”).

Chủ đề liên quan

Kết nối tín hiệu báo hiệu
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Mục Cài đặt tiểu
mục

Mặc định của nhà
sản xuất Mô tả

Tally Lamp
Brightness

High / Low /
Off

High Đặt độ sáng của đèn ghi/đếm.

G Tally Lamp
Enable /
Disable

Enable Bật/tắt đèn đếm G.

Tally Control
External /
Internal

Internal
Chọn mục tiêu để chấp nhận thông tin điều khiển đèn
ghi/đếm của thiết bị.
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IR Remote

Đặt cài đặt liên quan đến điều khiển từ xa hồng ngoại.
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Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Setting On / Off On Bật/tắt vận hành thiết bị từ điều khiển từ xa hồng ngoại.
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RCP/MSU

Cài đặt cấu hình khi RCP/MSU (tùy chọn) được kết nối.
Để biết thêm chi tiết, hãy tham khảo “Kết nối một RCP/MSU (tùy chọn)”.

Chú ý

Định cấu hình cài đặt trên RCP/MSU theo yêu cầu.

Yêu cầu một MSU cho hệ thống đa máy quay.

Khi sử dụng nhiều thiết bị MSU, hãy đặt một thiết bị MSU là thiết bị chính và đặt tất cả các thiết bị MSU còn lại là khách.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

CNS Mode
Off / Bridge / MCS /
PC Control

Off Đặt chế độ kết nối cho RCP/MSU.

Master IP
Address

Địa chỉ IPv4 0.0.0.0
Đặt địa chỉ IP của thiết bị chính khi xây dựng hệ thống
đa máy quay dựa trên LAN.

Camera No. Camera No. (1 đến
96)

1 Đặt số máy quay duy nhất trong hệ thống khi xây dựng
hệ thống đa máy quay dựa trên LAN.
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Lens Controller

Đặt các cài đặt cho bộ điều khiển ống kính đã kết nối (tùy chọn).
Để biết thêm thông tin chi tiết, hãy tham khảo “Kết nối bộ điều khiển ống kính”.

Chú ý

Khi [Setting] thay đổi, thiết bị sẽ khởi động lại. Tải lại trang trên trình duyệt web.
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Mục
Cài đặt

tiểu
mục

Mặc định
của nhà
sản xuất

Mô tả

Setting On / Off Off Đặt xem có sử dụng bộ điều khiển ống kính (tùy chọn) hay không.

Mode 0 đến 15 0

Đặt chế độ vận hành của bộ điều khiển ống kính (tùy chọn).
Các giá trị nằm trong phạm vi từ 0 đến 15 là khả dụng, nhưng các giá trị thực tế
có thể được chọn sẽ thay đổi tùy vào bộ điều khiển ống kính (tùy chọn). Để biết
chi tiết, hãy tham khảo hướng dẫn vận hành của bộ điều khiển ống kính.

Reverse On / Off Off Đảo ngược hướng xoay của bộ điều khiển ống kính (tùy chọn).

Initialize – – Khởi tạo bộ điều khiển ống kính (tùy chọn).
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Camera Name

Đặt các cài đặt liên quan đến tên camera (tên thiết bị).

Có thể nhập tối đa tám (từ 0 đến 8) ký tự sau đối với Camera Name.
Các ký tự chữ và số
Ký hiệu (khoảng trắng !#$`*+-./;<=>?@[\]^_`{|})

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Camera Name – FR7 Đặt tên camera.
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User

Đặt các cài đặt liên quan đến quyền truy cập của người dùng.

Cài đặt liên quan đến người dùng quản trị (Administrator) (bắt buộc)

Cài đặt liên quan đến người dùng thường (User 1 đến User 9) (không bắt buộc)
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Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

User Name – admin Đặt tên người dùng.

Current Password – –
Khi thay đổi mật khẩu, hãy nhập mật khẩu hiện
tại.

New Password – – Nhập mật khẩu mới.

Re-Type
Password

– – Nhập mật khẩu mới một lần nữa để xác nhận.

Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

User Name – – Đặt tên người dùng.

Current Password – –
Khi thay đổi mật khẩu, hãy nhập mật khẩu hiện
tại.

New Password – – Nhập mật khẩu mới.

Re-Type
Password – – Nhập mật khẩu mới một lần nữa để xác nhận.
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Wired LAN

Status
Hiển thị trạng thái mạng.

IPv4
Đặt các cài đặt liên quan đến mạng IPv4.

IPv6

Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

Host Name – – Hiển thị tên máy chủ lưu trữ.

MAC Address – – Hiển thị địa chỉ MAC của thiết bị.

Ethernet Status – – Hiển thị tốc độ truyền thông hiện tại.

IP Address – – Hiển thị địa chỉ IP của thiết bị.

Subnet Mask – – Hiển thị mặt nạ mạng con của thiết bị.

Gateway – – Hiển thị cửa ngõ mặc định IPv4 của thiết bị.

Primary DNS Server – – Hiển thị máy chủ DNS chính của thiết bị.

Secondary DNS
Server

– – Hiển thị máy chủ DNS phụ của thiết bị.

IPv6 Address 1 – – Hiển thị địa chỉ IPv6 1 của thiết bị.

IPv6 Address 2 – – Hiển thị địa chỉ IPv6 2 của thiết bị.

IPv6 Gateway – – Hiển thị cửa ngõ mặc định IPv6 của thiết bị.

Link-local IPv6
Address

– –
Hiển thị địa chỉ liên kết IPv6 cục bộ của thiết
bị.

Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

DHCP On / Off On Bật/tắt chức năng [DHCP].

IP Address – – Đặt địa chỉ IPv4 khi [DHCP] được đặt thành Off.

Subnet
Mask

– – Đặt mặt nạ mạng con khi [DHCP] được đặt thành Off.

Gateway – –
Đặt cổng mặc định IPv4 khi [DHCP] được đặt thành
Off.
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Đặt các cài đặt liên quan đến mạng IPv6.

Common
Đặt các cài đặt liên quan đến mạng IPv4/IPv6.
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Mục Cài đặt
tiểu mục

Mặc định của
nhà sản xuất Mô tả

Obtain an IP Address
Automatically

On / Off On Bật/tắt tự động nhận địa chỉ IPv6.

IP Address – –
Cài đặt địa chỉ IPv6 khi [Obtain an IP Address
Automatically] được đặt thành Off.

Prefix Length – –
Cài đặt tiền tố khi [Obtain an IP Address Automatically]
được đặt thành Off.

Gateway – –
Cài đặt cổng mặc định IPv6 khi [Obtain an IP Address
Automatically] được đặt thành Off.

Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

HTTP Port
80, 1024 đến
65534

80 Đặt số cổng HTTP.

DNS Auto On / Off On
Đặt xem có lấy địa chỉ DNS từ máy chủ DHCP
hay không.

Primary DNS Server Địa chỉ IPv4/IPv6 –
Cài đặt máy chủ DNS chính khi [DNS Auto] được
đặt thành Off.

Secondary DNS
Server

Địa chỉ IPv4/IPv6 –
Cài đặt máy chủ DNS phụ khi [DNS Auto] được
đặt thành Off.
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File Transfer

Đặt các cài đặt liên quan đến truyền tệp.
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Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Auto Upload
(Proxy)

On / Off Off Bật/tắt tính năng tự động tải lên tệp proxy.

Default
Upload
Server

Server Settings1
thành 3 > Display
Name

Server
Settings1

Chọn máy chủ tải lên cho tệp. Máy chủ được chọn ở đây sẽ
trở thành đích tải lên tự động cho các tệp proxy và đích tải lên
cho các tệp từ màn hình ảnh thu nhỏ.
Hiển thị các cài đặt [Display Name] được cấu hình trong
[Server Settings1 đến 3].
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FTP Server 1 thành 3

Đặt các cài đặt liên quan đến truyền FTP.
Cài đặt này chung cho FTP Server 1 đến 3.
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Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Display Name – –
Đặt tên của màn hình hiển thị trong menu thiết lập
đích truyền đến.

Service – – Hiển thị loại máy chủ.

Host Name – – Đặt tên máy chủ lưu trữ của máy chủ đích truyền đến.

Port 21, 990, 1024 đến
65534

21 Đặt số cổng của máy chủ đích truyền đến.

User Name – –
Đặt tên người dùng để xác thực kết nối máy chủ đích
truyền đến.

Password – –
Đặt mật khẩu xác thực của kết nối máy chủ đích
truyền đến.

Passive Mode On / Off Off Bật/Tắt chế độ thụ động.

Destination
Directory

– – Đặt tên của thư mục đích truyền đến.

Using Secure
Protocol

On / Off Off
Đặt xem sử dụng (On) hay không sử dụng (Off) chức
năng truyền FTP bảo mật.

Root Certificate – –

Tải chứng chỉ gốc dành cho truyền FTP bảo mật.
Nhấn nút [Load] và chọn chứng chỉ gốc trên màn hình
hiển thị.
Ấn nút [Delete] để xóa chứng chỉ gốc đã tải.

Root Certificate
Status

– – Hiển thị trạng thái tải của chứng chỉ gốc.

Reset – – Đặt lại các cài đặt [Server Settings] về mặc định.
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SSL

Đặt các cài đặt liên quan đến SSL.

SSL
Bật/tắt chức năng SSL.

SSL Server Authentication
Đặt các cài đặt liên quan đến xác thực máy chủ SSL.

Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Function
Disable / Enable / Enable (Allow HTTP connection for
some clients)

Disable
Bật/tắt chức năng
SSL.

Mục Cài đặt tiểu mục
Mặc định
của nhà
sản xuất

Mô tả

Certificate
Options

Use a self-signed certificate
(For test use) / Use an
external certificate

– Đặt phương thức cài đặt chứng chỉ máy chủ SSL.

Status – –
Hiển thị tính hợp lệ của chứng chỉ máy chủ SSL khi
[Certificate Options] được đặt thành [Use a self-
signed certificate (For test use)].

Issuer DN – –
Hiển thị tên phân biệt của nhà phát hành chứng chỉ
máy chủ SSL khi [Certificate Options] được đặt
thành [Use a self-signed certificate (For test use)].

Subject DN – –
Hiển thị tên phân biệt của đối tượng của chứng chỉ
máy chủ SSL khi [Certificate Options] được đặt
thành [Use a self-signed certificate (For test use)].

Available Period – –
Hiển thị khoảng thời gian hợp lệ của chứng chỉ máy
chủ SSL khi [Certificate Options] được đặt thành
[Use a self-signed certificate (For test use)].

Extended Key
Usage

– –
Hiển thị phương pháp sử dụng khóa mở rộng khi
[Certificate Options] được đặt thành [Use a self-
signed certificate (For test use)].

Delete – –

Nút này được hiển thị khi [Certificate Options] được
đặt thành [Use a self-signed certificate (For test
use)].
Xóa chứng chỉ máy chủ SSL đã cài đặt.
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Mục Cài đặt tiểu mục
Mặc định
của nhà
sản xuất

Mô tả

Import – –
Cài đặt chứng chỉ máy chủ SSL bên ngoài từ danh
sách khi [Certificate Options] được đặt thành [Use
an external certificate].

Private Key
Password

– –
Đặt mật khẩu cho thông tin khóa cá nhân của chứng
chỉ máy chủ SSL khi [Certificate Options] được đặt
thành [Use an external certificate].

Reset – –
Nút này sẽ xóa màn hình mật khẩu khóa cá nhân để
nhập mật khẩu mới.

Self-Signed
Certificate
Generation

– –
Ấn nút [Generate] để tạo chứng chỉ tự ký khi
[Certificate Options] được đặt thành [Use a self-
signed certificate (For test use)].
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Referer Check

Đặt các cài đặt liên quan đến kiểm tra Tham chiếu.

Exception List
Đặt cài đặt liên quan đến danh sách ngoại lệ của kiểm tra Tham chiếu.

Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Setting On / Off On Bật/tắt chức năng kiểm tra Tham chiếu.

Mục Cài đặt
tiểu mục

Mặc định của
nhà sản xuất Mô tả

No. 1 đến 10 – Đặt số ngoại lệ từ danh sách.

Host
Name

– – Đặt tên máy chủ lưu trữ của trường hợp ngoại lệ.

Port
Number

– – Đặt tên số cổng của trường hợp ngoại lệ.

Set – –
Ấn để đăng ký trường hợp ngoại lệ đã cấu hình vào danh sách ngoại
lệ.

Delete – –
Chọn trường hợp ngoại lệ mà bạn muốn xóa rồi nhấn nút để xóa
trường hợp ngoại lệ đã đăng ký từ danh sách ngoại lệ.
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Brute Force Attack Protection

Đặt cài đặt liên quan đến phòng ngừa tấn công mạnh.

Khi một nguồn tấn công được phát hiện, thông tin danh sách nguồn tấn công sẽ được hiển thị.
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Mục Cài đặt tiểu
mục

Mặc định của
nhà sản xuất Mô tả

Setting On / Off On Bật/tắt chức năng [Brute Force Attack Protection].

Count 3 đến 100 8
Đặt số lần thử mà sẽ được coi là một sự tấn công.
Được bật khi [Setting] được đặt thành On.

Release
Mode

Always /
Timer Timer

Đặt điều kiện nhả.
Được bật khi [Setting] được đặt thành On.
Always: Không xóa khỏi danh sách nguồn tấn công.
Timer: Xóa khỏi danh sách nguồn tấn công sau khi thời gian nhả
được đặt bằng cách sử dụng [Release Time] trôi qua.

Release
Time

30 đến
86400 s

60

Đặt thời gian nhả.
Được bật khi [Setting] được đặt thành On.
Khi Release Mode được đặt thành [Timer], các mục nhập bị xóa khỏi
danh sách nguồn tấn công sau khi thời gian nhả trôi qua.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Stream

Đặt các cài đặt phát trực tuyến (xem “Về phát trực tiếp”).

Stream Setting
Đặt các cài đặt liên quan đến giao thức phát trực tuyến.

Chú ý

Để sử dụng RTMP, đặt sẵn [Stream] > [Audio Stream] > [Setting] thành [On].

RTSP
Các mục sau được hiển thị khi [Stream Setting] được đặt thành [RTSP].
Đặt các cài đặt liên quan đến phát trực tuyến RTSP.

RTMP
Các mục sau được hiển thị khi [Stream Setting] được đặt thành [RTMP].
Đặt các cài đặt liên quan đến phát trực tuyến RTMP.

Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Setting
RTSP / RTMP / SRT-Caller / SRT-Listener /
NDI|HX / Off

RTSP
Chọn giao thức phát trực
tuyến.

Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Port Number
554, 1024 đến
65534

554 Đặt số cổng RTSP.

Time Out 0 đến 600 60 Đặt thời gian chờ của lệnh Keep Alive để phát
trực tuyến RTSP.

Authentication On / Off On Bật/tắt chức năng xác thực RTSP.

Video Port Number
1

1024 đến 65534 51000
Đặt số cổng để gửi video 1 cho phát trực tuyến
unicast RTSP.

Video Port Number
2

1024 đến 65534 53000
Đặt số cổng để gửi video 2 cho phát trực tuyến
unicast RTSP.

Audio Port Number 1024 đến 65534 57000
Đặt số cổng để gửi âm thanh cho phát trực tuyến
unicast RTSP.

Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

Server URL – – Đặt URL đích của kết nối RTMP hoặc RTMPS.
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SRT
Các mục sau được hiển thị khi [Stream Setting] đuợc đặt thành [SRT-Caller] hoặc [SRT-Listener].
Đặt các cài đặt liên quan đến phát trực tuyến SRT.

NDI|HX
Các mục sau được hiển thị khi [Stream Setting] được đặt thành [NDI|HX].
Đặt các cài đặt liên quan NDI|HX.

Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

Stream Key – –
Đặt khóa phát trực tuyến có được từ phía máy chủ
RTMP.

Root
Certificate

– –

Tải chứng chỉ gốc bắt buộc khi kết nối với máy chủ
RTMP.
Nhấn nút [Load] và chọn chứng chỉ gốc trên màn hình
hiển thị.
Ấn nút [Delete] để xóa chứng chỉ gốc đã tải.
Trạng thái được hiển thị trong [Root Certificate Status].

Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Destination – –
Đặt URL đích của kết nối khi thiết bị đang hoạt động
như một người gọi.

Port
Number

1024 đến 65534 4201
Đặt số cổng để nghe khi thiết bị đang hoạt động
như một người nghe.

Latency 20 đến 8000 ms 120 Đặt độ trễ.

TTL 1 đến 255 64 Đặt giá trị TTL.

Encryption Off / AES128 / AES256 Off Bật/tắt mã hóa và đặt phương pháp mã hóa.

Passphrase
0 hoặc chuỗi từ 10 đến
79 ký tự

0
Đặt cụm mật khẩu được sử dụng để mã hóa.
Ấn Reset để xóa cụm mật khẩu đã nhập.

ARC On / Off On Bật/tắt chức năng Adaptive Rate Control.

Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

License – – Hiển thị trạng thái cài đặt của khóa cấp phép NDI.

Source Name – – Hiển thị tên nguồn NDI.

Group On / Off Off Bật/tắt chức năng nhóm NDI.

Group Name – –
Được hiển thị khi chức năng nhóm NDI được đặt
thành On.
Đặt tên nhóm.

Discovery Server
1

– – Đặt máy chủ khám phá NDI 1.
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Chủ đề liên quan
Về phát trực tiếp

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

Discovery Server
2

– – Đặt máy chủ khám phá NDI 2.

Multicast Mode On / Off Off Bật/tắt phát trực tuyến đa điểm.

Multicast Prefix 239.255.0.0 239.255.0.0

Được hiển thị khi [Multicast Mode] được đặt thành
On.
Đặt tiền tố để sử dụng cho phát trực tuyến đa
điểm.

Multicast
Netmask

255.255.0.0 255.255.0.0

Được hiển thị khi [Multicast Mode] được đặt thành
On.
Đặt mặt nạ mạng xác định phạm vi địa chỉ đa
điểm.

Multicast TTL 1 đến 256 3
Được hiển thị khi [Multicast Mode] được đặt thành
On.
Đặt giá trị TTL cho phát trực tuyến đa điểm.

Multi-TCP Mode On / Off Off Bật/tắt chế độ Multi-TCP.

Unicast UDP
Mode

On / Off On Bật/tắt chế độ Unicast UDP.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Video Stream

Đặt các cài đặt liên quan đến codec video phát trực tuyến.

Video Stream 1
Đặt cài đặt liên quan đến codec video 1.

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Codec 1 H.264 / H.265 H.264 Đặt codec của hình ảnh 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080
Đặt kích thước hình ảnh của hình
ảnh 1.

Frame Rate 1

Để biết chi tiết về tốc độ khung hình
được hỗ trợ, hãy xem “Đặt bộ mã
hóa âm thanh để phát trực tiếp.”

–
Đặt tốc độ khung hình của hình ảnh
1.

I-Picture Mode 1 Time / Frame Time
Đặt khoảng thời gian chèn IDR-
Frame cho hình ảnh 1 dưới dạng
thời gian hoặc số lượng khung hình.

I-Picture Interval
1

1 / 2 / 3 / 4 / 5 s 1

Được hiển thị khi [I-Picture Mode 1]
được đặt thành Time.
Đặt khoảng thời gian cắm IDR-
Frame cho H.264 và H.265 là thời
gian.

I-Picture Ratio 1 15 đến 300 khung hình 30

Được hiển thị khi [I-Picture Mode 1]
được đặt thành Frame.
Đặt khoảng thời gian cắm IDR-
Frame cho H.264 và H.265 là số
lượng khung hình.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Đặt cấu hình H.264 hoặc H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR Đặt chế độ nén tốc độ bit của hình
ảnh 1.

Bit Rate 1

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

16000

Được hiển thị khi [Bit Rate
Compression Mode 1] được đặt
thành On.
Đặt giá trị mục tiêu tốc độ bit khi chế
độ nén tốc độ bit được đặt thành
CBR.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Đặt chất lượng H.264 hoặc H.265
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Video Stream 2
Đặt cài đặt liên quan đến codec video 2.

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Codec 2 H.264 / H.265 / Off Off Đặt codec của hình ảnh 2.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080
Đặt kích thước hình ảnh của hình ảnh
2.

Frame Rate 2

Để biết chi tiết về tốc độ khung
hình được hỗ trợ, hãy xem “Đặt bộ
mã hóa âm thanh để phát trực
tiếp.”

–
Được hiển thị khi [Codec 2] không
được đặt thành Off.
Đặt tốc độ khung hình của hình ảnh 2.

I-Picture Mode 2 Time / Frame Time

Được hiển thị khi [Codec 2] không
được đặt thành Off.
Đặt khoảng thời gian chèn IDR-Frame
cho hình ảnh 2 dưới dạng thời gian
hoặc số lượng khung hình.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Được hiển thị khi [Codec 2] không
được đặt thành Off và [I-Picture Mode
2] được đặt thành [Time].
Đặt khoảng thời gian cắm IDR-Frame
cho H.264 và H.265 là thời gian.

I-Picture Ratio 2 15 đến 300 khung hình 30

Được hiển thị khi [Codec 2] không
được đặt thành Off và [I-Picture Mode
2] được đặt thành [Frame].
Đặt khoảng thời gian cắm IDR-Frame
cho H.264 và H.265 là số lượng
khung hình.

Profile 2
H.264: high / main / baseline
H.265: main

– Đặt cấu hình H.264 hoặc H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Được hiển thị khi [Codec 2] không
được đặt thành Off.
Đặt chế độ nén tốc độ bit của hình
ảnh 2.

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

8000

Được hiển thị khi [Codec 2] không
được đặt thành Off và [Bit Rate
Compression Mode 2] được đặt thành
[On].
Đặt giá trị mục tiêu tốc độ bit khi chế
độ nén tốc độ bit được đặt thành
CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Được hiển thị khi [Codec 2] được đặt
thành H.264 và [Bit Rate
Compression Mode 2] được đặt thành
Off.
Đặt chất lượng H.264 hoặc H.265

423



Video Stream 3
Đặt cài đặt liên quan đến codec video 3.

Chủ đề liên quan

Đặt bộ mã hóa âm thanh để phát trực tiếp

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà
sản xuất Mô tả

Codec 3 JPEG JPEG
Đặt codec của hình
ảnh 3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Đặt kích thước hình
ảnh của hình ảnh 3.

Frame
Rate 3

Để biết chi tiết về tốc độ khung hình được hỗ trợ, hãy
xem “Đặt bộ mã hóa âm thanh để phát trực tiếp.” –

Đặt tốc độ khung hình
của hình ảnh 3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Đặt chất lượng.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Stream

Đặt cài đặt liên quan đến bộ mã hóa âm thanh.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản
xuất Mô tả

Setting On / Off Off Bật/tắt đầu ra phát trực tiếp âm thanh.

Codec
AAC (128kbps) / AAC
(256kbps)

AAC (128kbps)
Được hiển thị khi [Setting] được đặt thành
On.
Đặt bộ mã hóa âm thanh để phát trực tiếp.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Language

Đặt ngôn ngữ hiển thị.

Chú ý

Các ngôn ngữ khả dụng có thể khác nhau tùy thuộc vào quốc gia hoặc khu vực.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của nhà sản xuất Mô tả

Language – – Đặt ngôn ngữ hiển thị.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Accessibility

Đặt các cài đặt liên quan đến đọc âm thanh (chuyển văn bản thành giọng nói).

Chú ý

Chức năng này chỉ khả dụng trên các kiểu máy được bán ở Bắc Mỹ. Chức năng trình đọc màn hình chỉ có thể được sử dụng khi
ngôn ngữ được đặt thành tiếng Anh (kể từ ngày phát hành).

Bật chức năng trình đọc màn hình của trình duyệt web trên thiết bị chạy Ứng dụng web.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Screen
Reader

On / Off Off 
Bật/tắt chức năng của trình đọc màn hình trong
bảng điều khiển hình ảnh máy quay của Ứng dụng
web.

Speech
Rate

Slow2 / Slow1 / Normal /
Fast1 / Fast2 / Fast3 / Fast4

Normal
Đặt tốc độ của chức năng trình đọc màn hình.
Một đoạn văn mẫu được đọc to ở tốc độ đã định cấu
hình.

Speech
Volume

1 đến 15 7

Đặt âm lượng của chức năng trình đọc màn hình
của Ứng dụng Web.
Một đoạn văn mẫu được đọc to ở âm lượng đã cấu
hình.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Clock Set

Đặt các cài đặt đồng hồ bên trong.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục
Mặc định

của nhà sản
xuất

Mô tả

Current Date
& Time

– –
Hiển thị giờ hiện tại được cấu hình trên thiết
bị.

PC Clock – –
Hiển thị thời gian hiện tại của máy tính bảng
hoặc máy tính được dùng để cấu hình.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-yyyy
hh:mm:ss / dd-mm-yyyy hh:mm:ss

yyyy-mm-dd Đặt định dạng hiển thị cho ngày và giờ.

12 h / 24 h 12 h / 24 h 24 h
Đặt giờ thành định dạng hiển thị 12 giờ/24
giờ.

Time Setting
Keep current setting / Synchronize
with PC / Manual setting /
Synchronize with NTP

– Đặt phương thức cấu hình cho ngày và giờ.

yy-mm-dd
hh:mm:ss

yy: 19 đến 37
mm: 01 đến 12
dd: 01 đến 31
hh: 00 đến 23
mm: 00 đến 59
ss: 00 đến 59 (giây)

–
Được hiển thị khi [Time Setting] được đặt
thành Manual setting.
Đặt ngày và giờ thủ công.

NTP Auto On / Off Off

Được hiển thị khi [Time Setting] được đặt
thành Synchronize with NTP.
Đặt xem có lấy địa chỉ IP của máy chủ NTP
được từ máy chủ DHCP hay không.

NTP Server Địa chỉ IPv4/IPv6 hoặc tên máy chủ –

Được hiển thị khi [Time Setting] được đặt
thành [Synchronize with NTP] và [NTP Auto]
được đặt thành Off.
Chỉ định máy chủ NTP được sử dụng để đồng
bộ hóa thời gian.

Time Zone UTC − 12:00 đến UTC + 14:00 – Chọn múi giờ.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Reset

Khởi tạo thiết bị.

Reboot
Khởi động lại thiết bị.

Reset
Đặt lại các cài đặt của thiết bị.

Mục Cài đặt tiểu
mục

Mặc định của nhà sản
xuất Mô tả

Reboot Execute –

Khởi động lại thiết bị.
Execute: Thực hiện chức năng.

Chú ý

Sau khi khởi động lại, hãy tải lại trang trên trình duyệt
web.

Mục Cài đặt tiểu
mục

Mặc định của
nhà sản xuất Mô tả

All Reset (except for
Network Settings)

Execute –

Đặt lại các cài đặt của thiết bị (không bao gồm cài đặt
mạng).
Execute: Thực hiện chức năng.

Chú ý

Các giao diện cơ bản đã nhập và các tệp LUT bị xóa ghi
chú.

Network Reset Execute –

Đặt lại các cài đặt mạng của thiết bị.
Execute: Thực hiện chức năng.

Chú ý

Sau khi thực hiện Network Reset, thiết bị sẽ khởi động lại.
Sau khi khởi động lại, hãy tải lại trang trên trình duyệt web.

Factory Default Execute –

Trả các cài đặt của thiết bị về trạng thái mặc định của nhà
sản xuất.
Execute: Thực hiện chức năng.

Chú ý

Sau khi thực hiện Factory Default, thiết bị sẽ khởi động lại.
Sau khi khởi động lại, hãy tải lại trang trên trình duyệt web.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Information

Hiển thị thông tin máy quay và ống kính. Cũng được dùng để cập nhật phần mềm.

Camera
Hiển thị thông tin máy quay và cập nhật phần mềm.

Lens
Hiển thị thông tin ống kính và cập nhật phần mềm.

Mục Cài đặt tiểu
mục

Mặc định của nhà
sản xuất Mô tả

Model Name – – Hiển thị tên kiểu máy của máy quay.

Serial
Number

– – Hiển thị số sê-ri của máy quay.

Version
Number

– – Hiển thị phiên bản phần mềm của máy quay.

Version Up – –

Ấn nút [Choose File] và làm theo hướng dẫn trên màn hình để
cập nhật phần mềm máy quay.

Chú ý

Sau khi cập nhật, thiết bị sẽ khởi động lại. Sau khi khởi động lại,
hãy tải lại trang trên trình duyệt web.

Mục Cài đặt tiểu
mục

Mặc định của nhà
sản xuất Mô tả

Model Name – – Hiển thị tên kiểu máy của ống kính.

Serial
Number

– – Hiển thị số sê-ri của ống kính.

Version
Number

– – Hiển thị phiên bản phần mềm của ống kính.

Version Up – –

Ấn nút [Choose File] và làm theo hướng dẫn trên màn hình để cập
nhật phần mềm ống kính.

Để biết thêm thông tin chi tiết, hãy tham khảo “Cập nhật phần
mềm ống kính ngàm E.”

Chú ý

Sau khi cập nhật ống kính, thiết bị sẽ khởi động lại. Sau khi khởi
động lại, hãy tải lại trang trên trình duyệt web.

431



Chủ đề liên quan
Cập nhật phần mềm ống kính ngàm E

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

System Log

Đặt cài đặt liên quan đến nhật ký hệ thống.

Nhật ký thu được được hiển thị như bên dưới.

Chủ đề liên quan

Cập nhật phần mềm ống kính ngàm E

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning
& Info

Đặt cấp độ cho thao tác thêm một bản ghi vào nhật
ký hệ thống.

Log Size 200 đến 1024 1024
Đặt kích thước nhật ký để lưu trong nhật ký hệ
thống.

Download as
File

– –
Ấn nút [Download] và lưu nhật ký hệ thống vào máy
tính bảng hoặc máy tính bàn từ màn hình hiển thị.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

HTTP Access Log

Đặt cài đặt liên quan đến nhật ký truy cập HTTP.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục Cài đặt tiểu mục Mặc định của
nhà sản xuất Mô tả

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning
& Info

Đặt cấp độ cho thao tác thêm một bản ghi vào nhật
ký truy cập HTTP.

Log Size 200 đến 1024 1024
Đặt kích thước nhật ký để lưu trong nhật ký truy cập
HTTP.

Download as
File – –

Ấn nút [Download] và lưu nhật ký cập thống HTTP
vào máy tính bảng hoặc máy tính bàn từ màn hình
hiển thị.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Service

Nhận thông tin về thiết bị. Sử dụng khi liên hệ với đại diện dịch vụ Sony của bạn.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mục
Cài đặt

tiểu
mục

Mặc định
của nhà
sản xuất

Mô tả

I agree to download
device information.

– –

Đặt dấu kiểm tại đây để đồng ý nhận thông tin thiết bị và nhấn nút
[OK].
Ấn nút [Download] được hiển thị. Trình duyệt web sẽ tải xuống một
tệp có tên deviceinformation.dat trong giây lát.

Chú ý

Sau khi tải xuống, thiết bị sẽ khởi động lại. Khởi động lại bằng cách
thủ công nếu thiết bị không tự động khởi động lại. Sau khi khởi động
lại, hãy tải lại trang trên trình duyệt web.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

EULA

Hiển thị Thỏa thuận cấp phép người dùng cuối (EULA).

5-041-959-03(1) Copyright 2022 Sony Corporation

436



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Software

Hiển thị giấy phép phần mềm.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kết nối các màn hình giám sát và các thiết bị ghi bên ngoài

Để hiển thị các hình ảnh được ghi/phát lại trên màn hình giám sát bên ngoài, hãy đặt tín hiệu đầu ra video là màn hình
giám sát bên ngoài và sử dụng cáp phù hợp để kết nối với màn hình giám sát.
Bạn cũng có thể kết nối một thiết bị ghi bên ngoài và ghi tín hiệu đầu ra từ máy quay.
Bạn có thể cho hiển thị thông tin tương tự nhìn thấy được trong bảng điều khiển hình ảnh máy quay, chẳng hạn như
thông tin về trạng thái và các menu trên màn hình giám sát bên ngoài. Đặt loại hệ thống mong muốn cho màn hình hiển
thị thành On bằng cách sử dụng [Monitoring] > [Output Display] trong menu web.

Chú ý

Nếu màn hình HDMI được kết nối không hỗ trợ định dạng đầu ra HDMI được định cấu hình bằng menu [Monitoring] trong menu
web hoặc menu camera, hình ảnh máy quay sẽ không được xuất sang Ứng dụng web. Video phát trực tiếp cũng không thể xuất
ra.

Bạn có thể đặt cả hai tính năng [Output Display] > [SDI] và [HDMI/Stream] thành [Off], nhưng thao tác này sẽ cản trở việc sử
dụng menu camera và các chức năng phụ thuộc vào màn hình hiển thị. Ngoài ra, các thông báo lỗi của thiết bị sẽ bị giới hạn ở
các đèn (sáng hoặc nhấp nháy) của thiết bị và hiển thị nhãn thông báo ở bên phải trong Ứng dụng web. Để biết thêm về trạng
thái chi tiết, hãy đặt [Output Display] thành [On].

Gợi ý

[Output Display] > [SDI] được đặt thành [Off] và [HDMI/Stream] được đặt thành [On] theo mặc định của nhà sản xuất. Để sử
dụng phát trực tiếp như một video chính, hãy đặt [SDI] thành [On] và [HDMI/Stream] thành [Off] và theo dõi trạng thái máy quay
trên màn hình giám sát SDI.

Đầu nối SDI OUT (loại BNC)

Đặt định dạng đầu ra bằng cách sử dụng menu [Monitoring] trong menu web hoặc menu camera.
Sử dụng cáp đồng trục 75 Ω có sẵn trên thị trường để kết nối.

Chú ý

Kiểm tra xem kết nối giữa máy quay và thiết bị bên ngoài đã được ổn định chưa trước khi bật thiết bị lên.

Nên bật máy quay và thiết bị bên ngoài lên sau khi kết nối cáp đồng trục 75 Ω.
Nếu thiết bị bên ngoài phải được kết nối với máy quay trong khi máy quay đang bật, hãy kết nối cáp đồng trục 75 Ω với
thiết bị bên ngoài trước và sau đó mới kết nối thiết bị bên ngoài với máy quay.

Cách bắt đầu ghi đồng thời trên máy quay và thiết bị bên ngoài
Khi đầu ra tín hiệu SDI đã bật, hãy đặt [Project] > [SDI/HDMI Rec Control] > [Setting] thành [SDI/HDMI Remote I/F] hoặc
[Parallel Rec] trong menu camera để cho phép xuất tín hiệu kích hoạt REC ra thiết bị bên ngoài được kết nối với đầu nối
SDI OUT. Cài đặt như vậy sẽ đồng bộ hoạt động ghi trên thiết bị bên ngoài với máy quay.

Chú ý

Nếu thiết bị bên ngoài đã kết nối không hỗ trợ tín hiệu kích hoạt REC, thì thiết bị đó không thể hoạt động được.

Khi [Project] > [SDI/HDMI Rec Control] > [Setting] được đặt thành [SDI/HDMI Remote I/F] trong menu camera, đầu ra chỉ có tín
hiệu kích hoạt REC khi không gắn phương tiện ghi và nút START/STOP ghi được vận hành.

Đầu nối HDMI OUT (Đầu nối loại A)
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Đặt cài đặt đầu ra thành On/Off và định dạng đầu ra trong menu [Monitoring] trong menu camera.

Cách bắt đầu ghi đồng thời trên máy quay và thiết bị bên ngoài
Khi tín hiệu HDMI đã bật, hãy đặt [TC/Media] > [HDMI TC Out] > [Setting] thành [On] và [Project] > [SDI/HDMI Rec
Control] > [Setting] thành [SDI/HDMI Remote I/F] hoặc [Parallel Rec] trong menu camera để cho phép xuất tín hiệu kích
hoạt REC ra thiết bị bên ngoài được kết nối với đầu nối HDMI OUT. Cài đặt như vậy sẽ đồng bộ hoạt động ghi trên thiết
bị bên ngoài với máy quay.

Chú ý

Nếu thiết bị bên ngoài đã kết nối không hỗ trợ tín hiệu kích hoạt REC, thì thiết bị đó không thể hoạt động được.

Khi [Project] > [SDI/HDMI Rec Control] > [Setting] được đặt thành [SDI/HDMI Remote I/F] trong menu camera, đầu ra chỉ có tín
hiệu kích hoạt REC khi không gắn phương tiện ghi và nút START/STOP ghi được vận hành.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kết nối với RCP/MSU

Có thể điều khiển từ xa một số chức năng của thiết bị bằng cách kết nối bảng điều khiển từ xa (RCP) chẳng hạn như
RCP-3500/3501 hoặc thiết bị thiết lập chính (MSU) chẳng hạn như MSU-3500 với thiết bị qua cáp LAN.
Phương thức kết nối sẽ khác nhau tùy thuộc vào cấu hình của các thiết bị liên quan và ứng dụng.

Để thêm biết chi tiết về kết nối một-một giữa thiết bị và RCP, hãy tham khảo “Kết nối một-một giữa thiết bị và RCP”.
Để biết chi tiết về cách kết nối nhiều máy quay bằng MSU hoặc phần mềm điều khiển máy quay, hãy tham khảo “Sử
dụng thiết bị trong môi trường nhiều máy quay với phần mềm điều khiển từ xa MSU/máy quay”.

Chủ đề liên quan

Kết nối một-một giữa thiết bị và RCP

Sử dụng thiết bị trong môi trường nhiều máy quay với phần mềm điều khiển từ xa MSU/máy quay

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kết nối một-một giữa thiết bị và RCP

Chú ý

Hãy tham khảo “Danh sách chức năng được hỗ trợ” và định cấu hình thiết bị để thiết bị đáp ứng các điều kiện vận hành đối với
các chức năng mà bạn muốn sử dụng, sau đó bật kết nối với RCP bằng cách áp dụng quy trình sau đây.

Chủ đề liên quan
Danh sách chức năng được hỗ trợ

5-041-959-03(1) Copyright 2022 Sony Corporation

Bật các thiết bị.1

Đặt [Technical] > [RCP/MSU] > [CNS Mode] thành [Bridge] trong menu web của máy quay.2

Định cấu hình các thiết lập sau trên RCP.

Để biết chi tiết về cấu hình, hãy tham khảo hướng dẫn vận hành của RCP.

3

Đặt chế độ kết nối thành chế độ Bridge.1.
Đăng ký địa chỉ IP của máy quay.2.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Sử dụng thiết bị trong môi trường nhiều máy quay với phần mềm điều khiển từ xa
MSU/máy quay

Bạn có thể kết nối nhiều máy quay bằng MSU hoặc phần mềm điều khiển máy quay từ xa.

Chú ý

Hãy tham khảo “Danh sách chức năng được hỗ trợ” và định cấu hình thiết bị để thiết bị đáp ứng các điều kiện vận hành đối với
các chức năng mà bạn muốn sử dụng, sau đó bật kết nối với MSU hoặc phần mềm điều khiển từ xa của máy quay bằng cách áp
dụng quy trình sau đây.

Chủ đề liên quan

Danh sách chức năng được hỗ trợ

5-041-959-03(1) Copyright 2022 Sony Corporation

Bật các thiết bị.1

Định cấu hình cài đặt mạng hệ thống bằng MSU hoặc phần mềm điều khiển từ xa của máy quay.

Để biết chi tiết về cấu hình, hãy tham khảo hướng dẫn vận hành của MSU hoặc phần mềm điều khiển từ xa của
máy quay.

2

Định cấu hình các cài đặt sau đây bằng cách sử dụng [Technical] > [RCP/MSU] trong menu web của máy
quay.

3

Nếu sử dụng MSU, hãy đặt [CNS Mode] thành [MCS]. Nếu sử dụng phần mềm điều khiển từ xa của máy quay,
hãy đặt [CNS Mode] thành [PC Control].

1.

Đặt địa chỉnh IP của MSU chính hoặc phần mềm điều khiển từ xa của máy quay trong [Master IP Address].2.
Đặt số máy quay mà máy quay được đăng ký trong [Camera No.].3.
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Danh sách chức năng được hỗ trợ

Bảng sau đây cho thấy các chức năng được hỗ trợ và điều kiện vận hành tương ứng của chúng.

Bảng điều
khiển Chức năng của thiết bị Điều kiện vận hành

IRIS Điều chỉnh thủ công cửa điều sáng –

AUTO IRIS Chuyển Auto Iris bật/tắt –

ND
Chuyển vị trí đặt trước của bộ lọc ND
(Clear/Preset1 thành Preset3)

Chức năng này được bật khi [Shooting] > [ND Filter] >
[Mode] được đặt thành [Preset] trong menu camera.

MASTER
GAIN

Điều chỉnh độ lợi theo cách thủ công (đơn
vị 3 dB)

Được bật khi cả hai chế độ chụp đều được đặt thành
chế độ Custom và [Shooting] > [ISO/Gain/EI] > [Mode]
được đặt thành [dB] trong menu camera.

WHITE (R/B)
Điều chỉnh cân bằng trắng thủ công (R
Gain/B Gain)

Được bật khi [White Mode] được đặt thành [Memory
A(R/B)] hoặc [Memory A(T/T)].WHITE

(Color Temp)

Điều chỉnh cân bằng trắng (nhiệt độ/sắc độ
màu) thủ công

RCP – [Color Temp]: Nhiệt độ màu cân
bằng trắng
RCP – [Balance]: Giá trị sắc độ cân
bằng trắng

ATW
Bật/tắt chức năng ATW (Cân bằng trắng
theo dấu tự động)

Được bật khi chế độ chụp được đặt thành chế độ
Custom.

BLACK R/B Điều chỉnh cân bằng đen
Được bật khi chế độ chụp được đặt thành chế độ
Custom.
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Chú ý

Định cấu hình thiết bị để thiết bị đáp ứng các điều kiện vận hành đối với các chức năng mà bạn muốn sử dụng, sau đó bật kết
nối với RCP/MSU. Nếu các điều kiện vận hành được điều chỉnh sau khi bật kết nối, hành vi không chủ đích có thể xảy ra.
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Bảng điều
khiển Chức năng của thiết bị Điều kiện vận hành

MASTER
BLACK

Điều chỉnh mức màu đen chính

Được bật khi chế độ chụp được đặt thành chế độ
Custom.
H/V Ratio và Crispening được bật khi [Paint/Look] >
[Detail] > [Manual Setting] được đặt thành [On]
trong menu camera.

DETAIL

Bật/tắt chức năng chi tiết
Đặt mức chi tiết
Cài đặt H/V Ratio
Cài đặt Crispening

User Matrix

Bật/tắt chức năng hiệu chỉnh ma trận
của người dùng
Đặt các giá trị hiệu chỉnh ma trận (R-
G/R-B/G-R/G-B/B-R/B-G)

Multi Matrix

Bật/tắt chức năng hiệu chỉnh nhiều ma
trận
Đặt sắc độ màu và độ bão hòa của màu
được sử dụng để đa hiệu chỉnh ma trận

Knee
Bật/tắt chức năng hiệu chỉnh knee
Bật/tắt chức năng knee tự động
Đặt điểm đầu gối và độ dốc đầu gối

BARS Bật/tắt thanh màu

SHUTTER

Bật/tắt chức năng màn trập
Cài đặt giá trị tốc độ màn trập
(Bật/tắt màn trập tự động, cài đặt góc
màn trập, cài đặt màn trập chậm, cài đặt
ECS không được hỗ trợ.)

Chú ý

Cài đặt màn trập RCP có thể không
được hiển thị tùy thuộc vào giá trị tốc
độ màn trập được định cấu hình.

Cài đặt màn trập RCP có thể không
được hiển thị chính xác nếu màn
trập không thể được vận hành từ
RCP.

Khi bật màn trập tự động, màn trập tự động sẽ tiếp tục
hoạt động ngay cả khi bạn bật/tắt màn trập hoặc thay
đổi giá trị tốc độ màn trập từ RCP.
Khi màn trập được đặt thành [Angle], bật/tắt màn trập
hoặc thay đổi cài đặt tốc độ màn trập từ RCP không
được hỗ trợ.
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Về vận hành sử dụng bảng điều khiển từ xa RM-IP500 (tùy chọn)

Bạn có thể vận hành thiết bị bằng cách sử dụng Bảng điều khiển từ xa RM-IP500 của Sony chạy phiên bản phần mềm
2.2 trở lên. Các thiết bị giao tiếp với nhau bằng VISCA over IP (LAN).
Tùy thuộc vào mục mục tiêu để vận hành, bạn có thể cần xem hiển thị màn hình của thiết bị. Chuẩn bị màn hình giám
sát có thể được dùng để kiểm tra màn hình hiển thị.
Các chức năng vận hành sau đây được hỗ trợ từ Bảng điều khiển từ xa RM-IP500.

Chọn máy quay mục tiêu
Điều chỉnh khung (xoay, nghiêng, thu phóng)
Điều chỉnh lấy nét (không bao gồm vận hành cảm ứng)
Đăng ký và gọi lại các vị trí đặt trước
Vận hành menu của thiết bị (không bao gồm menu web)
Điều chỉnh độ sáng
Điều chỉnh cân bằng trắng
Điều chỉnh cân bằng đen
Điều chỉnh mức đầu vào âm thanh
Bắt đầu/dừng ghi
Thực thi các chức năng nút có thể gán của thiết bị

Để biết thêm chi tiết về vận hành RM-IP500, hãy tham khảo tài liệu hướng dẫn vận hành dành cho RM-IP500.

Gợi ý

Khi sử dụng bảng điều khiển RM-IP500, hãy sử dụng bảng điều khiển dành cho thiết bị mà có RM-IP500 đi kèm.

RM-IP500 (sử dụng bảng điều khiển cho thiết bị này)
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Kết nối bộ điều khiển từ xa RM-IP500

Để biết chi tiết về các chức năng chỉ định, hãy tham khảo tài liệu hướng dẫn vận hành dành cho RM-IP500.

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt công tắc SETUP 3 của thiết bị sang vị trí ON để bật giao tiếp VISCA over IP.

Chú ý

Cài đặt công tắc được áp dụng khi thiết bị được bật lần tiếp theo.

1

Kết nối RM-IP500 với cùng một mạng với thiết bị.2

Làm theo quy trình trong hướng dẫn vận hành RM-IP500 để định cấu hình kết nối VISCA over IP (LAN) trên
RM-IP500.

Chỉ định thiết bị này bằng cách sử dụng menu RM > AUTO IP SETUP > ASSIGN CAM.

3

Chỉ định các chức năng của thiết bị này cho các nút và núm vặn, theo yêu cầu, bằng cách sử dụng các mục
menu RM sau đây của RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Đồng bộ hóa với thiết bị bên ngoài

Khi ghi hình bằng cách sử dụng nhiều thiết bị, các thiết bị đó có thể được đồng bộ hóa thành tín hiệu tham chiếu cụ thể
hoặc mã thời gian thông qua đầu nối GENLOCK của chính các thiết bị này.

Để biết thêm thông tin chi tiết về genlock, hãy tham khảo “Đồng bộ hóa pha của tính hiệu video (Genlock).”
Để biết thêm thông tin chi tiết về đồng bộ hóa mã thời gian, hãy tham khảo “Khóa mã thời gian đối với các thiết bị
khác.”

Chủ đề liên quan

Đồng bộ hóa pha của tính hiệu video (Genlock)

Khóa mã thời gian đối với các thiết bị khác

5-041-959-03(1) Copyright 2022 Sony Corporation
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Đồng bộ hóa pha của tính hiệu video (Genlock)

Bạn có thể cung cấp tín hiệu tham chiếu cho đầu nối GENLOCK để bật genlock.
Các tín hiệu tham chiếu đầu vào có thể được sử dụng sẽ thay đổi tùy thuộc vào tần số hệ thống của định dạng ghi đã
chọn.

Bạn có thể kiểm tra trạng thái đồng bộ hóa bên ngoài bằng cách sử dụng [Technical] > [Genlock] > [Reference] trong
menu camera.

Chú ý

Nếu tín hiệu tham chiếu không ổn định, thì không thể có được genlock.

Không đồng bộ hóa được sóng mang thứ cấp.
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Tần số hệ thống của định dạng ghi Các tín hiệu tham chiếu đầu vào được hỗ trợ

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P 1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i 1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Khóa mã thời gian đối với các thiết bị khác

Cài đặt thiết bị cung cấp mã thời gian sang chế độ mà đầu ra mã thời gian vẫn tiếp tục chạy (chẳng hạn như Free Run
hoặc Clock).

Chú ý

Kiểm tra xem mã thời gian tham chiếu đã cung cấp và tín hiệu video tham chiếu có ở mối quan hệ pha mà tuân thủ theo tiêu
chuẩn mã thời gian SMPTE hay không.

Khi hoạt động với khóa ngoài, mã thời gian ngay lập tức nhận được khóa bằng mã thời gian bên ngoài và giá trị mã thời gian bên
ngoài xuất hiện trong vùng hiển thị dữ liệu thời gian. Tuy nhiên, không nên bắt đầu ghi ngay. Hãy chờ vài giây cho đến khi bộ tạo
mã thời gian ổn định trước khi ghi.

Nếu tần số của tín hiệu video tham chiếu và tần số khung hình trên thiết bị không giống nhau, thì sẽ không thể lấy được khóa và
thiết bị sẽ không hoạt động được bình thường. Nếu điều này xảy ra, mã thời gian sẽ không lấy được khóa bằng mã thời gian bên
ngoài.

Nếu nguồn mã thời gian bên ngoài bị ngắt kết nối, mã thời gian có thể dịch chuyển một khung hình trên mỗi giờ đối với mã thời
gian tham chiếu.

Cách để ngắt khóa bên ngoài
Thay đổi cài đặt [TC/Media] > [Timecode] trong menu camera.
Đồng bộ hóa bên ngoài cũng sẽ bị ngắt nếu thay đổi tần số hệ thống. Bên cạnh đó, khi bạn bắt đầu ghi ở chế độ ghi đặc
biệt (Slow & Quick Motion hoặc Interval Rec).

5-041-959-03(1) Copyright 2022 Sony Corporation

Đặt các chức năng sau trong [TC/Media] > [Timecode] trong menu camera.

Đặt [Mode] thành [Preset].
Đặt [Run] thành [Free Run].

1

Nhấn vào nút có thể gán đã được chỉ định chức năng [DURATION/TC/U-BIT] để hiển thị mã thời gian trên
màn hình.

2

Cung cấp tín hiệu video tham chiếu HD hoặc SD cho đầu nối GENLOCK và mã thời gian tham chiếu cho
đầu nối TC IN.

Bộ tạo mã thời gian của thiết bị lấy khóa có mã thời gian tham chiếu và cụm “EXT-LK” xuất hiện trên màn hình.
Sau khoảng 10 giây trôi qua sau khi mã thời gian khóa lại, trạng thái khóa bên ngoài được duy trì ngay cả khi
nguồn mã thời gian tham chiếu bên ngoài bị ngắt kết nối.

3
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Kết nối micrô bên ngoài hoặc thiết bị âm thanh bên ngoài

Bạn có thể nhập tín hiệu từ micrô bên ngoài hoặc thiết bị âm thanh bên ngoài và nhúng âm thanh vào video đã ghi hoặc
video đầu ra của thiết bị.

Kết nối micrô bên ngoài hoặc thiết bị âm thanh bên ngoài bằng cáp XLR.

Khi âm thanh được đặt thành [LINE] bằng cách sử dụng [Audio] > [Audio Input] > [AUDIO IN Select] trong menu
camera, đầu nối AUDIO IN hoạt động như đầu nối AUDIO IN CH-1 và đầu nối AUDIO IN CH-2.

1

Chân số Chức năng

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Tắt thiết bị và kết nối cáp XLR với đầu nối AUDIO IN.2

Đặt công tắc SETUP 2 để bật nguồn điện ảo theo yêu cầu.

Chuyển nguồn điện +48 V (nguồn ảo) như mô tả bên dưới.
Công tắc 2
Đặt xem nguồn điện +48 V (nguồn ảo) có được bật/tắt khi thiết bị đầu vào âm thanh được kết nối hay không.

3

Cài đặt Mô tả

OFF (mặc
định)

Thao tác này tắt nguồn điện ảo +48 V và đặt LINE hoặc đầu vào MIC thành nguồn âm thanh
CH-1 và CH-2.
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Chú ý

Cài đặt công tắc này sang vị trí ON và kết nối micrô không tương thích với nguồn +48V có thể làm hỏng thiết bị được kết
nối. Kiểm tra thông tin cài đặt trước khi kết nối thiết bị.

Cài đặt Mô tả

ON
Thao tác này tắt nguồn điện ảo +48V và micrô tương thích nguồn điện ảo thành nguồn âm
thanh CH-1 và CH-2.

Bật thiết bị và đặt loại thiết bị được kết nối bằng cách sử dụng [Audio] > [Audio Input] > [AUDIO IN Select]
trong menu camera.

4
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Quản lý/chỉnh sửa các clip bằng máy tính

Bạn có thể quản lý/chỉnh sửa clip bằng máy tính.

Nhập clip bằng đầu đọc thẻ (tùy chọn)

Kết nối đầu đọc thẻ CFexpress Type A hoặc đầu đọc thẻ SD với máy tính của bạn và sử dụng phần mềm hỗ trợ định
dạng ghi của thiết bị này, chẳng hạn như Catalyst Browse, để nhập các clip.

Sử dụng hệ thống chỉnh sửa phi tuyến tính

Trong hệ thống chỉnh sửa phi tuyến tính, bắt buộc cần phải có phần mềm chỉnh sửa (tùy chọn) có hỗ trợ các định dạng
được ghi bởi thiết bị.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Xuất tín hiệu cáp quang

Bạn có thể xuất một tín hiệu SDI được chuyển đổi sang tín hiệu quang bằng cách kết nối mô-đun SFP+ (tùy chọn) với
đầu nối OPTICAL của thiết bị. Sử dụng mô-đun SFP+ phù hợp với dải tín hiệu của từng định dạng.
Dải tín hiệu

4K (59.94p, 50p): 12G
4K (ngoài 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (ngoài 59.94p, 50p): 1.5G

Chú ý

Sử dụng mô-đun phù hợp với các tiêu chuẩn sau đây.

Tiêu chuẩn SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Tiêu chuẩn SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

Tín hiệu tương tự như đầu nối đầu ra SDI được đưa ra mô-đun SFP+.

Thiết bị này không hỗ trợ đầu vào tín hiệu cáp quang.

Sử dụng mô-đun SFP+ cho đầu ra tín hiệu cáp quang. Để biết chi tiết về các mô-đun SFP+ đã xác thực, hãy liên hệ đại lý Sony
của bạn hoặc đại diện dịch vụ Sony.
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* Mức điện năng I (1,0 W)
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Kết nối tín hiệu báo hiệu

Chủ đề này mô tả điều khiển tín hiệu báo hiệu.

Bật đèn báo hiệu bằng cách sử dụng tín hiệu từ bảng điều khiển từ xa

Bạn có thể bật đèn báo hiệu bằng lệnh VISCA over IP từ thiết bị bên ngoài, chẳng hạn như RM-IP500.
Đặt [Technical] > [Tally] > [Tally Control] thành [External] trong menu web hoặc menu camera.

Bật đèn báo hiệu từ thiết bị bên ngoài

Bạn có thể bật đèn báo hiệu của thiết bị sáng màu đỏ hoặc màu xanh lục từ thiết bị bên ngoài, chẳng hạn như RM-
IP500. Bạn có thể điều khiển báo hiệu bằng cách sử dụng các lệnh được truyền qua mạng hoặc sử dụng đầu vào tín
hiệu trên đầu nối OPTION của thiết bị.
Đặt [Technical] > [Tally] > [Tally Control] thành [External] trong menu web hoặc menu camera.
Khi nhập tín hiệu báo hiệu trên đầu nối OPTION, ngắn mạch chân 7 đến GND (chân 4 hoặc 5) để sáng đèn báo hiệu
màu xanh lục hoặc chân 8 đến GND (chân 4 hoặc 5) để làm sáng đèn báo hiệu màu đỏ.

Chú ý

Khi [Tally Control] được đặt thành [External], trạng thái ghi của thiết bị không được chỉ báo bằng đèn báo hiệu.

Khi nhập đồng thời báo hiệu màu đỏ và báo hiệu màu xanh lục, đèn báo hiệu của thiết bị sẽ sáng màu đỏ.

Thông số kỹ thuật chân đầu nối OPTION

Chân
số

Hướng tín
hiệu Thông số kỹ thuật tín hiệu

1 – Tín hiệu RS-232C TX (đối với bộ điều khiển ống kính)

2 – Tín hiệu RS-232C RX (đối với bộ điều khiển ống kính)

3 OUT

Đầu ra đèn báo hiệu màu xanh lục
Đầu ra cấp thấp khi đèn báo hiệu màu xanh lục được bật.
Hi-Z (đầu ra xả hở) khi đèn báo hiệu màu xanh lục không sáng.

4 – GND (Nối đất)

5 – GND (Nối đất)
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Bật đèn báo hiệu của thiết bị bên ngoài bằng tín hiệu từ thiết bị

Bạn có thể bật đèn báo hiệu của thiết bị bên ngoài bằng tín hiệu từ thiết bị bằng cách kết nối chân 3 và chân 6 của đầu
nối OPTION như hình dưới đây.
Ví dụ đầu nối OPTION chân 3 và 6

Chú ý

Không đặt điện áp vào chân 7 và 8.

Không kết nối thiết bị bên ngoài có thể đặt điện áp vào đầu nối OPTION.

Nếu điện áp kích từ hoặc nghịch vượt quá định mức được áp dụng cho chân 3 hoặc 6, nó có thể gây ra sự cố, khói hoặc hỏa
hoạn.

Đặt tín hiệu đầu ra bằng cách sử dụng [Technical] > [Tally] > [Tally Control] trong menu web hoặc menu camera.
[Internal]: Trạng thái vận hành ghi của thiết bị
[External]: Logical-AND của các tín hiệu báo hiệu màu đỏ/xanh lục mà thiết bị nhận được thông qua tín hiệu IN hoặc bảng điều
khiển từ xa.
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Chân
số

Hướng tín
hiệu Thông số kỹ thuật tín hiệu

6 OUT

Đầu ra đèn báo hiệu màu đỏ
Đầu ra cấp thấp khi đèn báo hiệu màu đỏ được bật.
Hi-Z (đầu ra xả hở) khi đèn báo hiệu màu đỏ không sáng.

7 IN
Đầu vào điều khiển bên ngoài báo hiệu của màu xanh lục
Ngắn mạch nối đất (chân 4 hoặc 5) làm cho đèn báo hiệu của thiết bị sáng màu xanh
lục.

8 IN
Đầu vào điều khiển bên ngoài của báo hiệu màu đỏ
Ngắn mạch nối đất (chân 4 hoặc 5) làm cho đèn báo hiệu của thiết bị sáng màu đỏ.
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Xuất dữ liệu theo dõi (free-d)

Thiết bị có thể xuất thông tin theo dõi xoay/nghiêng/thu phóng, lấy nét và cửa điều sáng được đồng bộ hóa với tín hiệu
đồng bộ.
Dữ liệu đầu ra tuân theo giao thức free-d, một tiêu chuẩn ngành. Bạn có thể chọn phương thức đầu ra, chọn giữa đầu ra
không đổi và đầu ra theo yêu cầu từ khách hàng. Chọn phương thức đầu ra theo hệ thống VR/AR của bạn.

Định dạng đầu ra dữ liệu

Gợi ý

Chi tiết kỹ thuật được cung cấp trong “Hướng dẫn tích hợp dành cho free-d.” Liên hệ với đại diện bán hàng của Sony.

Dữ liệu theo dõi do thiết bị xuất ra bao gồm dữ liệu sau theo định dạng được chỉ định trong Type D0/D1 của giao thức
free-d.
Type D0 – poll/command

Kiểm tra xem thiết bị đã được bật chưa.1

Đặt phương thức xuất dữ liệu theo dõi.

Đối với đầu ra không đổi

Đối với đầu ra theo yêu cầu của khách hàng

2

Đặt [Technical] > [Tracking Data Output] > [Transfer Mode] thành [Always] trong menu web.1.
Đặt ID của thiết bị trong [Camera ID].2.
Chỉ định địa chỉ IP đích của đầu ra trong [Destination Address].3.
Chỉ định số cổng đích của đầu ra trong [Destination Port].4.
Ấn nút [OK].5.

Đặt [Technical] > [Tracking Data Output] > [Transfer Mode] thành [On Demand] trong menu web.1.
Đặt ID của thiết bị trong [Camera ID].2.
Chỉ định số cổng nhận yêu cầu của khách hàng trong [Listen Port].3.
Ấn nút [OK].4.

Biểu tượng Nội dung Mô tả

<D0> Message type

<CA> Camera ID

<CD> command

Hỗ trợ các lệnh sau đây:

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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Type D1 – camera position/orientation data

Chú ý

Dữ liệu theo dõi có thể bị trì hoãn hoặc các giá trị có thể được cập nhật trong các tình huống sau đây:

Khi xuất video RAW
Khi S&Q Motion được bật
Khi hiển thị menu máy quay
Khi hiển thị màn hình thu nhỏ
Khi phát clip đã ghi
Khi hiển thị menu web
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Biểu tượng Nội dung Mô tả

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Góc xoay (−170° đến +170°)

<TH><TM><TL> Camera Tilt Angle Góc nghiêng (−30° đến +195°)

<RH><RM><TL> Camera Roll Angle Không được hỗ trợ (luôn là 0)

<XH><XM><XL> Camera X-Position Không được hỗ trợ (luôn là 0)

<YH><YM><YL> Camera Y-Position Không được hỗ trợ (luôn là 0)

<HH><HM><HL> Camera Height Không được hỗ trợ (luôn là 0)

<ZH><ZM><ZL> Camera Zoom Độ dài tiêu cự

<FH><FM><FL> Camera Focus Khoảng cách máy quay

<SH><SL> Spare/User Defined Vị trí cửa điều sáng

<CK> Checksum
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Hướng dẫn trợ giúp
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Kết nối bộ điều khiển ống kính

Bạn có thể vận hành thu phóng ống kính thu phóng thủ công từ Ứng dụng Web, RM-IP500 (tùy chọn), hoặc điều khiển
từ xa hồng ngoại bằng cách kết nối bộ điều khiển ống kính có bán trên thị trường (tùy chọn) tương thích với thiết bị này.
Để biết chi tiết về việc kết nối bộ điều khiển ống kính, hãy tham khảo hướng dẫn vận hành của bộ điều khiển ống kính.
Để biết chi tiết về việc điều chỉnh mức thu phóng bằng bộ điều khiển ống kính, hãy tham khảo “Điều chỉnh thu phóng
bằng bộ điều khiển ống kính”.

Chú ý

Trước khi sử dụng bộ điều khiển ống kính, hãy đọc kỹ hướng dẫn vận hành của bộ điều khiển ống kính và đảm bảo bạn hiểu đầy
đủ cách sử dụng nó. Sony sẽ không chịu trách nhiệm pháp lý đối với mọi khiếu nại dưới bất kỳ hình thức nào phát sinh từ việc sử
dụng bộ điều khiển ống kính.

Thu phóng chất lượng cao không khả dụng khi bộ điều khiển ống kính được bật. Bạn nên đặt tỷ lệ Thu phóng chất lượng cao
thành 1,0× hoặc tắt Thu phóng chất lượng cao.

Khi bật bộ điều khiển ống kính, bạn không thể ghi hoặc phát lại các thao tác định khung của máy quay.

Chủ đề liên quan

Điều chỉnh thu phóng bằng bộ điều khiển ống kính

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Điều chỉnh thu phóng bằng bộ điều khiển ống kính

Sử dụng quy trình sau để gắn bộ điều khiển ống kính (tùy chọn) và điều chỉnh thu phóng.

Kiểm tra trạng thái bộ điều khiển ống kính
Nhấn nút  (Trạng thái máy quay) trong khu vực chung của màn hình Ứng dụng Web để hiển thị màn hình trạng thái
máy quay.

Kết nối bộ điều khiển ống kính với đầu nối OPTION trên khối đầu nối của thiết bị.

Để biết thêm chi tiết về việc gắn, hãy tham khảo hướng dẫn vận hành của bộ điều khiển ống kính.

1

Thiết lập bộ điều khiển ống kính cho ống kính thu phóng.

Để biết chi tiết, hãy tham khảo hướng dẫn vận hành của bộ điều khiển ống kính.

2

Khóa xoay/nghiêng thiết bị và gắn ống kính thu phóng.

Để biết thêm chi tiết, hãy tham khảo “Gắn ống kính”.

3

Điều chỉnh bộ điều khiển ống kính để nó có thể vận hành ống kính thu phóng.4

Duy trì sự cân bằng về phía trước/phía sau của đầu máy quay sao cho đế trượt nằm ngang.

Để biết thêm chi tiết, hãy tham khảo hướng dẫn vận hành của bộ điều khiển ống kính và “Gắn ống kính”.

5

Đặt [Technical] > [Lens Controller] > [Setting] thành [On] trong menu web và nhấn nút [OK].

Thiết bị sẽ khởi động lại. Chờ cho đến khi vận hành đặt lại xoay/nghiêng hoàn tất.

6

Nhấn nút  (Khởi tạo bộ điều khiến ống kính) trong thẻ  (Others) trong bảng điều khiển máy
quay trên màn hình vận hành trực tiếp của Ứng dụng Web.

Bộ điều khiển ống kính di chuyển để phát hiện phạm vi thu phóng. Để biết chi tiết, hãy tham khảo hướng dẫn vận
hành của bộ điều khiển ống kính.
Khi chỉ báo  (Lỗi bộ điều khiển ống kính) thay đổi thành  (Bộ điều khiển ống kính sẵn sàng) trên góc trên bên
trái của bảng điều khiển hình ảnh máy quay, việc chuẩn bị hoàn tất.

Chú ý

Lưu ý phạm vi hoạt động của ống kính khi khởi tạo bộ điều khiển ống kính.

7

Điều chỉnh thu phóng bằng cách sử dụng thanh trượt [Zoom] trong Ứng dụng Web hoặc các nút điều khiển
thu phóng của bộ điều khiển từ xa.

8
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Bạn có thể kiểm tra trạng thái bộ điều khiển ống kính trong màn hình này.

Chú ý

Khi bạn thay ống kính, hãy khởi tạo bộ điều khiển ống kính.

Thu phóng chất lượng cao không khả dụng khi bộ điều khiển ống kính được bật. Bạn nên đặt tỷ lệ Thu phóng chất lượng cao
thành 1,0× hoặc tắt Thu phóng chất lượng cao.

5-041-959-03(1) Copyright 2022 Sony Corporation

Trạng thái Mô tả

Off Sử dụng thu phóng hiệu suất cao trong ống kính ngàm E.

Communication
Error

Có lỗi giao tiếp xảy ra giữa thiết bị và bộ điều khiển ống kính.
Kiểm tra kết nối giữa thiết bị và bộ điều khiển ống kính, sau đó tham khảo hướng dẫn vận hành
bộ điều khiển ống kính và khởi tạo bộ điều khiển ống kính.

Uninitialized Thực hiện khởi tạo.

Initializing Đợi cho đến khi quá trình khởi tạo hoàn tất.

Initialization
Failed

Kiểm tra kết nối giữa thiết bị và bộ điều khiển ống kính, sau đó tham khảo hướng dẫn vận hành
bộ điều khiển ống kính và khởi tạo bộ điều khiển ống kính.

Working Điều khiển thu phóng bằng bộ điều khiển ống kính.

Rotation Error
Phạm vi di chuyển thu phóng và phạm vi di chuyển ống kính đã lưu không phù hợp. Khởi tạo bộ
điều khiển ống kính.

System Error Kiểm tra kết nối giữa thiết bị và bộ điều khiển ống kính, tham khảo hướng dẫn vận hành bộ điều
khiển ống kính và khởi tạo bộ điều khiển ống kính hoặc chu kỳ hiệu suất của thiết bị và bộ điều
khiển ống kính.Unknown Error
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Thận trọng khi sử dụng

Những lưu ý khi vận chuyển và đóng gói
Khi vận chuyển hoặc đóng gói thiết bị, hãy duy trì các điều kiện sau đây và tránh làm rung hoặc sốc mạnh thiết bị.

Tháo ống kính và gắn nắp thân máy.
Sau khi di chuyển đầu máy quay (A) ra phía trước, xoay cần khóa đầu máy quay (B) theo hướng mũi tên để khóa
đầu máy quay.

Đặt đầu máy quay hướng về phía trước và khóa bằng cần khóa xoay/nghiêng.

Tháo các cáp kết nối.

Ngưng tụ hơi nước
Nếu bạn đột ngột đưa thiết bị từ nơi lạnh sang nơi ấm hoặc nếu nhiệt độ xung quanh tăng đột ngột thì hơi ẩm có thể
hình thành trên mặt ngoài và/hoặc mặt trong của thiết bị. Hiện tượng này gọi là ngưng tụ hơi nước. Nếu hiện tượng này
xảy ra, trước khi vận hành thiết bị, hãy tắt thiết bị và đợi cho đến khi không còn hơi nước ngưng tụ. Vận hành thiết bị khi
vẫn còn hiện tượng ngưng tụ có thể làm hỏng thiết bị.

Hiện tượng cảm biến hình ảnh của camera CMOS

Chú ý

Các hiện tượng sau đây có thể xảy ra trong hình ảnh là đặc trưng của cảm biến hình ảnh. Những vấn đề này không phải sự cố.

Đốm trắng
Mặc dù cảm biến hình ảnh được sản xuất bằng công nghệ chính xác cao, nhưng trong một số trường hợp hiếm gặp,
màn hình có thể xuất hiện các đốm trắng mịn do tia vũ trụ, v.v.
Điều này liên quan đến nguyên tắc của cảm biến hình ảnh và không phải là một sự cố. Thường xuyên thực hiện
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APR.
Các đốm trắng đặc biệt có xu hướng xuất hiện trong các trường hợp sau:

Khi hoạt động ở nhiệt độ môi trường cao
Khi bạn đã tăng độ lợi (độ nhạy)

Nhấp nháy
Nếu chụp dưới ánh sáng từ đèn huỳnh quang, đèn natri, đèn hơi thủy ngân hoặc đèn LED, màn hình có thể nhấp
nháy hoặc màu sắc có thể thay đổi.

Ống kính và thiết bị truyền động xoay/nghiêng
Nếu ống kính và cơ cấu truyền động xoay/nghiêng không được vận hành trong thời gian dài, độ nhớt của mỡ bôi bên
trong có thể tăng lên, ngăn cản cơ chế chuyển động. Vận hành ống kính và cơ chế xoay/nghiêng thường xuyên.

Đối với các bộ phận tiêu hao
Quạt và pin tích hợp là những bộ phận tiêu hao sẽ cần được thay thế định kỳ.
Khi hoạt động ở nhiệt độ phòng, chu kỳ thay thế thông thường sẽ là khoảng 5 năm. Tuy nhiên, chu kỳ thay thế này
chỉ là một hướng dẫn chung và không ngụ ý rằng các bộ phận này đảm bảo có vòng đời sử dụng như vậy.
Để biết chi tiết về việc thay thế các bộ phận, hãy liên hệ với đại lý của bạn.

Vòng đời của bộ đổi nguồn AC và tụ điện là khoảng 5 năm trong điều kiện nhiệt độ hoạt động bình thường và sử
dụng bình thường (8 giờ mỗi ngày; 25 ngày mỗi tháng). Nếu sử dụng vượt quá tần suất sử dụng bình thường trên,
vòng đời có thể giảm tương ứng.

Nên kiểm tra định kỳ để giữ cho thiết bị hoạt động bình thường và kéo dài vòng đời sử dụng của thiết bị. Liên hệ với đại
diện dịch vụ của Sony để biết thêm thông tin về việc kiểm tra.

Về pin sạc tích hợp
Thiết bị có pin sạc tích hợp để lưu ngày, giờ và các cài đặt khác ngay cả khi thiết bị đã tắt. Pin sạc tích hợp sẽ được sạc
sau 24 giờ nếu thiết bị được kết nối với ổ cắm điện bằng bộ chuyển đổi AC hoặc nếu được cấp điện qua PoE++ dù thiết
bị đang bật hay tắt. Pin sạc sẽ hết hoàn toàn trong khoảng 2 tháng nếu không kết nối bộ chuyển đổi AC với nguồn điện.
Sử dụng thiết bị sau khi sạc pin. Tuy nhiên, ngay cả khi không sạc pin, hoạt động của thiết bị sẽ không bị ảnh hưởng
miễn là bạn không cần ghi lại ngày tháng.

Vị trí sử dụng và cất giữ
Cất giữ ở nơi bằng phẳng, thông thoáng.
Tránh sử dụng hoặc cất giữ thiết bị ở những nơi sau đây.

Các vị trí tiếp xúc với nước mưa hoặc nước (kể cả dưới mái hiên)
Ngoài trời và các địa điểm vượt quá 40 °C
Hãy lưu ý rằng vào mùa hè ở vùng khí hậu ấm áp, nhiệt độ bên trong ô tô đóng cửa sổ có thể dễ dàng vượt quá 50
°C.
Vị trí lạnh hơn 0 °C.
Ở nơi ẩm ướt hoặc bụi bẩn. Nơi thiết bị có thể bị dính mưa
Vị trí có thể bị rung hoặc sốc
Các vị trí tạo ra bức xạ, tia X và từ trường mạnh.
Gần máy phát vô tuyến hoặc TV tạo ra trường điện từ mạnh.
Dưới ánh nắng trực tiếp hoặc để gần máy sưởi trong thời gian dài

Lưu ý về tia laze
Tia laze có thể làm hỏng cảm biến hình ảnh CMOS. Nếu bạn quay cảnh có chùm tia laze, hãy cẩn thận không để tia laze
hướng trực tiếp vào cảm biến hình ảnh CMOS của camera. Cụ thể, chùm tia laze công suất cao từ các thiết bị y tế hoặc
các thiết bị khác có thể gây hỏng hóc do ánh sáng phản xạ và ánh sáng tán xạ.

Để ngăn chặn nhiễu điện từ từ các thiết bị liên lạc di động
Việc sử dụng điện thoại di động và các thiết bị liên lạc khác gần thiết bị này có thể dẫn đến sự cố và nhiễu tín hiệu âm
thanh và hình ảnh. Bạn nên tắt nguồn của các thiết bị liên lạc di động gần thiết bị này.
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Không đặt sản phẩm này gần các thiết bị y tế
Sản phẩm này (bao gồm phụ kiện) có (nhiều) nam châm có thể gây nhiễu máy trợ tim, van shunt được lập trình để điều
trị bệnh não úng thủy, hay các thiết bị y tế khác. Không đặt sản phẩm này gần những người sử dụng các thiết bị y tế như
thế. Tham khảo ý kiến bác sĩ của bạn trước khi dùng sản phẩm này nếu bạn có sử dụng bất kỳ thiết bị y tế nào.

Các biện pháp phòng ngừa an toàn
SONY SẼ KHÔNG CHỊU TRÁCH NHIỆM PHÁP LÝ VỀ CÁC THIỆT HẠI THUỘC BẤT KỲ HÌNH THỨC NÀO LÀ HẬU
QUẢ CỦA VIỆC KHÔNG THỰC HIỆN CÁC BIỆN PHÁP BẢO MẬT PHÙ HỢP VỚI CÁC THIẾT BỊ TRUYỀN TẢI, SỰ
RÒ RỈ DỮ LIỆU KHÔNG THỂ TRÁNH ĐƯỢC DO CÁC THÔNG SỐ KỸ THUẬT TRUYỀN HOẶC CÁC VẤN ĐỀ BẢO
MẬT THUỘC BẤT KỲ HÌNH THỨC NÀO.
Tùy thuộc vào môi trường hoạt động, các bên thứ ba trái phép trên mạng có thể truy cập thiết bị. Khi kết nối thiết bị
với mạng, hãy đảm bảo rằng mạng được bảo vệ an toàn.
Từ quan điểm an toàn, khi sử dụng thiết bị được kết nối với mạng, bạn nhất định nên truy cập cửa sổ Điều khiển
thông qua trình duyệt Web và thay đổi cài đặt giới hạn truy cập từ các giá trị cài đặt trước của nhà sản xuất. Ngoài
ra, bạn nên đặt mật khẩu có chuỗi ký tự đủ dài để người khác khó đoán và lưu trữ mật khẩu đó một cách an toàn.
Khi kết nối sản phẩm này với mạng, hãy kết nối qua hệ thống cung cấp chức năng bảo vệ, chẳng hạn như bộ định
tuyến hoặc tường lửa. Nếu được kết nối mà không có biện pháp bảo vệ như vậy, các vấn đề bảo mật có thể xảy ra.

Nguồn điện
Thiết bị không được trang bị công tắc nguồn. Để tắt thiết bị, hãy kiểm tra xem tất cả các hoạt động đã kết thúc chưa
và thiết bị đang ở trạng thái chờ nguồn, sau đó ngắt kết nối bộ chuyển đổi AC. Khi sử dụng phân phối điện PoE++,
hãy ngắt kết nối cáp LAN.
Nếu có thể, hãy sử dụng nguồn điện từ nơi dễ cắm và tháo phích cắm điện.
Nếu bạn sử dụng ổ cắm ở nơi có nhiều bụi, hãy thường xuyên vệ sinh khu vực xung quanh ổ cắm để tránh bị trầy
xước.
Ngắt kết nối nguồn điện khi không sử dụng.

Các biện pháp phòng ngừa cho các bộ phận chuyển động
Đảm bảo rằng không có vật thể lạ xâm nhập vào các bộ phận chuyển động.
Không đặt quá tải khi di chuyển các bộ phận bằng tay. Làm như vậy có thể gây ra sự cố.
Không cản trở hoạt động của các bộ phận chuyển động trong quá trình chuyển động. Làm như vậy có thể gây ra
thương tích hoặc trục trặc.
Các bộ phận chuyển động có thể không hoạt động bình thường nếu không sử dụng thiết bị trong một thời gian dài.
Thường xuyên vận hành các chức năng xoay/nghiêng của thiết bị.

Các biện pháp phòng ngừa khi vận hành liên tục
Thiết bị có thể được cấp nguồn 24 giờ mỗi ngày, 365 ngày mỗi năm (trạng thái chờ nguồn).
Luôn thực hiện kiểm tra chụp ảnh và xác minh rằng thiết bị hoạt động bình thường.

Không đảm bảo chụp liên tục trong thời gian vượt quá 24 giờ.
Nếu chụp lâu hơn 24 giờ, hãy đặt thiết bị ở trạng thái chờ nguồn rồi khởi động lại thiết bị.

Lưu ý rằng Sony sẽ không chịu trách nhiệm bồi thường dưới bất kỳ hình thức nào về nội dung hình ảnh nếu bạn
không thể chụp do bất kỳ trục trặc nào khi sử dụng thiết bị này.
Hãy luôn đảm bảo rằng thiết bị hoạt động bình thường trước khi sử dụng. SONY SẼ KHÔNG CHỊU TRÁCH NHIỆM
PHÁP LÝ CHO BẤT KỲ THIỆT HẠI NÀO, BAO GỒM NHƯNG KHÔNG GIỚI HẠN, KHÔNG CHỊU TRÁCH NHIỆM
BỒI THƯỜNG CHO NHỮNG LỢI NHUẬN BỊ MẤT Ở THỜI ĐIỂM HIỆN TẠI HOẶC TƯƠNG LAI DO LỖI CỦA THIẾT
BỊ NÀY, DÙ LÀ TRONG THỜI GIAN BẢO HÀNH HAY SAU KHI ĐÃ HẾT BẢO HÀNH HOẶC VÌ BẤT KỲ LÝ DO GÌ.
SONY SẼ KHÔNG CHỊU TRÁCH NHIỆM VỀ PHÁP LÝ VỚI BẤT KỲ YÊU CẦU ĐÒI BỒI THƯỜNG NÀO CỦA
NGƯỜI DÙNG THIẾT BỊ HOẶC CỦA BÊN THỨ BA.
SONY SẼ KHÔNG CHỊU TRÁCH NHIỆM PHÁP LÝ VỀ VIỆC CHẤM DỨT HOẶC NGỪNG BẤT KỲ DỊCH VỤ LIÊN
QUAN ĐẾN THIẾT BỊ NÀY VÌ BẤT KỲ LÝ DO NÀO.

Các biện pháp phòng ngừa đối với chức năng ghi
Luôn ghi thử và kiểm tra để đảm bảo bạn đã ghi thành công. SONY SẼ KHÔNG CHỊU TRÁCH NHIỆM PHÁP LÝ
CHO BẤT KỲ THIỆT HẠI NÀO, BAO GỒM NHƯNG KHÔNG GIỚI HẠN, KHÔNG CHỊU TRÁCH NHIỆM BỒI
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THƯỜNG CHO VIỆC THIẾT BỊ NÀY HOẶC PHƯƠNG TIỆN GHI HOẶC BẤT KỲ PHƯƠNG TIỆN HOẶC HỆ
THỐNG LƯU TRỮ NÀO KHÁC KHÔNG THỂ GHI NỘI DUNG THUỘC BẤT KỲ LOẠI NÀO.
Hãy luôn đảm bảo rằng thiết bị hoạt động bình thường trước khi sử dụng. SONY SẼ KHÔNG CHỊU TRÁCH NHIỆM
PHÁP LÝ CHO BẤT KỲ THIỆT HẠI NÀO, BAO GỒM NHƯNG KHÔNG GIỚI HẠN, KHÔNG CHỊU TRÁCH NHIỆM
BỒI THƯỜNG CHO NHỮNG LỢI NHUẬN BỊ MẤT Ở THỜI ĐIỂM HIỆN TẠI HOẶC TƯƠNG LAI DO LỖI CỦA THIẾT
BỊ NÀY, DÙ LÀ TRONG THỜI GIAN BẢO HÀNH HAY SAU KHI ĐÃ HẾT BẢO HÀNH HOẶC VÌ BẤT KỲ LÝ DO GÌ.
SONY SẼ KHÔNG CHỊU TRÁCH NHIỆM VỀ PHÁP LÝ VỚI BẤT KỲ YÊU CẦU ĐÒI BỒI THƯỜNG NÀO CỦA
NGƯỜI DÙNG THIẾT BỊ HOẶC CỦA BÊN THỨ BA.
SONY SẼ KHÔNG CHỊU TRÁCH NHIỆM PHÁP LÝ VỀ VIỆC MẤT, SỬA CHỮA HOẶC TÁI TẠO BẤT KỲ DỮ LIỆU
NÀO ĐƯỢC GHI TRÊN HỆ THỐNG LƯU TRỮ NỘI BỘ, PHƯƠNG TIỆN GHI HOẶC BẤT KỲ HỆ THỐNG LƯU TRỮ
HOẶC PHƯƠNG TIỆN NÀO KHÁC.
SONY SẼ KHÔNG CHỊU TRÁCH NHIỆM PHÁP LÝ VỀ VIỆC CHẤM DỨT HOẶC NGỪNG BẤT KỲ DỊCH VỤ LIÊN
QUAN ĐẾN THIẾT BỊ NÀY VÌ BẤT KỲ LÝ DO NÀO.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Định dạng đầu ra và giới hạn

Chủ đề này mô tả định dạng đầu ra và giới hạn.

Chú ý

Độ phân giải của định dạng đầu ra bị giới hạn bởi thiết lập [Project] > [Rec Format] > [Frequency], [Codec] và [Video Format]
trong menu web hoặc menu camera.

Độ phân giải của định dạng đầu ra cũng bị giới hạn bởi sự kết hợp giữa tốc độ khung hình nhanh & chậm. Ngoài bảng định dạng
đầu ra của đầu nối SDI OUT/HDMI OUT bên dưới, đầu ra HDMI thay đổi thành Full HD hoặc thấp hơn khi tất cả các điều kiện
sau được đáp ứng.

[Shooting] > [S&Q Motion] > [Setting] được đặt thành [On]
[Shooting] > [S&Q Motion] > [Frame Rate] cao hơn 60fps

Khi đáp ứng được các điều kiện trên, các tùy chọn lựa chọn đầu ra HDMI 4096×2160P và 3840×2160P dành cho [Monitoring] >
[Output Format] > [SDI/HDMI] đều chuyển thành màu xám và không thể được chọn.

Hình ảnh không phải là đầu ra nếu độ phân giải lớn hơn độ phân giải hình ảnh phát lại được cấu hình.

Định dạng đầu ra của đầu nối SDI OUT/HDMI OUT

Khi tần số hệ thống là 50/59.94 Hz

Cài đặt Định dạng đầu ra có thể chọn

Chế độ ghi/phát lại Độ phân giải đầu ra RAW/
Độ phân giải ghi bên trong SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P (mặc định)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (mặc định)
1920×1080i
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Khi tần số hệ thống là 25/29.97 Hz

Cài đặt Định dạng đầu ra có thể chọn

Chế độ ghi/phát lại Độ phân giải đầu ra RAW/
Độ phân giải ghi bên trong SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A) (mặc định)
1920×1080P (mặc định)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A) (mặc định) 1920×1080P (mặc định)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A) (mặc định)
1920×1080P (mặc định)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Đầu ra dừng lại)
720×480P2)

720×576P3)

Không thể phủ lên màn hình hiển thị.1)

Khi tần số hệ thống là 59.942)

Khi tần số hệ thống là 503)

Cài đặt Output Format (độ phân giải đầu ra)

Chế độ ghi/phát lại Độ phân giải đầu ra RAW/
Độ phân giải ghi bên trong SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (mặc định)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
1920×1080i (mặc định)
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Khi tần số hệ thống là 23.98 Hz

Khi tần số hệ thống là 24 Hz

Cài đặt Output Format (độ phân giải đầu ra)

Chế độ ghi/phát lại Độ phân giải đầu ra RAW/
Độ phân giải ghi bên trong SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (mặc định) 1920×1080i (mặc định)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (mặc định) 1920×1080i (mặc định)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Cài đặt Output Format (độ phân giải đầu ra)

Chế độ ghi/phát lại Độ phân giải đầu ra RAW/
Độ phân giải ghi bên trong SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
3840×2160P
1920×1080P (mặc định)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (mặc định)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P (mặc định) 1920×1080P (mặc định)

3840×2160
3840×2160 (2SI)

3840×2160P
1920×1080P

1920×1080P (mặc định) 1920×1080P (mặc định)

1920×1080 1920×1080P (mặc định) 1920×1080P (mặc định)
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Cài đặt Output Format (độ phân giải đầu ra)

Chế độ ghi/phát lại Độ phân giải đầu ra RAW/
Độ phân giải ghi bên trong SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P (mặc định)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P (mặc định)

4096×2160P
1920×1080P (mặc định)
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Khắc phục sự cố

Nguồn điện

Đầu ra hình ảnh

Triệu chứng Nguyên nhân Giải pháp

Thiết bị không
bật nguồn.

Bộ chuyển đổi AC không được kết nối chắc chắn
với đầu nối DC IN.

Cắm dây nguồn chắc chắn đến mức có thể.

Dây nguồn AC không được cắm chắc chắn vào bộ
chuyển đổi AC hoặc ổ cắm AC.

Cắm dây nguồn chắc chắn đến mức có thể.

Cáp LAN không được kết nối chắc chắn giữa thiết
bị cấp nguồn PoE++ và thiết bị.

Kiểm tra xem cáp đã được cắm vào chưa cho
đến khi khóa.

Cáp LAN được kết nối với đầu nối OPTION, nhưng
không được kết nối với đầu nối LAN.

Kết nối cáp LAN với đầu nối LAN đúng cách.

Thiết bị được kết nối với thiết bị cấp nguồn không
hỗ trợ PoE++ (tuân thủ IEEE802.3bt, Loại 4, Bậc 8).

Kết nối với thiết bị cấp nguồn không hỗ trợ
PoE++ (tuân thủ IEEE802.3bt, Loại 4, Bậc 8).

Tổng mức tiêu thụ điện năng vượt quá mức đánh
giá tối đa của thiết bị cấp nguồn PoE++.

Tham khảo hướng dẫn vận hành cho thiết bị
cấp nguồn PoE++.

Cáp mạng có xếp hạng danh mục không hỗ trợ cấp
nguồn PoE++ được kết nối.

Sử dụng cáp mạng Loại 5e trở lên được kết
nối với đầu nối LAN.

Camera, thiết bị cấp nguồn PoE++ và các thiết bị
ngoại vi không được kết nối với đất.

Kết nối camera, thiết bị cấp nguồn PoE++ và
các thiết bị ngoại vi để kết nối với đất.

Triệu chứng Nguyên nhân Giải pháp

Không có hình ảnh nào
được xuất ra.

Các thiết bị được kết nối không được kết nối đúng cách.
Kết nối các thiết bị được kết
nối đúng cách.

Thiết lập ban đầu chưa được hoàn thành.
Hoàn thành thiết lập ban đầu
bằng Ứng dụng Web.

Không có hình ảnh nào
được xuất ra từ đầu nối
HDMI.

Tín hiệu không được thiết bị đích đầu ra HDMI hỗ trợ đang
được cấu hình.

Thay đổi cài đặt định dạng
đầu ra HDMI hoặc sử dụng
thiết bị hỗ trợ tín hiệu đầu ra.

Đang sử dụng cáp không hỗ trợ tiêu chuẩn HDMI đầu ra.
Sử dụng cáp hỗ trợ tiêu
chuẩn HDMI đầu ra đang
được sử dụng.
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Bộ điều khiển từ xa

Điều khiển hồng ngoại từ xa

Triệu chứng Nguyên nhân Giải pháp

Không có hình ảnh nào
được xuất ra từ đầu nối
SDI.

Cáp không hỗ trợ tiêu chuẩn SDI đầu ra đang được sử
dụng.

Sử dụng cáp hỗ trợ tiêu
chuẩn SDI đầu ra đang được
sử dụng.

Màn hình được kết nối với đầu nối SDI không hỗ trợ tín
hiệu đầu ra.

Sử dụng màn hình hỗ trợ
tiêu chuẩn SDI đầu ra.

Định dạng ghi được đặt cho đầu ra RAW.
Thay đổi định dạng ghi thành
cài đặt khác với đầu ra RAW.

Đầu ra HDMI được đặt thành độ phân giải SD. Đặt đầu ra HDMI thành độ
phân giải khác với SD.

Không có hình ảnh nào
được xuất ra từ sợi
quang hoặc hình ảnh bị
méo.

Mô-đun đang được sử dụng không tuân thủ các tiêu chuẩn
SFF hoặc SMPTE, hoặc không đáp ứng Mức công suất I
(1,0 W).

Xem “Xuất tín hiệu cáp
quang.”

Không có hình ảnh nào
được xuất ra hoặc bị
méo khi sử dụng đồng
bộ bên ngoài.

Tín hiệu đồng bộ bên ngoài phù hợp với định dạng tín hiệu
video đã định cấu hình không được đưa vào.

Nhập tín hiệu đồng bộ bên
ngoài phù hợp với định dạng
tín hiệu video đã định cấu
hình.

Có tạp âm trong âm
thanh.

Camera, thiết bị cấp nguồn PoE++ và các thiết bị ngoại vi
không được kết nối với đất.

Kết nối thiết bị, thiết bị cấp
nguồn PoE++ và các thiết bị
ngoại vi để kết nối với đất.

Thiết bị đang được sử dụng trong môi trường có các thiết
bị tạo ra điện trường và từ trường mạnh (chẳng hạn như
ăng ten máy phát TV/radio, máy phát vô tuyến nghiệp dư,
động cơ điều hòa không khí, máy biến áp cấp điện).

Tránh xa các thiết bị tạo ra
điện trường và từ trường
mạnh.

Ống kính, giá đỡ ống kính và bộ phận truyền động tiếp xúc
với thiết bị hoặc một vật thể trong môi trường xung quanh
và phát ra tiếng ồn bất thường.

Gắn ống kính đúng cách.

Kiểm tra xem có chướng
ngại vật nào gần camera
không.

Triệu chứng Nguyên nhân Giải pháp

Điều khiển hồng ngoại từ xa
không hoạt động khi được
nhấn.

Hoạt động điều khiển hồng ngoại từ
xa bị tắt.

Đặt [Technical] > [IR Remote] > [Setting] thành
[On] trong menu web.

Đã hết pin hoặc chiều phân cực
của pin không đúng.

Vận hành điều khiển hồng ngoại từ xa gần cảm
biến hồng ngoại từ xa của thiết bị. Nếu đèn
LED nguồn nhấp nháy, hãy thay pin.

Thiết lập ban đầu chưa được hoàn
thành.

Hoàn thành thiết lập ban đầu bằng Ứng dụng
Web.

Tốc độ vận hành
xoay/nghiêng chậm.

Tốc độ xoay/nghiêng từ điều khiển
hồng ngoại từ xa được đặt ở chế
độ bình thường.

Đặt công tắc SETUP 4 sang vị trí ON trên khối
đầu nối của thiết bị.
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Ứng dụng Web

Triệu chứng Nguyên nhân Giải pháp

Hoạt động nhắm mục tiêu
một camera khác với camera
chủ định.

Tín hiệu hồng ngoại được nhận bởi
một camera khác với camera chủ
định.

Đặt [Technical] > [IR Remote] > [Setting] thành
[Off] trong menu web của máy quay mà bạn
không muốn điều khiển.

Triệu chứng Nguyên nhân Giải pháp

Không thể vận hành camera từ bộ điều
khiển từ xa RM-IP500.

Nguồn điện cho camera
không được kết nối.

Kiểm tra xem đèn POWER của thiết bị sáng
màu xanh hay màu cam.

Camera hoặc bộ điều
khiển từ xa không được
kết nối với mạng.

Kiểm tra kết nối thiết bị và bộ điều khiển từ xa.

Thiết lập ban đầu của
camera chưa được hoàn
tất.

Hoàn thành thiết lập ban đầu bằng Ứng dụng
Web.

Giao tiếp VISCA over IP
không được bật.

Đặt công tắc SETUP 3 sang vị trí ON trên bảng
kết nối của thiết bị và khởi động lại thiết bị.

Địa chỉ IP của camera đã
thay đổi.

Kiểm tra địa chỉ IP của máy quay bằng cách sử
dụng [Network] > [Wired LAN] trong menu web
hoặc menu camera.

Địa chỉ IP của camera đã được thay
đổi bằng cách sử dụng AUTO IP
SETUP trên bộ điều khiển từ xa RM-
IP500.

Ít nhất 20 phút đã trôi
qua kể từ khi camera
được khởi động.

Khởi động lại thiết bị. Có thể thay đổi địa chỉ IP
bằng cách sử dụng AUTO IP SETUP trong vòng
20 phút đầu tiên sau khi khởi động thiết bị.
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Không thể kết nối bằng trình
duyệt web.

Cáp LAN loại 5e trở lên
không được kết nối.

Kết nối cáp LAN loại 5e trở lên.

Không kết nối đúng với
mạng LAN hoặc mạng
được kết nối không hoạt
động bình thường.

Kiểm tra xem đèn Link LED cho đầu nối LAN có
sáng không. Nếu đèn Link LED không sáng, hãy liên
hệ với quản trị viên mạng của bạn.

Nguồn điện cho camera
không được kết nối.

Xem phần “Nguồn điện” ở trên.

Địa chỉ IP hợp lệ không
được định cấu hình cho
thiết bị.

Thực hiện thiết lập lại mạng.

Địa chỉ IP đã định cấu
hình đang được sử dụng
trên một thiết bị khác.

Kiểm tra xem địa chỉ IP của các thiết bị ngoại vi có
phải là duy nhất không.

Mặt nạ mạng con được
cấu hình không khớp với
mạng con đã sử dụng.

Thực hiện thiết lập lại mạng.

Thiết bị đang được truy
cập trên cùng một mạng
cục bộ thông qua máy
chủ proxy.

Thay đổi cấu hình để máy chủ proxy không được sử
dụng.

Cửa ngõ mặc định được
định cấu hình cho thiết bị
không đúng.

Thực hiện thiết lập lại mạng.

URL đã nhập không
đúng.

Nhập URL đúng và thử lại.

Cổng HTTP không đúng.

Hiển thị menu camera trên màn hình bên ngoài và
kiểm tra cài đặt của [Network] > [Wired LAN] >
[HTTP Port]. Nếu một giá trị khác 80 được định cấu
hình, hãy thêm số cổng HTTP vào tên máy chủ lưu
trữ hoặc địa chỉ IP được nhập trong trình duyệt web.
Ví dụ: Nếu cổng HTTP được đặt thành 8080, hãy
nhập http://<IP Address>:8080

Số cổng HTTP của thiết
bị đang được lọc hoặc bị
chặn.

Đổi số cổng HTTP của thiết bị thành một cổng không
bị lọc hoặc bị chặn.

Bộ nhớ đệm cũ của trình
duyệt web đang có tác
động xấu.

Xóa bộ nhớ đệm khỏi trình duyệt web.

Không thể kết nối với Ứng dụng
Web bằng mã 2D (mã QR).

Thiết bị đang được sử
dụng không hỗ trợ
mDNS.

Sử dụng thiết bị hỗ trợ mDNS.
Nếu bạn đang sử dụng thiết bị không hỗ trợ mDNS,
hãy nhập trực tiếp địa chỉ IP vào trình duyệt web.

Máy tính bảng hoặc máy
tính được kết nối với
mạng khác với camera.

Kết nối máy tính bảng hoặc máy tính với cùng một
mạng cục bộ của thiết bị.
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Không thể kết nối với Ứng dụng
Web bằng cách nhập URL theo
cách thủ công.

Thiết bị đang được sử
dụng không hỗ trợ
mDNS.

Sử dụng thiết bị hỗ trợ mDNS.

Máy tính bảng hoặc máy
tính được kết nối với
mạng khác với camera.

Kết nối máy tính bảng hoặc máy tính với cùng một
mạng cục bộ của thiết bị.

Màn hình xác thực được hiển thị
liên tục.

Không nhập đúng tên
người dùng hoặc mật
khẩu.

Nhập tên người dùng và mật khẩu đã đăng ký. Nếu
bạn quên thông tin người dùng đã đăng ký, hãy xem
“Công tắc RESET” trong “Khối đầu nối” để khởi tạo
thông tin người dùng cho kết nối mạng.

Tên người dùng và mật
khẩu có thể đã bị thay đổi
bởi người dùng đăng
nhập bằng trình duyệt
web khác.

Kiểm tra tên người dùng và mật khẩu đúng với quản
trị viên thiết bị.

Hình ảnh camera không được
hiển thị trong Ứng dụng Web.

Đầu ra HDMI của camera
được đặt thành 720×480
hoặc 720×576.

Thay đổi độ phân giải của đầu ra HDMI của thiết bị.

Kết nối màn hình HDMI
không hỗ trợ tín hiệu đầu
ra HDMI của camera.

Tháo màn hình HDMI hoặc sử dụng màn hình HDMI
hỗ trợ cài đặt đầu ra HDMI.

Thiết bị đã được khởi
động lại và phiên bị ngắt
kết nối.

Chờ khoảng một phút và tải lại trình duyệt web.

Bộ nhớ đệm cũ của trình
duyệt web đang có tác
động xấu.

Xóa bộ nhớ đệm khỏi trình duyệt web.

Hình ảnh camera hiển thị trong
Ứng dụng Web có độ phân giải
thấp.

Độ phân giải cho phát
trực tuyến video 3 mà
Ứng dụng Web sử dụng
được đặt ở mức thấp.

Tăng giá trị bằng cách sử dụng [Stream] > [Video
Stream] > [Size 3] trong menu web.

Menu camera không xuất hiện khi
bạn nhấn nút [Menu].

Menu camera được định
cấu hình để không được
nhúng vào tín hiệu đầu ra
HDMI.

Đặt [Monitoring] > [Output Display] > [HDMI/Stream]
thành [On] trong menu web.

Giá trị của một cài đặt trên màn
hình cài đặt không được cập
nhật/hiển thị đúng cách.

Màn hình cài đặt của
Ứng dụng Web không tự
động phản ánh các cài
đặt đã thay đổi trong Ứng
dụng Web khác.

Nhấn nút [Reload] ở cuối màn hình cài đặt của Ứng
dụng Web. Các giá trị của cài đặt trên màn hình thiết
lập được hiển thị được tải lại và cập nhật.

Cài đặt của các tệp
Internet tạm thời đang bị
ảnh hưởng.

Xóa bộ nhớ đệm khỏi trình duyệt web.

Không thể tải xuống tệp cấu hình
hoặc nhật ký.

Chức năng tải xuống tệp
của trình duyệt web bị tắt.

Bật chức năng tải xuống tệp của trình duyệt web.
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Triệu chứng Nguyên nhân Giải pháp

Màn hình cài đặt của Ứng dụng
Uweb có thể truy cập được,
nhưng không thể thực hiện các
thao tác trên màn hình hoạt động
trực tiếp và màn hình hoạt động
phát lại.

Màn hình hoạt động của
Ứng dụng Web bị khóa.

Đặt công tắc khóa hoạt động ở trên cùng bên phải
trong Ứng dụng web thành vị trí  (Mở khóa vận
hành).

Màn hình Ứng dụng Web mất một
khoảng thời gian để hiển thị.

Hình ảnh phát trực tuyến
của thiết bị đang được
nhiều người dùng xem
đồng thời.

Giảm số lượng người dùng có thể truy cập đồng thời
vào Ứng dụng Web.

Hình ảnh bị méo hoặc giật.

Thông tin video không
được truyền đúng cách
do tắc nghẽn đường
truyền.

Giảm tốc độ bit phát trực tuyến hoặc đặt [Video
Stream 3] > [Size] thành tùy chọn nhỏ nhất, hoặc
giảm tốc độ để tạo lề trong băng tần truyền thông.

Nhiều trình duyệt web
đang chạy trên máy tính
bảng và đang chiếm bộ
nhớ.

Đóng mọi trình duyệt web đang chạy ẩn.

Quá nhiều thẻ trình duyệt
web được mở khiến hoạt
động bị chậm.

Đóng bất kỳ thẻ nào không được sử dụng.

Việc tích lũy quá nhiều bộ
nhớ đệm của trình duyệt
web và lịch sử duyệt web
đang làm chậm hoạt
động.

Xóa bộ nhớ đệm của trình duyệt web.

Triệu chứng Nguyên nhân Giải pháp

Hình ảnh trông bị méo khi bắt đầu và kết
thúc hoạt động xoay/nghiêng.

Hình ảnh có thể bị méo nếu bật chức năng
ổn định hình ảnh của ống kính.

Tắt chức năng ổn định
hình ảnh của ống kính.

Đã thay đổi góc xem mà không cần thao
tác của người dùng.

Đã xảy ra hiện tượng ống kính thở. Xem “Bù góc nhìn.”

Không thể thao tác lấy nét, thu phóng hoặc
cửa điều sáng.

Các cài đặt của công tắc trên ống kính có
thể không đúng.

Xem “Kiểm tra công tắc
ống kính.”

Triệu chứng Nguyên nhân Giải pháp

Không thể đặt lại chế độ
xoay/nghiêng.

Lẫy khóa xoay/nghiêng ở vị trí
LOCK.

Trượt lẫy khóa quét xoay/nghiêng lên xuống đến vị trí
UNLOCK (mở khóa).
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Camera không dừng ở vị
trí mong đợi.

Khối camera bị mất cân bằng.
Di chuyển khối camera về phía trước/phía sau đến vị trí
thích hợp như được mô tả trong phần “Gắn ống kính,”
sau đó bật lại thiết bị.

Đã gắn một ống kính không
hỗ trợ xoay/nghiêng.

Tham khảo thông tin về khả năng tương thích của ống
kính và gắn một ống kính hỗ trợ xoay/nghiêng, sau đó
bật lại thiết bị.

Không thể thực hiện đặt lại
xoay/nghiêng.

Thực hiện đặt lại xoay/nghiêng như mô tả trong “Đặt lại
chức năng xoay/nghiêng.”Một lực bất ngờ được tác

động vào đầu camera, gây ra
lỗi điều khiển xoay/nghiêng.

Máy quay không quay lại
mặt trước khi ấn nút

 (Trang chủ
xoay/nghiêng).

Chế độ gắn trần đã được kích
hoạt.

Đặt [Pan-Tilt] > [P/T Direction] > [Ceiling] trong menu web
theo cài đặt thực tế, sau đó bật lại thiết bị. Khi được gắn
trên trần, khối đầu nối sẽ ở phía trước camera.

Hoạt động xoay/nghiêng
bị hạn chế.

Giới hạn phạm vi
xoay/nghiêng được định cấu
hình.

Xóa cài đặt giới hạn phạm vi xoay/nghiêng, theo yêu cầu,
như mô tả trong “P/T Range Limit.”

Một lực bất ngờ được tác
động vào đầu camera, gây ra
lỗi xoay/nghiêng.

Thực hiện đặt lại xoay/nghiêng như mô tả trong “Đặt lại
chức năng xoay/nghiêng.”

Thao tác xoay/nghiêng di
chuyển theo hướng
ngược lại.

Cài đặt chế độ gắn trần khác
với trạng thái lắp thực tế.

Đặt [Pan-Tilt] > [P/T Direction] > [Ceiling] trong menu web
theo cài đặt thực tế.

Các cài đặt liên quan đến
hươngs xoay/nghiêng đã
được thay đổi.

Kiểm tra cài đặt [Pan-Tilt] > [P/T Direction] trong menu
web.

Hình ảnh không chuyển
động mượt mà khi bắt
đầu và kết thúc hoạt
động xoay/nghiêng.

Cài đặt gia tốc/giảm tốc hoạt
động xoay/nghiêng quá cao.

Giảm cài đặt gia tốc/giảm tốc hoạt động xoay/nghiêng để
chuyển động khi bắt đầu và kết thúc hoạt động
xoay/nghiêng mượt mà hơn bằng cách sử dụng [Pan-Tilt]
> [P/T Acceleration] > [Ramp Curve] trong menu web
hoặc menu camera. Lưu ý rằng điều này có nghĩa là ống
kính mất nhiều thời gian hơn để đạt được tốc độ tối đa.

Đã dừng hoạt động
xoay/nghiêng.

Khối camera bị mất cân bằng.
Di chuyển khối camera về phía trước/phía sau đến vị trí
thích hợp như được mô tả trong phần “Gắn ống kính,”
sau đó bật lại thiết bị.

Cài đặt đường dốc (gia
tốc/giảm tốc) quá cao đối với
ống kính đi kèm.

Nếu gắn ống kính lớn, hãy giảm giá trị [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] trong menu web hoặc
menu camera.

Đang sử dụng một ống kính
lớn.

Liên hệ với đại diện hỗ trợ Sony của bạn.
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Thiết bị bị che khuất khi
thao tác xoay/nghiêng.

Cần kẹp vít gắn vào bệ đỡ
ống kính chạm vào camera.

Xoay cần kẹp vít của bệ đỡ ống kính để nó hướng lên
trên.

Cần kẹp hỗ trợ ống kính chạm
vào camera.

Xoay cần kẹp hỗ trợ ống kính để hướng lên trên.

Cần khóa đầu camera chạm
vào camera.

Kiểm tra xem lẫy khóa đầu camera đã hoàn toàn ở vị trí
LOCK chưa.

Có tiếng ồn bất thường
trong quá trình hoạt động
xoay/nghiêng.

Camera bị mất cân bằng.
Di chuyển đầu camera về phía trước/phía sau đến vị trí
thích hợp sao cho đế trượt nằm ngang.

Cài đặt đường dốc (gia
tốc/giảm tốc) quá cao đối với
ống kính đi kèm.

Nếu gắn ống kính lớn, hãy giảm giá trị [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] trong menu web hoặc
menu camera.

Đầu camera không được cố
định ở vị trí và gây tiếng ồn di
chuyển trong quá trình hoạt
động.

Đặt lẫy khóa đầu camera sang vị trí LOCK.

Không thể lưu vị trí đặt
trước.

Không thể lưu cài đặt trước
nếu Thu phóng chất lượng
cao đang hoạt động.

Đặt tỷ lệ Thu phóng chất lượng cao về 1×. (cho biết tỷ lệ
không được hiển thị ở bên phải của  (Tỷ lệ thu
phóng))

Khung hình bị lệch khi
phát lại vị trí đặt trước.

Nhiệt độ của môi trường có
thể đã thay đổi đáng kể giữa
thời điểm lưu vị trí đặt trước
và khi vị trí đó được phát lại.

Lưu vị trí đặt trước.

Hiệu chỉnh ống kính không
được thực hiện.

Chạy hiệu chuẩn bằng cách sử dụng [Technical] > [Lens]
> [Lens Calibration] trong menu camera.

Một ống kính khác với ống
kính trước đó được gắn vào
khi lưu cài đặt trước. Hoặc vị
trí thu phóng để thu phóng thủ
công là khác nhau.

Lưu vị trí đặt trước.

Bảng điều khiển khung
của Ứng dụng web
chuyển sang màu xám
và không thể hoạt động.

Hoạt động xoay/nghiêng
không khả dụng khi màn hình
ảnh thu nhỏ được hiển thị và
trong khi phát lại.

Hiển thị màn hình điều khiển phát lại và thoát khỏi màn
hình thu nhỏ hoặc dừng phát lại.

Hoạt động xoay/nghiêng
không khả dụng khi hình ảnh
camera không thể hiển thị
trong Ứng dụng Web.

Xem “Ứng dụng Web” trong “Khắc phục sự cố.”

Lẫy khóa xoay/nghiêng ở vị trí
LOCK.

Trượt lẫy khóa quét xoay/nghiêng lên xuống đến vị trí
UNLOCK (mở khóa).

“Execute Pan-Tilt Reset”
được hiển thị bên dưới
bảng điều khiển khung
trong Ứng dụng web.

Một lực bất ngờ được tác
động vào đầu camera, gây ra
lỗi xoay/nghiêng.

Thực hiện đặt lại xoay/nghiêng như mô tả trong “Đặt lại
chức năng xoay/nghiêng.”
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Truyền tải tệp

Phát trực tuyến IP

Triệu chứng Nguyên nhân Giải pháp

Không bắt đầu ghi khi
nhấn nút START/STOP
ghi.

Thẻ nhớ đã đầy. Thay thẻ nhớ bằng thẻ nhớ có đủ dung lượng.

Thẻ nhớ cần được khôi phục. Khôi phục thẻ nhớ như mô tả trong “Khôi phục thẻ nhớ.”

Đèn ghi/đếm được định cấu
hình là đèn đếm, do đó đèn
không thể xác định trạng thái
ghi.

Định cấu hình đèn ghi/đếm để hoạt động như một đèn
ghi như được mô tả trong “Kết nối tín hiệu báo hiệu.”

Không thể ghi âm.

Một micrô không được kết nối.
Kết nối micrô hoặc thiết bị âm thanh với đầu nối AUDIO
IN trên khối đầu nối.

Cài đặt [Master Input Level] ở
giá trị nhỏ nhất.

Điều chỉnh [Master Input Level].

Âm thanh ghi được bị
méo.

Cài đặt mức đầu vào âm thanh
quá cao.

Điều chỉnh [CH1 Input Level] thành [CH4 Input Level] và
[Master Input Level].

Khi sử dụng micrô trong môi trường ồn ào, chẳng hạn
như địa điểm tổ chức nhạc sống, trước tiên hãy điều
chỉnh [AUDIO IN CH1 MIC Ref.] và [AUDIO IN CH2 MIC
Ref.].

Âm thanh ghi được có
độ ồn cao.

Cài đặt mức đầu vào âm thanh
quá thấp.

Điều chỉnh [Audio Input Level] và [Audio] > [Audio] >
[Audio Input] > [AUDIO IN CH1 MIC Ref.] hoặc [AUDIO
IN CH2 MIC Ref.] settings.

Không thể phát lại clip.

Clip đang được chỉnh sửa.
Không thể phát lại clip nếu bạn đã sửa đổi tên tệp hoặc
thư mục hoặc nếu clip đang được sử dụng trên máy
tính. Đây không phải là trục trặc.

Clip được ghi bằng camera
không phải thiết bị này.

Không thể phát lại hoặc hiển thị các clip được ghi bằng
camera không phải thiết bị này ở kích thước không
đúng. Đây không phải là trục trặc.

Triệu chứng Nguyên nhân Giải pháp

Tải lên tệp không
thành công.

Tên người dùng và mật khẩu trên
máy chủ không đúng.

Tên người dùng và mật khẩu trên máy chủ có thể
không đúng. Nhập các mục chính xác.
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Triệu chứng Nguyên nhân Giải pháp

Phát trực tuyến không khả
dụng.

Tên người dùng hoặc mật khẩu
đã nhập trong ứng dụng máy
khách để xem phát trực tuyến từ
thiết bị không đúng.

Nếu định dạng phát trực tuyến của thiết bị được đặt
thành [RTSP], [SRT-Listener], hoặc [NDI|HX], bạn
cần nhập tên người dùng và mật khẩu đã đặt cho
thiết bị này trong ứng dụng máy khách. Nhập đúng
tên người dùng và mật khẩu.

Giao thức phát trực tuyến không
được đặt.

Chọn giao thức mục tiêu bằng cách sử dụng
[Stream] > [Stream Setting] trong menu web.

Tối thiểu sáu phiên RTSP đã
được thiết lập.

Đặt số lượng phiên thành năm hoặc ít hơn.

Số cổng UDP không được đặt
đúng cách.

Đặt số cổng và các cài đặt khác cho giao thức mục
tiêu bằng cách sử dụng [Stream] > [Stream] >
[Stream Setting] trong menu web.

Giao tiếp UDP bị chặn. Kiểm tra cài đặt phần mềm bảo mật.

Âm thanh không được
phát trực tuyến.

Phát trực tiếp đầu ra âm thanh
được đặt thành [Off].

Đặt [Stream] > [Audio Stream] > [Setting] thành [On]
trong menu web.

Truyền trực tuyến đã bị
ngắt kết nối.

Cài đặt giao thức hoặc cài đặt
codec phát trực tuyến đã được
thay đổi trong quá trình phát trực
tuyến.

Đặt cài đặt giao thức và cài đặt codec phát trực
tuyến trước khi bắt đầu phát trực tuyến.

Không thể đặt kích thước
hình ảnh của [Video
Stream 1] thành
4096×2160 hay
3840×2160.

Kích thước hình ảnh là
1920×1080 khi [Output Format]
được đặt thành HDMI.

Không thể đặt kích thước hình ảnh để phát trực
tuyến cao hơn kích thước hình ảnh HDMI. Thay đổi
kích thước hình ảnh HDMI bằng cách sử dụng
[Monitoring] > [Output Format] trong menu web.

Không thể đặt tốc độ
khung hình của [Video
Stream 1] thành 60 FPS
hay 50 FPS.

Tốc độ khung hình phát trực
tuyến được đặt thành 29.97 hoặc
thấp hơn.

Tốc độ khung hình được sử dụng để phát trực tuyến
bị giới hạn bởi tần số hệ thống. Thay đổi tần số hệ
thống bằng cách sử dụng [Rec Format] >
[Frequency] trong menu web.

Không thể truy cập phát
trực tiếp [Video Stream 3].

[Video Stream 3] không hỗ trợ
RTSP/SRT/NDI.

Sử dụng [Video Stream 1] hoặc [Video Stream 2].

Màn hình RTSP/SRT
không được cập nhật/hiển
thị đúng cách.

Số cổng được sử dụng cho RTSP
hoặc SRT đang được lọc hoặc bị
chặn.

Đổi số cổng RTSP hoặc SRT thành một cổng không
bị lọc hoặc bị chặn bởi các thiết bị nhận phát trực
tuyến. Hoặc thay đổi số cổng được sử dụng cho
RTSP hoặc SRT trên thiết bị.

Hình ảnh bị méo hoặc
giật.

Thông tin video không được
truyền đúng cách do tắc nghẽn
đường truyền.

Giảm tốc độ bit phát trực tiếp hoặc đặt bộ giải mã
[Video Stream 2] ([Codec 2]) thành [Off] để tạo lề
trong băng tần truyền thông.

Thứ tự của các gói video đã thay
đổi trong kênh truyền thông.

Sử dụng cùng một nhà cung cấp dịch vụ Internet ở
cả phía thiết bị và phía bộ thu.

Không được phát hiện là
thiết bị NDI.

Giao thức phát trực tuyến không
được đặt thành NDI|HX.

Giao thức phát trực tuyến phải được đặt thành
NDI|HX để phát hiện thiết bị dưới dạng thiết bị NDI.
Đặt [Stream] > [Stream Setting] thành [NDI|HX]
trong menu web.
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Kết nối với các thiết bị bên ngoài

Đồng bộ hóa bên ngoài

Tally

Bộ điều khiển ống kính

Triệu chứng Nguyên nhân Giải pháp

Không thể sử dụng làm
thiết bị NDI.

Giấy phép NDI|HX chưa được cài
đặt.

Cài đặt giấy phép NDI|HX. Bạn có thể kiểm tra xem
có giấy phép NDI|HX không bằng cách sử dụng
[Stream] > [Stream] > [Stream Setting] > [NDI|HX] >
[License] trong menu web.

Triệu chứng Nguyên nhân Giải pháp

Không thể đồng bộ
hóa với nguồn bên
ngoài.

Tín hiệu đồng bộ bên ngoài phù hợp với
định dạng tín hiệu video đã định cấu hình
không được đưa vào.

Nhập tín hiệu đồng bộ bên ngoài phù hợp với định
dạng tín hiệu video đã định cấu hình.

Thiết bị được chấm dứt kép.
Thiết bị có một đầu cuối 75 Ω được tích hợp sẵn.
Kết nối trực tiếp với nguồn tín hiệu (một-một) hoặc
sử dụng bộ phân phối (bộ chia).

Triệu chứng Nguyên nhân Giải pháp

Đèn đếm
không sáng.

Độ sáng của đèn báo hiệu được đặt thành
Off.

Đặt bộ mã hóa âm thanh bằng cách sử dụng
[Technical] > [Tally] > [Tally Lamp Brightness] trong
menu web.

Đèn ghi/đếm được định cấu hình như một
đèn ghi.

Định cấu hình đèn ghi/đếm để hoạt động như một đèn
đếm như được mô tả trong “Kết nối tín hiệu báo hiệu.”

RM-IP500 được kết nối và VISCA over IP bị
tắt.

Đặt công tắc SETUP 3 sang vị trí ON trên khối đầu nối
của thiết bị.

Kết nối đầu nối OPTION không đúng hoặc
chốt mục tiêu không bị đoản mạch với
GND.

Chân 7 hoặc chân 8 đoản mạch của đầu nối OPTION
với GND như mô tả trong “Kết nối tín hiệu báo hiệu.”

Triệu chứng Nguyên nhân Giải pháp

[Communication Error] được
hiển thị trong  (Trạng thái
máy quay).

Máy quay không thể
giao tiếp với bộ điều
khiển ống kính.

Kiểm tra kết nối giữa thiết bị và bộ điều khiển ống kính, sau
đó cấp nguồn cho thiết bị và bộ điều khiển ống kính.

[Rotation Error] được hiển thị
trong  (Trạng thái máy
quay).

Lỗi xoay xảy ra với
bộ điều khiển ống
kính.

Phạm vi di chuyển thu phóng và phạm vi di chuyển ống kính
đã lưu không phù hợp. Khởi tạo bộ điều khiển ống kính.
Nếu sự cố vẫn tiếp diễn, hãy liên hệ với đại diện của nhà sản
xuất bộ điều khiển ống kính.
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Chủ đề liên quan

Xuất tín hiệu cáp quang

Khối đầu nối

Bù góc nhìn

Kiểm tra công tắc ống kính

Gắn ống kính

Đặt lại chức năng xoay/nghiêng

P/T Range Limit

Khôi phục thẻ nhớ

Kết nối tín hiệu báo hiệu

5-041-959-03(1) Copyright 2022 Sony Corporation

Triệu chứng Nguyên nhân Giải pháp

[System Error] được hiển thị
trong  (Trạng thái máy
quay).

Lỗi hệ thống xảy ra
với bộ điều khiển
ống kính.

Kiểm tra kết nối giữa thiết bị và bộ điều khiển ống kính, tham
khảo hướng dẫn vận hành bộ điều khiển ống kính và khởi
tạo bộ điều khiển ống kính hoặc chu kỳ hiệu suất của thiết bị
và bộ điều khiển ống kính.
Nếu sự cố vẫn tiếp diễn, hãy liên hệ với đại diện của nhà sản
xuất bộ điều khiển ống kính.

[Unknown Error] được hiển thị
trong  (Trạng thái máy
quay).

Lỗi chưa xác định
xảy ra với bộ điều
khiển ống kính.

Kiểm tra kết nối giữa thiết bị và bộ điều khiển ống kính, tham
khảo hướng dẫn vận hành bộ điều khiển ống kính và khởi
tạo bộ điều khiển ống kính hoặc chu kỳ hiệu suất của thiết bị
và bộ điều khiển ống kính.
Nếu sự cố vẫn tiếp diễn, hãy liên hệ với đại diện của nhà sản
xuất bộ điều khiển ống kính.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Thông báo lỗi/cảnh báo

Nếu một cảnh báo, thận trọng hoặc điều kiện hoạt động cần xác nhận xảy ra trên thiết bị, một thông báo sẽ hiển thị trong
bảng điều khiển hình ảnh máy quay, đồng thời đèn POWER và đèn NETWORK trên bảng điều khiển phía trước và đèn
ghi/báo hiệu bắt đầu nhấp nháy.

Chú ý

Chỉ báo nhấp nháy của đèn ghi/báo hiệu được bật khi cả hai tính năng [Technical] > [Tally] > [Tally Control] được đặt thành
[Internal] và [Tally Lamp Brightness] được đặt thành [Off] trong menu web hoặc menu máy quay.

Thông báo lỗi

Nếu đèn POWER và đèn NETWORK nhấp nháy như bên dưới, hãy thực hiện các biện pháp sau.

Thiết bị sẽ ngừng hoạt động khi xảy ra loại hiển thị sau.

Thông báo cảnh báo

Thực hiện theo các hướng dẫn được cung cấp nếu có hiển thị sau.

Đèn POWER Đèn
NETWORK Nguyên nhân và giải pháp

Nhấp nháy
chậm màu
cam

Nhấp nháy
chậm màu xanh

Thiết bị không thể vận hành bình thường. Để biết thêm thông tin chi tiết, hãy tham
khảo [Maintenance] > [System Log] trong menu web. Nếu sự cố vẫn tiếp diễn ngay
cả khi đặt thiết bị ở chế độ chờ hoặc tắt nguồn rồi bật lại, hãy liên hệ với đại diện
dịch vụ Sony của bạn.

Nhấp nháy
nhanh màu
cam

Nhấp nháy
nhanh màu
xanh

Đã xảy ra sự cố trên thiết bị. Hãy liên hệ với đại diện dịch vụ Sony.

Hiển thị
thông báo

Đèn ghi/
đếm Nguyên nhân và giải pháp

E + mã lỗi
Nhấp
nháy
nhanh

Cho biết sự bất thường trong thiết bị. Việc ghi hình dừng lại, ngay cả khi trong bảng điều
khiển hình ảnh máy quay hiển thị ●REC .
Tắt thiết bị và kiểm tra vấn đề với các thiết bị, cáp hoặc phương tiện. Nếu vẫn còn lỗi khi
bật lại thiết bị, hãy liên hệ với đại diện dịch vụ Sony. Có thể không hiển thị lỗi hoặc âm
thanh cảnh báo tùy thuộc vào trạng thái thiết bị.

Hiển thị thông báo Đèn ghi/đếm Nguyên nhân và giải pháp

Temperature High Nhấp nháy
Nhiệt độ bên trong cao.
Tắt máy quay và để máy nguội trước khi vận hành lại.

Media Temperature High Nhấp nháy
Nhiệt độ của thẻ CFexpress cao.
Tắt thiết bị và để nguội trước khi vận hành lại.
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Thông báo vận hành và thận trọng

Các thông báo vận hành và thận trọng sau có thể xuất hiện ở giữa màn hình. Làm theo hướng dẫn được đưa ra để giải
quyết vấn đề.

Hiển thị thông báo Đèn ghi/đếm Nguyên nhân và giải pháp

Voltage Low Nhấp nháy Điện áp DC IN thấp (mức 1). Kiểm tra nguồn điện.

Insufficient Voltage
Nhấp nháy
nhanh

Điện áp DC IN quá thấp (mức 2). Tính năng ghi bị tắt.
Kết nối nguồn điện khác.

Media Near Full Nhấp nháy
Dung lượng còn lại trên thẻ nhớ sắp hết.
Thay thế khi thuận tiện nhất.

Media Full
Nhấp nháy
nhanh

Không thể ghi hoặc sao chép clip vì thẻ nhớ không còn dung lượng.
Thay thế ngay.

Clips Near Full Nhấp nháy Số lượng clip thêm vào có thể ghi trên thẻ nhớ ngày càng thấp.
Thay thế khi thuận tiện nhất.

Clips Full
Nhấp nháy
nhanh

Đã đạt số lượng clip tối đa có thể ghi trên thẻ.
Không thể ghi hoặc sao chép thêm clip. Thay thế ngay.

Last Clip Recording Nhấp nháy
Clip hiện đang ghi là clip cuối cùng quay được vì đã đạt số lượng clip
tối đa.
Chuẩn bị thẻ nhớ mới.

Media(A) Life Near
End1) Nhấp nháy Thẻ nhớ sắp hết tuổi thọ. Thay thế khi thuận tiện nhất.

Media(A) Life End1) Nhấp nháy
nhanh

Thẻ nhớ đã hết tuổi thọ. Thay thế ngay.

Media(A) Near Full1) Nhấp nháy Khi sử dụng chức năng Simul Rec

Media(A) Full1) Nhấp nháy
nhanh

Khi sử dụng chức năng Simul Rec

Media(A) Clips Near
Full1) Nhấp nháy Khi sử dụng chức năng Simul Rec

Media(A) Clips Full1) Nhấp nháy
nhanh

Khi sử dụng chức năng Simul Rec

Media(A) Last Clip Rec1) Nhấp nháy Khi sử dụng chức năng Simul Rec

(Không hiển thị) Nhấp nháy

Lỗi chưa xác định xảy ra với bộ điều khiển ống kính.
Kiểm tra trạng thái ở trạng thái máy quay trong Ứng dụng Web.
Để biết thông tin chi tiết, hãy kiểm tra nhật ký hệ thống trong Ứng dụng
Web.

“(B)” sẽ hiển thị cho thẻ trong khe B.1)

Hiển thị thông báo Nguyên nhân và Giải pháp

Backup Battery End
Please Change

Dung lượng còn lại của pin dự phòng không đủ.
Kết nối thiết bị với nguồn điện trong ít nhất 24 giờ để sạc pin dự
phòng.

483



Thông tin lỗi phát trực tuyến RTMP

Thông tin lỗi sau có thể được hiển thị trên thiết bị. Thực hiện các hành động sau đây, theo yêu cầu.

Hiển thị thông báo Nguyên nhân và Giải pháp

Unknown Media(A)1)

Please Change

Đã lắp thẻ nhớ được phân vùng hoặc thẻ có nhiều clip hơn được
thiết bị hỗ trợ.
Không thể sử dụng thẻ trong thiết bị và phải thay thế.

Cannot Use Media(A)1)

Unsupported File System

Đã lắp thẻ nhớ sử dụng hệ thống tệp khác hoặc thẻ chưa được
định dạng.
Không thể sử dụng thẻ trong thiết bị và phải thay thế hoặc định
dạng bằng thiết bị.

Media Error
Media(A) Needs to be Restored1)

Đã xảy ra lỗi trên thẻ nhớ và phải khôi phục thẻ.
Khôi phục thẻ nhớ.

Media Error
Cannot Record to Media(A)1)

Thẻ nhớ có thể bị hỏng và không thể sử dụng để ghi được nữa.
Có thể phát lại, vì vậy bạn nên sao chép và thay thế thẻ nhớ.

Media Error
Cannot Use Media(A)1)

Thẻ nhớ có thể bị hỏng và không thể sử dụng để ghi hay phát lại
được nữa.
Không thể sử dụng thẻ trong thiết bị và phải thay thế.

Media(A) Error1)

Recording Halted
Playback Halted

Quá trình ghi và phát lại đã bị dừng do xảy ra lỗi khi sử dụng thẻ
nhớ.
Nếu sự cố vẫn tiếp diễn, hãy thay thẻ nhớ.

Media Reached Rewriting Limit
Change Media(A)1)

Thẻ nhớ đã hết tuổi thọ.
Sao lưu và thay thế thẻ ngay lập tức. Nếu tiếp tục sử dụng thẻ, có
thể không ghi hoặc phát lại được.
Để biết thêm chi tiết, hãy tham khảo hướng dẫn vận hành thẻ
nhớ.

The specified address is invalid.
Địa chỉ đã chỉ định không hợp lệ.
Kiểm tra thiết lập có chính xác không.

Cannot Use Specified Port Number
Số cổng đã chỉ định không hợp lệ.
Kiểm tra thiết lập có chính xác không.

Lens I/F Error(xx:xx)

Đã phát hiện lỗi ống kính trong giao tiếp I/F khi gắn ống kính ngàm
E.
Kiểm tra trạng thái kết nối với ống kính ngàm E.
Nếu sự cố vẫn tiếp diễn, hãy liên hệ với đại diện dịch vụ Sony của
bạn với mã lỗi (năm ký tự trong ngoặc đơn).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs was
reached.

Đã đạt giới hạn số lượng tác vụ truyền tối đa.
Xóa tất cả tác vụ không mong muốn. Thiết lập đích tải lên tự động
cho tệp proxy có thể không chính xác. Kiểm tra thiết lập có chính
xác không.

Fan Stopped

Quạt ngừng chạy.
Kiểm tra xem có bụi hay vật lạ không.
Nếu vẫn còn lỗi sau khi loại bỏ bụi hay vật lạ, hãy liên hệ với đại
diện dịch vụ Sony.

“(B)” sẽ hiển thị cho thẻ trong khe B.1)
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Thông tin lỗi phát trực tuyến SRT

Thông tin lỗi sau có thể được hiển thị trên thiết bị. Thực hiện các hành động sau đây, theo yêu cầu.

5-041-959-03(1) Copyright 2022 Sony Corporation

Mã lỗi
Mô tả Giải pháp

RTMP RTMPS

1002
1004

2002
2004

Không thể kết nối với máy
chủ RTMP.

Kiểm tra xem cài đặt URL máy chủ có chính xác không.
Kiểm tra kết nối mạng.

1003 2003 Không thể phân giải tên miền.
Kiểm tra xem cài đặt URL máy chủ có chính xác không.
Kiểm tra kết nối máy chủ DNS.

–
2005
2008

Lỗi CRL
Kiểm tra xem cài đặt URL máy chủ có chính xác không.
Kiểm tra xem đích kết nối có phải là trang web đáng tin cậy hay
không.

2006 Lỗi chứng chỉ CA
Kiểm tra xem cài đặt đồng hồ có chính xác không.
Kiểm tra xem chứng chỉ CA có chính xác không.

– 2007
Chưa cài đặt chứng chỉ CA.
Lỗi xác thực chứng chỉ máy
chủ.

Cài đặt chứng chỉ CA.
Kiểm tra xem đích kết nối có phải là trang web đáng tin cậy hay
không.

4002
Phiên RTMP đã bị ngắt kết
nối.

Thiết bị có thể đã bị ngắt kết nối ở phía máy chủ RTMP.
Kiểm tra xem cài đặt có khớp với tham số codec được đề xuất
của dịch vụ hay không.

4003
Chất lượng kết nối mạng
thấp.

Kiểm tra kết nối mạng.

Khác Lỗi khác.

Mã lỗi

Mô tả Giải phápSRT-
Caller

1001 Lỗi không mong muốn
Thiết bị có thể không hoạt động bình thường. Cấp nguồn thiết
bị.

1002
Liên lạc bị ngắt kết nối do thay đổi cài
đặt

Liên lạc bị ngắt kết nối vì cài đặt đã bị thay đổi.
Thiết lập lại kết nối.

5001 Lỗi không mong muốn
Thiết bị có thể không hoạt động bình thường. Cấp nguồn thiết
bị.

5005 Kết nối không thành công Kiểm tra xem cài đặt đích kết nối có chính xác không.

5006 Lỗi mã hóa Kiểm tra xem cài đặt mã hóa có chính xác không.

5007 Lỗi không mong muốn Thiết bị có thể không hoạt động bình thường. Cấp nguồn thiết
bị.5008 Lỗi không mong muốn

5009 Lỗi truyền tải
Thiết bị đã bị ngắt kết nối trong quá trình liên lạc.
Kiểm tra kết nối mạng.
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Danh sách mục menu

Các bảng sau đây liệt kê các mục menu của thiết bị.

Chú thích
“Menu camera” và “menu web”
●: Có sẵn
▲: Một số mục có sẵn
–: Không có sẵn

“All File” và “Scene File”
Có: Mục được lưu vào tệp ALL hoặc tệp cảnh
Không: Mục không được lưu

“All Reset (except for Network Settings)”
Khi [Reset]> [Reset] > [All Reset (except for Network Settings)] trong menu web được thực hiện:
Có: Mục được khởi tạo (không bao gồm các cài đặt mạng)
Không: Không áp dụng

“Network Reset”
Khi [Reset]> [Reset] > [Network Reset] trong menu web được thực hiện:
Có: Mục được khởi tạo (cài đặt mạng)
Không: Không áp dụng

“Factory Default”
Có: Mục được đặt lại về mặc định của nhà sản xuất
Không: Không áp dụng

Shooting

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Có Có Có Có Có

ND Filter ● – Có Có*1 Có Không Có

Shutter ● – Có Có Có Không Có

Iris ● – Có Có Có Không Có

Auto Exposure ● – Có Có*2 Có Không Có

White ● – Có Có*3 Có Không Có

White Setting ● – Có Không Có Không Có

Offset White ● – Có Không Có Không Có

Focus ● ▲ Có Không Có Không Có

S&Q Motion ● – Có Không Có Không Có
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Project

Paint/Look

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – Có Không Có Không Có

Noise
Suppression

● – Có Có Có Không Có

Flicker Reduce ● – Có Không Có Không Có

SteadyShot ● – Có Không Có Không Có

[Mode] không áp dụng*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] không áp dụng*2

[Preset White] không áp dụng*3

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Có Không Có Không Có

Rec Format ● ● Có Không Có*1 Không Có

Cine EI/Flex.ISO
Set

● – Có Không Có Không Có

Simul Rec ● ● Có Không Có Không Có

Proxy Rec ● ▲ Có Không Có Không Có

Interval Rec ● ● Có*2 Không Có Không Có

Picture Cache
Rec

● ● Có*2 Không Có Không Có

SDI/HDMI Rec
Control

● – Có Không Có Không Có

Assignable
Button

● – Có Không Có Không Có

All File – ● Không Không Không Không Không

[Frequency] không áp dụng*1

[Setting] không áp dụng*2

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – Không Không Không Không Không

Base Look ● ▲ Có*1 Không Có*1 Không Có*1

Reset Paint
Settings

● – Không Không Không Không Không
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Pan-Tilt

TC/Media

Monitoring

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – Có Có Có Không Có

Knee ● – Có Có Có Không Có

Detail ● – Có Không Có Không Có

Matrix ● – Có Có Có Không Có

Multi Matrix ● – Có*2 Có*2 Có Không Có

dữ liệu LUT được nhập dưới dạng giao diện cơ sở không được áp dụng*1

[Axis] không áp dụng*2

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● Không Không Có Không Không

P/T
Acceleration

● ● Không Không Có Không Không

P/T Range
Limit

– ● Không Không Có Không Không

P/T Direction – ● Không Không Có Không Không

P/T Preset – ● Không Không Có Không Không

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Có*1 Không Có Không Có

TC Display ● – Có Không Có Không Có

Users Bit ● – Có*1 Không Có Không Có

HDMI TC Out ● – Có Không Có Không Có

Clip Name
Format

● – *2 Không Có Không Có

Update Media ● – Không Không Không Không Không

Format Media ● – Không Không Không Không Không

Media Life ● – Không Không Không Không Không

[Setting] không áp dụng*1

[Auto Naming] áp dụng, [Camera ID] không áp dụng*2
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Audio

Thumbnail

Technical

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output Format ● ● Có Không Có Không Có

Output
Display

– ● Có Không Có Không Có

Display On/Off ● – Có Không Có Không Có

Video Signal
Monitor

● – Có Không Có Không Có

Marker ● – Có Không Có Không Có

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ Có Không Có Không Có

Audio
Output

● ▲ Có Không Có Không Có

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – Không Không Không Không Không

Set Clip Flag ● – Không Không Không Không Không

Lock/Unlock Clip ● – Không Không Không Không Không

Delete Clip ● – Không Không Không Không Không

Transfer Clip ● – Không Không Không Không Không

Transfer Clip
(Proxy)

● – Không Không Không Không Không

Filter Clips ● – Không Không Không Không Không

Customize View ● – Có Không Có Không Có

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color
Bars

● – *1 Không *1 Không Có

Genlock ● – Không Không Không Không Không
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Network

Stream

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Tally ● ● Có Không Có Không Có

Rec
Review

● – Có Không Có Không Có

Zoom ● – Có Không Có Không Có

IR
Remote

– ● Không Không Có Không Có

Lens ● – Có Không Có Không Có

APR ● – Không Không Không Không Không

[Type] áp dụng, [Setting] không áp dụng*1

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● Không Không Không Không Có

User – ● Không Không Không Có Có

Wired LAN*1 ▲ ● Không Không Không Có Không

File Transfer ● ▲ Có Không Có Có Có

FTP Server 1 – ● Không Không Có Không Có

FTP Server 2 – ● Không Không Có Không Có

FTP Server 3 – ● Không Không Có Không Có

SSL – ● Không Không Không Có Có

Referer Check – ● Không Không Không Có Có

Brute Force Attack
Protection

– ● Không Không Không Có Có

Không thể định cấu hình bằng menu máy quay (chỉ hiển thị)*1

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● Không Không Có*1 Không Có*1

Video
Stream

– ● Có Không Có Không Có

Audio
Stream

– ● Có Không Có Không Có
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Maintenance

5-041-959-03(1) Copyright 2022 Sony Corporation

[NDI|HX] > [License] không áp dụng*1

Mục
(cấp 2)

Menu
camera

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● Có Không Có Không Có

Accessibility – ● Có Không Không Không Có

Clock Set ● ● Có*1 Không Có*2 Không Có

Reset – ● Không Không Không Không Không

Hours Meter ● – Không Không Không Không Không

Information – ● Không Không Không Không Không

System Log – ● Không Không Không Không Có

HTTP Access
Log

– ● Không Không Không Không Có

Service – ● Không Không Không Không Không

EULA – ● Không Không Không Không Không

Software – ● Không Không Không Không Không

Thông tin ngày và giờ không thể áp dụng*1

Thông tin[Time Zone], ngày và giờ không thể áp dụng*2
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Mục đã lưu vị trí đặt trước

“Có” cho biết một cài đặt đã được lưu đối với vị trí đặt trước và “Không” cho biết một cài đặt chưa được lưu.

Mục xoay/nghiêng

Mục thu phóng

Mục lấy nét

Vị trí hiển thị Mục Lưu mục tiêu

Bảng điều khiển khung của màn hình vận hành trực tiếp
Vị trí xoay/nghiêng Có

[Pan-Tilt Speed] Không

[Pan-Tilt] trong menu web

[P/T Speed] Không

[P/T Acceleration] Không

[P/T Range Limit] Không

[P/T Direction] Không

[P/T Preset] > [Pan-Tilt] Không

[P/T Preset] > [Default] > [Pan-Tilt Speed] Có1)

Các giá trị cài đặt khi lưu vị trí đặt trước sẽ được lưu dưới dạng giá trị của vị trí đặt trước đó. Sau khi các giá trị được lưu, chúng có thể được
thay đổi cho từng vị trí đặt trước. Để biết thêm chi tiết, hãy tham khảo “Thay đổi tốc độ chuyển tiếp (xoay-nghiêng/thu phóng/lấy nét) của các vị
trí đặt trước bằng Ứng dụng Web”.

1)

Vị trí hiển thị Mục Lưu mục tiêu

Bảng điều khiển khung của màn hình vận hành trực tiếp
Vị trí thu phóng (khoảng cách tiêu cự) Có

[Zoom Speed] Không

[Pan-Tilt] > [P/T Preset] > [Default] trong menu web
[Zoom Sync] Có1)

[Zoom Speed] Có1)

[Technical] > [Zoom] trong menu camera [Zoom Type] Không

Các giá trị cài đặt khi lưu vị trí đặt trước sẽ được lưu dưới dạng giá trị của vị trí đặt trước đó. Sau khi các giá trị được lưu, chúng có thể được
thay đổi cho từng vị trí đặt trước. Để biết thêm chi tiết, hãy tham khảo “Thay đổi tốc độ chuyển tiếp (xoay-nghiêng/thu phóng/lấy nét) của các vị
trí đặt trước bằng Ứng dụng Web”.

1)
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Chủ đề liên quan
Thay đổi tốc độ chuyển đổi (xoay-nghiêng/thu phóng/lấy nét) khi khôi phục các vị trí đặt trước

5-041-959-03(1) Copyright 2022 Sony Corporation

Vị trí hiển thị Mục Lưu mục
tiêu

Bảng điều khiển hình ảnh máy quay của màn hình
vận hành trực tiếp

Tìm kiếm mục tiêu được chỉ định đối với AF theo
dõi thời gian thực

Không

Tọa độ đã chỉ định cho chức năng lấy nét điểm Không

Thẻ  (Focus) của màn hình vận hành trực tiếp

Nút chuyển [Touch Focus] Không

Nút chuyển [Auto Focus] Có

Trạng thái nút [Focus Hold] Không

Trạng thái nút [Push AF/MF] Không

[Face/Eye Detection AF] Có

[AF Subj. Shift Sens.] Có

[AF Transition Speed] Có

Focus Position Có1)

[Shooting] > [Focus] trong menu web

[Push AF Mode] (bao gồm cài đặt sử dụng các nút
có thể gán)

Không

[Touch Function in MF] Không

[AF Assist Control] Không

[Pan-Tilt] > [P/T Preset] > [Default] trong menu
web

[Focus Recall] Có2)

[MF Speed] Có2)

[Shooting] > [Focus] trong menu camera

Đặt kích thước và vị trí vùng lấy nét bằng cách sử
dụng [Focus Area]

Có

Đặt vị trí vùng lấy nét bằng cách sử dụng [Focus
Area (AF-S)]

Có

Không được khôi phục khi nút chuyển [Auto Focus] được thành on. Được khôi phục khi nút chuyển được đặt thành off.1)

Các giá trị cài đặt khi lưu vị trí đặt trước sẽ được lưu dưới dạng giá trị của vị trí đặt trước đó. Sau khi các giá trị được lưu, chúng có thể được
thay đổi cho từng vị trí đặt trước. Để biết thêm chi tiết, hãy tham khảo “Thay đổi tốc độ chuyển đổi (xoay-nghiêng/thu phóng/lấy nét) khi khôi
phục các vị trí đặt trước”.

2)

493



Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Sơ đồ khối

Audio Input

Audio Output

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cập nhật phần mềm ống kính ngàm E

Bạn có thể cập nhật phần mềm của ống kính ngàm E bằng thiết bị.
Tham khảo trang web về ống kính để biết các ống kính có thể được cập nhật và phần mềm tương ứng.
Phần mềm được cập nhật bằng cách sử dụng menu web.

Chú ý

Không thực hiện các hành động sau đây cho đến khi hoàn tất cập nhật.

Ngắt kết nối mạng
Tháo ống kính
Tắt nguồn

Nếu tin nhắn chỉ ra rằng cập nhật không thành công hiển thị, hãy kiểm tra mô tả được hiển thị và cố gắng cập nhật lại.

5-041-959-03(1) Copyright 2022 Sony Corporation

Gắn ống kính ngàm E vào thiết bị.1

Kiểm tra [Maintenance] > [Information] > [Lens] > [Model Name] và [Version Number] trong menu web.

Số phiên bản phần mềm của ống kính ngàm E được hiển thị ở bên cạnh.
Kiểm tra số phiên bản phần mềm, sau đó cập nhật phần mềm theo yêu cầu.

2

Tải xuống tệp cập nhật phần mềm ống kính cho Windows (.exe mở rộng) để thiết bị chạy Ứng dụng web.3

Trong [Maintenance] > [Information] > [Lens] > [Version Up], ấn nút [Choose File] và chọn tệp cập nhật đã
tải xuống.

4

Làm theo hướng dẫn trên màn hình.5
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Gắn nắp nút tháo ống kính

Bạn có thể ngăn việc tháo ống kính không chủ ý bằng cách gắn nắp nút tháo ống kính đi kèm với Giá đỡ trên trần CIB-
PCM1 (tùy chọn) vào nút tháo ống kính.

Chú ý

Cách này không ngăn việc tháo hoàn toàn ống kính.

Chủ đề liên quan

Gắn ống kính

5-041-959-03(1) Copyright 2022 Sony Corporation

Gắn ống kính.

Để biết thêm thông tin chi tiết về cách gắn ống kính, hãy tham khảo “Gắn ống kính.”

1

Trượt lẫy khóa xoay/nghiêng đến vị trí LOCK để khóa xoay/nghiêng đầu camera.2

Di chuyển khối camera đến vị trí để có thể gắn nắp đậy ống kính.3

Gắn nắp đậy ống kính sao cho nó che nút tháo ống kính.4

Giữ chặt nắp đậy ống kính bằng vít giữ nắp đậy ống kính.5
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Hướng dẫn trợ giúp
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Giấy phép

Giấy phép danh mục sáng chế AVC MPEG-4

SẢN PHẨM NÀY ĐƯỢC CẤP PHÉP THEO GIẤY PHÉP DANH MỤC SÁNG CHẾ AVC ĐỂ NGƯỜI TIÊU DÙNG SỬ
DỤNG CÁ NHÂN HOẶC CÁCH SỬ DỤNG KHÁC MÀ KHÔNG NHẬN ĐƯỢC THÙ LAO ĐỂ
(i) MÃ HÓA VIDEO THEO TIÊU CHUẨN AVC (“VIDEO AVC”) VÀ/HOẶC
(ii) GIẢI MÃ VIDEO AVC ĐƯỢC MÃ HÓA DO NGƯỜI TIÊU DÙNG THAM GIA VÀO HOẠT ĐỘNG CÁ NHÂN VÀ PHI
THƯƠNG MẠI VÀ/HOẶC NHẬN ĐƯỢC TỪ NHÀ CUNG CẤP VIDEO ĐƯỢC CẤP PHÉP CUNG CẤP VIDEO AVC.
GIẤY PHÉP KHÔNG ĐƯỢC CẤP HOẶC NGỤ Ý CHO VIỆC SỬ DỤNG VỚI CÁC MỤC ĐÍCH KHÁC. CÓ THỂ NHẬN
THÔNG TIN BỔ SUNG TỪ MPEG LA, L.L.C. XEM HTTP://WWW.MPEGLA.COM

Nhận phần mềm theo giấy phép GPL/LGPL

Sản phẩm này sử dụng phần mềm có áp dụng GPL/LGPL. Điều này cho biết rằng bạn có quyền truy cập, sửa đổi và
phân phối lại mã nguồn của các chương trình phần mềm này theo các điều kiện của GPL/LGPL.
Mã nguồn được cung cấp trên internet. Sử dụng URL sau và làm theo hướng dẫn tải xuống.
https://oss.sony.net/Products/Linux/
Chúng tôi không muốn bạn liên hệ với chúng tôi về nội dung của mã nguồn.

Mã nguồn μT-Kernel

Sản phẩm này sử dụng mã nguồn μT-Kernel theo giấy phép T-License 2.1 được cấp bởi TRON Forum (www.tron.org).

5-041-959-03(1) Copyright 2022 Sony Corporation
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Hướng dẫn trợ giúp

Interchangeable Lens Digital Camera
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Thông số kỹ thuật

Thông tin chung

Khối lượng
Khoảng 4,6 kg (chỉ thân máy)
Khoảng 6,0 kg (bao gồm ống kính SELP28135G)

Kích thước
Tham khảo “Kích thước bên ngoài.”

Nguồn điện yêu cầu
19,5 V DC
PoE++ (tuân thủ IEEE802.3bt, Loại 4, Bậc 8)

Năng lượng tiêu thụ
19,5 V DC: 80,0 W (tối đa)
PoE++: 71,3 W (tối đa)　

Nhiệt độ hoạt động
0 °C đến 40 °C

Nhiệt độ lưu trữ
−20 °C đến +60 °C

Định dạng ghi (video)
XAVC Intra
Chế độ XAVC-I 4K/QFHD: VBR, tốc độ bit 600 Mbps (tối đa), MPEG-4 AVC/H.264
Chế độ XAVC-I HD: CBG, 223 Mbps (tối đa), MPEG-4 AVC/H.264

XAVC Long
Chế độ XAVC-L QFHD: VBR, tốc độ bit 150 Mbps (tối đa), MPEG-4 H.264/AVC
Chế độ XAVC-L HD 50: VBR, 50 Mbps (tối đa), MPEG-4 H.264/AVC
Chế độ XAVC-L HD 35: VBR, 35 Mbps (tối đa), MPEG-4 H.264/AVC

Định dạng ghi (âm thanh)
LPCM 24-bit, 48 kHz, 4 kênh

Tỷ lệ khung hình ghi

XAVC Intra
Chế độ XAVC-I 4K: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
Chế độ XAVC-I QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Chế độ XAVC-I HD: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
Chế độ XAVC-L QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Chế độ XAVC-L HD 50: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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Chế độ XAVC-L HD 35: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Thời gian ghi/phát lại
XAVC Intra
Chế độ XAVC-I QFHD: 59.94P, Khoảng 30 phút (sử dụng CEA-G160T)
Chế độ XAVC-I HD: 59.94P, Khoảng 78 phút (sử dụng CEA-G160T)

XAVC Long
Chế độ XAVC-L QFHD: 59.94P, Khoảng 115 phút (sử dụng CEA-G160T)
Chế độ XAVC-L HD 50: 59.94P, Khoảng 155 phút (sử dụng CEA-G80T)
Chế độ XAVC-L HD 35: 59.94P, Khoảng 210 phút (sử dụng CEA-G80T)

Chú ý

Thời gian ghi/phát lại có thể thay đổi tùy theo điều kiện sử dụng và đặc điểm bộ nhớ. Thời gian ghi và phát lại đối với việc ghi liên
tục một clip duy nhất. Số lần thực tế có thể ngắn hơn, tùy thuộc vào số đoạn phim được ghi.

Phần điều khiển quét xoay/nghiêng lên xuống

Tốc độ xoay tối thiểu: 0,02 độ/giây
Tốc độ nghiêng tối thiểu: 0,02 độ/giây
Tốc độ xoay tối đa: 60 độ/giây
Tốc độ nghiêng tối đa: 60 độ/giây
Phạm vi xoay: −170 độ đến +170 độ
Phạm vi nghiêng: −30 độ đến +195 độ
Đánh giá tiêu chí tiếng ồn: NC35 hoặc thấp hơn
Vị trí đặt trước: 100

Phần camera

Thiết bị hình ảnh
Toàn khung 35mm (35,6 × 23,8 mm), bộ cảm biến Exmor R CMOS

Số điểm ảnh
Xấp xỉ 12,9 megapixel (tổng pixel)
Xấp xỉ 10,3 megapixel (pixel hữu ích)

Lấy nét tự động
Phương thức dò: Dò pha/dò tương phản

Bộ lọc ND nội bộ
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Biến tuyến tính ND: 1/4ND đến 1/128ND

Độ nhạy sáng ISO
ISO 800/12800 (Chế độ Cine EI, nguồn sáng D55)

Ngàm ống kính
Ngàm E

Độ rộng
15+ điểm
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Tốc độ màn trập
64F đến 1/8000 giây (23.98P)

Góc màn trập
5,6° đến 360°, 2 đến 64 khung

Chuyển động nhanh và chậm
XAVC QFHD: 1 fps đến 120 fps
XAVC HD: 1 fps đến 240 fps
XAVC 4K: 1 fps đến 60 fps
XAVC HD (S35): 1 fps đến 120 fps

Cân bằng trắng
2000 K đến 15000 K

Độ khuếch đại
−3 dB đến +30 dB (gia tăng 1 dB)

Giao diện cơ bản
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Phần âm thanh

Tần số lấy mẫu
48 kHz

Lượng tử hóa
24-bit

Tần số phản ứng
Chế độ MIC đầu vào XLR: 20 Hz đến 20 kHz (±3 dB hoặc thấp hơn)
Chế độ LINE đầu vào XLR: 20 Hz đến 20 kHz (±3 dB hoặc thấp hơn)

Phạm vi động
Chế độ MIC đầu vào XLR: 80 dB (Điển hình)
Chế độ LINE đầu vào XLR: 90 dB (Điển hình)

Biến âm
Chế độ MIC đầu vào XLR: 0,08% hoặc thấp hơn (Mức đầu vào −40 dBu)
Chế độ LINE đầu vào XLR: 0,08% hoặc thấp hơn (Mức đầu vào +14 dBu)

Phần đầu vào/đầu ra

Đầu vào
DC IN

Tuân thủ EIAJ, 19,5 V DC

AUDIO IN

Loại XLR, 5-pin, nữ
LINE / MIC / MIC+48V có thể chuyển đổi
MIC: Tương quan −30 dBu đến −80 dBu
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GENLOCK IN

Đầu nối BNC, 1,0 Vp-p, 75 Ω

TC IN

Đầu nối BNC

Đầu ra
SDI OUT

Đầu nối BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Đầu nối loại A

Đầu nối đầu ra OPTICAL

Tuân thủ SFP+
* Thiết bị này không hỗ trợ đầu vào tín hiệu quang học.

Đầu vào/đầu ra
Đầu nối LAN

RJ-45, 1000BASE-T

Đầu nối OPTION

RJ-45 kiểm đếm đầu nối đầu vào/đầu ra

Phần khe cắm phương tiện

Khe cắm thẻ CFexpress Type A/SD (2)

Phụ kiện đi kèm

Bộ đổi nguồn AC (1)
Dây nguồn (1)
Điều khiển hồng ngoại từ xa (1)
Nắp thân (1) (gắn vào thiết bị này)
Tấm giữ cáp HDMI (1)
Trước khi sử dụng thiết bị này (1)
Sách bảo hành (1)

Kích thước bên ngoài

Các kích thước là giá trị xấp xỉ.
Đơn vị: mm

Thân camera
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Giá đỡ trên trần
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Thiết kế và thông số kỹ thuật có thể thay đổi mà không cần thông báo.

5-041-959-03(1) Copyright 2022 Sony Corporation
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Thương hiệu

 là nhãn hiệu của Sony Group Corporation.
XAVC và  là các nhãn hiệu đã đăng ký của Sony Group Corporation.
Các thuật ngữ HDMI và HDMI High-Definition Multimedia Interface, cũng như lô-gô HDMI là các nhãn hiệu thương
mại hoặc các nhãn hiệu thương mại đã đăng ký của công ty HDMI Licensing Administrator, Inc. tại Hoa Kỳ và các
quốc gia khác.
Microsoft và Windows là các thương hiệu hay các thương hiệu đã đăng ký của Microsoft Corporation tại Hoa Kỳ
và/hoặc các quốc gia khác.
Mac và macOS là các nhãn hiệu đã đăng ký của Apple Inc. tại Hoa Kỳ và các quốc gia khác.
Lô-gô “Catalyst Browse” là nhãn hiệu hoặc nhãn hiệu đã đăng ký của Sony Group Corporation.
IOS là nhãn hiệu hoặc nhãn hiệu đã đăng ký của Cisco tại Hoa Kỳ và các quốc gia khác và nó được sử dụng theo
giấy phép.
iPadOS, Safari và iPad là các nhãn hiệu của Apple Inc., được đăng ký tại Hoa Kỳ và các quốc gia hay khu vực khác.
Android và Google Chrome là các nhãn hiệu hoặc nhãn hiệu đã đăng ký của Google LLC.
Wi-Fi là nhãn hiệu đã đăng ký của Wi-Fi Alliance.
Lô-gô SDXC là nhãn hiệu của SD-3C, LLC.
CFexpress và lô-gô CFexpress Type A là các nhãn hiệu của CompactFlash Association.
NewTek™ và NDI®là các nhãn hiệu của NewTek, Inc.
JavaScript là nhãn hiệu đã đăng ký của Oracle và/hoặc các chi nhánh của Oracle.
Intel, lô-gô Intel và Intel Core là các nhãn hiệu của Intel Corporation và các công ty con.
QR Code là nhãn hiệu của Denso Wave Inc.
Tất cả các tên công ty và tên sản phẩm khác đều là thương hiệu đã đăng ký hoặc thương hiệu của chủ sở hữu
tương ứng. Các mục đã đăng ký thương hiệu không được biểu thị bằng ký hiệu ™ hoặc ® trong tài liệu này.
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